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MyData – Home Care 

This document outlines the Home Care data you can access via MatrixCare MyData. MyData 

provides access to the following tables: 

• Activities 

• Activities Categories 

• Activity Entities 

• Activity Results 

• Activity Types 

• Address Book 

• Address Book Phones 

• Address Book Type 

• Admissions 

• Admissions Discharge Reasons 

• Admission Documents 

• Assessment 

• Attribute 

• Attribute Class 

• Authorization Dates 

• Authorization Detail 

• Availability Dates 

• Bill Codes 

• Bill Type 

• Branches 

• Branch Holidays 

• Branch Margins 

• Branch Taxes 

• Branch Tax Groups 

• Caregiver 

• Caregiver Branches 

• Caregiver Hiring 

• Caregiver Phones 

• Caregiver Referral Type 

• Caregiver Skill 

• Caregiver Values 

• Entities 

• Expense Types 

• HHA Categories 

• HHA Tasks 

• Invoice Batch 

• Invoice Batch Taxes 

• Invoice Batch Tax Groups 

• Invoice Details 

• Invoice Header 

• Invoice Process 

• Margin Types 

• Medications 

• OT Exempt Types 

• Payer Bill Codes 

• Payer Branches 

• Payer Phones 

• Payer Services 

• Payer Status 

• Payer Type 

• Payers 

• Payment Posting 

• Payment Posting Type 

• Payment Register  

• Payment Register Types 

• Payment Types 

• Payroll Adjustment 

• Region 

• Referral Entities 

• Region 

• Region Entities 

• Referral Facilities 
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• Client 

• Client Attributes 

• Client Branches 

• Client Date Status 

• Client Date Types 

• Client Dates 

• Client Documents 

• Client Inpatient Tracking 

• Client Inquiry 

• Client Inquiry Field List Items 

• Client Inquiry Fields 

• Client Inquiry Phones 

• Client Inquiry Rating 

• Client Inquiry Relation 

• Client Inquiry Values 

• Client Payers 

• Client Type 

• Diagnosis 

• Diagnosis Categories 

• Emergency Types 

• Payroll Adjustment Code 

• Payroll Batch 

• Payroll Details 

• Payroll Details OT 

• Phone Type 

• Physician 

• Physician Phones 

• Physician Status 

• Plan of Care 

• Plan of Care Diagnosis 

• Plan of Care Documents 

• Report Groups 

• Schedules 

• Schedules Tasks 

• Service Code 

• Referral Facilities Branches 

• Referral Facilities Status 

• Referral Facilities Documents 

• Referral Facility Documents Share 

levels 

• Referral Join 

• Referral Non Admission Reasons 

• Referral Rating 

• Referral Staff Join 

• Referral Territories 

• Referral Types 

• Referral By 

• Referral By Status 

• Plan of Care Medications 

• Plan of Care Mod Orders 

• Plan of Care Orders 

• Race 

• Rate Bill Shifts 

• Rate Schedule Last Changes 

• Rates 

• Rates Override Type 

• Rates type 

• Record Type 

• Report Group Types 

• Schedule Expenses 

• Schedule Payers 

• Schedule Recurrence 

• Schedule Shift 

• Schedule Shift Payers 

• Service Plans 

• Skill Categories 

• Tax Types 

• TelephonyCalls 

• Telephony Call Tasks 

• Users 
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Configuring MyData for Home Care 

For guidance on how to configure and set up MyData, refer to the MyData User Guide. Contact 

Home Care Support for additional information. 
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Activities 

 [dbo].[T_Activities] 

 

Description 

Contains data for Activity records for Related Entities. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
act_ID 

System generated unique identifier for Activity 

record. 

UI Location: Clients > Client Activities > ID 

bigint 8 False 1 - 1  

(2)

 

act_BranchID 

Branch ID of the related Branch. ID is used to pull 

office name to drop down control in the UI. 

Relates to T_Branches.br_ID. 

UI Location: Clients > Client Activities > Details tab 

> Office 

int 4 False   

 
act_StartTime 

Start Date/Time of the Activity. The default is the 

current date and time. 

UI Location: Clients > Client Activities > Details tab 

> Start 

and UI Location: Clients > Client Activities > Start 

Time 

datetime 8 False   

 act_EndTime 

End Date/Time of the Activity. End time defaults to 

the current date/time plus 15 minutes. 

UI Location: Clients > Client Activities > Details tab 

> End 

and UI Location: Clients > Client Activities > End 

Time 

datetime 8 False   

 
act_ActivityCategoryID 

Activity category ID of the related ActivityCategory. 

ID is used to pull activity category name to drop 

down control in the UI. 

Categories are setup on DDM > Activity 

Categories. 

Relates to T_ActivityCategories.actcat_ID. 

UI Location: Clients > Client Activities > Details tab 

> Category 

int 4 False   
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and UI Location: Clients > Client Activities > 

Category 

 
act_ActivityTypeID 

Activity Type ID of the related ActivityType. ID is 

used to pull activity type name to drop down control 

in the UI. 

Types are different for each Category. The Type 

will show in the Reminders as the Description. For 

more information. 

Activity Category selection filters Activity Type 

options in the UI. 

If act_ActivityTypeID is set to 3 then the record 

shows in communication screen not in the activity 

screen. 

Category types are setup on DDM > Activity Types. 

Relates to T_ActivityTypes.acttype_ID. 

UI Location: Clients > Client Activities > Details tab 

> Type 

and UI Location: Clients > Client Activities > Type 

int 4 False   

 
act_ActivityResultID 

Activity Result ID of the related ActivityResult. ID is 

used to pull activity results to drop down control in 

the UI. 

Activity results are setup on DDM > Activity 

Results. 

Activity Category selection filters Activity Results 

options in the UI. 

Relates to T_ActivityResults.actrslt_ID. 

UI Location: Clients > Client Activities > Details tab 

> Result 

and UI Location: Clients > Client Activities > 

Results 

int 4 False   

 act_Subject 

Subject/Description of the Activity that shows in the 

Activity tab. 

UI Location: Clients > Client Activities > Details tab 

> Subject 

and UI Location: Clients > Client Activities > 

Subject 

nvarchar(256) 512 True   

 act_Notes 

Additional notes for the Activity. If Display on 

Calendar is checked, the notes will appear on the 

Schedule Calendar and can be modified there also. 

Any changes made from the Schedule Calendar 

will be noted on the History tab of the activity. 

There is no character limit in this field. 

If act_ActivityTypeID is set to 3 then the record 

shows in communication screen not in the activity 

screen. 

UI Location: Clients > Client Activities > Details tab 

> Notes 

and UI Location: Clients > Client Activities > Notes 

nvarchar(max) max True   
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and UI Location: Clients > Client Activities > 

Communications > Notes 

 
act_ActivityShareLevelID 

Share Level ID of the related ShareLevel. ID is 

used to pull share level name to drop down control 

in the UI. 

Choose to select the needed Share Level for the 

activity. The default is Everyone. For more 

information, see DDM Activity Share Level. 

Relates to T_ActivityShareLevels.actslvl_ID. 

UI Location: Clients > Client Activities > Details tab 

> Share Level 

and UI Location: Clients > Client Activities > Share 

Level 

int 4 False  ((1)) 

 
act_RecurrenceId 

Recurrence ID of the related Recurrence. 

Relates to T_ActivityRecurrence.actrec_ID. 

bigint 8 True   

 act_IsRecurringAppointmentRoot 

True if a recurring appointment. Does not display 

on the User Interface. 

bit 1 False  ((0)) 

 act_CreatedDate 

The date the Activities record was created.  UTC 

date updated by SQL Server's current UTC date.  

UI Location: Clients > Client Activities > Created 

On 

datetime 8 False  (getutcdate()) 

 act_CreatedUser 

The user logged in to the system when the 

Activities record was created. 

UI Location: Clients > Client Activities > Created By 

nvarchar(50) 100 False   

 act_ModifiedDate 

The date when the Activities record was last 

modified.  UTC date updated by SQL Server's 

current UTC date. 

UI Location: Clients > Client Activities > Modified 

On 

datetime 8 False  (getutcdate()) 

 act_ModifiedUser 

The user logged in to the system when the 

Activities record was last modified.  

UI Location: Clients > Client Activities > Modified 

By 

nvarchar(50) 100 False   

 act_TS 

The time stamp of the Activities record. 

timestamp 8 False   

 
act_FollowupDate 

Reminder date for the Activity. 

A date for follow up action. This date represents 

the date the activity should begin to display in the 

user's Reminders. 

UI Location: Clients > Client Activities > Details tab 

> Reminder 

and UI Location: Clients > Client Activities > 

Reminder 

datetime 8 True   
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 act_LegacyID 

Not used. 

int 4 True   

 act_Dismiss 

Not used. 

bit 1 False  ((0)) 

 act_ReminderNotes 

Not used. 

nvarchar(2048) 4096 True   

 act_AssociatedCosts 

The cost associated with the activity performed, if 

needed. 

UI Location: Clients > Client Activities > Details tab 

> Cost 

and UI Location: Clients > Client Activities > Cost 

smallmoney 4 False  ((0)) 

 
act_LetterID 

ID of the Letter that generated this Activity.  

Null if not generated by a Letter. If this activity was 

generated from Letters, ID is used to pull letter n 

ame to the control in the UI. 

Relates to T_Letters.let_ID. 

UI Location: Clients > Client Activities > Details tab 

> Letter 

int 4 True   

 act_DisplayOnCalendar 

True if activity should be shown on the calendar as 

a scheduled event. 

If true, pushes and displays the current activity to 

the Schedule Calendar of the entity as well as all 

Related Entities. This checkbox provides the ability 

to push an activity directly to an entity’s schedule 

calendar. When the activity record is saved, that 

record will populate to the schedule calendar of the 

selected entity and all related entities. Schedule 

Conflict Checks will not run against these 

schedules. If checked, and the Activity Start/End 

Dates span multiple months, the Activity only 

dipslays on the month of the Start Date (will NOT 

span across two months on the Monthly Schedule 

Calendar display). 

UI Location: Clients > Client Activities > Details tab 

> Display On Calendar 

bit 1 False  ((0)) 

 act_StartOffset 

The number of minutes used to calculate local time 

based on UTC time for the activity starting time. 

smallint 2 True   

 act_EndOffset 

The number of minutes used to calculate local time 

based on UTC time for the activity ending time. 

smallint 2 True   

 act_TimeZoneID 

The ID of the timezone at the office location. 

smallint 2 True   
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Indexes 

Foreign Keys 

 

 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_Activities act_ID True 80 

 IX_T_Activities_BranchID_FollowupDate act_BranchID, act_FollowupDate   

 IX_T_Activities_act_BranchID_act_StartTime act_BranchID, act_StartTime  80 

Name No Check Columns 

FK_T_Activities_T_ActivityCategories  act_ActivityCategoryID->[dbo].[T_ActivityCategories].[actcat_ID] 

FK_T_Activities_T_ActivityRecurrence  act_RecurrenceId->[dbo].[T_ActivityRecurrence].[actrec_ID] 

FK_T_Activities_T_ActivityResults  act_ActivityResultID->[dbo].[T_ActivityResults].[actrslt_ID] 

FK_T_Activities_T_ActivityShareLevels True act_ActivityShareLevelID->[dbo].[T_ActivityShareLevels].[actslvl_ID] 

FK_T_Activities_T_ActivityTypes  act_ActivityTypeID->[dbo].[T_ActivityTypes].[acttype_ID] 

FK_T_Activities_T_Branches  act_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_Activities_T_Letters  act_LetterID->[dbo].[T_Letters].[let_ID] 
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Activity Categories 

 [dbo].[T_ActivityCategories] 

 

Description 

Contains data for Activity records for Categories. 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
actcat_ID Int  False 10001,1  

 actcat_Active Bit  False  ((1)) 

 actcat_CreatedDate datetime  False  (getutcdate()) 

 actcat_CreatedUser nvarchar(50)  False   

 actcat_ModifiedDate datetime  False  (getutcdate()) 

 actcat_ModifiedUser nvarchar(50)  False   

 actcat_TS timestamp  False   

 actcat_Name nvarchar(50)  False  ('') 

 actcat_ListItemType tinyint  False  ((0)) 

 
actcat_RptGroupID int  False  ((1)) 

 
actcat_BranchID int  True   

 
actcat_OverrideID int  True   

 actcat_Description nvarchar  True   

 actcat_DisplayOnCalendar bit  False  ((0)) 

Key Name Key Columns Unique Fill Factor 

 

PK_T_ActivityCategories actcat_ID True 80 

 IX_T_ActivityCategories_BranchOverrideName actcat_BranchID,  actcat_OverrideI

D, actcat_Name 

True 80 

 IX_T_ActivityCategories_Name actcat_Name False 80 

 IX_T_ActivityCategories_RptGroupID actcat_RptGroupID False  

Name Columns 

FK_T_ActivityCategories_T_ActivityCategories actcat_OverrideID-> [dbo].[T_ActivityCategories] ([actcat_ID]) 

FK_T_ActivityCategories_T_ActivityCategoriesRG actcat_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 

FK_T_ActivityCategories_T_Branches actcat_BranchID-> [dbo].[T_Branches] ([br_ID]) 
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Activity Entities 

 [dbo].[T_ActivityEntities] 

 

 

Description 

Maps Activity records to an entity. 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
actent_ID 

Unique Identifier for the ActivityEntity 

bigint 8 False 1 - 1  

 
actent_RecordType 

Specifies the Entity Type: 

 

None = 0 

Caregiver = 1 

Client = 2 

Physician = 3 

Payers = 4 

Admission = 5 

ReferralSource = 6 

SalesRep = 7 

GlobalSettings = 10 

OfficeSettings = 11 

UserSettings = 12 

ReferralContact = 17 

AddressBook = 73 

Staff = 75 

ClientInquiry = 76 

tinyint 1 False   

 
actent_RecordID 

Unique identifier for the entity of a 

specific type. 

bigint 8 False   

(2)

 

actent_ActivitiesID 

Activity ID of the associated Activity. 

bigint 8 False   

 actent_Notify 

Specifies whether the related entity 

should be notified. 

bit 1 False  ((0)) 

 actent_Print 

 

bit 1 False  ((0)) 

 
actent_Dismiss 

 

bit 1 False   
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Indexes 

Foreign Keys 

 

 

 actent_ReminderDismissedBy 

User that dismissed the reminder. 

nvarchar(50) 100 True   

 actent_ReminderDismissDate 

Date the reminder was dismissed. 

datetime 8 True   

 
actent_FollowupDate 

Reminder date for the entity. 

datetime 8 True   

 actent_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 actent_CreatedUser 

 

nvarchar(50) 100 False   

 actent_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 actent_ModifiedUser 

 

nvarchar(50) 100 False   

 actent_TS 

 

timestamp 8 False   

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_ActivityEntities actent_ID True 80 

 IX_T_ActivityEntities_ActivitiesID actent_ActivitiesID  80 

 IX_T_ActivityEntities_Dismiss_FollowupDate actent_Dismiss, actent_FollowupDate   

 IX_T_ActivityEntities_actent_Record-

Type_actent_RecordID 

actent_RecordID, actent_RecordType, 

actent_ActivitiesID 

 80 

Name Delete Columns 

FK_T_ActivityEntities_T_Activities Cascade actent_ActivitiesID->[dbo].[T_Activities].[act_ID] 
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Activity Results 

 [dbo].[T_ActivityResults] 

 

Description 

Contains data for Activity records for Results. 

Columns 

Indexes 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
actrslt_ID int  False 10001,1  

 
actrslt_ActivityCategoryID int  False   

 actrslt_Active bit  False  ((1)) 

 actrslt_CreatedDate datetime  False   

 actrslt_CreatedUser nvarchar  False   

 actrslt_ModifiedDate datetime  False   

 actrslt_ModifiedUser nvarchar  False   

 actrslt_TS timestamp  False   

 actrslt_Name nvarchar(50)  True  (‘’) 

 actrslt_ListItemType tinyint  False  ((0)) 

 
actrslt_RptGroupID int  False  ((7)) 

 
actrslt_BranchID int  True   

 
actrslt_OverrideID int  True   

 actrslt_Description nvarchar  True   

Key Name Key Columns Unique 

Fill 

Factor 

 

PK_T_ActivityResults actrslt_ID True 80 

 IX_T_ActivityResults_actrslt_ActivityTypeI

D 

actrslt_ActivityCategoryID False 80 

 IX_T_ActivityResults_BranchID_OverrideI

D_CategoryID_Name 

actrslt_BranchID,  actrslt_OverrideID,  a

ctrslt_ActivityCategoryID,  actrslt_Name 

True 80 
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Foreign Keys 

 

 

 

Name Columns 

FK_T_ActivityResults_T_ActivityCategories actrslt_ActivityCategoryID-> [dbo].[T_ActivityCategories] 

([actcat_ID]) 

FK_T_ActivityResults_T_ActivityResults actrslt_OverrideID-> [dbo].[T_ActivityResults] ([actrslt_ID]) 

FK_T_ActivityResults_T_Branches actrslt_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_ActivityResults_T_ReportGroups actrslt_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Activity Types 

 [dbo].[T_ActivityTypes] 

 

Description 

Contains data for Activity records for Types. 

Columns 

Indexes 

 

  

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
acttype_ID int  False 10001,1  

 
acttype_ActivityCategoryID int  False   

 acttype_Active bit  False  ((1)) 

 acttype_CreatedDate datetime  False  (getutcdate()) 

 acttype_CreatedUser nvarchar(50)  False   

 acttype_ModifiedDate datetime  False   

 acttype_ModifiedUser nvarchar(50)  False   

 acttype_TS timestamp  False   

 acttype_Name nvarchar(50)  True  ('') 

 acttype_ListItemType tinyint  False  ((0)) 

 
acttype_RptGroupID int  False  ((24)) 

 
acttype_BranchID int  True   

 
acttype_OverrideID int  True   

 acttype_Description nvarchar(1000)  True   

Key Name Key Columns Unique 

Fill 

Factor 

 

PK_T_ActivityTypes acttype_ID True 80 

 IX_T_ActivityTypes_acttype_Activity

CategoryID_acttype_Name 

acttype_ActivityCategoryID,  acttype_Name False 80 

 IX_T_ActivityTypes_BranchID_Overri

deID_CategoryID_Name 

acttype_BranchID,  acttype_OverrideID,  act

type_ActivityCategoryID,  acttype_Name 

True 80 
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Foreign Keys 

 

 

 

Name Columns 

FK_T_ActivityTypes_T_ActivityCategories acttype_ActivityCategoryID-> [dbo].[T_ActivityCategories] 

([actcat_ID]) 

FK_T_ActivityTypes_T_ActivityTypes acttype_OverrideID-> [dbo].[T_ActivityTypes] ([acttype_ID]) 

FK_T_ActivityTypes_T_Branches acttype_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_ActivityTypes_T_ReportGroups acttype_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Address Book 

 [dbo].[T_AddressBook] 

 

Description 

Address Book Records 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
addbk_ID 

Unique identifier for AddressBook 

record 

bigint 8 False 1 - 1  

(2)

 

addbk_BranchID 

br_ID of the related Branch. 

int 4 False   

(2) 
addbk_FirstName 

First Name 

nvarchar(50) 100 True   

(2) 
addbk_LastName 

Last Name 

nvarchar(50) 100 True   

 
addbk_CompanyName 

Company Name 

nvarchar(60) 120 True   

 addbk_Title 

Title 

nvarchar(60) 120 True   

 addbk_ContactName 

Contact Name 

nvarchar(50) 100 True   

 addbk_Position 

Position 

nvarchar(50) 100 True   

 addbk_BirthDate 

Birth Date 

datetime 8 True   

 
addbk_TypeID 

addbktyp_ID of AddressBook 

record Type. 

int 4 True   

 addbk_Notes 

Notes 

nvarchar(max) max True   

 addbk_Address1 

Address Line 1 

nvarchar(255) 510 True   

 addbk_Address2 

Address Line 2 

nvarchar(60) 120 True   

 addbk_City 

City 

nvarchar(50) 100 True   

 addbk_StateOrProvince 

State or Province 

nvarchar(20) 40 True   

 addbk_PostalCode 

Postal Code 

nvarchar(20) 40 True   
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 addbk_County 

County 

nvarchar(50) 100 True   

 addbk_Country 

Country 

int 4 True  ((240)) 

 addbk_Email 

Primary Email 

nvarchar(50) 100 True   

 addbk_Email2 

Secondary Email 

nvarchar(50) 100 True   

 addbk_CreatedUser 

 

nvarchar(50) 100 False   

 addbk_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 addbk_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 addbk_ModifiedUser 

 

nvarchar(50) 100 False   

 addbk_TS 

 

timestamp 8 False   

 addbk_AllowMassEmail 

True if the Contact can be mass 

emailed. 

bit 1 False  ((0)) 

 addbk_LegacyID 

 

int 4 True   

 
addbk_SalutationID 

salut_ID of the Salutation 

int 4 True   

 addbk_Hobbies 

Hobbies 

nvarchar(256) 512 True   

 addbk_LegacyBranchID 

 

int 4 True   

 addbk_ContactTypeBitwise 

0: AddressBook 

1: ReferrralSource 

2: ReferralContact 

4: Client 

8: Caregiver 

16 Physician 

32 Payers 

64: Staff 

128: UserSettings 

tinyint 1 False  ((0)) 

 temp_ID 

 

bigint 8 True   

 temp_Table 

 

nvarchar(50) 100 True   

 addbk_TextMessage 

Phone Number for Text Notifications 

nvarchar(50) 100 True   

 
addbk_RegionID 

reg_ID of the Region 

int 4 True   

 addbk_Website 

Website 

nvarchar(192) 384 True   
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Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_AddressBook addbk_ID True 80 

 IX_T_AddressBook_BranchID addbk_BranchID  80 

 IX_T_AddressBook_CompanyName addbk_CompanyName   

 IX_T_AddressBook_FirstNAme addbk_FirstName  80 

 IX_T_AddressBook_LastName addbk_LastName  80 

 IX_T_AddressBook_Unique addbk_BranchID, addbk_LastName, addbk_FirstName  80 

Name Columns 

FK_T_AddressBook_T_AddressBookType addbk_TypeID->[dbo].[T_AddressBookType].[addbktyp_ID] 

FK_T_AddressBook_T_Branches addbk_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_AddressBook_T_Region addbk_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_AddressBook_T_Salutation addbk_SalutationID->[dbo].[T_Salutation].[salut_ID] 
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Address Book Phones 

 [dbo].[T_AddressBookPhones] 

 

Columns 

Indexes 

Foreign Keys 

 

 

 

 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity 

Default 

 

adbkph_ID bigint  False (1,1)  

 

adbkph_AddressBookID bigint  False   

 adbkph_Phone [nvarchar](30) 30 False   

 

adbkph_PhoneType int  False   

 adbkph_Note [nvarchar](256) 256 True   

 adbkph_Sequence smallint  False  1 

Key Name Key Columns Unique Fill Factor 

 

PK_T_AddressBookPhones adbkph_ID True 80 

 IX_T_AddressBookPhones_Unique adbkph_AddressBookID, adbkph_Sequence True  

Name Columns 

FK_T_AddressBookPhones_T_AddressBook adbkph_AddressBookID-> [dbo].[T_AddressBook] ([addbk_ID]) 

FK_T_AddressBookPhones_T_PhoneType adbkph_PhoneType-> [dbo].[T_PhoneType] ([pht_ID]) 
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Address Book Type 

 [dbo].[T_AddressBookType] 

 

Columns 

 

  

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

addbktyp_ID 

Unique identifier for AdressBookType 

int  False (10001,1)  

 

addbktyp_Name 

Name of AddressBookType 

[nvarchar](50) 50 False   

 addbktyp_Active 

True if the AdressBookType option is 

selectable for new AddressBook 

records 

bit  False  1 

 addbktyp_CreatedDate datetime  False  (getutcdate()) 

 addbktyp_CreatedUser [nvarchar](50) 50 False   

 addbktyp_ModifiedDate datetime  False  (getutcdate()) 

 addbktyp_ModifiedUser [nvarchar](50) 50 False   

 addbktyp_TS timestamp  False   
 

addbktyp_ListItemType 

Specifies the scope of the 
Address Book Types 

0 = System, 1 = Branch, 2 = Override, 

3 = Branch No Global 

tinyint  False  0 

 
addbktyp_RptGroupID 

rptgrp_ID of the Report Group that the 

Share Level is associated with 

int  False  110 

 
addbktyp_BranchID 

br_ID of the related Branch 

int  False   

 
addbktyp_OverrideID 

addbktyp_ID of 

the AdressBookType to Override. 

int  False   

 addbktyp_Description 

Description of AdressBookType 

[nvarchar](1000) 1000 False   
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Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique Fill Factor 

 

PK_T_AddressBookType addbktyp_ID True 80 

 IX_T_AddressBookType_BranchOverrideName addbktyp_BranchID, addbktyp_OverrideID, 

addbktyp_Name 

True 80 

Name Columns 

FK_T_AddressBookType_T_AddressBookType addbktyp_OverrideID-> [dbo].[T_AddressBookType] ([addbktyp_ID]) 

FK_T_AddressBookType_T_Branches addbktyp_BranchID]-> [dbo].[T_Branches] ([br_ID]) 

FK_T_AddressBookType_T_ReportGroups addbktyp_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 



22 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Admission Documents 

 [dbo].[T_AdmissionDocuments] 

 

Description 

Admission Documents/Attachments. 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
admdoc_ID 

Unique identifier for Admission-

Document. 

bigint 8 False 1 - 1  

 

admdoc_AdmissionID 

adm_ID of the Admission the 

attachment is attached to. 

bigint 8 False   

 
admdoc_TypeID 

doctyp_ID of the Type of attachment. 

int 4 False   

 admdoc_Data 

Binary data of attachment 

image max False   

 admdoc_Format 

File extension of attahchment 

nvarchar(50) 100 False   

 admdoc_FileName 

Name of the attachment. 

nvarchar(256) 512 False   

 admdoc_FileSize 

File size of attachment 

bigint 8 True   

 admdoc_Thumbnail 

Data for thumnbail if attachment is an 

image. 

image max True   

 admdoc_Notes 

Notes 

nvarchar(4000) 8000 True   

 
admdoc_Sharelevel 

admdocslvl_ID of the Share Level 

int 4 False   

 admdoc_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 admdoc_CreatedUser 

 

nvarchar(50) 100 False   

 admdoc_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 admdoc_ModifiedUser 

 

nvarchar(50) 100 False   

 admdoc_TS 

 

timestamp 8 False   

 admdoc_isCompressed 

True if the file was compressed. 

bit 1 False  ((0)) 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 23 

Indexes 

Foreign Keys 

 

 

 
admdoc_SubTypeID 

docstyp_ID of the Subtype, if any. 

int 4 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_AdmissionDocuments admdoc_ID True 80 

 IX_T_AdmissionDocuments admdoc_AdmissionID  80 

Name Columns 

FK_T_AdmissionDocuments_T_Admission admdoc_AdmissionID->[dbo].[T_Admissions].[adm_ID] 

FK_T_AdmissionDocuments_T_AdmissionDocument-

ShareLevels 

admdoc_Sharelevel->[dbo].[T_AdmissionDocumentShare-

Levels].[admdocslvl_ID] 

FK_T_AdmissionDocuments_T_DocumentSubTypes admdoc_SubTypeID->[dbo].[T_DocumentSubTypes].[docstyp_ID] 

FK_T_AdmissionDocuments_T_DocumentTypes admdoc_TypeID->[dbo].[T_DocumentTypes].[doctyp_ID] 
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Admissions 

 [dbo].[T_Admissions] 

 

Description 

Records for Clients' Admissions. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) Allow Nulls Identity Default 

 

adm_ID 

System generated unique identifier for the 

admission record. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission ID (List View) 

and from Navigation menu > Clients > Client 

List tab > Admission > ID 

bigint 8 False 1 - 1  

 

adm_BranchID 

ID of the branch related to the admission. 

Used to pull office name and show in the UI. 

Relates to T_Branches.br_ID 

UI Location: Navigation menu > Clients > 

Client List tab > Admission > Admission tab > 

Office 

int 4 False   

(2)

 

adm_ClientID 

ID of the client related to the admission. 

Used to pull client name to show in the UI. 

Relates to T_Client.cli_ID 

and from Navigation menu > Clients > Client 

List tab > Admission > Client 

bigint 8 False   

 adm_MedicalRecordNumber 

Internal medical record number used to 

identify this admission, as entered on the 

primary Admission tab. 

UI Location: From Navigation menu > Clients 

> Client List tab > MR Number 

and from Navigation menu > Clients > Client 

List tab > Admission > Admission tab > 

Medical Record Number 

nvarchar(50) 100 True   

 adm_ReferralDate 

Referral date of the admission, as entered on 

Admission Referral. 

Non-UTC date. 

datetime 8 True   
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UI Location: From Navigation menu > Clients 

> Client List tab > Admission tab > Referral 

Date (List View) 

and from Navigation menu > Clients > Client 

List tab > Admission > Referral tab > Referral 

Date (through ReferralEditor1 Method) 

 adm_ReferralTakenBy 

Not used. 

nvarchar(50) 100 True   

 
adm_ReferralTypeID 

ID of the referral entity related to the 

admission. Used to pull entity type name. 

Relates to T_ReferralTypes.reftyp_ID 

int 4 True   

 
adm_NonAdmissionReasonID 

ID of the related referral non-admission 

reason for the record. Used to pull non-

admission reason name to show in the UI. 

This allows the agency to track why a client 

did not come onto service. For more 

information, see DDM Referral Non-

Admission Reasons. 

Relates to T_ReferralNonAdmission-

Reasons.refnar_ID 

UI Location: from Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Reason for Non-Admission 

int 4 True   

 
adm_StatusID 

ID of the related admission status for the 

admission record. Used to pull status name 

which shows in the UI. 

Relates to T_AdmissionStatus.admsts_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission Status (List 

View) 

and from Navigation menu > Clients > Client 

List tab > Admission > Status 

int 4 False   

 
adm_InternalCaseMgrID 

ID of the related caregiver that is the case 

manager in the admission record. Used to 

pull the case manager name through the 

search box to show in the UI. The Case 

Manager for this admission. Each employee 

must be designated as a Case Manager on 

the Caregiver HR tab (or Staff HR tab) in 

order to be selected here. Search for 

Caregivers or Staff configured to be a Case 

Manager. Click the icon to go to the record 

for the Case Manager. 

Relates to T_Caregiver.car_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Case Manager 

bigint 8 True   

 adm_VerbalSOCDate 

The verbal Start of Care date for this 

admission. 

datetime 8 True   
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Non-UTC date. 

UI Location: From Navigation menu > Clients 

> Client List tab > VSOC Date (Hidden) 

and from Navigation menu > Clients > Client 

List tab > Admission > Admission tab > 

Verbal SOC Date 

 adm_VerbalSOCTakenBy 

The name of the staff member who took the 

verbal Start of Care date. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Verbal SOC Taken By 

nvarchar(50) 100 True   

 
adm_SourceID 

ID of the related admission source for the 

admission record. Used to pull source of 

admission name. The appropriate Source of 

Admission. Medicare uses this to correctly 

establish and track home health episodes. 

The Reason Code displays below the 

selected source. 

Relates to T_AdmissionsSources.admsrc_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Source of Admission 

int 4 True   

 
adm_ActualSOCDate 

The Start of Care date of this Admission. If 

the client record was converted from a Client 

Inquiry, the SOC date will pull from the Client 

Inquiry Service Call tab. 

Non-UTC date. 

UI Location: From Navigation menu > Clients 

> Client List tab > SOC Date 

and from Navigation menu > Clients > Client 

List tab > Admission > SOC 

datetime 8 True   

 adm_PrimaryDiagnosis 

The primary diagnosis for the admission. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Primary Diagnosis 

nvarchar(1024) 2048 True   

 adm_DiagnosisNotes 

Additional diagnosis notes for the admission. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Diagnosis Notes 

nvarchar(1024) 2048 True   

 adm_ExcludeBillingFlag 

True if this admission should not be included 

in the billing process. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Exclude from 

Billing 

bit 1 False  ((0)) 

 adm_DischargeDate 

The date the client was discharged. 

Non-UTC date. 

datetime 8 True   
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UI Location: From Navigation menu > Clients 

> Client List tab > Discharge Date 

and from Navigation menu > Clients > Client 

List tab > Admission > Discharge tab > 

Discharge Date 

 
adm_DischargeReasonID 

ID of the related discharge reason for the 

admission record. Used to pull discharge 

reason name to show in the UI. Once 

selected, the discharge reason code displays 

the right of the D/C Reason field. For more 

information, see DDM Admission Discharge 

Reasons. 

Relates to T_AdmissionsDischarge-

Reasons.admdcr_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> D/C Reason 

int 4 True   

 adm_DischargeRecordedDate 

The date the discharge was recorded, if 

different from the Discharge Date.  

Non-UTC date. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Discharge Recorded Date 

datetime 8 True   

 adm_LastServiceDate 

The last service date for this admission. 

Non-UTC date. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Last Service Date 

datetime 8 True   

 adm_DischargeSummaryReason 

Summary of the discharge reason for this 

admission. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Discharge Reason 

nvarchar(255) 510 True   

 adm_DischargeSummaryEvaluationOfGoals 

Evaluation Goals for Discharge. Summary of 

the evaluation of goals for the Client. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Evaluation Goals 

nvarchar(255) 510 True   

 adm_DischargeSummaryConditionOfClient 

Condition of Client after Discharge. Summary 

of the condition of the Client. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Condition of Client 

nvarchar(255) 510 True   

 adm_DischargeSummaryDispositionOfClient 

Disposition of Client after Discharge. 

Summary of the disposition of the Client. 

nvarchar(255) 510 True   
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UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Disposition Notes 

 adm_OtherDischargeNotes_InternalUse 

Other discharge notes for internal use only. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Discharge tab 

> Other D/C Notes (Internal Use) 

nvarchar(255) 510 True   

 adm_CreatedDate 

The date the admission record was 

created.  UTC date updated by SQL Server's 

current UTC date.  

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Created On (through ModifiedRecord1 

method) 

datetime 8 False  (getutcdate(

)) 

 adm_CreatedUser 

The user logged in to the system when the 

admission record was created 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Created By (through ModifiedRecord1 

method) 

nvarchar(50) 100 False   

 adm_ModifiedDate 

The date when the admission record was last 

modified.  UTC date updated by SQL 

Server's current UTC date 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Modified On (through ModifiedRecord1 

method) 

datetime 8 False  (getutcdate(

)) 

 adm_ModifiedUser 

The user logged in to the system when the 

admission record was last modified. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Modified By (through ModifiedRecord1 

method) 

nvarchar(50) 100 False   

 adm_TS 

The timestamp of the admission record. 

timestamp 8 False   

 adm_NonAdmitDate 

Date of Non-Admittance of the admission 

record. 

Non-UTC date. 

UI Location: from Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Non Admit Date 

datetime 8 True   

 adm_HHASpecialInstructions 

Any special instructions, as needed. This 

information pulls to the Service Plan report 

on the Admission Reports.  

nvarchar(512) 1024 True   
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UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

Service Plan > Special Instructions 

 adm_HHAActivities 

Any activities, as needed. This information 

pulls to the Service Plan report on the 

Admission Reports. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

Service Plan > Activities 

nvarchar(512) 1024 True   

 adm_HHAOtherInstructions 

Any other instructions, as needed. This 

information pulls to the Service Plan report 

on the Admission Reports and POC Reports 

tabs. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

Service Plan > Other Instructions 

nvarchar(512) 1024 True   

 
adm_RelInfo 

Release information. Select from Informed 

Consent (I), No Release on File (N) -or- 

Signed Release on File (Y). 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Release Information 

nchar(1) 2 False  ('N') 

 
adm_AssignBenefits 

Assign Benefits. Assignment on File or No 

Assignment on File. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Assign Benefits 

nchar(1) 2 True   

 

adm_ReferralEntityTypeID 

ID of the referral entity type related to the 

admission. Used to pull entity type name to 

show in the UI. 

Relates to T_ReferralEntities.refent_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Entity Type (through ReferralEditor1 Method) 

tinyint 1 True   

 
adm_ReferralEntityID 

ID of the referral entity related to the 

admission. 

bigint 8 True   

 adm_ReferralNotes 

Any notes related to the admission referral 

record. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Notes (through ReferralEditor1 Method) 

nvarchar(max) max True   

 

adm_ReferralCampaignID 

ID of the referral campaign. Used to pull 

campaign name to show in the UI. If the 

agency sponsors Marketing Campaigns and 

the referral was the result of a campaign, 

select the option from the Campaign list. All 

int 4 True   



30 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

active campaigns are available for selection. 

For further information, see DDM Referral 

Campaigns. 

Relates to T_ReferralCampaigns.refcamp_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Campaign (through ReferralEditor1 Method) 

 
adm_ReferralContactJoinID 

Relates to T_ReferralJoin.refjoin_ID 

bigint 8 True   

 adm_StaffID 

 

ID of the related marketing staff on the 

admission record. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Marketing Staff (through ReferralEditor1 

Method) 

bigint 8 True   

 
adm_OasisPhysicianID 

ID of the related physician that will be 

included on the Oasis export on the 

admission record. 

Relates to T_Physician.phys_ID 

bigint 8 True   

 
adm_AdmissionsDispositionReasonsID_NAR 

ID of the related admission disposition 

reason for the admission record. Used to pull 

disposition name to show in the UI. When a 

client is discharged or determined to be a 

non admit, it is recommended to track the 

disposition reason as well as the discharge 

or non admit reason. Disposition Reasons 

help to define the state of the client, or where 

the client went after leaving the agency. 

Disposition Reasons are not required. For 

more information, see DDM Admission 

Disposition Reasons. 

Relates to T_AdmissionsDisposition-

Reasons.admdispr_ID 

UI Location: from Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Disposition Reason 

int 4 True   

 adm_NonAdmitNotes 

Any needed notes relate to non-admit of the 

admission record. 

UI Location: from Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Notes 

nvarchar(255) 510 True   

 
adm_AdmissionsDispositionReasonsID_-

DChg 

ID of the related admission disposition 

discharge reason for discharge on the 

admission record. Used to pull admission 

disposition discharge reason name. 

Relates to T_AdmissionsDisposition-

Reasons.admdispr_ID 

int 4 True   
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adm_ReferralTakenByID 

ID of the caregiver that referred the client for 

this admission record. Used to pull the 

referral name. 

Relates to T_Caregiver.car_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Referral tab > 

Taken By (through ReferralEditor1 Method) 

bigint 8 True   

 adm_CAHPSParticipationDeclined 

Exclusion indicator for client survey 

participation. Checking the box indicates the 

client should be included in the Total Number 

of Patients count only. Detailed client data is 

not included in the data file. 

Admission.CAHPS permission is required to 

access this option tab. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

CAHPS > Client Declines Survey 

Participation 

bit 1 False  ((0)) 

 adm_CAHPSReceivingHospice 

Exclusion indicator for client receiving 

hospice services. Checking the box indicates 

the client should be included in the Total 

Number of Patients count only. Detailed 

client data is not included in the data file. 

Admission.CAHPS permission is required to 

access this option tab. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

CAHPS > Client is Receiving Hospice 

Services 

bit 1 False  ((0)) 

 adm_CAHPSReceivingPediatric 

Exclusion indicator for client receiving 

pediatric services. Checking the box 

indicates the client should be included in the 

Total Number of Patients count only. Detailed 

client data is not included in the data file. 

Admission.CAHPS permission is required to 

access this option tab. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

CAHPS > Client is Receiving Pediatric 

Services 

bit 1 False  ((0)) 

 adm_CAHPSReceivingMaternity 

Exclusion indicator for client receiving 

maternity services. Checking the box 

indicates the client should be included in the 

Total Number of Patients count only. Detailed 

client data is not included in the data file. 

Admission.CAHPS permission is required to 

access this option tab. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission 

CAHPS > Client is Receiving Maternity 

Services 

bit 1 False  ((0)) 
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 adm_F2FEncounter 

The Face to Face Encounter date for the 

Start of Care Episode for this admission. Part 

of PPS 2011 regulatory changes with 

Medicare and cannot drop a final claim 

without this information. One F2F Encounter 

is needed for each Admission. This field is 

not required and may be modified at any 

time. Read the Face to Face Encounter 

Reference Sheet for information and 

documentation requirements. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> F2F Encounter 

date 3 True   

 adm_ReceivingInsulinInjectionServices 

Check the box if the client is receiving these 

services. Enter additional Notes in the field if 

needed (1000 character max). The default is 

set to unchecked when creating new 

Admissions. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Receiving Insulin Injection Services 

bit 1 False  ((0)) 

 adm_ReceivingHospiceServices 

Check the box if the client is receiving these 

services. Enter additional Notes in the field if 

needed (1000 character max). The default is 

set to unchecked when creating new 

Admissions. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Receiving Hospice services 

bit 1 False  ((0)) 

 adm_ReceivingInsulinServicesNotes 

Notes related to insulin injection services. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> unlabeled box under checkbox 

nvarchar(1000) 2000 True   

 adm_ReceivingHospiceServicesNotes 

Notes about hospice services. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> unlabeled box under checkbox 

nvarchar(1000) 2000 True   

 
adm_CertPhysicianID 

The ID of the certifying physician assigned to 

a the admission. Used to pull certifying 

physician name through the search box to 

show in the UI. the physician who will sign 

the F2F (Face to Face Encounter). The PPS 

Final Claim requires reporting of the 

Certifying Physician for certification periods 

starting on or after 07/01/2014. It is no longer 

required to save the Admission. If the 

Physician is not already in the database, add 

using the Physicians module under 

Operations from the Navigation Menu. 

bigint 8 True   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 33 

 

  

Relates to T_Physician.phys_ID 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Certifying Physician 

 adm_SupervisorID 

The ID of the supervisor for the admission. 

Used to pull supervisor name through the 

search box to show in the UI. Select a 

Supervisor for this admission. Each 

employee must be designated as a 

Supervisor on the Caregiver HR tab (or Staff 

HR tab) in order to be selected here. Search 

for Caregivers or Staff configured to be a 

Supervisor. Click the icon to go to the record 

for the Supervisor. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Supervisor 

bigint 8 True   

 adm_CoordinatorID 

The ID of the coordinator for the admission. 

Used to pull coordinator name through the 

search box to show in the UI. Select a 

Coordinator for this admission. Each 

employee must be designated as a 

Coordinator on the Caregiver HR tab (or Staff 

HR tab) in order to be selected here. Search 

for Caregivers or Staff configured to be a 

Coordinator. Click the icon to go to the record 

for the Coordinator. 

UI Location: From Navigation menu > Clients 

> Client List tab > Admission > Admission tab 

> Coordinator 

bigint 8 True   

 adm_Features 

This is a bitfield for controlling feature flags at 

the admission level. 

0=no features enabled 

1=Medication Module Enabled 

bigint 8 False  ((0)) 



34 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_Admissions adm_ID True 80 

 IX_T_Admissions_AdmID_ClientID adm_ID, adm_ClientID True 80 

 IX_T_Admissions_ActualSOCDate adm_ActualSOCDate  80 

 IX_T_Admissions_BranchID adm_BranchID  80 

 IX_T_Admissions_ClientID adm_ClientID  80 

 IX_T_Admissions_ReferralCampaignsID adm_ReferralCampaignID  80 

 IX_T_Admissions_ReferralEntityTypeID_Referral-

EntityID 

adm_ReferralEntityTypeID, adm_Referral-

EntityID 

 80 

Name Columns 

FK_T_Admissions_T_AdmissionsDischarge-

Reasons 

adm_DischargeReasonID->[dbo].[T_AdmissionsDischarge-

Reasons].[admdcr_ID] 

FK_T_Admissions_T_AdmissionsDisposition-

Reasons_Discharge 

adm_AdmissionsDispositionReasonsID_DChg->[dbo].[T_Admissions-

DispositionReasons].[admdispr_ID] 

FK_T_Admissions_T_AdmissionsDisposition-

Reasons_NonAdmitRsn 

adm_AdmissionsDispositionReasonsID_NAR->[dbo].[T_Admissions-

DispositionReasons].[admdispr_ID] 

FK_T_Admissions_T_AdmissionsSources adm_SourceID->[dbo].[T_AdmissionsSources].[admsrc_ID] 

FK_T_Admissions_T_AdmissionStatus adm_StatusID->[dbo].[T_AdmissionStatus].[admsts_ID] 

FK_T_Admissions_T_Branches adm_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_Admissions_T_Caregiver adm_InternalCaseMgrID->[dbo].[T_Caregiver].[car_ID] 

FK_T_Admissions_T_Caregiver_ReferralTaken-

By 

adm_ReferralTakenByID->[dbo].[T_Caregiver].[car_ID] 

FK_T_Admissions_T_Client adm_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_Admissions_T_Physician_CertPhysicianID adm_CertPhysicianID->[dbo].[T_Physician].[phys_ID] 

FK_T_Admissions_T_Physician_OasisPhysician adm_OasisPhysicianID->[dbo].[T_Physician].[phys_ID] 

FK_T_Admissions_T_ReferralCampaigns adm_ReferralCampaignID->[dbo].[T_ReferralCampaigns].[refcamp_ID] 

FK_T_Admissions_T_ReferralEntities adm_ReferralEntityTypeID->[dbo].[T_ReferralEntities].[refent_ID] 

FK_T_Admissions_T_ReferralJoin adm_ReferralContactJoinID->[dbo].[T_ReferralJoin].[refjoin_ID] 

FK_T_Admissions_T_ReferralTypes adm_ReferralTypeID->[dbo].[T_ReferralTypes].[reftyp_ID] 

FK_T_Admissions_T_RefferalNonAdmission-

Reasons 

adm_NonAdmissionReasonID->[dbo].[T_ReferralNonAdmission-

Reasons].[refnar_ID] 
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Admissions Discharge Reasons 

 [dbo].[T_AdmissionsDischargeReasons] 

 

Description 

Admission Discharge Reasons 

Columns 

 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
admdcr_ID 

Unique identifier for Discharge Reason  

int 4 False 10001 - 

1 

 

 admdcr_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 admdcr_CreatedUser 

 

nvarchar(50) 100 False   

 admdcr_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 admdcr_ModifiedUser 

 

nvarchar(50) 100 False   

 admdcr_TS 

 

timestamp 8 False   

 admdcr_Code 

 

nvarchar(50) 100 True   

 
admdcr_Name 

Name of Discharge Reason 

nvarchar(50) 100 False  ('') 

 
admdcr_ListItemType 

Specifies the scope of the Reason.  

0 = System, 1 = Branch, 2 = Override, 3 = 

Branch No Global 

tinyint 1 False  ((0)) 

 
admdcr_RptGroupID 

rptgrp_ID of the Report Group that the 

Discharge Reason is associated with. 

int 4 False  ((31)) 

 
admdcr_BranchID 

br_ID of the related Branch. 

int 4 True   

 

admdcr_OverrideID 

admdcr_ID of the Discharge Reason to 

Override. 

int 4 True   

 admdcr_Active 

True if the Discharge Reason is selectable 

for new Admission records. 

bit 1 False   

 admdcr_Description 

Description of the Discharge Reason  

nvarchar(1000) 2000 True   
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_AdmissionsDischargeReasons admdcr_ID True 80 

 IX_T_AdmissionsDischargeReasons admdcr_BranchID, admdcr_OverrideID, admdcr_Name True  

Name Columns 

FK_T_AdmissionsDischargeReasons_T_Admissions-

DischargeReasons 

admdcr_OverrideID->[dbo].[T_AdmissionsDischarge-

Reasons].[admdcr_ID] 

FK_T_AdmissionsDischargeReasons_T_Branches admdcr_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_AdmissionsDischargeReasons_T_ReportGroups admdcr_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 
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Assessment 

 [dbo].[T_Assessment] 

 

 

Note: Detailed documentation is pending. 
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Attribute 

 

 [dbo].[T_Attribute] 

 

 

Note: Detailed documentation is pending. 
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Attribute Class 

 

 [dbo].[T_AttributeClass] 

 

 

Note: Detailed documentation is pending. 

 

 



40 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Authorization 

 [dbo].[T_Authorization] 

 

 

Note: Detailed documentation is pending. 
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Authorization Dates 

 [dbo].[T_AuthorizationDates] 

 

 

Note: Detailed documentation is pending. 
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Authorization Detail 

 [dbo].[T_AuthorizationDetail] 

 

 

Note: Detailed documentation is pending. 
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Availability Dates 

 [dbo].[T_AvailabilityDates] 

 

Description 

Caregiver date ranges for schedule availability. 

Columns 

 

  

Key Name 

Data 

Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Default 

 

avdt_CaregiverID 

Caregiver ID for the availability dates record. 

Relates to [T_Caregiver].[car_ID]. 

bigint 8 False  

 

avdt_RecID 

The ID of the related recurrence for the availability dates record.  

Relates to [T_AvailabilityRecurrence].[avrec_ID]. 

bigint 8 False  

 

avdt_StartTime 

Starting day and time of the availability period on the current record.  

UI Location: Schedule Calendar > Select > Caregiver > Availability tab 

> Availability Recurrence window > Schedule Time > Start (time 

portion) 

UI Location: Schedule Calendar > Select > Caregiver > Availability tab 

> Availability Recurrence window > Schedule Time > Range of 

Recurrence  > Start (date portion) 

datetime 8 False  

 

avdt_EndTime 

Ending day and time of the availability period on the current record. 

UI Location: Schedule Calendar > Select > Caregiver > Availability tab 

> Availability Recurrence window > Schedule Time > End (time 

portion) 

UI Location: Schedule Calendar > Select > Caregiver > Availability tab 

> Availability Recurrence window > Schedule Time > Range of 

Recurrence  > End by (date portion) 

datetime 8 False  

 

avdt_Status 

Availability status of the caregiver during the period in the current 

record. 

UI Location: Schedule Calendar > Select > Caregiver > Availability tab 

> Availability Recurrence window > Status 

Values: 0 = Unavailable, 1 = Available 

tinyint 1 False ((0)) 
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Data Type Unique 

 
PK_T_AvailabilityDates avdt_CaregiverID, avdt_StartTime,  avdt_EndTime, 

avdt_Status 

 True 

 ID_T_AvailabilityDates_Start-

EndCar 

avdt_Status, avdt_StartTime, avdt_EndTime avdt_-

CaregiverID 

 

 IX_T_AvailabilityDates avdt_RecID   

Name Delete Columns 

FK_T_AvailabilityDates_T_AvailabilityRecurrence Cascade avdt_RecID->[dbo].[T_AvailabilityRecurrence].[avrec_ID] 

FK_T_AvailabilityDates_T_Caregiver  avdt_CaregiverID->[dbo].[T_Caregiver].[car_ID] 
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Bill Codes 

 

 [dbo].[T_BillCodes] 

 

 

Note: Detailed documentation is pending. 
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Bill Type 

 

 [dbo].[T_BillType] 

 

 

Note: Detailed documentation is pending. 
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Branch Holidays 

 [dbo].[T_BranchHolidays] 

 

Description 

Details about holidays for the branch. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
brhol_ID 

The ID of the BranchHoliday record. 

bigint 8 False 1 - 1  

 

brhol_BranchID 

The branch ID for the record. 

Relates to [T_Branches].[br_ID]. 

UI Location: Office > Holidays tab > ID 

int 4 False   

 brhol_Name 

The name of the holiday. 

UI Location: Office > Holidays tab > Holiday column 

nvarchar(50) 100 False   

 
brhol_StartDate 

Start date and time of the holiday. The start time 

defaults to 12:00 am.  

UTC date updated by SQL server based on office 

time zone. 

UI Location: Office > Holidays tab > Start Date/Time 

column 

datetime 8 False   

 brhol_EndTime 

End date and time of the holiday. The end time 

defaults to 12:00 am.  

UTC date updated by SQL server based on office 

time zone. 

UI Location: Office > Holidays tab > End Date/Time 

column 

datetime 8 False   

 
brhol_Multiplier 

The multiplier to be used against the established bill 

rates for the holiday rate calculations. The default 

value is 1.00.  Leave this value if no multiplier is to 

be used.  The multiplier for time and a half is 1.50. 

UI Location: Office > Holidays tab > Bill Multiplier 

column 

decimal(8,2) 5 False  ((0)) 

 brhol_Addition 

The additional amount to be added to the established 

hourly bill rates for the holiday rate calculations. The 

smallmoney 4 False  ((0)) 
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default value is 0.00.  Leave this value if no Add-On 

is to be used. 

UI Location: Office > Holidays tab > Bill Hourly Add-

On column 

 brhol_CreatedDate 

The date the record was created.  

UTC date updated by SQL Server's current UTC 

date. 

datetime 8 False  (getutcdate()) 

 brhol_CreatedUser 

The user who created the record. 

nvarchar(50) 100 False   

 brhol_ModifiedDate 

The date the record was modified. 

UTC date updated by SQL Server's current UTC 

date. 

datetime 8 False  (getutcdate()) 

 brhol_ModifiedUser 

The user who made the most recent record 

modification. 

nvarchar(50) 100 False   

 brhol_TS 

The time stamp for the record. 

timestamp 8 False   

 brhol_PayMultiplier 

The multiplier to be used against the established pay 

rates for the holiday rate calculations. The default 

value is 1.00.  Leave this value if no multiplier is to 

be used.  The multiplier for time and a half is 1.50. 

UI Location: Office > Holidays tab > Pay Multiplier 

column 

decimal(8,2) 5 False  ((0)) 

 brhol_PayAddition 

The additional amount to be added to the established 

hourly pay rates for the holiday rate calculations. The 

default value is 0.00.  Leave this value if no Add-On 

is to be used. 

UI Location: Office > Holidays tab > Pay Hourly Add-

On column 

smallmoney 4 False  ((0)) 

 brhol_PayVisitAddition 

The additional amount to be added to the established 

visit pay rates for the holiday rate calculations. The 

default value is 0.00.  Leave this value if no Add-On 

is to be used. 

UI Location: Office > Holidays tab > Pay Visit Add-

On column 

smallmoney 4 False  ((0)) 

 brhol_BillVisitAddition 

The additional amount to be added to the established 

visit bill rates for the holiday rate calculations. The 

default value is 0.00.  Leave this value if no Add-On 

is to be used. 

UI Location: Office > Holidays tab > Bill Visit Add-On 

column 

smallmoney 4 False  ((0)) 
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Indexes 

Foreign Keys 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_BranchHolidays brhol_ID True 80 

 IX_T_BranchHolidays_Unique brhol_BranchID, brhol_StartDate True 80 

Name Columns 

FK_T_BranchHolidays_T_Branches brhol_BranchID->[dbo].[T_Branches].[br_ID] 
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Branch Margins 

 [dbo].[T_BranchMargins] 

 

Description 

Gross Margin table with entries for liabilities that affect Gross Margin. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
brmarg_ID 

The ID field of the BranchMarginsInfo object. 

This is a system generated ID number for the 

branch margin record. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > brmarg_ID (Hidden) 

bigint 8 False 1 - 1  

 
brmarg_BranchID 

The BranchID field of the BranchMarginsInfo 

object. 

This is a system generated branch ID number in 

the branch margin record. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > BranchID (Hidden) 

int 4 False   

 
brmarg_TypeID 

The TypeID field of the BranchMarginsInfo object. 

This is a system generated branch margin type ID 

number in the branch margin record. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > brmarg_TypeID (Hidden) 

int 4 False   

 brmarg_Name 

The Name field of the BranchMarginsInfo object. 

The name of the branch margin. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Name 

nvarchar(50) 100 False   

 brmarg_Desc 

The Desc field of the BranchMarginsInfo object. 

The description of the branch margin. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Description 

nvarchar(100) 200 True   

 
brmarg_Percent 

The Percent field of the BranchMarginsInfo object. 

The percentage number amount.The sum of 

all brmarg_Percent is called Payroll-

Margin, BranchMargin, PayrollMargin. 

decimal(5,4) 5 True   
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UI Location: Settings > Office > Office Settings > 

Gross Margin > % 

 
brmarg_FixedAmt 

The FixedAmt field of the BranchMarginsInfo 

object. 

The sum of all brmarg_FixedAmt is called Payroll-

MarginFixedAmt. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Fixed Amount 

money 8 True   

 brmarg_EffectiveStart 

The EffectiveStart field of the BranchMarginsInfo 

object. 

UTC date updated by SQL server based on office 

time zone. 

Beginning date for the current record to apply. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Effective From 

datetime 8 False   

 brmarg_EffectiveEnd 

The EffectiveEnd field of the BranchMarginsInfo 

object. 

UTC date updated by SQL server based on office 

time zone. 

Ending date for the current record to apply. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Effective To 

datetime 8 False   

 brmarg_CreatedDate 

The Date the BranchMargins Record was 

Created. 

UTC date updated by SQL server's current UTC 

date. 

The date the branch margin record was created. 

Also called CreatedDate. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Created On 

datetime 8 False  (getutcdate()) 

 brmarg_CreatedUser 

The CreatedUser field of the BranchMarginsInfo 

object. 

The used logged in to the system when the 

branch margin record was created. 

Also called CreatedUser. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Created By 

nvarchar(50) 100 False   

 brmarg_ModifiedDate 

The Date the BranchMargins Record was last 

Modified. 

UTC date updated by SQL server's current UTC 

date. 

The date when the branch margin record was last 

modified. 

Also called ModifiedDate. 

datetime 8 False  (getutcdate()) 
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Indexes 

 

Foreign Keys 

 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Modified On 

 brmarg_ModifiedUser 

The ModifiedUser field of the BranchMarginsInfo 

object. 

The used logged in to the system when the 

branch margin record was last modified. 

Also called ModifiedUser. 

UI Location: Settings > Office > Office Settings > 

Gross Margin > Modified By 

nvarchar(50) 100 False   

 brmarg_TS 

The TS field of the BranchMarginsInfo object. 

The timestamp field of the branch margin record. 

timestamp 8 False   

Key Name Key Columns Unique Fill Factor 

 
PK_T_BranchMargins brmarg_ID True 80 

Name Columns 

FK_T_BranchMargins_T_Branches brmarg_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_BranchMargins_T_MarginTypes brmarg_TypeID->[dbo].[T_MarginTypes].[margtyp_ID] 
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Branch Taxes 

 [dbo].[T_BranchTaxes] 

 

Description 

Defines the relationship between different Tax Types and Tax Groups that are associated with 

an Office. The Tax Types are defined in Dropdown Maintenance and the Tax Groups are 

associated with an Office and defined in the Tax Groups tab of Office. A Branch Tax record 

must be created when a new Tax Groups record is created and additional Branch Tax records 

can be added to an existing Branch Tax Group record.  

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
brtx_ID 

System generated unique ID for the Branch Tax record. 

int 4 False 1 - 1  

 

brtx_GroupID 

The id of the associated Branch Tax Group record. Not 

shown in the UI; only the description is shown in the UI.  

int 4 False   

 
brtx_TaxTypeID 

The id of the associated Tax Type record. Not shown in the 

UI; only the description is shown in the UI. 

int 4 False   

 brtx_Desc 

The description of this Branch Tax. Entered on the 

Office>Tax Groups form. Called Description in the Branch 

Tax grid in the UI. 

nvarchar(100) 200 True   

 
brtx_Percent 

The percentage value of the tax for this Branch Tax 

record. Entered on the Office>Tax Groups form, in the 

Branch Tax grid. Called % in the UI. The percentage of the 

Invoice Detail amount that will be added to the taxes of an 

applicable Invoice Detail.  

decimal(10,6) 9 True   

 
brtx_FixedAmt 

The fixed amount value of the tax for this Branch Tax 

record. Entered on the Office>Tax Groups form, in the 

Branch Tax grid. Called Fixed Amount in the UI. This is a 

fixed amount is an amount that will be added to the taxes 

of an applicable Invoice Detail.  

money 8 False   

 brtx_EffectiveStart 

The Effective Start date for this Branch Tax record. It is 

UTC and is updated by SQL Server based on the office 

time zone. Called Effective From in Office>Tax Groups and 

only the Date component is shown on the UI. 

datetime 8 False   
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 brtx_EffectiveEnd 

The Effective End date for this Branch Tax record. It is 

UTC and is updated by SQL Server based on the office 

time zone. Called Effective To in Office>Tax Groups and 

only the Date component is shown on the UI. 

datetime 8 False   

 brtx_CreatedDate 

The Date the Branch Tax record was created. It is a UTC 

date and is updated by the SQL Server current UTC date. 

This date is converted to the user's computer's timezone in 

the UI. Called Created On in Office>Tax Groups form, 

shown in the Branch Tax grid.  

datetime 8 False   

 brtx_CreatedUser 

The user logged in the system when this Branch Tax  

record was created. Called Created By in Office>Tax 

Groups form, in the Branch Tax grid. 

nvarchar(50) 100 False   

 brtx_ModifiedDate 

The date that this record was last modified. It is a UTC 

date and is updated by the SQL Server current UTC date. 

This date is converted to the user's computer's timezone in 

the UI. Called Modified On in Office>Tax Groups form, 

showin in the Branch Tax grid. 

datetime 8 False   

 brtx_ModifiedUser 

The last user to modify this Branch Tax record. Called 

Modified By in Office>Tax Groups form, in the Branch Tax 

grid. 

nvarchar(50) 100 False   

 brtx_TS 

The TS field of the Branch Tax record. 

timestamp 8 False   

 brtx_HCPCS 

The HCPCS code, if required by a payer. If different payers 

require different HCPCS Codes then add a Tax Group for 

each payer. Called HCPCS Code in the UI, shown in the 

Branch Tax grid. 

nchar(25) 50 True   

 
brtx_AcctID 

The FK to the T_AcctsCharts table. The default acctID is 

set to 1 ( Default Account). This is called Accounting Chart 

in the Branch Tax grid in the UI. 

int 4 True  ((1)) 

 brtx_AcctCode 

The Account Code of the associated Accounting Chart, if it 

exists. Called Account Code in the UI. 

nvarchar(50) 100 True   
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Indexes 

 

Foreign Keys 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_BranchTaxes brtx_ID True 80 

 IX_T_BranchTaxes_GroupID brtx_GroupID  80 

Name Delete Columns 

FK_T_BranchTaxes_T_BranchCharts  brtx_AcctID->[dbo].[T_AcctCharts].[acct_ID] 

FK_T_BranchTaxes_T_BranchTaxGroups Cascade brtx_GroupID->[dbo].[T_BranchTaxGroups].[brtg_ID] 

FK_T_BranchTaxes_T_TaxTypes  brtx_TaxTypeID->[dbo].[T_TaxTypes].[taxtyp_ID] 
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Branch Tax Groups 

 [dbo].[T_BranchTaxGroups] 

 

Description 

Defines the relationship between the office and tax groups. Entries are defined in Office>Tax 

Groups in the UI. The system provides the ability to add taxes to invoices for specified services 

that are set up at the Office level.  

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
brtg_ID 

System generated unique ID for the Branch Tax 

Groups record.  

int 4 False 1 - 1  

 

brtg_BranchID 

The ID of the Branch that this Branch Tax Group 

record is associated with. Flows from [T_-

Branches].[br_id] 

int 4 False   

 brtg_Name 

Name of the Tax Group. Called Tax Group in 

Office>Tax Groups form. 

nvarchar(50) 100 False   

 brtg_CreatedDate 

The Date the Branch Tax Group record was 

created. UTC date. Updated by SQL Server's 

current UTC date. Called Created On in 

Office>Tax Groups form.  

datetime 8 False   

 brtg_CreatedUser 

The user logged in the system when the record 

was created. Called Created By in Office>Tax 

Groups form. 

nvarchar(50) 100 False   

 brtg_ModifiedDate 

The user logged in the system when the record 

was last modified. UTC date. Updated by SQL 

Server's current UTC date. Called Modified On in 

Office>Tax Groups form. 

datetime 8 False  (getutcdate()) 

 brtg_ModifiedUser 

The user logged in the system when the record 

was last modified. Called Modified By in 

Office>Tax Groups form. 

nvarchar(50) 100 False   

 brtg_TS 

The TS field of the Branch Tax Group record.  

timestamp 8 False   

 brtg_Description 

The description of the Branch Tax Group 

nvarchar(1000) 2000 True   
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Indexes 

Foreign Keys 

 

 

 

 

record.  Called Description in Office>Tax Groups 

form. 

Key Name Key Columns Unique Fill Factor 

 
PK_T_BranchTaxGroups brtg_ID True 80 

 IX_T_BranchTaxGroups_BranchID brtg_BranchID  80 

Name Columns 

FK_T_BranchTaxGroups_T_Branches brtg_BranchID->[dbo].[T_Branches].[br_ID] 
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Branches 

 [dbo].[T_Branches] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

br_ID 

The ID field of the BranchSettingsInfo, BranchList-

ItemInfo, PayerBranchAreaPayRatesInfo, Payer-

BranchAreaBillRatesInfo, BranchSettingsMainInfo 

and DuplicateSSNInfo objects. 

This is a system generated number. 

Also called entityID, BranchID, cBranchID. 

UI Location: Settings > Office > Office Settings > ID 

int 4 False 1 - 1  

 br_FormalName 

The FormalName field of the BranchSettingsMain-

Info and BranchListItemInfo objects. 

Name of the Office as it should appear on 

invoices.Also called FranchiseName, Provider-

Name, BranchFormalName, OfficeFormalName, 

BranchName. 

nvarchar(128) 256 False   

 
br_Name 

The Name field of the BranchesInfo, ClientListItem, 

BranchListItemInfo, PhysicianListItem, Caregiver-

ListItem and DuplicateSSNInfo objects. 

Name of the Office as it should appear in the drop 

down for Office. Also called FranchiseNumber, 

EntityName, Name, BranchName, UserPriBranch, 

office, OfficeNickName. 

nvarchar(50) 100 False   

 br_DBA 

The DBA field of the BranchSettingsMainInfo 

object. 

This is another name that the company is doing 

business as. This is only informational and will not 

appear on invoices. 

UI Location: Settings > Office > Office Settings > 

Main > DBA 

nvarchar(128) 256 True   

 br_CompanyID 

The CompanyID field of the BranchSettingsMain-

Info object. 

Used in lines of business where the agency has 

internal IDs for each company. Also called 

CompanyNumber. 

UI Location: Settings > Office > Office Settings > 

Main > Company ID 

nvarchar(50) 100 True   
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 br_CompanyAgreementStartDate 

The CompanyAgreementStartDate field of the 

BranchSettingsMainInfo object. 

Date the Office started doing business. 

UI Location: Settings > Office > Office Settings > 

Main > Start Date 

datetime 8 True   

 br_CompanyAgreementExpirationDate 

The CompanyAgreementExpirationDate field of the 

BranchSettingsMainInfo object. 

Date the Office stopped doing business. This only 

shows that the Office is no  

longer in business and does not inactivate it. An 

Office End Date (along with the existence of a 

Client Inquiry Portal Script and/or Caregiver Inquiry 

Portal Script) is used to determine if the Office 

should be available for selection on your agency's 

website. If DO NOT want Client Inquiries coming 

into the system from the Portal and have created 

Client Inquiry Portal Scripts for those offices, then 

set the End Date on the Office record. If the Office 

End Date is less than or equal to the current date, 

the Office will not display for selection on the Client 

Inquiry Portal. See Client Inquiry Portal for full 

details on utilizing the Client Inquiry Portal feature 

and  

Caregiver Inquiry Portal for full details on utilizing 

the Caregiver Inquiry Portal feature.  

UI Location: Settings > Office > Office Settings > 

Main > End Date 

datetime 8 True   

 br_BusinessType 

The BusinessType field of the BranchSettingsMain-

Info object. 

Type of business for this office: Corporation, LLC, 

Partnership, S Corporation, or Sole Proprietorship. 

UI Location: Settings > Office > Office Settings > 

Main > Business Type 

nvarchar(50) 100 True  (N'Corporation') 

 br_PotentialClients 

The PotentialClients field of the BranchSettings-

MainInfo object. 

This is currently only used in the Potential Client 

Dashboard. 

UI Location: Settings > Office > Office Settings > 

Main > Potential Client Base 

int 4 True   

 br_DateEstablished 

The DateEstablished field of the BranchSettings-

MainInfo object. 

Date when the Office was established. 

Also called StartDate. 

UI Location: Settings > Office > Office Settings > 

Main > Date Established 

datetime 8 True   

 
br_LocationID 

The LocationID field of the BranchesInfo and 

BranchListItemInfo objects. 

int 4 False   
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br_ParBranchID 

The ParBranchID field of the BranchesInfo and 

BranchListItemInfo objects. 

int 4 True   

 br_Address1 

The Address1 field of the BranchesInfo and 

BranchListItemInfo objects. 

Also called ProviderAddress1. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

nvarchar(50) 100 True   

 br_Address2 

The Address2 field of the BranchesInfo and 

BranchListItemInfo objects. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements.. 

nvarchar(50) 100 True   

 br_City 

The City field of the BranchSettingsMainInfo and 

BranchListItemInfo objects. 

Also called City, ProviderCity. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

nvarchar(50) 100 True   

 br_StateOrProvince 

The StateOrProvince field of the BranchSettings-

MainInfo and BranchListItemInfo objects. 

Also called State, ProviderStateOrProvince 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

nvarchar(20) 40 True   

 br_PostalCode 

The PostalCode field of the BranchSettingsMain-

Info and BranchListItemInfo objects. 

Also called ProviderPostalCode, BranchAddress, 

Zip. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

nvarchar(20) 40 True   
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Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

 br_County 

The County field of the BranchSettingsMainInfo 

object. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

nvarchar(50) 100 True   

 br_Country 

The Country field of the BranchSettingsMainInfo 

object. 

Part of the physical address of the company. Used 

for Office address at top of the Invoice and Invoice 

Statements for Standard Invoice, Payer Invoice, 

and Invoice Statement reports. The Remit to 

Address (on the Office Billing tab) will show on the 

receipt stub at bottom of invoices and invoice 

statements. 

int 4 False  ((240)) 

 br_UTCOffsetHours 

The UTCOffsetHours field of the BranchSettings-

MainInfo object. 

int 4 False   

 br_AgencyLicenseNumber 

The AgencyLicenseNumber field of the Branch-

SettingsMainInfo and EFTInfo objects. 

This number will appear at the top of all Standard 

Invoices, below the office name, address and Tax 

ID number. If left blank, then the Outstanding 

Invoice Statement for a Client, the Outstanding 

Invoice Statement for a Payer, and the Outstanding 

Invoice Statements for all Clients and Payers will 

not display this field label. 

UI Location: Settings > Office > Office Settings > 

Main > Agency License 

nvarchar(50) 100 True   

 

br_SchedulingWeekStartDay 

The SchedulingWeekStartDay field of the Branch-

SettingsSchedulingInfo and BranchListItemInfo 

objects. 

The payroll week for the Office is defined on this 

tab, and you can choose the Week Start Day and  

Time. This setting does not necessarily reflect the 

start of the company work week. It is a definition  

of the payroll week, which allows you to calculate 

payroll on a weekly basis. The first interval ends at 

the end of the scheduling week and then every 7 

days thereafter. The Work Week is defined by the 

'Week Start Day' configured on this tab. 

UI Location: Settings > Office > Office Settings > 

Payroll > Week Start Day 

tinyint 1 False  ((0)) 
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br_SchedulingWeekStartTime 

The SchedulingWeekStartTime field of the Branch-

SettingsSchedulingInfo object. 

The payroll week for the Office is defined on this 

tab, and you can choose the Week Start Day and  

Time. This setting does not necessarily reflect the 

start of the company work week. It is a definition  

of the payroll week, which allows you to calculate 

payroll on a weekly basis. The first interval ends at 

the end of the scheduling week and then every 7 

days thereafter. The Work Week is defined by the 

'Week Start Day' configured on this tab. 

UI Location: Settings > Office > Office Settings > 

Payroll > Week Start Time 

smalldatetime 4 False  (((1)/(1))/(1900)) 

 br_DefaultTravelTime 

The DefaultTravelTime field of the BranchSettings-

SchedulingInfo and BranchListItemInfo objects. 

Number of minutes to allow in between visits. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Travel Time 

tinyint 1 False  ((0)) 

 br_SchedulingConflictsOverride 

The SchedulingConflictsOverride field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

User override the number of minutes to allow in 

between visits. 

Override Level: 

User Override - The default behavior for the level of 

conflict checking can be overridden in the next area 

of the system (Global to Office to User). 

No Override - The default behavior for level of 

conflict checking cannot be overridden by settings 

in the next area of the system (Global to Office to 

User).Do Not Check - Bypasses running any 

conflict checks. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Travel Time 

tinyint 1 False  ((0)) 

 
br_SchedulingScheduleConflictsAllow 

The SchedulingScheduleConflictsAllow field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

Select whether to check for conflicting dates/times 

for the Caregiver. (For example, the Caregiver has 

schedules for the same date/time for two different 

Clients.) 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

tinyint 1 False  ((0)) 
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save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Scheduling Conflicts 

 br_SchedulingScheduleConflictsOverride 

The SchedulingScheduleConflictsOverride field of 

the BranchSettingsSchedulingInfo and BranchList-

ItemInfo objects. 

User override schedule conflicts. 

Override Level: 

User Override - The default behavior for the level of 

conflict checking can be overridden in the  

next area of the system (Global to Office to User). 

No Override - The default behavior for level of 

conflict checking cannot be overridden by  

settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > Scheduling Conflicts 

tinyint 1 False  ((0)) 

 
br_SchedulingAvailabilityConflictsAllow 

The SchedulingAvailabilityConflictsAllow field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

Select whether to check for conflicting pre-

configured availability for the Caregiver. (For 

example, the Caregiver is vailable/unavailable to 

work on specific dates/times.) 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Availability Conflicts 

tinyint 1 False  ((0)) 

 br_SchedulingAvailabilityConflictsOverride 

The SchedulingAvailabilityConflictsOverride field of 

the BranchSettingsSchedulingInfo and BranchList-

ItemInfo objects. 

User override availability conflicts. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

by settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > Availability Conflicts 

tinyint 1 False  ((0)) 
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br_SchedulingDNUConflictsAllow 

The SchedulingDNUConflictsAllow field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

Select whether to check for Do Not Use, 

Restrictions, or Orientation conflicts  

while scheduling. For more information, see Client 

Matching or Caregiver Matching. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > DNU Conflicts 

tinyint 1 False  ((0)) 

 br_SchedulingDNUConflictsOverride 

The SchedulingDNUConflictsOverride field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

User Override DNU conflicts. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

by settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > DNU Conflicts 

tinyint 1 False  ((0)) 

 
br_SchedulingAuthorizationConflictsAllow 

The SchedulingAuthorizationConflictsAllow field of 

the BranchSettingsSchedulingInfo and BranchList-

ItemInfo objects. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Authorization Conflicts 

tinyint 1 False  ((0)) 

 br_SchedulingAuthorizationConflictsOverride 

The SchedulingAuthorizationConflictsOverride field 

of the BranchSettingsSchedulingInfo and Branch-

ListItemInfo objects. 

tinyint 1 False  ((0)) 
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User override authorization conflicts.Override 

Level:User Override - The default behavior for the 

level of conflict checking can be overridden in the 

next area of the system (Global to Office to 

User).No Override - The default behavior for level 

of conflict checking cannot be overridden by 

settings in the next area of the system (Global to 

Office to User).UI Location: Settings > Office > 

Office Settings > Scheduling > Authorization 

Conflicts 

 
br_SchedulingCaregiverExpirationsAllow 

The SchedulingCaregiverExpirationsAllow field of 

the BranchSettingsSchedulingInfo and BranchList-

ItemInfo objects. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Caregiver Expirations 

tinyint 1 False  ((0)) 

 br_SchedulingCaregiverExpirationsOverride 

The SchedulingCaregiverExpirationsOverride field 

of the BranchSettingsSchedulingInfo and Branch-

ListItemInfo objects. 

User override caregiver expirations.Override 

Level:User Override - The default behavior for the 

level of conflict checking can be overridden in the 

next area of the system (Global to Office to 

User).No Override - The default behavior for level 

of conflict checking cannot be overridden by 

settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > Caregiver Expirations 

tinyint 1 False  ((0)) 

 br_SchedulingCheckForOvertime 

The SchedulingCheckForOvertime field of the 

BranchSettingsSchedulingInfo and BranchListItem-

Info objects. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

tinyint 1 False  ((0)) 
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UI Location: Settings > Office > Office Settings > 

Scheduling > Check for Overtime 

 br_SchedulingCheckForOvertimeOverride 

The SchedulingCheckForOvertimeOverride field of 

the BranchSettingsSchedulingInfo and BranchList-

ItemInfo objects. 

User override check for overtime. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

by settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > Check for Overtime 

tinyint 1 False  ((0)) 

 
br_ScheduleListMaxDays 

The ScheduleListMaxDays field of the Branch-

SettingsSchedulingInfo and BranchListItemInfo 

objects. 

The value in this field controls the maximum 

number of days that can be searched  

as the date range in Office Schedules and Office 

Activities. The maximum value  

that can be entered into this field is 62. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Schedule/Activity List Max Days 

tinyint 1 False  ((30)) 

 br_RemitAddress1 

The RemitAddress1 field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the  

receipt stubs at the bottom of invoices and invoice 

statements for Standard  

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical  

address (on the Office Main tab) will show on  

the top portion of invoices and invoice statements. 

nvarchar(50) 100 True   

 br_RemitAddress2 

The RemitAddress2 field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

nvarchar(50) 100 True   

 br_RemitCity 

The RemitCity field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

nvarchar(50) 100 True   
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Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

 br_RemitStateOrProvince 

The RemitStateOrProvince field of the Branches-

Info and BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

nvarchar(20) 40 True   

 br_RemitPostalCode 

The RemitPostalCode field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

nvarchar(20) 40 True   

 br_RemitCounty 

The RemitCounty field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

nvarchar(50) 100 True   

 br_RemitCountry 

The RemitCountry field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

int 4 False  ((240)) 

 br_RemitPostalCodeID 

The RemitPostalCodeID field of the BranchesInfo 

and BranchListItemInfo objects. 

Remit To or billing address information that should 

appear on the receipt stubs at the bottom of 

invoices and invoice statements for Standard 

Invoice, Payer Invoice, and Invoice Statement 

reports. The Office physical address (on the Office 

Main tab) will show on the top portion of invoices 

and invoice statements. 

int 4 False  ((1)) 
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 br_RemitPhone 

The RemitPhone field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information. 

Also called PhoneCountryCode, ProviderPhone, 

ServicePrvdrPhone. Remit Phone. 

UI Location: Settings > Office > Office Settings > 

Billing > Phone 

nvarchar(30) 60 True   

 br_RemitFax 

The RemitFax field of the BranchesInfo and 

BranchListItemInfo objects. 

Remit To or billing address information. 

Also called ProviderFax, Remit Fax. 

UI Location: Settings > Office > Office Settings > 

Billing > Fax 

nvarchar(30) 60 True   

 br_RemitContactName 

The RemitContactName field of the Branch-

SettingsBillingInfo, BranchListItemInfo and 

CMS1500BillingDefaultsInfo objects. 

Remit To or billing address information. 

UI Location: Settings > Office > Office Settings > 

Billing > Contact Name 

nvarchar(60) 120 True   

 br_RemitEmail 

The RemitEmail field of the BranchSettingsBilling-

Info object. 

Remit To or billing address information. 

Also called Remit Email.UI Location: Settings > 

Office > Office Settings > Billing > Email 

nvarchar(50) 100 True   

 br_InvoiceNote 

The InvoiceNote field of the BranchSettingsBilling-

Info object. 

This will appear at the bottom of all Standard, 

Basic, and  

Payer Invoices for the office. A Client specific 

Invoice Note can also be entered on the individual 

Clients record (on the Client Advanced tab). (Max. 

character limit of 1000) 

UI Location: Settings > Office > Office Settings > 

Billing > Invoice Note 

varchar(1000) 1000 True   

 br_InvoiceTagLine 

The InvoiceTagLine field of the BranchSettings-

BillingInfo object. 

This will appear at the top of all Standard Invoices, 

beneath the Office name. 

UI Location: Settings > Office > Office Settings > 

Billing > Invoice Tag Line 

nvarchar(80) 160 True   

 br_InvoiceDueDays 

The InvoiceDueDays field of the BranchSettings-

BillingInfo object. 

The Invoice Due Days will calculate out a Due Date 

from the Invoice Date and display that date on all 

Standard Invoices. A value of 0 in this field will 

tinyint 1 False  ((0)) 
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display the words Upon Receipt on the invoice in 

the Due Date field. 

UI Location: Settings > Office > Office Settings > 

Billing > Invoice Due Days 

 br_BankAccountType 

The office's bank account type. (Values: C or S) 

UI Location: Settings > Office > Office Settings > 

Owners > AccountType 

nvarchar(2) 4 True   

 br_EDIAdditionalID 

The EDIAdditionalID field of the BranchSettings-

BillingInfo object. 

This is used when a Payer specifies a specific ID 

for Loop 20100AA (Billing Provider Name) on the 

Payer EDI Settings tab. Enter that ID here. In the 

Payer EDI Settings tab, Loop 20100AA must be set 

to Office Additional. 

UI Location: Settings > Office > Office Settings > 

Billing > Additional ID 

nvarchar(20) 40 True   

 br_EDIAdditionalIDType 

The EDIAdditionalIDType field of the Branch-

SettingsBillingInfo object. 

This is used when a Payer specifies a specific 

Type for Loop 20100AA. Enter that Type here. In 

the Payer EDI Settings tab, Loop 20100AA must be 

set to Office Additional. 

UI Location: Settings > Office > Office Settings > 

Billing > Additional Type 

nvarchar(3) 6 True   

 br_OasisIFEnabledFlag 

The OasisIFEnabledFlag field of the Branch-

SettingsBillingInfo and BranchListItemInfo objects. 

bit 1 False  ((0)) 

 
br_NPI 

The NPI field of the BranchSettingsBillingInfo, 

PlanOfCareAdmissionInfo and BranchListItemInfo 

objects. 

Also called ProviderNPI. This is the national 

provider identification number. 

Enter the office NPI number in order to pull the 

data to Provider Information locators when NPI is 

selected in the Payer EDI Settings tab. 

UI Location: Settings > Office > Office Settings > 

Billing > NPI 

nvarchar(10) 20 True   

 br_FedTaxID 

The FedTaxID field of the BranchSettingsBillingInfo 

object. 

Enter the Tax ID number for the company as it 

should appear on invoices. The  

drop down box allows the user to select either EIN 

or SSN as appropriate. If  

processing H1500s, UB04s, or PPS batches, select 

EIN to pull the Tax ID number  

to Provider Information locators when EIN is 

selected in the Payer EDI Settings tab. If left  

nvarchar(15) 30 True   
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blank, then the Outstanding Invoice Statement for a 

Client, the Outstanding  

Invoice Statement for a Payer, and the Outstanding 

Invoice Statements for all  

Clients and Payers WILL NOT display this field 

label. 

Also called Fed Tax ID.UI Location: Settings > 

Office > Office Settings > Billing > Tax ID Number 

 br_Taxonomy 

The Taxonomy field of the BranchSettingsBilling-

Info object. 

Enter the Taxonomy Code from the NPPES 

Registry Form. The Home Health Taxonomy  

Code in PC Ace is 251E0000X. This code shows 

on the 837. 

UI Location: Settings > Office > Office Settings > 

Billing > Taxonomy 

nvarchar(15) 30 True   

 br_Shift1Desc 

The Shift1Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill  

rates at the Office level, eliminating the need to 

create specific codes to  

handle payroll and billing issues. Each office can 

define up to six shifts. Type the name of each shift 

in the  

shift description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True  (N'Shift 1') 

 br_Shift2Desc 

The Shift2Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill rates at the Office level, eliminating 

the need to create specific codes to handle payroll 

and billing issues. Each office can define up to six 

shifts. Type the name of each shift in the shift 

description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True   

 br_Shift3Desc 

The Shift3Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill rates at the Office level, eliminating 

the need to create specific codes to handle payroll 

and billing issues. Each office can define up to six 

shifts. Type the name of each shift in the shift 

description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True   
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 br_Shift4Desc 

The Shift4Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill rates at the Office level, eliminating 

the need to create specific codes to handle payroll 

and billing issues. Each office can define up to six 

shifts. Type the name of each shift in the shift 

description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True   

 br_Shift5Desc 

The Shift5Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill rates at the Office level, eliminating 

the need to create specific codes to handle payroll 

and billing issues. Each office can define up to six 

shifts. Type the name of each shift in the shift 

description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True   

 br_Shift6Desc 

The Shift6Desc field of the BranchListItemInfo and 

BranchSettingsPayrollInfo objects. 

The Office Shifts offers the ability to configure shifts 

for pay and bill rates at the Office level, eliminating 

the need to create specific codes to handle payroll 

and billing issues. Each office can define up to six 

shifts. Type the name of each shift in the shift 

description boxes. 

UI Location: Settings > Office > Office Settings > 

Billing > Shifts 

nvarchar(25) 50 True   

 
br_OTDayRateType 

The OTDayRateType field of the BranchesInfo0 

and BranchListItemInfo objects. 

Blended or Disabled. The rate type of Blended will 

use the total pay amount for  

the caregiver and divide it by the total hours 

worked to calculate the regular  

pay rate. 

UI Location: Settings > Office > Office Settings > 

Payroll > Rate Type (Under Daily Overtime) 

tinyint 1 False  ((1)) 

 br_OTDayHours 

The OTDayHours field of the BranchesInfo0 and 

BranchListItemInfo objects. 

Also called DayOTThreshold. 

This defines the regular pay limit per day, and 

when exceeded the overtime calculations will be 

applied. 

UI Location: Settings > Office > Office Settings > 

Payroll > Hours (Under Daily Overtime) 

tinyint 1 False  ((8)) 
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 br_OTDayMultiplier 

The OTDayMultiplier field of the BranchesInfo0 and 

BranchListItemInfo objects. 

This defines the multiplying value to be used when 

calculating the overtime pay.  

Also called DayOTMultiplier. 

UI Location: Settings > Office > Office Settings > 

Payroll > Multiplier (Under Daily Overtime) 

decimal(5,2) 5 False  ((1.0)) 

 
br_OTWeekRateType 

The OTWeekRateType field of the BranchesInfo0 

and BranchListItemInfo objects.Blended or 

Disabled.�The rate type of Blended will use the 

total pay amount for the caregiver and divide it by 

the total hours worked to calculate the regular pay 

rate. 0 ��Blended( the overtime will be calculated 

as Blended rate 

 1 Disabled(No overtime will be caculated for the 

Branch) 

UI Location: Settings > Office > Office Settings > 

Payroll > Rate Type (Under Weekly Overtime) 

tinyint 1 False  ((1)) 

 br_OTWeekHours 

The OTWeekHours field of the BranchesInfo0 and 

BranchListItemInfo objects. 

Also called WeekOTThreshold. 

This defines the regular pay limit per week, and 

when exceeded the overtime  

calculations will be applied.UI Location: Settings > 

Office > Office Settings > Payroll > Hours (Under 

Weekly Overtime) 

tinyint 1 False  ((40)) 

 
br_OTWeekMultiplier 

The OTWeekMultiplier field of the BranchesInfo0 

and BranchListItemInfo objects. 

This defines the multiplying value to be used when 

calculating the overtime pay.  

Also called WeekOTMultiplier. 

UI Location: Settings > Office > Office Settings > 

Payroll > Multiplier (Under Weekly Overtime) 

decimal(5,2) 5 False  ((1.5)) 

 br_PayrollCompanyCode 

The PayrollCompanyCode field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

The payroll company code. 

Also called PrCoID, PRCompCode, Payroll Co. 

Code, CompanyCode, UI Location: Settings > 

Office > Office Settings > Payroll > Company Code 

nvarchar(10) 20 True   

 br_MappingToolsID 

The MappingToolsID field of the BranchSettings-

MainInfo and BranchListItemInfo objects. 

Select the Mapping Type from drop down box 

choosing either MapQuest, Open Street Maps, or 

Yahoo Maps for output when using mapping 

features and Drive Lists. Select 'Open Street Map' 

to use the stored GEO codes for entity's being 

int 4 False  ((2)) 
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mapped with Drive Lists and Maps. 'Open Street 

Map' will always be used for  

Address Verification. See Caregiver Search: 

Address Verification & GPS for details on this 

feature.  

UI Location: Settings > Office > Office Settings > 

Advanced > Mapping Types 

 br_UseMapPoint 

The UseMapPoint field of the BranchSettingsMain-

Info and BranchListItemInfo objects. 

Check this box to use MapPoint in the Scheduling 

module. 

UI Location: Settings > Office > Office Settings > 

Advanced > Use MapPoint in the Scheduling 

module (Check Box) 

bit 1 False  ((0)) 

 br_MapPointUserName 

The MapPointUserName field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

UI Location: Settings > Office > Office Settings > 

Advanced > User name (Under Mapping 

Information) 

nvarchar(50) 100 True   

 br_MapPointPassword 

The MapPointPassword field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

UI Location: Settings > Office > Office Settings > 

Advanced > Password (Under Mapping 

Information) 

nvarchar(50) 100 True   

 br_ReplicationServerID 

Not used. 

nvarchar(32) 64 True   

 br_ReplicationUserName 

Not used. 

nvarchar(64) 128 True   

 br_TimeZoneID 

Time zone ID number for the Branches record.Also 

called TzoneID. 

smallint 2 False  ((70)) 

 br_CreatedDate 

The Date the Branches Record was created. 

UTC date. Updated by SQL Server's current UTC 

date. 

Also called CreatedDate. 

datetime 8 False  (getutcdate()) 

 br_CreatedUser 

The user logged in the system when the record 

was created.Also called CreatedUser. 

nvarchar(50) 100 False   

 br_ModifiedDate 

The date the Branches record was last modified. 

UTC date. Updated by SQL Server's current UTC 

date. 

Also called ModifiedDate. 

datetime 8 False  (getutcdate()) 

 br_ModifiedUser 

 

The user logged in the system when the record 

was last modified. 

nvarchar(50) 100 False   
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Also called ModifiedUser. 

 br_TS 

The TS field of the BranchSettingsInfo object. 

The timestamp field of the Branches record. 

Also called TS. 

timestamp 8 False   

 br_PayrollDivisionCode 

The PayrollDivisionCode field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

Payroll Company Division code of the branch. 

UI Location: Settings > Office > Office Settings > 

Payroll > Division Code 

nvarchar(10) 20 True   

 br_LegacyBranchID 

Not used. 

int 4 True   

 br_AcctSystem 

The AcctSystem field of the BranchSettingsBilling-

Info object. 

The system to use extracted data. Ex: When 

extracting to QuickBooks, enter QB here. 

Also called Acct System. 

UI Location: Settings > Office > Office Settings > 

Billing > System 

nvarchar(50) 100 True   

 br_AcctAccrual 

The AcctAccrual field of the BranchSettingsBilling-

Info object. 

Choose Accrual (value 0), Cash 

(value 1 default), Details (value 2), MIP/Accrual 

(value 5). Accrual  

recognizes revenue using the service date as the 

transaction date,  

whereas Cash recognizes revenue using the 

payment posting date to the  

invoice as the transaction date. Revenue is created 

once services are  

billed for both types of accounting. Add 

MIP/Accrual is for 

clients using MIP for their accounting. 

UI Location: Settings > Office > Office Settings > 

Billing > Type (Radio Buttons) 

tinyint 1 False  ((2)) 

 br_BankAccountNumber 

The BankAccountNumber field of the BranchesInfo 

object. 

The branch's bank account number. Encrypted in 

database. 

UI Location: Settings > Office > Office Settings > 

Owners > Account Number 

varbinary(255) 255 True   

 br_BankRoutingNumber 

The BankRoutingNumber field of the BranchesInfo 

object. 

The branch's bank account routing number. 

Encrypted in database. 

varbinary(255) 255 True   
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UI Location: Settings > Office > Office Settings > 

Owners > Routing Number 

 br_AcctName 

The AcctName field of the BranchSettingsBilling-

Info object. 

When extracting to QuickBooks, enter the name of 

the Customer Name as created in  

QuickBooks. 

Also called acctName, Acct Name. 

UI Location: Settings > Office > Office Settings > 

Billing > Client Name 

nvarchar(50) 100 True  ((1)) 

 br_PCEFileExtractPrefix 

The PCEFileExtractPrefix field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

The prefix for the payroll extract file naming 

convention. 

UI Location: Settings > Office > Office Settings > 

Payroll > File Extract Prefix 

nvarchar(3) 6 True   

 br_PCEUseCompanyCode 

The PCEUseCompanyCode field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

Check the box to include the Company Code in the 

file naming  

convention. 

UI Location: Settings > Office > Office Settings > 

Payroll > Use Company Code 

bit 1 False  ((0)) 

 br_PCECompanyCodeChars 

The PCECompanyCodeChars field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

The number of characters for the Company Code. 

UI Location: Settings > Office > Office Settings > 

Payroll > Characters 

tinyint 1 False  ((0)) 

 br_PCEUseBatchID 

The PCEUseBatchID field of the BranchSettings-

PayrollInfo and BranchListItemInfo objects. 

Check the box to include the Payroll Batch ID 

number in the file naming  

convention. 

UI Location: Settings > Office > Office Settings > 

Payroll > Use Batch ID in File Name 

bit 1 False  ((0)) 

 br_PCEBatchIDNums 

The PCEBatchIDNums field of the BranchSettings-

PayrollInfo and BranchListItemInfo objects. 

Enter the number of digits from the Payroll Batch 

ID to be used in the file  

naming convention. These will be the last 2 digits 

of the Batch ID. If the Batch  

ID is less than the number entered, the ID will be 

padded with leading zeroes to  

reach the number of digits entered. 

tinyint 1 False  ((0)) 
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UI Location: Settings > Office > Office Settings > 

Payroll > Digits 

 br_PCEFileExtension 

The PCEFileExtension field of the BranchSettings-

PayrollInfo and BranchListItemInfo objects. 

Enter the file extension name (csv). Leave blank to 

save payroll extract  

files without an extension to accommodate third 

party payroll applications that  

cannot import files with extensions. 

UI Location: Settings > Office > Office Settings > 

Payroll > File Extension 

nvarchar(3) 6 True   

 br_PCEDefaultPath 

The PCEDefaultPath field of the BranchSettings-

PayrollInfo and BranchListItemInfo objects. 

The default path location to save the Payroll 

Extract file. 

UI Location: Settings > Office > Office Settings > 

Payroll > Default File Path 

nvarchar(240) 480 True   

 
br_FedTaxIDType 

The FedTaxIDType field of the BranchSettings-

BillingInfo object. 

Enter the Tax ID number for the company as it 

should appear on invoices. The  

drop down box allows the user to select either EIN 

or SSN as appropriate. If  

processing H1500s, UB04s, or PPS batches, select 

EIN to pull the Tax ID number  

to Provider Information locators when EIN is 

selected in the Payer EDI Settings tab. If left  

blank, then the Outstanding Invoice Statement for a 

Client, the Outstanding  

Invoice Statement for a Payer, and the Outstanding 

Invoice Statements for all  

Clients and Payers WILL NOT display this field 

label. 

UI Location: Settings > Office > Office Settings > 

Billing > Tax ID Number 

char(1) 1 False  ('E') 

 br_OTWeekEarnCode 

The OTWeekEarnCode field of the BranchSettings-

PayrollInfo object. 

Earn Code if required by a customized payroll 

extract file. 

UI Location: Settings > Office > Office Settings > 

Payroll > Earn Code (Under Weekly Overtime) 

nvarchar(50) 100 True   

 br_TelephonyLoginName 

The TelephonyLoginName field of the Branches-

Info object. 

The assigned login name to log into the telephony 

account. 

UI Location: Settings > Office > Office Settings > 

Telephony > Login name 

nvarchar(200) 400 True   
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 br_TelephonyUploadRunInterval 

The TelephonyUploadRunInterval field of the 

BranchesInfo object. 

The number of minutes to wait between data 

uploads. 15 minute interval is  

recommended. 

UI Location: Settings > Office > Office Settings > 

Telephony > Upload Interval 

int 4 False  ((0)) 

 br_TelephonyDownloadRunInterval 

The TelephonyDownloadRunInterval field of the 

BranchesInfo object. 

The number of minutes to wait between data 

downloads. 5 minute interval is  

recommended. 

UI Location: Settings > Office > Office Settings > 

Telephony > Download Interval 

int 4 False  ((0)) 

 br_TelephonyUploadRange 

The TelephonyUploadRange field of the Branches-

Info object. 

Not used with Telephony. If other, enter the 

number of days  

into the future that schedules should be uploaded 

to the telephony provider. 

UI Location: Settings > Office > Office Settings > 

Telephony > Upload Range 

int 4 False  ((0)) 

 br_TelephonyLogXmlDown 

The TelephonyLogXmlDown field of the Branches-

Info object. 

Used to store additional diagnostics during the 

implementation phase or when requested. 

UI Location: Settings > Office > Office Settings > 

Telephony > Log XML Down 

bit 1 False  ((0)) 

 br_TelephonyLogXmlUp 

The TelephonyLogXmlUp field of the BranchesInfo 

object. 

Used to store additional diagnostics during the 

implementation phase or when  

requested. 

UI Location: Settings > Office > Office Settings > 

Telephony > Log XML UP 

bit 1 False  ((0)) 

 br_TelephonyPassword 

The TelephonyPassword field of the BranchesInfo 

object. 

The assigned password to log into the telephony 

account. 

UI Location: Settings > Office > Office Settings > 

Telephony > Password 

nvarchar(100) 200 True   

 br_TelephonyAccountId 

The TelephonyAccountId field of the BranchesInfo 

and BranchListItemInfo objects. 

MatrixCare assigned Telephony Account ID. 

nvarchar(50) 100 True   
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UI Location: Settings > Office > Office Settings > 

Telephony > Account ID 

 
br_DefaultServiceCodeId 

The TelephonyAccountId field of the BranchesInfo 

and BranchListItemInfo objects. 

Not used with Telephony. If other, select the default 

service  

code for any visits created in the system by the 

telephony  

provider Interface. This pertains to visits that were 

completed by the Caregiver  

but no previous scheduled visit existed in the 

system. 

UI Location: Settings > Office > Office Settings > 

Telephony > Service Code 

int 4 True   

 
br_DefaultMileageId 

The ID of the default service code (where is-

Expense = true) to use in Web2 for mileage during 

schedule completion. Not currently used in 

Telephony. 

UI Location: Settings > Office > Office Settings > 

Telephony > Mileage Code 

int 4 True   

 br_OTDayEarnCode 

The OTDayEarnCode field of the BranchSettings-

PayrollInfo object. 

Earn Code if required by a customized payroll 

extract file. 

UI Location: Settings > Office > Office Settings > 

Payroll > Earn Code (Under Daily Overtime) 

nvarchar(50) 100 True  ('0A') 

 br_EmailSenderAddress 

The EmailSenderAddress field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

The e-mail address to attach to any outgoing e-

mails. 

UI Location: Settings > Office > Office Settings > 

Advanced > Email Address 

nvarchar(50) 100 True   

 br_EmailHostName 

The EmailHostName field of the BranchSettings-

MainInfo and BranchListItemInfo objects. 

The name of the server that will be sending e-

mails. 

UI Location: Settings > Office > Office Settings > 

Advanced > Server Name 

nvarchar(100) 200 True   

 br_EmailHostPort 

The EmailHostPort field of the BranchSettings-

MainInfo and BranchListItemInfo objects. 

The port that outgoing e-mails will be sent across 

(generally port 25). 

UI Location: Settings > Office > Office Settings > 

Advanced > Port 

int 4 True   
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 br_EmailHostUsesSSL 

The EmailHostUsesSSL field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

Check this box if e-mails are sent securely over 

SSL. 

UI Location: Settings > Office > Office Settings > 

Advanced > Server Requires SSl (Check box) 

bit 1 False  ((0)) 

 br_EmailHostUserName 

The EmailHostUserName field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

The name of the server that will be sending e-

mails. 

UI Location: Settings > Office > Office Settings > 

Advanced > Server Name 

nvarchar(50) 100 True   

 br_EmailHostPassword 

The EmailHostPassword field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

The password to authenticate with the mail server. 

UI Location: Settings > Office > Office Settings > 

Advanced > Password 

varbinary(255) 255 True   

 br_EmailHostDomain 

The EmailHostDomain field of the BranchSettings-

MainInfo and BranchListItemInfo objects. 

The domain of the mail server. 

UI Location: Settings > Office > Office Settings > 

Advanced > Domain 

nvarchar(50) 100 True   

 
br_OASIS_Medicare_Payer_ID 

The OASIS_Medicare_Payer_ID field of the 

BranchSettingsMainInfo object. 

This is a system generated Medicare payer ID 

number for the branches record. 

bigint 8 True   

 
br_OASIS_Medicaid_Payer_ID 

The OASIS_Medicaid_Payer_ID field of the 

BranchSettingsMainInfo object. 

This is a system generated Medicaid payer ID 

number for the branches record. 

bigint 8 True   

 br_OASIS_M0016_Branch_ID 

The OASIS_M0016_Branch_ID field of the Branch-

SettingsMainInfo object. 

This is the unique branch ID assigned to this office, 

obtained from CMS. If you  

are transitioning this office from another system, 

the branch ID from the old  

system must match this value. If entered, this field 

is subject to the following  

constraint: it must either start with a P or an N 

followed by nine spaces, or  

contain uppercase letters/numbers in the first 2 

positions, a Q, 4 uppercase  

letters/numbers, and 3 numbers. 

UI Location: Settings > Office > Office Settings > 

Advanced > Branch ID (M0016) 

nvarchar(10) 20 True   
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 br_TelephonySetC 

The TelephonySetC field of the BranchesInfo and 

BranchListItemInfo objects. 

Check the box for the schedule status to move 

directly to 'C' Completed  

status when a departure call for the schedule 

exists. Uncheck the box for the  

schedule status to move to Telephony Completed 

(will need to manually Complete  

the schedules for payroll and billing processing). 

UI Location: Settings > Office > Office Settings > 

Telephony > Set telephony-completed schedules 

directly to schedule status of complete (Check box) 

bit 1 False  ((0)) 

 br_CompanyUri 

The CompanyUri field of the BranchSettingsMain-

Info and BranchListItemInfo objects. 

Also called Website, WebAddress. 

The value entered here will pull to the Caregiver 

Name Badges Report with  

the option of Always use Office URL is selected. 

Enter your  

Office's web address in this field to add this data to 

your Caregiver  

Badges. 

UI Location: Settings > Office > Office Settings > 

Advanced > Company URL 

nvarchar(256) 512 True   

 br_OASIS_IgnoreFatalEdits 

The OASIS_IgnoreFatalEdits field of the Branch-

SettingsMainInfo, AssessmentInfo and BranchList-

ItemInfo objects. 

If checked yes, timing edits are not run for recerts if 

no SOC assessment exists. Used for new 

implmentations that have to start clients in mid 

stream. When transitioning from an older system 

this checkbox allows you to create recert 

assessments even if the initial assessment does 

not exist. If this is not  

checked, this would generate an error.  

UI Location: Settings > Office > Office Settings > 

Advanced > Relax Recert Timing Rules 

bit 1 False  ((0)) 

 br_AvgEpisodeDays 

The AvgEpisodeDays field of the BranchSettings-

BillingInfo object. 

Used to set the average episode closing days 

(default 45) and is used to defer  

revenue for PPS invoices. 

UI Location: Settings > Office > Office Settings > 

Billing > Avg Episode Days 

smallint 2 False  ((45)) 

 br_AcctExtractOnClose 

The AcctExtractOnClose field of the Branch-

SettingsBillingInfo and BranchListItemInfo objects. 

Used to determine whether an account extract will 

be generated when a period is  

bit 1 False  ((0)) 
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closed. By default, this value is not checked. When 

checked and a period is  

closed, an accounting extract will be generated. 

This accounting extract record  

will include all invoices, postings and payment 

accounting extract records that  

are closed in the period and have not been 

extracted so far. When this setting  

is checked, the option to manually create an 

account extract from the account  

extract form will be disabled. 

UI Location: Settings > Office > Office Settings > 

Billing > Create accounting extract on closing 

 br_AcctExtractGrpGLDate 

The AcctExtractGrpGLDate field of the Branch-

SettingsBillingInfo object. 

Used to determine whether GL entries created for 

an accounting extract will be  

grouped by the GL date. If checked, the GL entries 

will be grouped by GL date  

(service date, posting date, deposit date) and the 

account chart ID. If not  

checked, GL entries will be dated using the 

account extract date and therefore  

all GL with the same Account Chart will be grouped 

together. 

UI Location: Settings > Office > Office Settings > 

Billing > Group GL by date 

bit 1 False  ((1)) 

 br_PCELimitBatchIDInFile 

The PCELimitBatchIDInFile field of the Branch-

SettingsPayrollInfo and BranchListItemInfo 

objects.Check the box to limit the Payroll Batch ID 

within the extract file to a  

specified number of digits. 

UI Location: Settings > Office > Office Settings > 

Payroll > Limit Batch ID in Extract File 

bit 1 False  ((0)) 

 br_PCEBatchIDInFileNums 

The PCEBatchIDInFileNums field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

Enter the number of digits from the Payroll Batch 

ID to be used in the file  

naming convention. These will be the last 2 digits 

of the Batch ID. If the Batch  

ID is less than the number entered, the ID will be 

padded with leading zeroes to  

reach the number of digits entered. 

UI Location: Settings > Office > Office Settings > 

Payroll > Digits 

tinyint 1 False  ((0)) 

 br_TelephonyTypeID 

The TelephonyTypeID field of the BranchesInfo 

and BranchListItemInfo objects. 

int 4 True   
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The telephony provider you use from the drop 

down box. 

UI Location: Settings > Office > Office Settings > 

Telephony > Telephony Provider 

 br_OASISExtractDefaultPath 

The OASISExtractDefaultPath field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

This allows you to set a default path to the folder 

where the CMS extract file  

should be saved. 

UI Location: Settings > Office > Office Settings > 

Advanced > Default Extract File Path 

nvarchar(240) 480 True   

 br_OASIS_HHA_Agency_Id 

The OASIS_HHA_Agency_Id field of the Branch-

SettingsMainInfo object. The medicare id for the 

entire HHA. This can sometimes be the federal tax 

id. 

This is the agency ID assigned to this office, 

obtained from CMS. The value  

entered stamps in the header record of the OASIS 

assessment at the time the  

assessment is created. This data is also displayed 

in the body of the  

assessment. It is recommended that this should be 

entered in the office record  

prior to creating any OASIS assessments. 

UI Location: Settings > Office > Office Settings > 

Advanced > HHA Agency ID 

nvarchar(16) 32 True   

 br_OTWeekDeductEarn 

The OTWeekDeductEarn field of the Branch-

SettingsPayrollInfo object. 

The D/E Code if required by a customized payroll 

extract files. 

UI Location: Settings > Office > Office Settings > 

Payroll > D/E Code (Under Weekly Overtime) 

nvarchar(5) 10 False  (N'E') 

 br_OTDayDeductEarn 

The OTDayDeductEarn field of the BranchSettings-

PayrollInfo object. 

The D/E Code if required by a customized payroll 

extract files. 

UI Location: Settings > Office > Office Settings > 

Payroll > D/E Code (Under Daily Overtime) 

nvarchar(5) 10 False  (N'E') 

 br_TelephonyLogLevel 

The TelephonyLogLevel field of the BranchesInfo 

object. 

0: None 

1: Error Only 

2: Warnings and Errors 

3: All 

tinyint 1 False  ((2)) 

 br_ElectronicPmtProcessEnabled 

The ElectronicPmtProcessEnabled field of the 

bit 1 False  ((0)) 
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BranchListItem and BranchSettingsElectPmt-

ProcessInfo objects. 

If BranchSettingsElectPmtProcess isnot nothing 

br_ElectronicPmtProcessEnabled is enabled. 

 br_ElectronicPaymentProcessingTypesID 

The ElectronicPaymentProcessingTypesID field of 

the BranchesInfo and BranchListItemInfo objects. 

Payment processing type. 'FlashBanc-

Authorize.net' or 'PayRight' 

UI Location: Settings > Office > Office Settings > 

Elect Pmt Process > Processing Type 

int 4 True   

 br_ElectronicPmtProcessLogin 

The ElectronicPmtProcessLogin field of the 

BranchesInfo and BranchListItemInfo objects. 

User Name and Password are provided to you by 

the Payment Gateway (FlashBanc or PayRight).  

NOTE: The Payment Gateway may refer to the 

User Name and Password as the API  

Login ID and Transaction Key for Flashbanc. For 

PayRight, the User Name is the Consumer Key 

and Password is the Consumer Secret. The AIM 

and CIM logins will be identical when  

using FlashBanc and PayRight.  

UI Location: Settings > Office > Office Settings > 

Elect Pmt Process > User Name (Under 

Authorizations) 

varbinary(255) 255 True   

 br_ElectronicPmtProcessPassword 

The ElectronicPmtProcessPassword field of the 

BranchesInfo and BranchListItemInfo objects. 

User Name and Password are provided to you by 

the Payment Gateway (FlashBanc or PayRight). 

NOTE: The Payment Gateway may refer to the 

User Name and Password as the API Login ID and 

Transaction Key for Flashbanc. For PayRight, the 

User Name is the Consumer Key and Password is 

the Consumer Secret. The AIM and CIM logins will 

be identical when using FlashBanc and PayRight. 

UI Location: Settings > Office > Office Settings > 

Elect Pmt Process > Password (Under 

Authorizations) 

varbinary(255) 255 True   

 br_ElectronicPmtCustInfoMgtLogin 

The ElectronicPmtCustInfoMgtLogin field of the 

BranchesInfo and BranchListItemInfo objects. 

User name to access customer management only. 

No payment processing. 

UI Location: Settings > Office > Office Settings > 

Elect Pmt Process > User Name (Customer 

Information Management) 

varbinary(255) 255 True   

 br_ElectronicPmtCustInfoMgtPassword 

The ElectronicPmtCustInfoMgtPassword field of 

the BranchesInfo and BranchListItemInfo objects. 

Password to access customer management only. 

No payment processing. 

varbinary(255) 255 True   
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UI Location: Settings > Office > Office Settings > 

Elect Pmt Process > Password (Customer 

Information Management) 

 br_IncludePrevPayDates 

The IncludePrevPayDates field of the Branch-

SettingsPayrollInfo and BranchListItemInfo objects. 

0 : Equal to Pay Date. When this option is selected, 

completed payable schedules with a schedule Pay  

Date equal to the payroll batch Pay Date are pulled 

into the batch. 

1 : Less or Equal to Pay Date. This is the default 

setting on new office records.When this option is 

selected,  

completed payable schedules with a schedule Pay 

Date less than or equal  

to the payroll batch Pay Date will be pulled into the 

batch. Where the  

schedule Pay Date does not match the Payroll 

Batch Pay Date, the schedule Pay  

Date will be updated to match when the batch is 

finalized. Works with the NPD  

Payroll Batching process. 

UI Location: Settings > Office > Office Settings > 

Payroll > Pay Date Options (Radio Button) 

bit 1 False  ((1)) 

 br_ElectronicPmtValidation 

The ElectronicPmtValidation field of the BranchList-

ItemInfo and BranchSettingsElectPmtProcessInfo 

objects. 

True = liveMode, False = none 

bit 1 False  ((0)) 

 br_TelephonyTimeSource 

The TelephonyTimeSource field of the Branches-

Info and BranchListItemInfo objects. 

The recommended setting is 'Use Call Time'. Use 

Call Time uses the actual  

call in/out times and units for payroll and billing. 

Actual times and units are  

displayed on invoices.  

'Keep Sch.Time and Units - the originally 

scheduled time and units  

will stay on the schedule. This setting could make 

sense if your caregivers are  

salaried and clients have strict expectations of what 

their bill should say,  

regardless of what work was actually performed. 

(For example: Schedule A is  

expected from 8:00-9:00am. Calls come in at 8:03 

and 9:45am. Schedule Time will  

continue to say 8:00-9:00am, and bill/pay units will 

stay at 1.0. Invoice will  

display 8:00-9:00am.)  

0: Use Actual Times 

1: Use Schedule Times 

tinyint 1 False  ((0)) 
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UI Location: Settings > Office > Office Settings > 

Telephony > Telephony Time Source 

 br_InvParm_DisplayBrLogo 

The InvParm_DisplayBrLogo field of the Branches-

Info object. 

Select either True or False to determine whether 

the Office Logo should display  

on the invoice. 

0: False, 1: True 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Office Logo 

tinyint 1 False  ((0)) 

 br_InvParm_DisplayCrBalances 

The InvParm_DisplayCrBalances field of the 

BranchesInfo object. 

Select Display Only, Display and Deduct, or Do Not 

Display to determine  

whether any credit balances should display or 

display with deductions on the  

invoice.Display Only displays the sum of the credit 

balance(s) -  

will not deduct the amount from the total amount 

due on the invoice.Display and Deduct displays the 

sum of the credit balance(s)  

and deducts that amount from the total amount due 

on the invoice for display  

purposes only.Do Not Display will not pull the sum  

of the credit balance(s) and will not display.Default 

displays only on the Payer record.UI Location: 

Settings > Office > Office Settings > Billing Rpt 

Parms > Display Credit Balance 

tinyint 1 False  ((0)) 

 br_InvParm_DisplayCarFistNameOnly 

 

The InvParm_DisplayCarFistNameOnly field of the 

BranchesInfo object. 

Select Full Name, First Name Only, or No Name to 

determine how to display the  

Caregiver's  name, if at all, on the invoice. 

Full Name displays the Caregiver's First and Last 

Name in  

the 'Caregiver' column on the invoice. 

First Name Only displays the Caregiver's First 

Name in the  

'Caregiver column on the invoice. 

No Name hides the 'Caregiver' column on the 

invoice. 

Default uses the setting from the Office record.UI 

Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Caregiver Name 

tinyint 1 False  ((0)) 

 br_InvParm_DisplayRecentPmts 

The InvParm_DisplayRecentPmts field of the 

BranchesInfo object. 

tinyint 1 False  ((0)) 
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Select either True or False to determine whether to 

display recent payments. 

0: False, 1: True 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Recent Payments 

 br_InvParm_DisplayOutstandingInv 

The InvParm_DisplayOutstandingInv field of the 

BranchesInfo object. 

Select either True or False to determine whether to 

display any outstanding  

invoices 

0: False, 1: True 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Outstanding Invoices 

tinyint 1 False  ((0)) 

 br_InvParm_DisplayDepositBalances 

The InvParm_DisplayDepositBalances field of the 

BranchesInfo object 

Select either True or False to determine whether 

deposit balances should display  

on invoices. 

0: False, 1: True 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Outstanding Invoices 

tinyint 1 False  ((0)) 

 br_InvParm_PmtWithinDays 

The InvParm_PmtWithinDays field of the 

BranchesInfo object. 

Payment Postings with a posting date within a 

number of days from the current  

date. The default setting is 90 days (sums the 

Payment Postings with a posting  

date 90 days back from the current date).Also 

called PaymentWithinDays.UI Location: Settings > 

Office > Office Settings > Billing Rpt Parms > 

Display Payments Within Days 

tinyint 1 False  ((90)) 

 

br_PayrollExtractTypeID 

The PayrollExtractTypeID field of the BranchList-

ItemInfo and BranchSettingsPayrollInfo objects. 

This is a system generated ID number for the 

extract type of the braches record. 

int 4 False  ((2)) 

 br_TelephonyTimeBeforeArrivalLimit 

The TelephonyTimeBeforeArrivalLimit field of the 

BranchesInfo and BranchListItemInfo objects. 

The allowable minutes before Caregivers 

scheduled arrival time to be considered  

valid for the call-in time. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time Threshold before arrival 

int 4 False  ((0)) 

 br_TelephonyTimeAfterArrivalLimit 

The TelephonyTimeAfterArrivalLimit field of the 

BranchesInfo and BranchListItemInfo objects. 

The allowable minutes after Caregivers scheduled 

arrival time to be considered  

int 4 False  ((0)) 
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valid for the call-in time. Arrival Calls display in 

Yellow during this period. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time Threshold after arrival 

 br_TelephonyTimeBeforeDepartureLimit 

The TelephonyTimeBeforeDepartureLimit field of 

the BranchesInfo and BranchListItemInfo objects. 

The allowable minutes before Caregivers 

scheduled departure time to be  

considered valid for the call-out time. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time Threshold before departure  

int 4 False  ((0)) 

 br_TelephonyTimeAfterDepartureLimit 

The TelephonyTimeAfterDepartureLimit field of the 

BranchesInfo and BranchListItemInfo objects. 

The allowable minutes after Caregivers scheduled 

departure time to be considered  

valid for the call-out time. Departure Calls display in 

Yellow during this  

period. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time Threshold after departure  

int 4 False  ((0)) 

 br_TelephonyCreateNewSchOnNoMatch 

The TelephonyCreateNewSchOnNoMatch field of 

the BranchesInfo and BranchListItemInfo objects. 

If unchecked, will not be able to create a schedule 

from calls. 

UI Location: Settings > Office > Office Settings > 

Telephony > Allow creation of a new schedule if 

downloaded schedule does not match an  

existing one  

bit 1 False  ((0)) 

 br_TelephonyRoundUp 

The TelephonyRoundUp field of the BranchesInfo 

and BranchListItemInfo objects. 

Check the box to round the call times. All unit types 

(15min, 30min, hourly)  

are eligible for rounding. 

UI Location: Settings > Office > Office Settings > 

Telephony > Round Call Times when imported into 

schedules 

bit 1 False  ((0)) 

 br_TelephonyRoundIncrement 

The TelephonyRoundIncrement field of the 

BranchesInfo and BranchListItemInfo objects. 

Enter the number of minutes to be used for 

rounding. Available for all unit  

types. 

UI Location: Settings > Office > Office Settings > 

Telephony > Round call times to how many 

minutes 

int 4 False  ((0)) 

 br_TelephonyEmailDestTypeOnMissedVisit 

The TelephonyEmailDestTypeOnMissedVisit field 

of the BranchesInfo object. 

tinyint 1 False  ((0)) 
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 br_TelephonyEmailAddrOnMissedVisit 

The TelephonyEmailAddrOnMissedVisit field of the 

BranchesInfo object. 

Alternative email address for email notification to 

be sent for Missed CheckIn and/or Missed Check-

Out. Multiple email addresses may be entered, 

separated by a semicolon (;). It is recommended to 

add the addresses in after Telephony has been 

turned on to reduce the number of notifications 

received. Notifications will not be sent for 

schedules in the past (where the created on 

date/time of the schedule is greater than the start 

date/time of the schedule). Notifications will not be 

sent for Clients or Caregivers who have the 

'Upload Telephony' setting unchecked. 

UI Location: Settings > Office > Office Settings > 

Telephony > To 

nvarchar(200) 400 True   

 br_TelephonyParentID 

The TelephonyParentID field of the BranchesInfo 

and BranchListItemInfo objects. 

The Parent Office for the account; if applicable. 

The Parent Office can  

be different than the selected Office if multiple 

Offices sharing one telephony  

account. 

UI Location: Settings > Office > Office Settings > 

Telephony > Tel. Parent Office 

int 4 True   

 br_485Box5Default 

This field is used in both the plan of care and the 

assessment screens to determine the branch 

identifier. It determines if the NPI or Provider# 

should pull to Box 5 of the OASIS C/485 

Assessment, the Plan of Care > Intake 2 Tab and 

the 485 Report. The existing field on OASIS C/485 

Assessments has been relabeled to 485 Box (5) 

Identifier. Note: This table setting is at the office 

level, and controls which identifier is used at the 

time OASIS C/485 Assessments are created, the 

Plan of Care > Intake2 Tabs are viewed, and the 

485 Reports are drafted or finalized for the office.  

0 = Use br_NPI on T_Branches. Pulls the office 

NPI to Box 5, this is the default setting. 

1 = Go to the primary payer on the patient's 

admission, join to T_Payers, and pull the value 

from pay_AgencyProviderNum. 

2 = Use no identifier, simply insert a single space ' 

'. 

tinyint 1 False  ((0)) 

 br_MinWage 

The MinWage field of the BranchSettingsPayroll-

Info object. 

Your state's minimum wage amount if applicable. 

This field will be used for OT processing of New 

York payroll. 

Also called BRMinWage 

smallmoney 4 False  ((0)) 
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UI Location: Settings > Office > Office Settings > 

Payroll > Minimum Wage 

 br_TelephonyNotificationMaxHoursAgo 

The TelephonyNotificationMaxHoursAgo field of 

the BranchesInfo object. 

int 4 False  ((24)) 

 br_FTPPayrollSettings 

Also called FTPPayrollSettingsData. 

varbinary(max) max True   

 br_TreatmentWeekStartDay 

The TreatmentWeekStartDay field of the Branch-

ListItem and BranchSettingsSchedulingInfo 

objects. Choose your Treatment Week start day 

from the drop down box for the day of  

the week you use for your agency. Specifies the 

day your agency's Treatment Week  

begins. Treatment Weeks can be used when 

entering frequencies in Authorizations, Plan of 

Care Orders and MOD  

Orders. For example, if a Client is scheduled for 

services for 8 weeks  

starting on a Thursday, but the Treatment Week 

begins on Monday, the first week  

of the plan of care will be from Thursday to Sunday 

(4 days) so that the  

remaining weeks in the plan of care match the 

Treatment Week. 

UI Location: Settings > Office > Office Settings > 

Advanced > Treatment Week Start Day 

tinyint 1 False  ((0)) 

 br_OAReqForClients 

The OAReqForClients field of the BranchListItem 

and BranchSettingsMainInfo objects. 

Also called DisplayOfficeArea. 

UI Location: Settings > Office > Office Settings > 

Advanced > Is Office Area Required for Clients 

bit 1 False  ((0)) 

 br_TelephonyServiceChangeFlagBehavior 

The TelephonyServiceChangeFlagBehavior field of 

the BranchSettingsTelephonyInfo object. 

Choose 'Allow None' to have no service changes 

pass through automatically.  

Choose 'Allow If Same Category' to allow the 

service code override only if the  

service code falls within the same service code 

category of the service code  

originally scheduled. Choose 'Allow All' to allow all 

service code overrides  

unconditionally. 

UI Location: Settings > Office > Office Settings > 

Telephony > Automatic Schedule Service Change 

Behavior 

smallint 2 True   

 br_TelephonyCheckInResetThreshold 

The TelephonyCheckInResetThreshold field of the 

BranchSettingsTelephonyInfo object. 

smallint 2 True  ((30)) 
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If a schedule already had a missed check-in/out 

notification sent, but the  

visit is moved to a different time, this setting 

determines if the schedule  

should be eligible for another missed check-in/out 

notification. Enter the  

number of minutes required to trigger a reset: 30 

minutes is the default;  

Blank=never reset; 0=reset on any change. 

UI Location: Settings > Office > Office Settings > 

Telephony > Notification Reset Threshold 

 br_InvParm_DisplaySchTime 

The InvParm_DisplaySchTime field of the Branch-

BillingRptParmsInfo object. 

Select either True or False to determine whether to 

display schedule start and  

end times on invoices. The default is True. 

Determines whether to display Start and End 

Times on Invoice Details on (all versions) of the 

Standard Invoice, Payer Invoice, and Basic Invoice 

0: False 

 1: True 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Schedule Start/End 

Times 

tinyint 1 False  ((1)) 

 
br_BillTypeID 

The BillTypeID field of the BranchSettingsBilling-

Info and BranchListItemInfo objects. 

Select the default Bill Type for new Payer records. 

This setting affects newly  

created Payer records only. Newly created Payers 

that have the office as the  

"Belongs To' office will default to this Bill Type. If 

you leave this setting  

blank, new Payer records will be created with the 

bill type of Standard  

Invoice. See Also Standard Invoice Bill  

Type Sample and Basic Invoice Bill Type  

Sample and Payer Invoice Bill Type Sample. 

The default Bill Type for new payer records with 

this belongs to office.  

UI Location: Settings > Office > Office Settings > 

Billing > Invoice Default Bill Type 

int 4 True   

 br_AutoPost 

The AutoPost field of the BranchSettingsBillingInfo 

and BranchListItemInfo objects. 

Default is unchecked. When checked, an option of 

'Auto Post' defaults on the  

'Payment and Postings' form, and any new 

payments apply automatically to  

outstanding invoices. Automatically apply 

Payments to Invoices. Default value of FALSE. 

bit 1 False  ((0)) 
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UI Location: Settings > Office > Office Settings > 

Billing > Automatically Apply Payments to Invoices 

 br_AddressVerification 

The AddressVerification field of the Branch-

SettingsMainInfo and BranchListItemInfo objects. 

Select the Address Verification method from the 

drop down box by  

choosing:  

Manual (the default) - verification will run only when  

take action of clicking the verification button on the 

entity's address. Must  

have permission to edit addresses to manually run 

verification. 

Forced - verification will automatically run when an  

address is saved or when a change to an existing 

address is saved. Do not need  

to perform the action of clicking the verification 

button for the process to  

run. Also have the option of clicking the button and 

manually running the  

verification if needed.UI Location: Settings > Office 

> Office Settings > Advanced > Address 

Verification 

smallint 2 True   

 br_InvParm_DisplaySchNote 

Determines whether to display Schedule Notes 

(sch_Description) on the Standard and Payer 

Invoice. 

Select either True or False to determine whether to 

display any notes that exist  

on the Notes tab of schedules at the time invoices 

are finalized on the Standard  

and Payer invoice types. The default is False. If set 

to True, the notes that  

exist on the Notes tab of Schedule  

Calendar Details at time invoice is finalized will 

display on Standard and  

Payer invoice types. Changes made to the 

schedule notes after the invoice is finalized will not 

be  

included on the invoice reports. If the Schedule 

crosses multiple invoice detail  

records (due to office shifts or holiday shifts) the 

Note will repeat on each  

invoice detail line on the reports. 

VALUES 

0: False  

1: True 

DEFAULT 

0: False 

UI Location: Settings > Office > Office Settings > 

Billing Rpt Parms > Display Schedule Notes 

tinyint 1 False  ((0)) 
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 br_TelephonyEmailFromAddrOnMissedVisit 

The TelephonyEmailFromAddrOnMissedVisit field 

of the BranchSettingsTelephonyInfo object. 

From email address for 'Missed Check-In 

Notifications. Specify the email  

From address for notifications. If address entered, 

provides the recipient with  

an email address to reply back to (in the event the 

recipient is mistakenly  

receiving these and need to contact the office 

sending emails out). Not required  

- if null a default value will be provided and 

CANNOT be replied back to. 

UI Location: Settings > Office > Office Settings > 

Telephony > From 

nvarchar(200) 400 True   

 br_MgmtInterfPassword 

 

varbinary(255) 255 True   

 br_AllowSMSTextMessaging 

True means the office permits users to send SMS 

Text messages in interactive screens like 

Caregiver Search. Does not apply to telephony. 

Check this box to enable sending SMS text 

messages and/or emails to  

Caregivers directly from the Caregiver Search. On 

the Caregiver>Main tab must also check off the 

'Txt'  

box within the phone grid for the number to receive 

SMS text messages from the  

system. See Sending SMS Text Messages and 

Email Notifications to  

Caregivers for complete details.  

UI Location: Settings > Office > Office Settings > 

Advanced > Allow Text Messages 

bit 1 True   

 br_Aalic 

Field used to auto apply licenses when rolling 

named user license project to prod. 

bit 1 False  ((1)) 

 br_SchedulingSkillGroupCheckAllow 

Select whether to check for Skill Groups from the 

Caregiver Skill Codes tab.  

Default, Disallow, Warn Only, or Do Not Check with 

optional Override options for  

Skill Groups. Works in conjunction with settings on 

the Caregiver>Skill  

Codes tab for schedule conflict checking. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

tinyint 1 True   
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save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Skill Groups 

 br_SchedulingSkillGroupCheckOverride 

User override check for Scheduling Skill Group. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

by settings in the next area of the system (Global to 

Office to User). 

UI Location: Settings > Office > Office Settings > 

Scheduling > Skill Groups (2nd field) 

tinyint 1 True   

 br_TimeAndAttendLocationThreshold 

Distance (in miles) that is maximum acceptable 

range.  If outside range, system will show QA flag 

to alert users and not auto-complete schedule. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time & Attendance: Location 

Threshold 

decimal(7,4) 5 True   

 br_TimeAndAttendLocationMinAccuracy 

Accuracy (in miles) that is maximum acceptable 

range.  If outside range, system will show QA flag 

to alert users and not auto-complete schedule. 

UI Location: Settings > Office > Office Settings > 

Telephony > Time & Attendance: Minimum 

Accuracy 

decimal(7,4) 5 True   

 br_TimeAndAttendPortalEnabled 

True means the office can participate in Time And 

Attendance collection on the SonetoWeb Portal. 

bit 1 True   

 br_AdministratorEmail 

Office administrator email. 

UI Location: Settings > Office > Office Settings > 

Advanced > Admin Email 

nvarchar(200) 400 True   

 br_PCE_FileNameSuffix 

If "Use Extract Date in File name (MMDDYY)" is 

checked, file name suffix will be "{MMDDYY}". 

Use Extract Date in File name (MMDDYY) UI 

Location: Settings > Office > Office Settings > 

Payroll > Use Extract Date in File name 

(MMDDYY) (Check box) 

nvarchar(20) 40 True   

 br_SchedulingCGStatusConflictsAllow 

Select whether to check for the status of the 

Caregiver for scheduling. (For example, the 

Caregiver is Inactive or Terminated). If select 'User 

Override' for this Conflict Check on this setting, 

then can change the default behavior on the 

User>Scheduling tab. When scheduling, the 

conflict check runs if scheduling settings set to 

'Warn Only' or 'Disallow'. Caregiver Status Check. 

Conflict notification setting for Caregiver Status at 

the office level. 

tinyint 1 False  ((0)) 
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Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Caregiver Status 

 br_SchedulingCGStatusConflictsOverride 

Conflict override setting for Caregiver Status at the 

office level. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

by settings in the next area of the system (Global to 

Office to User).UI Location: Settings > Office > 

Office Settings > Scheduling > Caregiver Status 

(2nd field) 

tinyint 1 False  ((1)) 

 br_MaxWeekHours 

The maximum weekly hours setting from 1 -168. 

UI Location: Settings > Office > Office Settings > 

Payroll > Max Hour Check 

tinyint 1 False  ((168)) 

 br_SchedulingCheckForMaxHours 

Select 'Yes', 'No', or 'Default' (with User Override or 

No Override). Provides a warning box if a caregiver 

exceeds the weekly maximum hours. Works in 

conjunction with OT conflict checks. 

Caregiver Status Check. Conflict notification setting 

for Caregiver Status at the office level. 

Conflict Check Level: 

Default - Takes the level set at the next highest 

level (whether Global or Office). 

Disallow - Runs the conflict check, warns the user, 

and does not allow them to save the record. For 

more information, see Schedule Conflict Warning. 

Warn Only - Runs the conflict check and warns the 

user, but allows them to Ignore the warning and 

save the record. For more information, see 

Schedule Conflict Warning. 

UI Location: Settings > Office > Office Settings > 

Scheduling > Check for Max Hours 

tinyint 1 False  ((0)) 

 br_SchedulingCheckForMaxHoursOverride 

Conflict override setting for Check Max Hours at 

the office level. 

Override Level:User Override - The default 

behavior for the level of conflict checking can be 

overridden in the next area of the system (Global to 

Office to User).No Override - The default behavior 

for level of conflict checking cannot be overridden 

tinyint 1 False  ((0)) 
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by settings in the next area of the system (Global to 

Office to User).UI Location: Settings > Office > 

Office Settings > Scheduling > Check for Max 

Hours (2nd field) 

 br_EDISFLAdditionalID 

The EDISFLAdditionalID field is used as an 

additional ID for the Service Facility Location. 

The facility ID. 

UI Location: Settings > Office > Office Settings > 

Billing > Facility ID 

nvarchar(20) 40 True   

 br_EDISFLAdditionalIDType 

The EDISFLAdditionalIDType field is used as an 

additional ID Type for the Service Facility Location. 

This is used when a Payer specifies a specific 

Type for Loop 20100AA. Enter that  

Type here. In the Payer EDI Settings tab, Loop 

20100AA must be set to Office  

Additional. 

UI Location: Settings > Office > Office Settings > 

Billing > Additional Type 

nvarchar(3) 6 True   

 
br_PayrollTravelTimeThreshold 

br_PayrollTravelTimeThreshhold stores the max 

number of minutes between schedules that will 

result in the automatic creation of Travel Time for 

Payroll purposes.  At least initially this value will be 

used as the duration of the automatically generated 

Payroll Travel Time.  The default value will be 0 

which will prevent the automatic creation of Travel 

Time.  The maximum value allowed will be 1440 

minutes, which seems reasonably large and should 

accomodate even the least reasonable situations. 

UI Location: Settings > Office > Office Settings > 

Billing > Travel Time Threshold 

int 4 False  ((0)) 

 br_OperationsFeatures 

A bit flag used to record various operations level 

features that are to be enabled for this office. 

None = 0 

ServicePlanVersioning = 1 

MedicationModule = 2 

bigint 8 False  ((0)) 

 br_BillPayKey 

The BillPayKey field of the BranchSettingsMainInfo 

object. 

The API key to send in the payload to make 

payments to vendor with.  UI Location: Settings > 

Office > Office Settings > Advanced > Bill/Pay Key 

nvarchar(50) 100 True   

 br_BillPayLocationID 

Unique identifier used in combination with br_Bill-

PayKey to make payments through PayRight. 

Automatically generated on record creation and 

should not be changed. 

uniqueidentifier 16 False  (newid()) 

 br_IsHolidayOTEligible 

Is Office Holiday OT Eligible. When the value = 1 

bit 1 False  ((1)) 
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Indexes 

 

Foreign Keys 

 

 

 

then Holiday Pay is included in Regular Rate OT 

Calculation. 

 br_InvoiceEmailBody 

The InvoiceEmailBody field of the BranchSettings-

BillingInfo object. If entered, this will appear in the 

email body of emailed invoices. (Max. character 

limit of 1000)  

UI Location: Settings > Office > Office Settings > 

Billing > Invoice Email 

nvarchar(1000) 2000 True   

 br_ElectronicProcessingMerchantID 

Electronic Processing Merchant ID 

nvarchar(40) 80 True   

 br_FtpEftSettings 

Ftp settings for the Royalty Extract to upload the 

file to a ftp location. Encrypted in database. 

varbinary(max) max True   

 br_TelephonyAllowShorterSch  

 

bit 1 False  [(0)} 

Key Name Key Columns Unique Fill Factor 

 
PK_T_Branches br_ID True 80 

 IX_T_Branches_Name br_Name True 80 

 IX_T_Branches_PayrollExtractType br_PayrollExtractTypeID, br_ID   

 IX_T_LocationID br_LocationID  80 

 IX_T_Par_Branch_ID br_ParBranchID  80 

Name Columns 

FK_T_Branches_T_BillType br_BillTypeID->[dbo].[T_BillType].[biltyp_ID] 

FK_T_Branches_T_Payers_OASIS_Medicaid br_OASIS_Medicaid_Payer_ID->[dbo].[T_Payers].[pay_ID] 

FK_T_Branches_T_Payers_OASIS_Medicare br_OASIS_Medicare_Payer_ID->[dbo].[T_Payers].[pay_ID] 

FK_T_Branches_T_PayrollExtractTypes br_PayrollExtractTypeID->[dbo].[T_PayrollExtractTypes].[prolle_ID] 

FK_T_ServiceCode_T_Branches_DefaultMileage br_DefaultMileageId->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_ServiceCode_T_Branches_DefaultServiceCode br_DefaultServiceCodeId->[dbo].[T_ServiceCode].[svcc_ID] 
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Caregiver 

 [dbo].[T_Caregiver] 

 

Description 

Caregiver personal and professional information. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

car_ID 

System generated unique ID for the caregiver record. 

Used to pull caregiver name to show in the UI. 

UI Location: Search box results in various locations > 

ID, 

Schedule Calendar > List View > Caregiver 

and Caregiver > ID 

bigint 8 False 1 - 1  

 
car_LastName 

Caregiver's last name. 

UI Location: Search box results in various locations > 

Last Name, 

Schedule Calendar > List View > Caregiver (Last, 

First), 

Caregiver > Last 

and Training Register > Last Name 

nvarchar(50) 100 False   

 
car_FirstName 

Caregiver's first name. 

UI Location: Search box results in various locations > 

First Name, 

Schedule Calendar > List View > Caregiver (Last, 

First), 

Caregiver > First 

and Training Register > First Name 

nvarchar(50) 100 False   

 car_MiddleName 

The middle name of the caregiver. 

UI Location: Caregiver > Middle 

nvarchar(50) 100 True   

(2)

 

car_StatusID 

The status ID of the caregiver. Pulls the status name 

and show in the UI. 

Relates to [T_CaregiverStatus].[carstat_ID]. Some 

examples of statuses are Active, On Leave, Retired, 

etc. 

For more information, see DDM > Caregiver Status 

int 4 False   
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UI Location: Search box results in various locations > 

ID 

and Caregiver > Status 

(3)

 

car_BranchID 

 

Office ID where the caregiver belongs to. Used to pull 

office name to UI. 

Relates to [T_Branches].[br_ID]. 

UI Location: Caregiver > Office > Belongs to Office 

int 4 False   

 
car_RegionID 

Office ID where the caregiver belongs to. Used to pull 

office name to UI. 

Relates to [T_Branches].[br_ID]. 

UI Location: Search box results in various locations > 

Office 

and Caregiver > Office 

int 4 True   

 car_InternalID 

The caregiver's optional internal ID. 

UI Location: Caregiver > Main > Internal ID 

nvarchar(20) 40 True   

 car_Phone 

Not used. Moved to T_CaregiverPhones. 

nvarchar(30) 60 True   

 car_PhoneType 

Not used. Moved to T_CaregiverPhones. 

int 4 True   

 car_Title 

The caregiver's title. 

UI Location: Caregiver > Main > Title 

nvarchar(50) 100 True   

 

car_SkillCd 

The skill category ID of the caregiver. The primary 

skill category of the caregiver. Once saved, the Skill 

Category can only be changed on the Skill Codes 

screen. For further information, see DDM Skill 

Categories or Caregiver Skill Codes. Used to pull skill 

category name to the UI. 

Relates to [T_SkillCategories].[skillc_ID]. Some 

examples of skill categories are C.N.A, HHA, RN, etc. 

For more information, see DDM > Skill Categories 

UI Location: Search box results in various locations > 

Skill Category 

and Caregiver > Main > Title 

int 4 True   

 car_Address1 

Holds the main address information. 

UI Location: Caregiver > Main > Address1 (through 

AddressList object) 

nvarchar(255) 510 True   

 car_Address2 

Optional address field. 

UI Location: Caregiver > Main > Address2 (through 

AddressList object) 

nvarchar(60) 120 True   

 car_City 

City of the entity. 

nvarchar(50) 100 True   
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UI Location: Caregiver > Main > City (through 

AddressList object) 

 car_StateOrProvince 

State of the entity. 

UI Location: Caregiver > Main > State (through 

AddressList object) 

nvarchar(20) 40 True   

 car_PostalCode 

Postal code of the entity. The system accepts +4 

postal codes. The +4 postal code will display on all 

correspondence (letters, envelopes, labels and 

invoices) and reports that utilize postal codes 

(including the Caregiver Name Badge report). The 

non-numeric value (dash) will be stripped from the 

OASIS extract file, the CAHPS extract file, and the 

837 electronic billing files. 

UI Location: Caregiver > Main > Postal Code 

(through AddressList object) 

nvarchar(20) 40 True   

 car_County 

County of the entity. 

UI Location: Caregiver > Main > County (through 

AddressList object) 

nvarchar(50) 100 True   

 
car_Country 

Country of the entity. 

Relates to [T_Countries].[ctry_ID]. 

UI Location: Caregiver > Main > Country (through 

AddressList object) 

int 4 False  ((240)) 

 car_Email1 

Country of the entity. 

Relates to [T_Countries].[ctry_ID]. 

UI Location: Caregiver > Main > Country (through 

AddressList object) 

nvarchar(50) 100 True   

 car_Email2 

Caregiver secondary e-mail address. 

UI Location: Caregiver > Main > Email 2 

nvarchar(50) 100 True   

 car_TextMessage 

Future use. 

UI Location: Caregiver > Main > Text Message 

nvarchar(50) 100 True   

 car_Birthdate 

Caregiver's birth date. 

UI Location: Caregiver > Payroll > Birth Date 

datetime 8 True   

 car_SpouseName 

The caregiver's spouse name. 

UI Location: Caregiver > Main > Spouse Name 

nvarchar(50) 100 True   

 car_Notes 

Optional notes about the caregiver. 

UI Location: Caregiver > Main > Notes 

nvarchar(4000) 8000 True   

 car_ADPFileNum 

Read Only field. Utilized if an agency has a 

customized payroll extract file which requires this 

information. Payroll file number of the Caregiver’s 

nvarchar(50) 100 True   
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‘Belongs To’ office. Modify the payroll file number(s) 

on the Caregiver>Offices tab. A single agency may 

have multiple offices in the application, and may 

share caregivers across offices. Payroll companies 

often require a different payroll file number for each 

office the caregiver provides payable services for. 

Share one caregiver record across multiple offices 

with different payroll file numbers for each of those 

offices. 

UI Location: Caregiver > Payroll > Payroll File 

Number 

 
car_NPI 

Caregiver's NPI number. 

UI Location: Caregiver > Payroll > NPI 

nvarchar(10) 20 True   

 car_EmpSubCod_UD 

Utilized if an agency has a customized payroll extract 

file which requires this information. 

UI Location: Caregiver > Payroll > Department Code 

nvarchar(15) 30 True   

 
car_Group 

The group with which the Caregiver should be 

associated. The Group selected controls the type of 

Payroll Batch the caregiver or staff will pull into. The 

Group is not a required field, and if left blank the 

Caregiver will only pull into payroll batches where the 

Group is also left blank. 

Relates to [T_CaregiverGroup].[carg_ID]. 

UI Location: Caregiver > Payroll > Group 

int 4 True   

 car_EmpOTFlag 

When checked or value = 1, excludes the Caregiver 

from the OT pay rate calculations. 

UI Location: Caregiver > Payroll > OT Exempt 

bit 1 False  ((0)) 

 
car_TelephonyID 

 

Optional field for caregiver's telephony ID number. If 

telephony number is not provided then the system 

automatically updates the filed tp be car_ID field 

value. 

UI Location: Caregiver > HR > Telephony ID# 

nvarchar(36) 72 False   

 car_Supervisor 

The ID of the supervisor of the caregiver. Selected 

through the search box and displayed in the UI in the 

txtSupervisor box. 

UI Location: Caregiver > HR > Supervisor 

bigint 8 True   

 car_Manager 

The ID of the manager of the caregiver. Selected 

through the search box and displayed in the UI in the 

txtManager box. 

UI Location: Caregiver > HR > Manager 

bigint 8 True   

 car_InternalCaseMgr 

Bitwise mask of flags to indicate caregiver 

responsibilities:  CaseManager = 1, Supervisor = 2, 

Coordinator = 4 

tinyint 1 False  ((0)) 
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UI Location: Caregiver > HR > Case Manager, 

Caregiver > HR > Case Supervisor and Caregiver > 

HR > Case Coordinator 

 car_ShiftDiffFlag 

Not used. 

bit 1 False  ((0)) 

 
car_PayType 

The Pay Type controls whether the caregiver's 

completed schedules will be stamped with a Pay 

Date. If the Pay Type of Salary is selected, and 

scheduled visits are completed for that caregiver, the 

Pay Date will not automatically stamp on the 

schedule records. To pass a Salary caregiver through 

the payroll batching process, the user must manually 

set the Pay Date on the schedule item. Values are 0: 

Non Salary, 1: Salary. 

UI Location: Caregiver > Payroll > Pay Type 

tinyint 1 False  ((0)) 

 
car_WageChartID 

The ID of the caregiver's wage chart. Used to pull 

wage chart name to UI which is a read only field 

which displays the wage chart as specified on the 

Caregiver Office tab. 

Relates to [T_BranchChartGroups].[brcg_ID]. 

UI Location: Caregiver > Payroll > Wage Chart 

int 4 True   

 car_PayRate 

The caregiver's salary amount - for informational 

purposes only. 

UI Location: Caregiver > Payroll > Salary 

money 8 False  ((0)) 

 car_NumAllowances 

Total Number of Federal Allowances you are 

claiming. Utilized for the Infiniti payroll extract - 

otherwise this is informational. (Max. Value of 99) 

UI Location: Caregiver > Payroll > Fed Allowances 

tinyint 1 False  ((0)) 

 car_WithHold 

Additional Federal Withholding to be held from each 

paycheck. Utilized for the Infiniti payroll extract - 

otherwise this is informational. 

UI Location: Caregiver > Payroll > Fed Withhold 

money 8 False  ((0)) 

 car_PayPreference 

Caregiver's pay preference - for informational 

purposes only. 

UI Location: Caregiver > Payroll > Pay Preference 

nvarchar(2) 4 True  ('CK') 

 car_VacationHours 

The vacation hours assigned to the Caregiver - for 

informational purposes only. 

UI Location: Caregiver > Payroll > Vacation Hours 

decimal(5,2) 5 True   

 car_DDBankAcctType 

Caregiver's account type. Checking or Savings - for 

informational purposes only. 

UI Location: Caregiver > Payroll > Account Type 

char(1) 1 True   

 car_ExcludeHoliday 

When checked or value = 1, excludes this individual 

Caregiver from the Holiday pay rate calculation. 

bit 1 False  ((0)) 
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UI Location: Caregiver > Payroll > Exclude Holiday 

 car_CreatedDate 

Date and time the record was created. 

UTC date updated by SQL Server's current UTC 

date. 

UI Location: Caregiver > Main > Created On (through 

ModifiedRecord1 object) 

datetime 8 False  (getutcdate()) 

 car_CreatedUser 

User who created the record.  

UI Location: Caregiver > Main > Created By (through 

ModifiedRecord1 object) 

nvarchar(50) 100 False   

 car_ModifiedDate 

Date and time the record was last modified. 

UTC date updated by SQL Server's current UTC 

date. 

UI Location: Caregiver > Main > Modified On (through 

ModifiedRecord1 object) 

datetime 8 False  (getutcdate()) 

 car_ModifiedUser 

User who last modified the record. 

UI Location: Caregiver > Main > Modified By (through 

ModifiedRecord1 object) 

nvarchar(50) 100 False   

 car_TS 

The time stamp of the caregiver record. 

timestamp 8 False   

 
car_Role 

Defines the caregiver's role. Caregiver role is for 

individuals who cares for clients and needs to be 

scheduled with clients, Caregiver/Staff role is for 

individuals that cares for and gets scheduled with 

clients but also works internally in the office, or Staff 

for staff that work only internally in the office and do 

not need to be scheduled with clients. Records 

assigned to the caregiver role displays in Caregiver, 

records assigned to the Caregiver/Staff role display in 

both Caregiver and Staff, and records assigned to the 

Staff role display in the Staff module. One last 

distinction is scheduling, as Caregiver and 

Caregiver/Staff can be scheduled but Staff cannot. 

1: Caregiver, 2: OfficeStaff, 3: CaregiverOfficeStaff 

UI Location: Search box results in various locations > 

Role, 

Caregiver > Main > Role 

and Training Register > Roles  

tinyint 1 False  ((1)) 

 car_LegacyID 

An alternative numeric caregiver or staff ID, if 

needed. 

UI Location: Caregiver > Main > Alt. ID 

int 4 True   

 car_LegacyBranchID 

Not used. 

int 4 True   

 car_EmpSSN 

The Caregiver's Social Security number. This is an 

encrypted column. 

varbinary(255) 255 True   
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UI Location: Caregiver > Payroll > Social Security # 

 car_DDBankRoutingNum 

The Caregiver's bank routing number - for 

informational purposes only. This is an encrypted 

column. 

UI Location: Caregiver > Payroll > Bank Routing 

Number 

varbinary(255) 255 True   

 car_DDBankAcctNum 

The Caregiver's bank account number - for 

informational purposes only. This is an encrypted 

column. 

UI Location: Caregiver > Payroll > Bank Account 

Number 

varbinary(255) 255 True   

 
car_CalcUniqueSSN 

Used to check for duplicate SSN#. Encrypted field. 

varbinary(255) 255 True   

 car_BonusPointsThershold 

The points threshold the Caregiver is to achieve for 

the designated period, as appropriate. 

UI Location: Caregiver > Payroll > Points Threshold 

decimal(4,2) 5 False  ((0)) 

 
car_EmpSexID 

The sex ID of the caregiver. Used to pull sex name to 

UI. 

Relates to [T_Gender].[gndr_ID]. 

UI Location: Caregiver > Main > Sex 

int 4 True   

 
car_MaritalStatID 

The ID of the marital status of the caregiver. Used to 

pull maritus status name to the UI. 

Relates to [T_MaritalStatus].[marit_ID]. 

UI Location: Caregiver > Main > Marital Status 

int 4 True   

 
car_EmpSalutID 

Salutation ID for the caregiver. Used to pull salutation 

name to the UI. The Salutation is used when running 

a mail merge or printing labels or envelopes in 

Letters.  For further information see DDM Salutations 

and Letters. 

Relates to [T_Salutation].[salut_ID] 

UI Location: Caregiver > Main > Salutation 

int 4 True   

 car_Nickname 

The nickname of the caregiver. 

UI Location: Caregiver > Main > Nickname 

nvarchar(32) 64 True   

 car_AllowMassEmail 

When selected or value is 1, allows letters and other 

items to be sent to this Caregiver from within the 

system. 

UI Location: Caregiver > Main > Allow MatrixCare to 

Email this Caregiver 

bit 1 False  ((0)) 

 
car_ReferralTerritoryID 

The territory to which the caregiver should be 

associated. This is also for informational purposes 

only at this time. For further information, see DDM 

Referral Territories. 

int 4 True   
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Relates to [T_ReferralTerritories].[refter_ID]. 

UI Location: Caregiver > Main > Territory 

 car_UploadTelephony 

When box is checked or value = 1, it enables upload 

telephony for the caregiver. 

UI Location: Caregiver > HR > Upload Telephony 

bit 1 False  ((1)) 

 car_WSNumAllowances 

Total Number of Work State Allowances the caregiver 

is claiming. Utilized for the Infiniti payroll extract - 

otherwise this is informational. (Max. Value of 99) 

UI Location: Caregiver > Payroll > Work St 

Allowances 

tinyint 1 True   

 car_WSWithHold 

Additional Work State Withholding to be held from 

each paycheck. Utilized for the Infiniti payroll extract - 

otherwise this is informational. 

UI Location: Caregiver > Payroll > Work St Withhold 

money 8 True   

 car_SUISDI_TaxJurisdiction 

State Unemployment Insurance/State Disability 

Insurance Tax Jurisdiction (from T_StateProvinces). 

Utilized for the Infiniti payroll extract - otherwise this is 

informational. 

UI Location: Caregiver > Payroll > SUI/SDI State 

nvarchar(50) 100 True   

 car_FedFilingStatus 

Utilized for the Infiniti payroll extract - otherwise this is 

informational. 

1: Single, 2: Married, 3: Married at Single Rate 

UI Location: Caregiver > Payroll > Fed File Status 

tinyint 1 True   

 
car_WSFilingStatus 

Work State Filing Status (from T_StateFilingStatus). 

Utilized for the Infiniti payroll extract - otherwise this is 

informational. 

Relates to [T_StateFilingStatus].[sfs_ID]. 

UI Location: Caregiver > Payroll > Work St File 

Status 

int 4 True   

 car_WorkState 

Utilized for the Infiniti payroll extract - otherwise this is 

informational. 

UI Location: Caregiver > Payroll > Work State 

nvarchar(50) 100 True   

 car_RSNumAllowances 

Total Number of Residential State Allowances the 

Caregiver is claiming. Utilized for the Infiniti payroll 

extract - otherwise this is informational. (Max. Value 

of 99) 

UI Location: Caregiver > Payroll > Res St Allowances 

tinyint 1 True   

 car_RSWithHold 

Additional Residential State Withholding to be held 

from each paycheck. Utilized for the Infiniti payroll 

extract - otherwise this is informational. 

UI Location: Caregiver > Payroll > Res St Withhold 

money 8 True   
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car_RSFilingStatus 

Residential State Filing Status. Utilized for the Infiniti 

payroll extract - otherwise this is informational. 

Relates to [T_StateFilingStatus].[sfs_ID]. 

UI Location: Caregiver > Payroll > Res St File Status 

int 4 True   

 car_TelephonyAllowCaregiverPhone 

When selected or value = 1, enables to use caregiver 

cell phone number (configured on the 

Caregiver>Main tab) for telephony arrival and 

departure calls if the Client does not have a phone, 

has a rotary phone that cannot use IVR system or 

lives in a facility. Coordinates with the checkbox 

under the Telephony Settings box on the Client > 

Advanced tab. 

UI Location: Caregiver > HR > Tel. Complete with 

Caregiver Phone 

bit 1 False  ((0)) 

 car_EDIAdditionalID 

The ID specified by the Payer. Pulls to 24J top on 

1500 invoices.  [For NJ Medicaid, the ID will be the 

Caregiver’s Certified Home Health Aide Number] 

UI Location: Caregiver > Payroll > Additional ID 

nvarchar(20) 40 True   

 car_EDIAdditionalIDType 

The Qualifier specified by the Payer. Pulls to 24I top 

on 1500 invoices. [For NJ Medicaid, the Qualifier will 

be 0B] 

UI Location: Caregiver > Payroll > Additional Type 

nvarchar(3) 6 True   

 
car_RaceID 

The caregiver's race. Selections available originate 

from DDM Races List. 

Relates to [T_Race].[rce_ID]. 

UI Location: Caregiver > Main > Race 

int 4 True   

 car_EmpMHFlag 

When selected or value = 1, excludes this individual 

Caregiver from the weekly maximum hours conflict 

check. 

UI Location: Caregiver > Payroll > Bypass Max Hrs 

bit 1 False  ((0)) 
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Indexes 

 

Foreign Keys 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_Caregiver car_ID True 80 

 IX_T_Caregiver_BranchID_TelephonyID car_BranchID, car_TelephonyID True 80 

 IX_T_Caregiver_UniqueSSN car_CalcUniqueSSN, car_BranchID True 80 

 IX_T_Caregiver_BranchID car_BranchID, car_StatusID, car_ID  80 

 IX_T_Caregiver_CarFirstName car_FirstName  80 

 IX_T_Caregiver_CarSkillCode car_SkillCd  80 

 IX_T_Caregiver_LastName car_LastName  80 

 IX_T_Caregiver_StatusID car_StatusID  80 

Name Columns 

FK_T_Caregiver_T_BranchChartGroups car_WageChartID->[dbo].[T_BranchChartGroups].[brcg_ID] 

FK_T_Caregiver_T_Branches car_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_Caregiver_T_CaregiverGroup car_Group->[dbo].[T_CaregiverGroup].[carg_ID] 

FK_T_Caregiver_T_CaregiverStatus car_StatusID->[dbo].[T_CaregiverStatus].[carstat_ID] 

FK_T_Caregiver_T_Countries car_Country->[dbo].[T_Countries].[ctry_ID] 

FK_T_Caregiver_T_Gender car_EmpSexID->[dbo].[T_Gender].[gndr_ID] 

FK_T_Caregiver_T_MaritalStatus car_MaritalStatID->[dbo].[T_MaritalStatus].[marit_ID] 

FK_T_Caregiver_T_Race car_RaceID->[dbo].[T_Race].[rce_ID] 

FK_T_Caregiver_T_ReferralTerritories car_ReferralTerritoryID->[dbo].[T_ReferralTerritories].[refter_ID] 

FK_T_Caregiver_T_Region car_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_Caregiver_T_Salutation car_EmpSalutID->[dbo].[T_Salutation].[salut_ID] 

FK_T_Caregiver_T_SkillCategories car_SkillCd->[dbo].[T_SkillCategories].[skillc_ID] 

FK_T_Caregiver_T_StateFilingStatus_RS car_RSFilingStatus->[dbo].[T_StateFilingStatus].[sfs_ID] 

FK_T_Caregiver_T_StateFilingStatus_WS car_WSFilingStatus->[dbo].[T_StateFilingStatus].[sfs_ID] 
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Caregiver Branches 

 [dbo].[T_CaregiverBranches] 

 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
carbr_ID 

System generated unique ID for the Caregiver 

Branches record. 

bigint 8 False 1 - 1  

(2)

 

carbr_CaregiverID 

The ID of the Caregiver that this Caregiver 

Branches record is associated with. Flows from 

[T_Caregiver].[car_id] 

bigint 8 False   

(2)

 

carbr_Branch_ID 

The ID of the Branch that this Caregiver Branches 

record is associated with. Flows from [T_-

Branches].[br_id]. Shown in the Caregiver/Offices 

form as the Office Description. 

int 4 False   

 carbr_CreatedUser 

The user logged in the system when the record 

was created. Called Created By in the 

Caregiver>Offices form. 

nvarchar(50) 100 False   

 carbr_CreatedDate 

The Date the Caregiver Branches record was 

created. UTC date. Updated by SQL Server's 

current UTC date. Called Created On in the 

Caregiver>Offices form. 

datetime 8 False  (getutcdate()) 

 carbr_ModifiedUser 

The user logged in the system when the record 

was last modified. Called Modified By in the 

Caregiver>Offices form. 

nvarchar(50) 100 False   

 carbr_ModifiedDate 

The date that this record was last modified. It is a 

UTC date and is updated by the SQL Server 

current UTC date. This date is converted to the 

user's computer's timezone in the UI. Called 

Modified On in the Caregiver>Offices form, show 

in the Offices grid. 

datetime 8 False  (getutcdate()) 

 carbr_TS 

The TS field of the Caregiver Branches record. 

timestamp 8 False   

 
carbr_WageChartID 

The ID of the Branch Chart Groups Wage Chart 

record that this Caregiver Branches record is 

associated with. [T_BranchChartGroups].[brcg_ID] 

int 4 True   

 carbr_ADPFileNum 

The Payroll File Number for the Caregiver office  

nvarchar(50) 100 True   
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Indexes 

 

Foreign Keys 

 

 

 

level. Called Payroll File Number in the 

Caregiver/Offices form, shown in the Offices grid. 

Key Name Key Columns Unique Fill Factor 

 
PK_T_CaregiverBranches carbr_ID True 80 

 IX_T_CaregiverBranches_Unique carbr_CaregiverID, carbr_Branch_ID True 80 

 IX_T_CaregiverBranches_BranchID carbr_Branch_ID  80 

 IX_T_CaregiverBranches_CaregiverID carbr_CaregiverID  80 

Name Delete Columns 

FK_T_CaregiverBranches_T_BranchCharts  carbr_WageChartID->[dbo].[T_BranchChartGroups].[brcg_ID] 

FK_T_CaregiverBranches_T_Branches  carbr_Branch_ID->[dbo].[T_Branches].[br_ID] 

FK_T_CaregiverBranches_T_Caregiver Cascade carbr_CaregiverID->[dbo].[T_Caregiver].[car_ID] 
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Caregiver Dates 

 [dbo].[T_CaregiverDates] 

 

Description 

Records for Caregiver Dates. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
carbt_ID 

System generated unique identifier for 

the Caregiver Dates record. 

bigint  False 1,1  

 
carbt_CaregiverID 

The ID of the Caregiver for the 

Caregiver Dates record. Relates to [T_-

Caregiver].[car_ID]  Caregiver details 

tab > ID' 

bigint 8 False   

 
carbt_Date 

The expiration date of document or 

certification associated with this record. 

UI Location: Caregiver details tab > 

Expirations > Expiration Date' 

datetime  True   

 
cardt_TypeID 

The caregiver dates type ID for the 

Caregiver Dates record. Pulls the date 

type name to show in the UI. 

Caregiver dates are set up on Drop 

Down Maintenance tab > Caregiver 

Dates 

Caregiver Dates types refer to the 

document or certification with expiration 

date. Ex: ACLS, CPR Certification, 

Drivers License, Drug Screening, Auto 

Liability Insurance, etc. 

Relates to 

[T_CaregiverDateTypes].[cardttyp_ID]. 

Called Date_Type. 

UI Location: Caregiver details tab > 

Expirations > Date Type' 

int  False   

 cardt_Notes 

Any notes associated to this record 

UI Location: Caregiver details tab > 

Expirations > Notes' 

[nvarchar](4000) 4000 True   
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Indexes 

 

Foreign Keys 

 

 

 

 

 cardt_CreatedDate 

The date the Caregiver Dates record 

was created. UTC date updated by SQL 

Server''s current UTC date. 

UI Location: Caregiver details tab > 

Expirations > Created On' 

datetime  False  (getutcdate()) 

 cardt_CreatedUser 

The user who created the Caregiver 

Dates record. 

UI Location: Caregiver details tab > 

Expirations > Created By' 

[nvarchar](50) 50 False   

 cardt_ModifiedDate 

The date when the Caregiver Dates 

record was last modified.  UTC date 

updated by SQL Server''s current UTC 

date. 

UI Location: Caregiver details tab > 

Expirations > Modified On' 

datetime  False  (getutcdate()) 

 cardt_ModifiedUser 

The user logged in to the system when 

the Caregiver Dates record was last 

modified 

UI Location: Caregiver details tab > 

Expirations > Modified By' 

[nvarchar](50) 50 False   

 cardt_TS 

The timestamp for the Caregiver Dates 

record. 

[timestamp]  False   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverDates cardt_ID True 80 

 IX_T_CaregiverDates_CaregiverID cardt_CaregiverID False 80 

 IX_T_CaregiverDates_CaregiverID_TypeID cardt_CaregiverID,  cardt_TypeID True 80 

 IX_T_CaregiverDates_TypeID cardt_TypeID False 80 

Name Columns 

FK_T_CaregiverDates_T_Caregiver cardt_CaregiverID-> [dbo].[T_Caregiver] ([car_ID]) 

FK_T_CaregiverDates_T_CaregiverDateTypes cardt_TypeID-> [dbo].[T_CaregiverDateTypes] ([cardttyp_ID]) 
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Caregiver Date Types 

 [dbo].[T_CaregiverDateTypes] 

 

Description 

Records for Caregiver Date Types. 

Columns 

Key Name Data Type Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity Default 

 

cardttyp_ID 

System generated unique 

identifier for caregiver date 

types. Starts at 10001. 

int  False 10001,1  

 cardttyp_Name 

Documents/Certification 

Names for the Expiration tab 

on the caregiver screen. 

[nvarchar](50) 50 True   

 cardttyp_Warn 

Setting that will warn a user 

about caregiver expired 

documents or certifications 

during scheduling. 

bit  False   

 cardttyp_Active 

Active Status that can be set 

in the drop down maintenance 

screen. 

bit  False   

 cardttyp_CreatedDate 

Date and time the record 

was created. 

datetime  False  (getutcdate()) 

 cardttyp_CreatedUser 

User that created the record. 

[nvarchar](50) 50 False   

 cardttyp_ModifiedDate 

Date and time the record was 

last modified. 

datetime  False  (getutcdate()) 

 cardttyp_ModifiedUser 

User that last modified the 

record. 

[nvarchar](50) 50 False   

 cardttyp_TS 

The timestamp field of the 

record 

timestamp  False   

 cardttyp_ListItemType tinyint  False   
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Indexes 

Foreign Keys 

 

 

The list type of the record for 

the DropDown List control. 0 = 

Global, 1 = Office, 2 = 

Override 

 

cardttyp_RptGroupID 

rptgrp_ID of the Report Group 

that the Type is associated 

with to help group records in a 

general category 

int  False   

 

cardttyp_BranchID 

br_ID of the related to specific 

Branch. Null if the 

ListItemType is 0 (System). 

int  True   

 

cardttyp_OverrideID 

ID for the parent record that 

will be overriden. Override List 

Item Types are used when an 

Office wishes to have different 

settings on an existing Global 

List Item.  The Override List 

Item will have the same Name 

as the Global List Item, but will 

be configured with different 

settings. 

int  True   

 cardttyp_Description 

Description of for the record 

(Optional) 

[nvarchar](1000) 1000 True   

 cardttyp_ReminderItem 

Setting to determine if the 

record should show up as a 

part of the reminders for a 

user 

bit  False   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverDateTypes cardttyp_ID True 80 

 IX_T_CaregiverDateTypes_active cardttyp_Active False 80 

 IX_T_CaregiverDateTypes_BranchOverrideName cardttyp_BranchID, 

cardttyp_OverrideID, 

cardttyp_Name 

True 80 

Name Columns 

FK_T_CaregiverDateTypes_T_Branches cardttyp_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_CaregiverDateTypes_T_CaregiverDateTypes cardttyp_OverrideID-> [dbo].[T_CaregiverDateTypes] 

([cardttyp_ID]) 

FK_T_CaregiverDateTypes_T_ReportGroups cardttyp_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Caregiver Documents 

 [dbo].[T_CaregiverDocuments] 

 

Description 

Records for Caregiver Documents. 

Columns 

Key Name Data Type Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity Default 

 

cardoc_ID 

System generated unique 

identifier for the record. 

bigint  False 1,1  

 

cardoc_CaregiverID 

Caregiver ID for the 

document record. 

bigint  False   

 

cardoc_TypeID 

main document type id for the 

file linked to the caregiver 

linked to the 

T_DocumentTypes.doctyp_ID 

field. 

int  False   

 cardoc_Data 

field that stores the file (blob 

field type) 

image  False   

 cardoc_Format 

The file format of the 

attachment. (Record Picture 

type attachments should be 

the format type of .jpg or the 

image does not display on 

reports) 

[nvarchar](50) 50 False   

 cardoc_FileName 

The original location of the 

attachment. Once the 

attachment is captured, the 

document is stored in the 

database. This field is for 

reference only. 

[nvarchar](256) 256 False   

 cardoc_FileSize 

The file size of the 

attachment. (Max. file size is 

6MB) 

bigint  True   

 cardoc_Thumbnail image  True   
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Indexes 

 

  

A preview image of the 

attachment. 

 cardoc_Notes 

Notes for the attachment 

record 

[nvarchar](4000) 4000 True   

 

cardoc_Sharelevel 

Set the permission for 

viewing this attachment. The 

default permission level is 

everyone. On the Office level, 

the permission levels are set 

in DDM Branch Document 

Share Levels. 

int  False   

 cardoc_CreatedDate 

Date and time the record was 

created. 

datetime  False  (getutcdate()) 

 cardoc_CreatedUser 

User that created the record. 

[nvarchar](50) 50 False   

 cardoc_ModifiedDate 

Date and time the record was 

last modified. 

datetime  False  (getutcdate()) 

 cardoc_ModifiedUser 

User that last modified the 

record. 

[nvarchar](50) 50 False   

 cardoc_TS 

The timestamp field of the 

record. 

timestamp  False   

 cardoc_isCompressed 

Is the file compressed. File 

will not be compressed if the 

extention is ''.tif'', ''.gif'', ''.jpg'', 

''.mp3'', ''.mpg'', ''.zip'', ''.gzip'', 

''.pdf'' 

Bit  False  ((0)) 

 

cardoc_SubTypeID 

Subcategory document type 

id for the file linked to the 

caregiver. It is linked to 

T_DocumentSubTypes. 

int  True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverDocuments cardoc_ID True  

 IX_T_CaregiverDocuments cardoc_CaregiverID   
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Foreign Keys 

 

 

 

Name Columns 

FK_T_CaregiverDocuments_T_Caregiver cardoc_CaregiverID-> [dbo].[T_Caregiver] 

([car_ID]) 

FK_T_CaregiverDocuments_T_CaregiverDocumentShareLevels cardoc_Sharelevel-> 

[dbo].[T_CaregiverDocumentShareLevels] 

([cardocslvl_ID]) 

FK_T_CaregiverDocuments_T_DocumentSubTypes cardoc_SubTypeID-> [dbo].[T_DocumentSubTypes] 

([docstyp_ID]) 

FK_T_CaregiverDocuments_T_DocumentTypes cardoc_TypeID-> [dbo].[T_DocumentTypes] 

([doctyp_ID]) 
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Caregiver Group 

 [dbo].[T_CaregiverGroup] 

 

Description 

Records for Caregiver Group. 

Columns 

Key Name Data Type Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity Default 

 

carg_ID 

Caregiver group Id 

int  False (10001,1)  

 carg_Name 

Caregiver group name 

[nvarchar](50) 50 True   

 carg_Active 

Indicates if Caregiver is 

Active (0 - False, 1 - True) 

bit  False   

 carg_CreatedUser 

Created By User 

[nvarchar](50) 50 False   

 carg_CreatedDate 

Created Date 

datetime  False  (getutcdate()) 

 carg_ModifiedUser 

Modified By User 

[nvarchar](50) 50 False   

 carg_ModifiedDate 

Modified Date 

datetime  False  (getutcdate()) 

 carg_TS 

Timestamp 

timestamp  False   

 carg_ListItemType 

The list type of the record 

for the DropDown List 

control. 0 = Global, 1 = 

Office, 2 = Override 

tinyint  False   

 

carg_RptGroupID 

rptgrp_ID of the Report 

Group that the Type is 

associated with to help 

group records in a general 

category. 

int  False   

 

carg_BranchID 

br_ID of the related to 

specific Branch. Null if the 

ListItemType is 0 (System). 

int  True   
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Indexes 

Foreign Keys 

 

 

 

 

carg_OverrideID 

ID for the parent record that 

will be overriden. Override 

List Item Types are used 

when an Office wishes to 

have different settings on 

an existing Global List 

Item.  The Override List 

Item will have the same 

Name as the Global List 

Item, but will be configured 

with different settings. 

int  True   

 carg_Description 

Description 

[nvarchar](1000) 1000 True   

 carg_IsContractor 

Indicates whether the 

Caregiver is a Contractor (0 

- False, 1 - True) 

bit  False   

 carg_AutoCalcTravel 

Indicates whether a 

Caregiver is eligible for 

Auto Calculated Travel 

Time (0 - False, 1 - True). 

bit  False   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverGroup carg_ID True 80 

 IX_T_CaregiverGroup_BranchOverrideName carg_BranchID, carg_OverrideID, 

carg_Name 

True 80 

Name Columns 

FK_T_CaregiverGroup_T_Branches carg_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_CaregiverGroup_T_CaregiverGroup carg_OverrideID-> [dbo].[T_CaregiverGroup] ([carg_ID]) 

FK_T_CaregiverGroup_T_ReportGroups carg_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Caregiver Hiring 

 [dbo].[T_CaregiverHiring] 

 

Description 

Caregiver employment information. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
carhr_ID 

System generated unique ID for the Caregiver Hiring 

record. 

bigint 8 False 1 - 1  

 

carhr_carID 

The Caregiver ID for the Caregiver Hiring record. 

Related to [T_Caregiver].[car_ID]. 

bigint 8 False   

 carhr_AppliedDate 

Date the Caregiver applied with the agency. Non UTC 

date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Applied Date 

datetime 8 True   

 carhr_InterviewDate 

Date the Caregiver interviewed with the agency. Non 

UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Interview Date 

datetime 8 True   

 
carhr_HireDate 

Date the agency hired the Caregiver. When Hire Dates 

exist on the Hire History records, the First Service 

Date and Last Service Date values that display in the 

Caregiver List are those from the most recent Hire 

History record for the Caregiver. Non UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Hire Date 

datetime 8 True   

 carhr_StartDate 

Date the Caregiver began working for the agency. Non 

UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Start Date 

datetime 8 True   

 carhr_OrientationDate 

Date the Caregiver successfully completed orientation. 

Non UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Orientation Date 

datetime 8 True   
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 carhr_Position 

Position the Caregiver holds/held. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Position 

nvarchar(50) 100 True   

 carhr_SeparationDate 

Date the Caregiver left the agency. Non UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Separation Date 

datetime 8 True   

 carhr_SeparationReason 

The reason the Caregiver left the agency. For more 

information, see DDM Caregiver Separation Reasons. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Separation Notes 

nvarchar(255) 510 True   

 carhr_CreatedDate 

The date the Caregiver Hiring record was created. 

UTC date updated by SQL Server current UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Created On 

datetime 8 False  (getutcdate()) 

 carhr_CreatedUser 

The user logged in to the system when the Caregiver 

Hiring record was created. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Created By 

nvarchar(50) 100 False   

 carhr_ModifiedDate 

The date when Caregiver Hiring record was last 

modified. UTC date updated by SQL Server current 

UTC date  

UI Location: Caregivers > Caregiver Details > HR tab 

> Modified On 

datetime 8 False  (getutcdate()) 

 carhr_ModifiedUser 

The user logged in to the system when the Caregiver 

Hiring record was last modified.  

UI Location: Caregivers > Caregiver Details > HR tab 

> Modified By 

nvarchar(50) 100 False   

 carhr_TS 

The time stamp of the Caregiver Hiring record. 

timestamp 8 False   

 
carhr_InterviewStaffID 

The ID of the caregiver who ran the interview; it pulls 

the caregiver name to display in the UI. Selected 

though a drop down search box. 

Related to [T_Caregiver].[car_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Interviewed By 

bigint 8 True   

 
carhr_InterviewScheduled_ActivityID 

The Activity ID for the Caregiver Hiring record. 

Related to [T_Activities].[act_ID]. 

bigint 8 True   

 carhr_ReferralDate 

Date the Caregiver inquired about the agency. Non 

UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Inquiry Date 

datetime 8 True   
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 carhr_ReferralTakenBy 

Replaced by carhr_ReferralTakenByID. Not used. 

nvarchar(50) 100 True   

 
carhr_ReferralEntityTypeID 

The ID of the entity type that referred the Caregiver to 

the agency; it pulls the entity type name to show in the 

UI. Selected through a drop down menu. 

Related to [T_ReferralEntities].[refent_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Referral Entity Types 

tinyint 1 True   

 carhr_ReferralEntityID 

The ID of the referral entity; it pulls the referral entity 

name to show in the UI. When the Referral Entity Type 

is selected, the appropriate Entity name drop down 

search box will appear in Entity Name so the user can 

select the appropriate name of the referring entity.  

UI Location: Caregivers > Caregiver Details > HR tab 

> Entity Name 

bigint 8 True   

 
carhr_ReferralContactJoinID 

The ID of the caregivers referral contact; it pulls the 

referral contact name to show in the UI. If Referral 

Source is selected as the Referral Entity Type, this 

field is active and allows the user to select a Referral 

Contact associated with the Referral Entity. 

Related to [T_ReferralJoin].[refjoin_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Contact Name 

bigint 8 True   

 
carhr_ReferralCampaignID 

The ID of the marketing campaign which referred the 

Caregiver to the agency; it pulls the campaign name to 

show in the UI. Selected through the drop down list. 

For further information, see DDM Referral Campaigns. 

Related to [T_ReferralCampaigns].[refcamp_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Campaign 

int 4 True   

 
carhr_StaffID 

The ID of the marketing staff member if the referral 

was the result of that Staffs marketing efforts; it pulls 

the marketing staff member name to show in the UI. 

Selected through drop down search box. 

Related to [T_Caregiver].[car_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Marketing Staff 

bigint 8 True   

 carhr_ReferralNotes 

Stores any notes as needed. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Notes 

nvarchar(max) max True   

 
carhr_ReferralTypeID 

The ID of the referral type; it pulls the referral type 

name to show in the UI. It is populated from the record 

of the Entity Name when chosen. 

Related to [T_ReferralTypes].[reftyp_ID]. 

int 4 True   
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Indexes 

 

  

UI Location: Caregivers > Caregiver Details > HR tab 

> Type 

 
carhr_CaregiverSeparationReasonID 

The reason the Caregiver left the agency. For more 

information, see DDM Caregiver Separation Reasons. 

Related to [T_CaregiverSeparation-

Reasons].[carsepr_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Separation Reason 

int 4 True   

 
carhr_ReferralTakenByID 

The ID of the staff member who took the inquirys 

information. The link between Staff member and user 

is set on User Security. The ID is used to pull the 

name of the staff member to show in the UI. Selected 

through the drop down search box. 

Related to [T_Caregiver].[car_ID]. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Taken By 

bigint 8 True   

 carhr_FirstServiceDate 

Date the Caregiver completed his/her first service for 

the agency. A stored field. The Service Date values 

are updated by a nightly SQL Job that updates the 

caregivers Completed Service Hours. Non UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> First Service Date 

datetime 8 True   

 carhr_LastServiceDate 

A system stored field, reflecting the last service date 

falling between the Hire Date and Separation Date, or 

between the Hire Date and the current date where no 

Separation Date exists. The Service Date values are 

updated by a nightly SQL Job that updates the 

caregivers Completed Service Hours. You can 

configure the schedule statuses that are included in 

the SQL Job, using the Is Active Caregiver setting. It is 

recommended to set C (Completed) and T (Telephony 

Completed) status schedules for Is Active Caregiver. 

Non UTC date. 

UI Location: Caregivers > Caregiver Details > HR tab 

> Last Service Date 

datetime 8 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_CaregiverHiring carhr_ID True 80 

 IX_T_CaregiverHiring_carID_HireDate carhr_carID, carhr_HireDate  80 
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Foreign Keys 

 

 

Name Columns 

FK_T_CaregiverHiring_T_Activities carhr_InterviewScheduled_ActivityID->[dbo].[T_Activities].[act_ID] 

FK_T_CaregiverHiring_T_Caregiver carhr_carID->[dbo].[T_Caregiver].[car_ID] 

FK_T_CaregiverHiring_T_Caregiver_Interview-

StaffID 

carhr_InterviewStaffID->[dbo].[T_Caregiver].[car_ID] 

FK_T_CaregiverHiring_T_Caregiver_Referral-

TakenBy 

carhr_ReferralTakenByID->[dbo].[T_Caregiver].[car_ID] 

FK_T_CaregiverHiring_T_Caregiver-

SeparationReasons 

carhr_CaregiverSeparationReasonID->[dbo].[T_CaregiverSeparation-

Reasons].[carsepr_ID] 

FK_T_CaregiverHiring_T_CaregiverStaff carhr_StaffID->[dbo].[T_Caregiver].[car_ID] 

FK_T_CaregiverHiring_T_ReferralCampaigns carhr_ReferralCampaignID->[dbo].[T_ReferralCampaigns].[refcamp_ID] 

FK_T_CaregiverHiring_T_ReferralEntities carhr_ReferralEntityTypeID->[dbo].[T_ReferralEntities].[refent_ID] 

FK_T_CaregiverHiring_T_ReferralJoin carhr_ReferralContactJoinID->[dbo].[T_ReferralJoin].[refjoin_ID] 

FK_T_CaregiverHiring_T_ReferralTypes carhr_ReferralTypeID->[dbo].[T_ReferralTypes].[reftyp_ID] 
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Caregiver Phones 

 [dbo].[T_CaregiverPhones] 

 

Description 

Records for Caregiver Phones. 

Columns 

  

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
cph_ID 

System generated ID for the record. 

bigint 8 False 1 - 1  

 

cph_CaregiverID 

The caregiver ID for the record. 

Relates to [T_Caregiver].[car_ID]. 

bigint 8 False   

 cph_Phone 

Phone number for the current caregiver phone record.  

UI Location: Caregivers > Main tab > Phone No 

column 

nvarchar(30) 60 False   

 
cph_PhoneType 

The ID of the phone type. Ex: 1: Fax, 2: Home, 3: 

Work, 4: Mobile. Those are default phone types 

present in all databases.  

Any phone type over 10000 is a custom phone type 

specific to the database.  

Relates to [T_PhoneType].[pht_ID]. 

UI Location: Caregivers > Main tab > Type column 

int 4 False   

 cph_Note 

Notes for the current phone record. 

UI Location: Caregivers > Main tab > Note column 

nvarchar(256) 512 True   

 
cph_Sequence 

The order records were entered. Used to order 

queries. The number marked as primary always has 

the sequence number 1.  

smallint 2 False  ((1)) 

 cph_MsgType 

Bitwise flag to indicate how line can be used. Values: 

1: Tel, 2: Txt and 3: Tel and Txt 

UI Location: Caregivers > Main tab > Tel and Txt 

columns checkboxes 

int 4 True   
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Indexes 

Foreign Keys 

 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_CaregiverPhones cph_ID True 80 

 IX_T_CaregiverPhones_Unique cph_CaregiverID, cph_Sequence True 80 

Name Delete Columns 

FK_T_CaregiverPhones_T_Caregiver Cascade cph_CaregiverID->[dbo].[T_Caregiver].[car_ID] 

FK_T_CaregiverPhones_T_PhoneType  cph_PhoneType->[dbo].[T_PhoneType].[pht_ID] 
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Caregiver Referral Type 

 [dbo].[T_CaregiverReferralType] 

 

Description 

Records for Caregiver Referral Type. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity 

Default 

 

carreft_ID 

System generated unique 

identifier for the record. 

int  False (10001,1)  

 carreft_Name 

Name of the field type for the 

record. 

[nvarchar](50) 50 True   

 carreft_Active 

Active status for the record to 

show or not show in the 

dropdown field. 

  False  0 

 carreft_CreatedDate 

Date and time the record was 

created. 

  False   

 carreft_CreatedUser 

User that created the record 

[nvarchar](50) 50 False   

 carreft_ModifiedDate 

Date and time the record was 

modified. 

  False   

 carreft_ModifiedUser 

User that last modified the 

record. 

[nvarchar](50) 50 False   

 carreft_TS 

The timestamp field of the 

record. 

  False   

 carreft_ListItemType 

The list type of the record for 

the DropDown List control. 0 

= Global, 1 = Office, 2 = 

Override 

  False  0 

 

carreft_RptGroupID 

rptgrp_ID of the Report 

Group that the Type is 

int  False  54 
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Indexes 

Foreign Keys 

 

 

associated with to help group 

records in a general 

category. 

 

carreft_BranchID 

br_ID of the related to 

specific Branch. Null if the 

ListItemType is 0 (System). 

int  True   

 

carreft_OverrideID 

carreft_OverrideID - ID for 

the parent record that will be 

overriden. Override List Item 

Types are used when an 

Office wishes to have 

different settings on an 

existing Global List 

Item.  The Override List Item 

will have the same Name as 

the Global List Item, but will 

be configured with different 

settings. 

int  True   

 carreft_Description 

Description text for the 

record. 

[nvarchar](1000) 1000 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverReferralType carreft_ID True 80 

 IX_T_CaregiverReferralType_BranchOverrideName carreft_BranchID, 

carreft_OverrideID, 

carreft_Name 

True 80 

Name Columns 

FK_T_CaregiverReferralType_T_Branches carreft_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_CaregiverReferralType_T_CaregiverReferralType carreft_OverrideID-> [dbo].[T_CaregiverReferralType] 

([carreft_ID]) 

FK_T_CaregiverReferralType_T_ReportGroups carreft_RptGroupID-> [dbo].[T_ReportGroups] 

([rptgrp_ID]) 
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Caregiver Skill 

 [dbo].[T_CaregiverSkill] 

 

Description 

Records for Caregiver Skill. 

Columns 

 

  

Key Name Data Type Max 

Length 

(Bytes) 

Allow 

Nulls 

Identity Default 

 

carsk_ID 

System generated unique 

identifier for the record. 

bigint  False (1,1)  

 

carsk_CaregiverID 

Caregiver Record ID linked to 

the T_Caregiver table. 

bigint  False   

 

carsk_SkillGroupID 

skillg_ID from T_SkillGroup 

table. It is found on the skill 

codes tab on the caregiver 

screen. 

int  False   

 carsk_CreatedDate 

Date and time the record was 

created 

datetime  False  (getutcdate()) 

 carsk_CreatedUser 

User that created the record. 

[nvarchar](5

0) 

50 False   

 

carsk_ModifiedDate 

Date and time the record was 

last modified. 

datetime  False  (getutcdate()) 

 

carsk_ModifiedUser 

User that last modified the 

record 

[nvarchar](5

0) 

50 False   

 

carsk_TS 

The timestamp field of the 

record. 

timestamp  False   
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Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverSkill carsk_ID True 80 

 IX_T_CaregiverSkill_CaregiverID carsk_CaregiverID False 80 

 IX_T_CaregiverSkill_SkillID carsk_SkillGroupID False 80 

 IX_T_CaregiverSkill_Unique carsk_CaregiverID, 

carsk_SkillGroupID 

True 80 

Name Columns 

FK_T_CaregiverSkill_T_Caregiver carsk_CaregiverID-> [dbo].[T_Caregiver] ([car_ID]) 

FK_T_CaregiverSkill_T_SkillLevel carsk_SkillGroupID-> [dbo].[T_SkillGroup] ([skillg_ID]) 
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Caregiver Values 

 [dbo].[T_CaregiverValues] 

 

Description 

Records for Caregiver Values. 

Columns 

Indexes 

Foreign Keys 

 

 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

carv_RecordID 

caregiver ID for the 

record. 

bigint  False   

 

carv_FieldID 

ID related to the 

T_CaregiverFields.c

arf_ID table. 

int  False   

 carv_Value 

Value for the custom 

tab field. Stored as a 

string. 

[nvarchar](max

) 

 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_CaregiverValues carv_RecordID, carv_FieldID True 80 

 IX_T_CaregiverValues_FieldID carv_FieldID False 80 

     

Name Columns 

FK_T_CaregiverValues_T_Caregiver carv_RecordID-> [dbo].[T_Caregiver] ([car_ID]) 

FK_T_CaregiverValues_T_CaregiverFields carv_FieldID-> [dbo].[T_CaregiverFields] ([carf_ID]) 
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Client 

 [dbo].[T_Client] 

 

Description 

Main client record. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

cli_ID 

Unique system generated ID for the Client record. 

UI Location: 

- Clients (Form View) > Main > Select > Search Results 

> ID 

- Clients (Form View) > ID 

- Clients > Client List > ID 

bigint 8 False 1 - 1  

 
cli_TypeID 

The ID of the type of client. Used to pull client type 

name from related table. Types are set up on Drop 

Down Maintenance tab. 

Examples are: Values are: Direct Care, Facility 

Contract, Hospital Staff Relief, Sub Contract, Non-

Patient, Elim Park Facility, Bed Rest-PEN, Patient-PEN, 

ALF Placement, Intermittent Care, Extended Care, Non-

Peds, Peds, etc. 

Relates to [T_ClientType].[clt_ID] 

int 4 True   

 
cli_LastName 

Last name of client. 

UI Location: 

- Clients (Form View) > Main > Select > Search Results 

> Last Name 

- Clients (Form View) > Last 

- Clients > Client List > Last Name 

nvarchar(50) 100 False   

 
cli_FirstName 

First name of client. 

UI Location: 

- Clients (Form View) > Main > Select > Search Results 

> First Name 

- Clients (Form View) > First 

- Clients > Client List > Fist Name 

nvarchar(50) 100 False   

(3)

cli_BranchId 

The ID of the office to which the client belongs. The 

default value will be the user’s primary office. The office 

int 4 False   
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selected defaults as the Belong To Office on Client 

Offices tab. Once saved, the Client Office assignment 

can be changed on Client Offices. Used to pull office 

name from related table. 

Relates to [T_Branches].[br_ID] 

UI Location: 

- Clients (Form View) > Main > Select > Search Results 

> Office 

- Clients (Form View) > Main > Office 

- Clients > Client List > Office 

 cli_MiddleName 

The middle name of client. 

UI Location: 

- Clients (Form View) > Main >Middle Name 

- Clients > Client List > Office 

nvarchar(50) 100 True   

(2)

 

cli_StatusID 

The ID of the status of the client. Used to pull client 

status name from related table. Statuses are set up on 

Drop Down Maintenance tab 

Examples are: Active, Inactive, Pending, Discharged 

Inquiry, Non Admit, Negotiating, etc. 

Relates to [T_ClientStatus].[cls_ID] 

UI Location: 

- Clients (Form View) > Main > Select > Search Results 

> Status 

- Clients (Form View) > Status 

- Clients > Client List > Status 

int 4 False   

 

cli_PayerID 

The ID of the client's payer. Used to pull client's payer 

name from related table. 

Filled in when a payer is created from the client record. 

Relates to [T_Payers].[pay_ID] 

bigint 8 True   

 cli_Address1 

Main physical address of the client such as the street 

and number. 

UI Location: 

- Clients (Form View) > Main > Address 1 (through 

AddressEditor) 

- Clients > Client List > Address 1 (through Address-

Editor) 

nvarchar(255) 510 True   

 cli_Address2 

Additional physical address of the client like apartment 

number, etc. 

UI Location: 

- Clients (Form View) > Main > Address 2 (through 

AddressEditor) 

- Clients > Client List > Address 2 (through Address-

Editor) 

nvarchar(60) 120 True   

 cli_City 

The city of the client's physical address. 

nvarchar(50) 100 True   
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UI Location: 

- Clients (Form View) > Main > City (through Address-

Editor) 

- Clients > Client List > City (through AddressEditor) 

 cli_StateOrProvince 

The state or provice of of the client's physical address. 

UI Location: 

- Clients (Form View) > Main > State (through Address-

Editor) 

- Clients > Client List > State (through AddressEditor) 

nvarchar(20) 40 True   

 cli_PostalCode 

The postal code of of the client's physical address. 

UI Location: 

- Clients (Form View) > Main > Postal Code (through 

AddressEditor) 

- Clients > Client List > Postal Code (through Address-

Editor) 

nvarchar(20) 40 True   

 cli_County 

The county of of the client's physical address. 

UI Location: 

- Clients (Form View) > Main > County (through 

AddressEditor) 

- Clients > Client List > County (through AddressEditor) 

nvarchar(50) 100 True   

 
cli_Country 

The country of of the client's physical address. Pulled 

from related table. 

Relates to [T_Countries].[ctry_ID] 

UI Location: 

- Clients (Form View) > Main > Country (through 

AddressEditor) 

- Clients > Client List > Country (through AddressEditor) 

int 4 False  ((240)) 

 cli_Phone 

Not used. Legacy field moved to T_ClientPhones. 

nvarchar(30) 60 True   

 cli_PhoneTypeID 

Not used. Legacy field moved to T_ClientPhones. 

int 4 True   

 
cli_RaceID 

The ID of the client's race. Used to pull race from related 

table. Races are set up on Drop Down Maintenance tab. 

Examples are: American Indian or Alaska Native, Asian, 

Black or African-American, Hispanic or Latino, Native 

Hawaiian or Pacific Islander, White, Unknown, Indian 

Relates to [T_Race].[rce_ID] 

UI Location: 

- Clients (Form View) > Advanced > Race 

int 4 True   

 cli_MaritalStatus 

The client's marital status, pulled from T_MaritalStatus 

table. 

Examples are: Single, Married, Divorced, Widowed, 

Other, PDomestic Part 

UI Location: 

nvarchar(1) 2 True   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 133 

- Clients (Form View) > Advanced > Marital Status 

 cli_Travel_Directions 

Any travel directions to the client's house as needed. 

UI Location: 

- Clients (Form View) > Main > Travel Directions 

nvarchar(2000) 4000 True   

 cli_Email 

Main client's email. 

UI Location: 

- Clients (Form View) > Main > Email 1 

- Clients > Client List > Email 

nvarchar(50) 100 True   

 cli_Email2 

Additional client's email. 

UI Location: 

- Clients (Form View) > Main > Email 2 

nvarchar(50) 100 True   

 cli_Notes 

Internal notes for the client 

UI Location: 

- Clients (Form View) > Advanced > Additional Notes 

nvarchar(4000) 8000 True   

 cli_BirthDate 

The client's birthday. The Client's age will calculate 

based on the birth year entered. 

Non-UTC date. 

UI Location: 

- Clients (Form View) > Advanced > Birth Date 

datetime 8 True   

 cli_Sex 

The sex of the client. 

Examples are: Male, Female 

UI Location: 

- Clients (Form View) > Main > Sex 

- Clients > Client List > Sex 

nvarchar(1) 2 True   

 cli_Suffix 

Client's suffix. 

UI Location: 

- Clients (Form View) > Suffix 

nvarchar(10) 20 True   

 cli_DisasterPlanCode 

Internal disaster planning code with available Quick 

Notes. Drop down arrow button displays the Quickpick 

List - check item(s) from the list. 

Disaster planning codes are set up on Drop Down 

Maintenance tab > Quick Notes 

UI Location: 

- Clients (Form View) > Main > Disaster Code Plan 

nvarchar(20) 40 True   

 cli_DisasterPlanNotes 

Disaster planning instructions with available Quick 

Notes. Drop down arrow button  displays the Quickpick 

List - check item(s) from the list. 

Disaster planning codes are set up on Drop Down 

Maintenance tab > Quick Notes 

nvarchar(255) 510 True   
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UI Location: 

- Clients (Form View) > Main > Disaster Planning 

 
cli_TelephonyID 

Defaults to match the System ID. Field can be modified. 

SSN should NOT be used as the telephony ID. 

Cannot have the same telephony ID in the same 

branch.UI Location: 

- Clients (Form View) > Advanced > Telephony ID 

- Clients > Client List > Tel ID 

nvarchar(36) 72 False   

 cli_AuthCheck 

Not used. 

bit 1 False  ((0)) 

 
cli_RegionID 

The ID of the client's region. Used to pull office areas 

from related table. Office areas are set up on Drop 

Down Maintenance tab. 

Relates to [T_Region].[reg_ID] 

UI Location: 

- Clients (Form View) > Main > Office Area 

- Clients > Client List > Office Area 

int 4 True   

 
cli_DefaultServiceCode 

Service code to schedule for this client when a visit is 

completed by the Santrax telephony interface. This 

value overrides anything set up at the Office 

level.  (Note: Telephony does NOT use the Default 

Service field.). Pulled from related table. Service codes 

are set up on Drop Down Maintenance tab. 

Examples are: RN Visit, RN Hourly, RN SOC, HHA Visit, 

HHA Hourly, HHA Live-In, PT Daily Visit, etc. 

Relates to [T_ServiceCode].[svcc_ID] 

UI Location: 

- Clients (Form View) > Advanced > Default Service 

int 4 True   

 cli_MastSchedWeekCode 

Not used. 

nvarchar(1) 2 True   

 cli_Mail_Date 

Non-UTC date. 

datetime 8 True   

 cli_NOKName 

Client's next of kin name. 

UI Location: 

- Clients (Form View) > Contacts > Name (under Next of 

Kin) 

nvarchar(50) 100 True   

 cli_NOKPhone1 

The primary phone number for the next of kin 

UI Location: 

- Clients (Form View) > Contacts > Phone 1 (under Next 

of Kin) 

nvarchar(30) 60 True   

 cli_NOKPhone2 

The alternate phone number for the next of kin. 

UI Location: 

- Clients (Form View) > Contacts > Phone 2 (under Next 

of Kin) 

nvarchar(30) 60 True   
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 cli_NOKRelation 

The relationship of the next of kin to the client. 

UI Location: 

- Clients (Form View) > Contacts > Relation (under Next 

of Kin) 

nvarchar(20) 40 True   

 cli_HEPatientLivesWith 

The name of the person with whom the client lives. 

UI Location: 

- Clients (Form View) > Contacts > Client lives with 

(under Home Environment) 

nvarchar(50) 100 True   

 cli_HEPetsInHome 

Lists any pets in the home. 

UI Location: 

- Clients (Form View) > Contacts > Pets in the home 

(under Home Environment) 

nvarchar(50) 100 True   

 cli_HESmokersInHome 

Check the box if there are smokers in the client's home. 

UI Location: 

- Clients (Form View) > Contacts > Smokers in the 

home (under Home Environment) 

bit 1 False  ((0)) 

 cli_LPAdvanceDirectives 

Check the box if the client has advanced directives. 

UI Location: 

- Clients (Form View) > Contacts > Advanced Directives 

(under Legal Papers) 

bit 1 False  ((0)) 

 cli_LPLocationOf 

The location of the advanced directives. It is set up on 

Drop Down Maintenance tab > Quick Notes 

UI Location: 

- Clients (Form View) > Contacts > Location Of (under 

Legal Papers) 

nvarchar(400) 800 True   

 cli_LPCopyRequested 

Check the box if the agency has requested a copy of the 

advanced directives. 

UI Location: 

- Clients (Form View) > Contacts > Copy Requested 

(under Legal Papers) 

bit 1 False  ((0)) 

 cli_LPLivingWill 

Check the box if the client has a living will. 

UI Location: 

- Clients (Form View) > Contacts > Living Will (under 

Legal Papers) 

bit 1 False  ((0)) 

 cli_LPCopyObtained 

Check the box if the agency has received a copy of the 

advanced directives. 

UI Location: 

- Clients (Form View) > Contacts > Copy Obtained 

(under Legal Papers) 

bit 1 False  ((0)) 
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 cli_LPHCSurrogate 

Check the box if the client has a health care surrogate.  

UI Location: 

- Clients (Form View) > Contacts > HC Surrogate (under 

Legal Papers) 

bit 1 False  ((0)) 

 cli_ACIHName 

Name of the second client in the home. If the client was 

converted from a Client Inquiry, this information will pull 

from the Client Inquiry Client tab. 

UI Location: 

- Clients (Form View) > Contacts > Name (under 

Additional Client In Home) 

nvarchar(50) 100 True   

 cli_ACIHGreeting 

Enter the Salutation for the second client in the home. 

For further information see DDM Salutations. Pulls from 

T_Salutations table. 

Salutations are set up on Drop Down Maintenance tab. 

Examples are: Mr., Mrs., Dr., Madam, Ms., Sir, 

Dear,  Bishop, Evangelist, Pastor 

UI Location: 

- Clients (Form View) > Contacts > Salutation (under 

Additional Client In Home) 

nvarchar(50) 100 True   

 cli_ACIHRelation 

Relationship of the second client to the primary client. If 

the client was converted from a Client Inquiry, this 

information will pull from the Client Inquiry Client tab. 

UI Location: 

- Clients (Form View) > Contacts > Relation (under 

Additional Client In Home) 

nvarchar(20) 40 True   

 cli_ACIHBirthDate 

Birth Date of the second client in the home. If the client 

was converted from a Client Inquiry, this information will 

pull from the Client Inquiry Client tab. 

Non-UTC date. 

UI Location: 

- Clients (Form View) > Contacts > DOB (under 

Additional Client In Home) 

datetime 8 True   

 cli_RequiresOrientation 

Check this box to signify that each caregiver scheduled 

to this client must have an orientation. When checked, a 

scheduling message displays for any caregiver 

scheduled to the client where there is no Matching 

Orientation record created. The level of the scheduling 

check will be determined by the DNU Settings on either 

the Global, Office, or User Scheduling Settings. 

UI Location: 

- Clients (Form View) > Main > Requires Orientation 

bit 1 False  ((0)) 

 cli_CreatedDate 

Date and time the record was created. 

UTC date updated by SQL Server's current UTC date.  

UI Location: 

datetime 8 False  (getutcdate()) 
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- Clients (Form View) > Main > Created On (through 

ModifiedRecord1) 

- Clients > Client List > Created On (through Modified-

Record1) 

 cli_CreatedUser 

User who created the record. 

UI Location: 

- Clients (Form View) > Main > Created By (through 

ModifiedRecord1) 

- Clients > Client List > Created By (through Modified-

Record1) 

nvarchar(50) 100 False   

 cli_ModifiedDate 

Date and time the record was last modified. 

UTC date updated by SQL Server's current UTC date.  

UI Location: 

- Clients (Form View) > Main > Modified On (through 

ModifiedRecord1) 

- Clients > Client List > Modified On (through Modified-

Record1) 

datetime 8 False  (getutcdate()) 

 cli_ModifiedUser 

User who last modified the record. 

UI Location: 

- Clients (Form View) > Main > Modified By (through 

ModifiedRecord1) 

- Clients > Client List > Modified By (through Modified-

Record1) 

nvarchar(50) 100 False   

 cli_TS 

The timestamp of the Client record. 

timestamp 8 False   

 cli_LegacyID 

Alternate ID number or legacy ID number. 

Called ClientAltID . 

UI Location: 

- Clients (Form View) > Main > Alt. ID 

int 4 True   

 cli_LegacyBranchID 

Not used. 

int 4 True   

 
cli_OasisInterfaceID 

Not used. 

nvarchar(50) 100 True   

 cli_SSN 

Client's social security number. Encrypted. 

UI Location: 

- Clients (Form View) > Advanced > SSN 

varbinary(255) 255 True   

 
cli_CalcUniqueSSN 

Used for social security number encryption. 

varbinary(255) 255 True   

 cli_UploadTelephony 

Determines whether the Client is eligible to be uploaded 

with the telephony vendor. The default setting is true 

(checked). Must be checked to upload Client to 

telephony and send a missed check-in notification. 

UI Location: 

bit 1 False  ((1)) 
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- Clients (Form View) > Advanced > Upload Telephony 

 cli_AllowMassEmail 

Check this box to allow letters and other items to be 

sent to this Client from within the system. 

Called CanEmail. 

UI Location: 

- Clients (Form View) > Main > Allow MatrixCare to 

Email this Client 

bit 1 False  ((0)) 

 cli_InquiryDate 

If the client was converted from a Client Inquiry record, 

the inquiry date will pull from that Client Inquiry record. 

The Client Inquiry icon next to the date is enabled, and 

allows you to jump back to the record if needed. 

Non-UTC date. 

UI Location: 

- Clients (Form View) > Inquiry Date 

datetime 8 True   

 
cli_Salut 

The client's salutation. Pulled from related table. 

Salutations are set up on Drop Down Maintenance tab. 

Examples are: Mr., Mrs., Dr., Madam, Ms., Sir, 

Dear,  Bishop, Evangelist, Pastor 

Relates to [T_Salutation].[salut_ID] 

UI Location: 

- Clients (Form View) > Main > Salutation 

- Clients > Client List > Salutation 

int 4 True   

 cli_POLST 

Check the box to indicate that the form has been used 

with the Client. A checked POLST box will display as 

Yes on the Plan of Care Information Sheet and with an 

X on the Service Provision Plan Report. The POLST 

form is currently used in the states of Washington, 

Oregon, and California. It contains information about an 

individual’s end of life decisions, such as 

cardiopulmonary resuscitation (CPR). The most frequent 

use of the form is as a summary of an individual’s 

advance directive decisions and information. According 

to the Department of Health, the form itself is not an 

advance directive. 

UI Location: 

- Clients (Form View) > Contacts > POLST (under Legal 

Papers) 

bit 1 False  ((0)) 

 cli_TelephonyAllowCaregiverPhone 

Check this box to use a caregivers cell phone number 

(configured on the Caregiver>Main tab) for telephony 

arrival and departure calls if the client does not have a 

phone, or has a rotary phone that cannot use IVR 

system or lives in a facility. Coordinates with the 

checkbox in the header above Hire History grid on the 

Caregiver>HR tab. 

UI Location: 

- Clients (Form View) > Advanced > Tel. Complete with 

Caregiver Phone 

bit 1 False  ((0)) 
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 cli_DisplayOnCaregiverPortal 

Free-form text area where office staff can write notes 

about the client to show on the caregiver's portal. 

Enter information specific to a client for the client's 

caregivers to see when logging into the Caregiver 

Portal. No duration for how long the information displays 

on the Caregiver Portal. Text entered here displays on 

the Portal. Message displays in the details of each 

schedule in the 'Note From Client Record' section in the 

Schedule Details at the bottom of the page. See 

Caregiver and Client Portals for full details on using the 

portals. 

UI Location: 

- Clients (Form View) > Advanced > Display on 

Caregiver Portal 

nvarchar(4000) 8000 True   

 cli_HIC 

Client's health insurance claim number. Encrypted. 

UI Location: 

- Clients (Form View) > Main > HIC # 

varbinary(255) 255 True   

 cli_InvcPrintLine 

Optional statement that prints on the Client invoice 

under the Client Note section and prints on the Standard 

Invoice and Standard Statement types. (Maximum 

character limit of 4000 - Note: Including a large amount 

of additional text on the Standard Invoice and Standard 

Invoice Statements can result in lengthy reports, with 

pages breaking between inserted sections (such as 

Outstanding Invoices) and the Notes sections). 

UI Location: 

- Clients (Form View) > Advanced > Prints on Client 

Invoice 

nvarchar(4000) 8000 True   

 cli_BillingOTCalcType 

Use the Billing Overtime option when the client has a 

payer, or multiple payers, that are billed overtime. This 

option benefits the single payer allocation, private pay 

and clients.  

Checking the Billing Settings Auto Bill OT checkbox at 

the Client level allows all payers to pay overtime 

automatically. 

If the client has payers that will not pay over time, then 

the agency must either turn the client Auto Bill OT 

setting off, or manually remove the Overtime Bill Units 

from the schedules of the payer that will not pay for 

overtime. 

UI Location: 

- Clients (Form View) > Advanced > Auto Bill OT 

tinyint 1 False  ((2)) 

 cli_Nickname 

The nickname of the client. 

nvarchar(32) 64 True   

 cli_CensusExclude 

Describes whether this record is to be excluded from 

census type areas. Currently only describes inclusion in 

CareCommunity functionality (EMPI, Schedules). 

Bit 1 False  ((0)) 
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Indexes 

 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_Client cli_ID True 80 

 IX_T_Client_BranchID_TelephonyID cli_BranchId, cli_TelephonyID True 80 

 IX_T_Client_UniqueSSN cli_CalcUniqueSSN, cli_BranchId True 80 

 IX_T_Client_BranchID cli_BranchId, cli_StatusID, cli_ID  80 

 IX_T_Client_FirstName cli_FirstName  80 

 IX_T_Client_LastName cli_LastName  80 

 IX_T_Client_OasisInterfaceID cli_OasisInterfaceID  80 

 IX_T_Client_PayerID cli_PayerID  80 

 IX_T_Client_Status cli_StatusID  80 

Name Columns 

FK_T_Client_T_Branches cli_BranchId->[dbo].[T_Branches].[br_ID] 

FK_T_Client_T_ClientStatus cli_StatusID->[dbo].[T_ClientStatus].[cls_ID] 

FK_T_Client_T_ClientType cli_TypeID->[dbo].[T_ClientType].[clt_ID] 

FK_T_Client_T_Countries cli_Country->[dbo].[T_Countries].[ctry_ID] 

FK_T_Client_T_Payers cli_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_Client_T_Race cli_RaceID->[dbo].[T_Race].[rce_ID] 

FK_T_Client_T_Region cli_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_Client_T_Salutation cli_Salut->[dbo].[T_Salutation].[salut_ID] 

FK_T_Client_T_ServiceCode cli_DefaultServiceCode->[dbo].[T_ServiceCode].[svcc_ID] 
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Client Attributes 

 [dbo].[T_ClientAttributes] 

 

Description 

Table client attributes contains restrictions and attributes used for matching client with caregiver 

during scheduling process. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
cliattr_ID 

System generated ID for the Client Attributes record. 

UL Location: Staff > Matching > ID as ID (Hidden) 

bigint 8 False 1 - 1  

 

cliattr_Cli_ID 

Client ID in the Client Attributes record. 

bigint 8 False   

 

cliattr_Atr_ID 

Attribute ID in the Client Attributes record. 

Attributes are used to match client and caregiver 

during scheduling process based on professional 

skills, language and other factors. 

UL Location: Staff > Matching > Attribute as Atr_ID 

int 4 False   

 
cliattr_Score 

Attribute score of the Client Attributes record. Ranges 

from 0 to 100. 

It denotes the weighted importance of the attribute 

when searching for matching  

Caregiver records for the Client. 

tinyint 1 True   

 cliattr_CreatedDate 

Date Client Attributes record was created. SQL 

Server’s current UTC date. 

UL Location: Staff > Matching > Created On by as 

CreatedDate 

datetime 8 False  (getutcdate()) 

 cliattr_CreatedUser 

The user who created the Client Attributes record. 

UL Location: Staff > Matching > Created by as 

CreatedUser 

nvarchar(50) 100 False   

 cliattr_ModifiedDate 

Date Client Attributes record's most recent 

modification. SQL Server’s current UTC date. 

UL Location: Staff > Matching > Modified On as 

ModifiedDate 

datetime 8 False  (getutcdate()) 

 cliattr_ModifiedUser 

User who made Client Attributes record's most recent 

modification. 

nvarchar(50) 100 False   



142 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Indexes 

Foreign Keys 

 

 

UL Location: Staff > Matching > Modified by as 

ModifiedUser 

 cliattr_TS 

Client Attributes record's timestamp field. 

UL Location: Staff > Matching > TS as TS (Hidden) 

timestamp 8 False   

Key Name Key Columns Unique Fill Factor 

 
PK_T_ClientAttributes cliattr_ID True 80 

 IX_T_ClientAttributes_Atr_ID cliattr_Atr_ID  80 

 IX_T_ClientAttributes_Cli_ID cliattr_Cli_ID  80 

Name Columns 

FK_T_ClientAttributes_T_Attribute cliattr_Atr_ID->[dbo].[T_Attribute].[atr_ID] 

FK_T_ClientAttributes_T_Client cliattr_Cli_ID->[dbo].[T_Client].[cli_ID] 
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Client Branches 

 [dbo].[T_ClientBranches] 

 

Description 

This table holds the branches where clients have relationships. 

Columns 

 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
clibr_ID 

System generated ID for the Client Branch 

record. 

bigint 8 False 1 - 1  

(2)

 

clibr_ClientID 

Client ID in the Client Branch record. 

bigint 8 False   

(2)

 

clibr_Branch_ID 

Branch ID in the Client Branch record. 

The first record is the main office for the client 

is associated. More offices can be added. 

int 4 False   

 clibr_CreatedUser 

The user who created the Client Branch 

record. 

UI Location: Clients > Client icon > Created By 

column as CreatedUser 

nvarchar(50) 100 False   

 clibr_CreatedDate 

Date Client Branch record was created. SQL 

Server’s current UTC date. 

UI Location: Clients > Client icon > Created On 

column as CreatedDate 

datetime 8 False  (getutcdate()) 

 clibr_ModifiedUser 

User who made Client Branch record's most 

recent modification. 

UI Location: Clients > Client icon > Modified 

By column as ModifiedUser 

nvarchar(50) 100 False   

 clibr_ModifiedDate 

Date Client Branch record's most recent 

modification. SQL Server’s current UTC date. 

UI Location: Clients > Client icon > Modified 

On column as ModifiedDate 

datetime 8 False  (getutcdate()) 

 clibr_TS 

Client Branch record's timestamp field. 

timestamp 8 False   
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_ClientBranch clibr_ID True 80 

 IX_T_ClientBranch_Unique clibr_Branch_ID, clibr_ClientID True 80 

 IX_T_ClientBranch_BranchID clibr_Branch_ID  80 

 IX_T_ClientBranch_ClientID clibr_ClientID  80 

Name Delete Columns 

FK_T_ClientBranch_T_Branches  clibr_Branch_ID->[dbo].[T_Branches].[br_ID] 

FK_T_ClientBranch_T_Client Cascade clibr_ClientID->[dbo].[T_Client].[cli_ID] 
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Client Date Status 

 [dbo].[T_ClientDateStatus] 

 

 

Note: Detailed documentation is pending. 
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Client Date Types 

 [dbo].[T_ClientDateTypes] 

 

 

Note: Detailed documentation is pending. 
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Client Dates 

 [dbo].[T_ClientDates] 

 

Description 

Data regarding tracking of important client's documents, whether they have been received, and 

when they expire. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
clidt_ID 

System generated ID for the Client Dates record. 

Also called DocumentID. 

bigint 8 False 1 - 1  

 

clidt_ClientID 

The client ID of the Client Dates record. 

Flows from [T_Client].[cli_ID]. 

bigint 8 False   

 clidt_DueDate 

The date the document is due from the client. 

Also called DocumentDueDate. 

Non-UTC date.UI Location: Clients > Documents > 

Due Date 

datetime 8 True   

 clidt_RecievedDate 

The date the document was received from the 

client. 

Non-UTC date. 

UI Location: Clients > Documents > Received Date 

datetime 8 True   

 clidt_Date 

The date the client's document expires. 

Also called DocumentExpirationDate. 

Non-UTC date. 

UI Location: Clients > Documents > Expiration Date 

datetime 8 True   

 clidt_SentDate 

The date the document was sent to the client. 

Non-UTC date. 

UI Location: Clients > Documents > Sent Date 

datetime 8 True   

 

clidt_TypeID 

The type of the client's document. 

Flows from [T_ClientDateTypes].[clidttyp_ID]. It is 

setup on Drop Down Maintenance > Client Date 

Types 

Some examples of document type are: Assignment 

of Benefits, Power of Attorney, Service Agreement, 

etc. 

UI Location: Clients > Documents > Document 

int 4 False   
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Indexes 

Foreign Keys 

 

 

 
clidt_StatusID 

The status of the client's document. 

Flows from [T_ClientDateStatus].[clidstat_ID]. It is 

setup on Drop Down Maintenance > Client 

Document Date Status. Some examples of status 

are: N/A, Not available, Not sent, Not received, Not 

signed, etc. 

UI Location: Clients > Documents > Status 

int 4 True   

 clidt_Notes 

Any applicable notes pertaining the document. 

Also called DocumentNotes. 

UI Location: Clients > Documents > Notes 

nvarchar(4000) 8000 True   

 clidt_CreatedDate 

Date the Client Date record was created. 

UTC date updated by SQL Server's current UTC 

date. 

datetime 8 False  (getutcdate()) 

 clidt_CreatedUser 

The user who created the Client Dates record. 

nvarchar(50) 100 False   

 clidt_ModifiedDate 

Date Client Date record's most recent modification. 

UTC date updated by SQL Server's current UTC 

date. 

datetime 8 False  (getutcdate()) 

 clidt_ModifiedUser 

User who made Client Dates record's most recent 

modification. 

nvarchar(50) 100 False   

 clidt_TS 

Client Dates record's timestamp field. 

timestamp 8 False   

Key Name Key Columns Unique Fill Factor 

 
PK_T_ClientDates clidt_ID True 80 

 IX_T_ClientDates_ClientID clidt_ClientID  80 

 IX_T_ClientDates_TypeID clidt_TypeID  80 

Name Columns 

FK_T_ClientDates_T_Client clidt_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_ClientDates_T_ClientDateStatus clidt_StatusID->[dbo].[T_ClientDateStatus].[clidstat_ID] 

FK_T_ClientDates_T_ClientDateTypes clidt_TypeID->[dbo].[T_ClientDateTypes].[clidttyp_ID] 
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Client Documents 

 [dbo].[T_ClientDocuments] 

 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
clidoc_ID bigint 8 False 1 - 1  

 
clidoc_ClientID bigint 8 False   

 
clidoc_TypeID int 4 False   

 clidoc_Data image max False   

 clidoc_Format nvarchar(50) 100 False   

 clidoc_FileName nvarchar(256) 512 False   

 clidoc_FileSize bigint 8 True   

 clidoc_Thumbnail image max True   

 clidoc_Notes nvarchar(4000) 8000 True   

 
clidoc_Sharelevel int 4 False   

 clidoc_CreatedDate datetime 8 False  (getutcdate()) 

 clidoc_CreatedUser nvarchar(50) 100 False   

 clidoc_ModifiedDate datetime 8 False  (getutcdate()) 

 clidoc_ModifiedUser nvarchar(50) 100 False   

 clidoc_TS timestamp 8 False   

 clidoc_isCompressed bit 1 False  ((0)) 

 
clidoc_SubTypeID int 4 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_ClientDocuments clidoc_ID True 80 

 IX_T_ClientDocuments clidoc_ClientID  80 

Name Columns 

FK_T_ClientDocuments_T_ClientDocumentShare-

Levels 

clidoc_Sharelevel->[dbo].[T_ClientDocumentShareLevels].[clidocslvl_-

ID] 

FK_T_ClientDocuments_T_Clientes clidoc_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_ClientDocuments_T_DocumentSubTypes clidoc_SubTypeID->[dbo].[T_DocumentSubTypes].[docstyp_ID] 

FK_T_ClientDocuments_T_DocumentTypes clidoc_TypeID->[dbo].[T_DocumentTypes].[doctyp_ID] 
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Client Inpatient Tracking 

 [dbo].[T_ClientInpatientTracking] 

 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity 

 
cinptr_ID 

 

int 4 False 1 - 1 

 

cinptr_ClientID 

Identity of the Client admitted to the Facility 

bigint 8 False  

 cinptr_AdmissionDate 

Date the Client was Admitted to the Facility 

datetime 8 False  

 cinptr_AdmissionReason 

Reason for Admission of the Client to the Facility 

int 4 False  

 cinptr_DischargeDate 

Date the Client was Released from the Facility 

datetime 8 True  

 cinptr_DischargeDisposition 

Reason the Client was Released from the Facility.  

Values are as follows: 

id: 4: "Discharged to ALF" 

id: 2: "Discharged to Home with Homecare" 

id: 0: "Discharged to Home with Hospice" 

id: 1: "Discharged to Home with Skilled Care" 

id: 5: "Discharged to LTAC" 

id: 3: "Discharged to SNF" 

id: 9999: "Other" 

int 4 True  

 cinptr_DischargeDisposition 

Reason the Client was Released from the Facility 

int 4 True  

 
cinptr_ReferralFacilityID 

Identity of the Facility that the Client was admitted to 

bigint 8 False  

 cinptr_CreatedDate 

 

datetime 8 False  

 cinptr_CreatedUser 

 

nvarchar(50) 100 False  

 cinptr_ModifiedDate 

 

datetime 8 False  

 cinptr_ModifiedUser 

 

nvarchar(50) 100 False  

 cinptr_TS 

 

timestamp 8 False  

 cinptr_AdmissionReasonComments 

Comment Regarding the Admission Reason  

nvarchar(max) max True  

 cinptr_DischargeDispositionComments 

Comment Regarding the Discharge Disposition 

nvarchar(max) max True  
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique 

 
PK_T_ClientInpatientTracking cinptr_ID True 

 IX_T_ClientInpatientTracking_ClientID cinptr_ClientID  

Name Columns 

FK_T_ClientInpatientTracking_T_Client cinptr_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_ClientInpatientTracking_T_ReferralFacilities cinptr_ReferralFacilityID->[dbo].[T_ReferralFacilities].[reffac_ID] 



152 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Client Inquiry 

 [dbo].[T_ClientInquiry] 

 

Description 

Records information regarding service inquiries for potential clients. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
cliinq_ID 

System generated ID for the client inquiry record. 

UI Location: Client Inquiry > ID 

and Client Inquiry > Caller > Select > ID (search 

results) 

bigint 8 False 1 - 1  

 cliinq_BranchID 

Branch ID of the client inquiry record. Used to pull 

branch name to UI. The office to which the inquiry 

belongs. The default value is the user's 

Working Office, as set on User Main. 

During the conversion from a client inquiry to an 

active client, cliinq_BranchID flows to T_Client.cli_-

BranchID and T_Admissions.adm_BranchID. 

UI Location: Client Inquiry > Caller > Office 

and Client Inquiry > Caller >Select > Office (search 

results) 

int 4 False   

 cliinq_Date 

The date of the inquiry call. Defaults to the current 

date. 

During the conversion from a client inquiry to an 

active client, cliinq_Date flows to T_Client.cli_Inquiry-

Date. 

Non-UTC date. 

UI Location: Client Inquiry > Caller > Inquiry Date 

datetime 8 False   

 
cliinq_CallerRelatonID 

The ID of the caller relationship type of the client 

inquiry record.Used to pull client relationship type to 

UI. 

For further information, see DDM Client Inquiry 

Relations. If Self is chosen for this field, make sure to 

enter the email address and check the 'Allow Matrix-

Care to Email This Caller' box prior to choosing Self 

for this info to copy forward to the  Client Inquiry Client 

tab and eventually to the Clients Main tab (once the 

inquiry is converted to a Client). When Caller's 

'Relation to Client' is not Self, a Contact record is 

int 4 True   
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created with ContactType of 'Emergency', otherwise 

no Contact record is created when inquiry is 

converted to a Client record. When the caller’s 

relationship is other than 'Self', during the convert 

process the Caller’s Email Address will become a part 

of the Emergency Contact record. 

Flows from T_ClientInquiryRelation.cliinqrel_ID. 

UI Location: Client Inquiry > Caller > Relation to Client 

 cliinq_CallerAddress1 

The main address information of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerAddress1 flows to T_Client-

Emergency.clc_Address1. 

UI Location: Client Inquiry > Caller > Address 1 

(through AddressEditorCaller) 

nvarchar(50) 100 True   

 cliinq_CallerAddress2 

The additional address information of the inquiring 

caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerAddress2 flows to T_Client-

Emergency.clc_Address2. 

UI Location: Client Inquiry > Caller > Address 

2 (through AddressEditorCaller) 

nvarchar(60) 120 True   

 cliinq_CallerCity 

The city of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerCity flows to T_Client-

Emergency.clc_City. 

UI Location: Client Inquiry > Caller > City 

(through AddressEditorCaller) 

nvarchar(50) 100 True   

 cliinq_CallerStateOrProvince 

The state of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerStateOrProvince flows to T_-

ClientEmergency.clc_StateOrProvince. 

UI Location: Client Inquiry > Caller > State 

(through AddressEditorCaller) 

nvarchar(20) 40 True   

 cliinq_CallerPostalCode 

The postal code of the inquiring caller. May type in the 

+4 code for a 9 digit zip code. 9 digit zip codes will 

display on all correspondence (letters, envelopes, 

labels, invoices) and reports that utilize zip codes 

(including the Caregiver Name  

Badge). To create a 9 digit zip code, select the 5 digit 

zip code from the Zip list, type in the dash and the 

additional 4 digits and click Save. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerPostalCode flows to T_-

ClientEmergency.clc_PostalCode. 

UI Location: Client Inquiry > Caller > Postal Code 

(through AddressEditorCaller) 

nvarchar(20) 40 True   

 cliinq_CallerCounty 

The county of the inquiring caller. 

nvarchar(50) 100 True   
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During the conversion from a client inquiry to an 

active client, cliinq_CallerCounty flows to T_Client-

Emergency.clc_County. 

UI Location: Client Inquiry > Caller > County 

(through AddressEditorCaller) 

 cliinq_CallerCountry 

The country of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerCountry flows to T_Client-

Emergency.clc_Country. 

UI Location: Client Inquiry > Caller > Country 

(through AddressEditorCaller) 

int 4 False  ((240)) 

 cliinq_CallerPhone1 

The primary phone number of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerPhone1 flows 

to T_ClientEmergency.clc_Phone1. 

UI Location: Client Inquiry > Caller > Phone 1and 

Client Inquiry > Caller > Select > Phone (search 

results) 

nvarchar(30) 60 True   

 cliinq_CallerPhone2 

The secondary phone number of the inquiring caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerPhone2 flows 

to T_ClientEmergency.clc_Phone2. 

UI Location: Client Inquiry > Caller > Phone 2 

nvarchar(30) 60 True   

 cliinq_ClientLastName 

The last name of the client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientLastName flows to T_-

Client.cli_LastName. 

UI Location: Client Inquiry > Caller > Caller Last 

Name 

and Client Inquiry > Caller > Select > Last 

Name (search results) 

nvarchar(50) 100 True   

 cliinq_ClientFirstName 

The first name of the client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientFirstName flows to T_-

Client.cli_FirstName. 

UI Location: Client Inquiry > Caller > First Name 

and Client Inquiry > Caller > Select > First 

Name (search results) 

nvarchar(50) 100 True   

 cliinq_ClientAddress1 

The main address information of the client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientAddress1 flows to T_-

Client.cli_Address1. 

UI Location: Client Inquiry > Client > Address 1 

(through AddressEditorClient) 

nvarchar(50) 100 True   
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 cliinq_ClientAddress2 

The additional address information of the client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientAddress2 flows to T_-

Client.cli_Address2. 

UI Location: Client Inquiry > Client > Address 2 

(through AddressEditorClient) 

nvarchar(60) 120 True   

 cliinq_ClientCity 

The city of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientCity flows to T_Client.cli_-

City. 

UI Location: Client Inquiry > Client > City 

(through AddressEditorClient) 

nvarchar(50) 100 True   

 cliinq_ClientStateOrProvince 

The state of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientStateOrProvince flows 

to T_Client.cli_StateOrProvince. 

UI Location: Client Inquiry > Client > State 

(through AddressEditorClient) 

nvarchar(20) 40 True   

 cliinq_ClientPostalCode 

The postal code of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientPostalCode flows 

to T_Client.cli_PostalCode. 

UI Location: Client Inquiry > Client > Postal Code 

(through AddressEditorClient) 

nvarchar(20) 40 True   

 cliinq_ClientCounty 

The county code of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientCounty flows 

to T_Client.cli_County. 

UI Location: Client Inquiry > Client > County 

(through AddressEditorClient) 

nvarchar(50) 100 True   

 cliinq_ClientCountry 

The country code of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientCountry flows 

to T_Client.cli_Country. 

UI Location: Client Inquiry > Client > Country 

(through AddressEditorClient) 

int 4 False  ((240)) 

 cliinq_ClientBirthDate 

The birth date of the inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientBirthDate flows to T_-

Client.cli_BirthDate. 

Non-UTC date. 

UI Location: Client Inquiry > Client > Birth Date (Client 

Information) 

datetime 8 True   
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 cliinq_SecondClientName 

The name of the second inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_SecondClientName flows to T_-

Client.cli_ACIHName. 

UI Location: Client Inquiry > Client > Name (2nd 

Client In Home Information) 

nvarchar(50) 100 True   

 cliinq_SecondClientRelation 

The caller relationship with the second inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_SecondClientRelation flows to T_-

Client.cli_ACIHRelation. 

UI Location: Client Inquiry > Client > Relationship 

(2nd Client In Home Information) 

nvarchar(20) 40 True   

 cliinq_SecondClientBirthDate 

The birth date of the second inquired client. 

During the conversion from a client inquiry to an 

active client, cliinq_SecondClientBirthDate flows to 

T_Client.cli_ACIHBirthDate. 

Non-UTC date. 

UI Location: Client Inquiry > Client > Birth Date (2nd 

Client In Home Information) 

datetime 8 True   

 cliinq_ReferralDate 

The referral date of the client inquiry. The value 

entered is converted to the Admission Referral Date 

on the Client record. 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralDate flows to T_-

Admissions.adm_ReferralDate. 

Non-UTC date. 

UI Location: Client Inquiry > Referral > Referral Date 

(through ReferralEditor1) 

datetime 8 True   

 
cliinq_ReferralTypeID 

The referral type ID of the client inquiry. This 

information will auto populate from the record chosen 

in the Entity Selection. 

Flows from: T_ReferralTypes.reftyp_ID 

UI Location: Client Inquiry > Referral > Entity Type 

(through ReferralEditor1) 

int 4 True   

 cliinq_LocationIsClient 

Not used. 

bit 1 False  ((0)) 

 cliinq_ServiceCallAddress1 

The main address information of the service call 

contact. 

UI Location: Client Inquiry > Service Call > Address 1 

(through AddressEditorServiceCall) 

nvarchar(50) 100 True   

 cliinq_ServiceCallAddress2 

The additional address information of the service call 

contact. 

UI Location: Client Inquiry > Service Call > Address 2 

(through AddressEditorServiceCall) 

nvarchar(60) 120 True   
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 cliinq_ServiceCallCity 

The city of the service call contact. 

UI Location: Client Inquiry > Service Call > City 

(through AddressEditorServiceCall) 

nvarchar(50) 100 True   

 cliinq_ServiceCallStateOrProvince 

The state of the service call contact. 

UI Location: Client Inquiry > Service Call > State 

(through AddressEditorServiceCall) 

nvarchar(20) 40 True   

 cliinq_ServiceCallPostalCode 

The postal code of the service call contact. 

UI Location: Client Inquiry > Service Call > Postal 

Code (through AddressEditorServiceCall) 

nvarchar(20) 40 True   

 cliinq_ServiceCallCounty 

The county of the service call contact. 

UI Location: Client Inquiry > Service Call > County 

(through AddressEditorServiceCall) 

nvarchar(50) 100 True   

 cliinq_ServiceCallCountry 

The country of the service call contact. 

UI Location: Client Inquiry > Service Call > Country 

(through AddressEditorServiceCall) 

int 4 False  ((240)) 

 cliinq_ServiceCallPhone1 

The primary phone number of service call contact. 

UI Location: Client Inquiry > Service Call > Phone 1 

nvarchar(30) 60 True   

 cliinq_ServiceCallPhone2 

The secondary phone number of service call contact. 

UI Location: Client Inquiry > Service Call > Phone 2 

nvarchar(30) 60 True   

 cliinq_Notes 

Any notes as needed. Additional documentation for 

why the inquiry will not be converted - Not required 

but when entered pull to the Inquiry Non Conversions 

report. (Max. limit of 1000 characters) 

During the conversion from a client inquiry to an 

active client, cliinq_Notes flows to T_Client.cli_Notes 

and T_ClientEmergency.clc_Notes. 

UI Location: Client Inquiry > Caller > Notes 

nvarchar(4000) 8000 True   

 
cliinq_NonAdmissionReasonID 

If the Inquiry record was not converted to a Client 

record, select the reason for non conversion. For 

more information, see DDM Referral Non Admission 

Reasons. 

During the conversion from a client inquiry to an 

active client, cliinq_NonAdmissionReasonID flows to 

T_Admissions.adm_NonAdmissionReasonID. 

Flows from: T_ReferralNonAdmission-

Reasons.refnar_ID 

UI Location: Client Inquiry > Caller > Reason 

int 4 True   

 cliinq_ActualSOCDate 

Enter the date the services for the Client are to 

start. The value entered will be converted to the Client 

record’s Admission Start of Care date. 

datetime 8 True   
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During the conversion from a client inquiry to an 

active client, cliinq_ActualSOCDate flows to T_Client-

Payers.clipay_EffectiveDate, T_Admissions.adm_-

VerbalSOCDate and T_Admissions.adm_Actual-

SOCDate. 

UI Location: Client Inquiry > Service Call > Start of 

Service 

 
cliinq_PayerID 

The client's payer ID of the client inquiry record. Used 

to pull payer name for the UI. 

Flows from: T_Payers.pay_ID 

During the conversion from a client inquiry to an 

active client, cliinq_PayerID flows to T_Client-

Payers.clipay_PayerID.  

UI Location for the payer name: Client Inquiry > 

Service Call > Payer 

bigint 8 True   

 
cliinq_ConvertedClientID 

System generated number to identify the new Client 

record. Click on the Client icon to the right of the 

Client ID to jump to the newly created Client record. 

Flows from: T_Client.cli_ID. 

UI Location: Client Inquiry > Service Call > Client ID 

bigint 8 True   

 cliinq_CreatedDate 

The date the client inquiry record was created. 

UTC date updated by SQL Server's current UTC date. 

UI Location: Client Inquiry > Caller > Created On 

(through ModifiedRecord1) 

datetime 8 False  (getutcdate()) 

 cliinq_CreatedUser 

The user logged in to the system when the client 

inquiry record was created.  

UI Location: Client Inquiry > Caller > Created 

By (through ModifiedRecord1) 

nvarchar(50) 100 False   

 cliinq_ModifiedDate 

The date when the client inquiry record was last 

modified. 

UTC date updated by SQL Server's current UTC date. 

UI Location: Client Inquiry > Caller > Modified 

On (through ModifiedRecord1) 

datetime 8 False  (getutcdate()) 

 cliinq_ModifiedUser 

The user logged in to the system when the client 

inquiry record was last modified. 

UI Location: Client Inquiry > Caller > Modifies 

By (through ModifiedRecord1) 

nvarchar(50) 100 False   

 cliinq_TS 

The timestamp of the client inquiry record. 

timestamp 8 False   

 
cliinq_BillTo 

Select Self if the Client will be billed for services; 

select Other if another payer source will be billed for 

services. If Self is selected, the Payer drop down will 

disable, and a Client Payer record will be created 

when the Convert to Client button is clicked. 

Values: 0 = Self, 1 = Other 

tinyint 1 False  ((0)) 
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UI Location: Client Inquiry > Service Call > Bill to 

 cliinq_ConvertedClientDate 

Date and time the inquiry record was converted to a 

Client record. 

Non-UTC date. 

UI Location: Client Inquiry > Service Call > Converted 

On 

datetime 8 True   

 cliinq_ConvertedClientUser 

MatrixCare user who converted the Inquiry record a 

Client record. 

UI Location: Client Inquiry > Service Call > Converted 

By 

nvarchar(50) 100 True   

 cliinq_LegacyID 

Not used. 

int 4 True   

 cliinq_CallerFirstName 

First name of the caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerFirstName flows to T_Client-

Emergency.clc_FirstName. 

UI Location: Client Inquiry > First Name 

nvarchar(50) 100 True   

 cliinq_CallerLastName 

Last name of the caller. 

During the conversion from a client inquiry to an 

active client, cliinq_CallerLastName flows to T_Client-

Emergency.clc_LastName. 

UI Location: Client Inquiry > Caller Last Name 

nvarchar(50) 100 True   

 
cliinq_CaregiverID 

The caregiver ID of the client inquiry record. 

Flows from: T_Caregiver.car_ID 

bigint 8 True   

 cliinq_AmbulatoryFlag 

Select check box to add comments. When converted 

to a Client, this information does not  

transfer to the Client record. 

UI Location: Client Inquiry > Service Plan > 

Ambulatory 

bit 1 False  ((0)) 

 cliinq_AmbulatoryNotes 

Notes box is enable when 'Ambulatory' check box is 

selected. When converted to a Client, this information 

does not transfer to the Client record. 

UI Location: Client Inquiry > Service Plan > 

Ambulatory 

nvarchar(max) max True   

 cliinq_MedicationsFlag 

Select check box to add comments. When converted 

to a Client, this information does not transfer to the 

Client record. 

UI Location: Client Inquiry > Service Plan > Taking 

Medications 

bit 1 False  ((0)) 

 cliinq_MedicationsNotes 

Notes box is enable when 'Taking Medications' check 

box is selected. When converted to a Client, this 

information does not transfer to the Client record.  

nvarchar(max) max True   
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UI Location: Client Inquiry > Service Plan > Taking 

Medications 

 cliinq_IncontinentFlag 

Select check box to add comments. When converted 

to a Client, this information does not transfer to the 

Client record. 

UI Location: Client Inquiry > Service Plan > 

Incontinent 

bit 1 False  ((0)) 

 cliinq_IncontinentNotes 

Notes box is enable when 'Incontinent' check box is 

selected. When converted to a Client, this information 

does not transfer to the Client record. 

UI Location: Client Inquiry > Service Plan > 

Incontinent 

nvarchar(max) max True   

 cliinq_AllowMassEmail 

Checking this box allow letters and other items to be 

sent to this caller from  

within the system. 

UI Location: Client Inquiry > Caller > Allow MatrixCare 

to Email This Caller 

bit 1 False  ((0)) 

 cliinq_CallerEmail 

Email address for caller. If the email address is 

entered and the 'Allow MatrixCare to Email This 

Caller' box is checked prior to setting the above 

Relation to Client as Self, then the email will copy 

forward to the Client Inquiry Client tab and eventually 

to the Clients Main tab (once the inquiry is converted 

to a client). Can choose to view Caller Email column 

within custom layouts from the Layout Toolbar 

Column Chooser. When the caller’s relationship is 

other than 'Self', during the convert process the 

Caller’s Email Address will become a part of the 

Emergency Contact record (T_ClientEmergency.clc_-

LastName) 

UI Location: Client Inquiry > Caller > Email 

nvarchar(50) 100 True   

 cliinq_LocationIsServiceCall 

Not used. 

bit 1 False  ((0)) 

 cliinq_CallerBrochureSent 

For informational purposes only. Check to indicate 

that marketing materials have been sent to the caller. 

UI Location: Client Inquiry > Caller > Brochure Sent 

bit 1 False  ((0)) 

 cliinq_ClientBrochureSent 

For informational purposes only. Check to indicate 

that marketing materials have been sent to the client. 

UI Location: Client Inquiry > Client > Brochure Sent 

bit 1 False  ((0)) 

 cliinq_ServiceCallBrochureSent 

For informational purposes only. Check to indicate 

that marketing materials have been sent to the service 

call contact. 

UI Location: Client Inquiry > Service Call > Brochure 

Sent 

bit 1 False  ((0)) 
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cliinq_ReferralEntityTypeID 

Entity Type for the source of the referral. Used to pull 

referral entity name to UI. 

Flows from: T_ReferralEntities.refent_ID 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralEntityTypeID flows to T_-

Admissions.adm_ReferralEntityTypeID and can flow 

to T_Admissions.adm_ReferralTypeID. 

UI Location: Client Inquiry > Referral > Entity Type 

(Through ReferralEditor1) 

tinyint 1 True   

 
cliinq_ReferralEntityID 

System generated referral entity ID for the client 

inquiry record. 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralEntityID flows to T_-

Admissions.adm_ReferralEntityID and can flow to T_-

Admissions.adm_ReferralTypeID. 

bigint 8 True   

 cliinq_ReferralNotes 

Any notes related to referral. 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralNotes flows to T_-

Admissions.adm_ReferralNotes. 

UI Location: Client Inquiry > Referral > Notes 

(Through ReferralEditor1) 

nvarchar(max) max True   

 

cliinq_ReferralCampaignID 

Referral campaign ID for the referral. Used to pull 

referral campaign name to UI. 

If the agency sponsors Marketing Campaigns and the 

referral was the result of a campaign, select the option 

from the Campaign list. All active campaigns will 

be available for selection. For further information, see 

DDM Referral Campaigns. 

Flows from: T_ReferralCampaigns.refcamp_ID 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralCampaignID flows to T_-

Admissions.adm_ReferralCampaignID. 

UI Location: Client Inquiry > Referral > Entity Type 

(Through ReferralEditor1) 

int 4 True   

 
cliinq_ReferralContactJoinID 

Referral contact join ID for the client inquiry record. 

Flows from: T_ReferralJoin.refjoin_ID 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralContactJoinID flows to T_-

Admissions.adm_ReferralContactJoinID. 

bigint 8 True   

 cliinq_StaffID 

If the referral was the result of a marketing staff’s 

efforts, select that staff in the Marketing Staff field. 

Used to pull staff name to UI. 

During the conversion from a client inquiry to an 

active client, cliinq_StaffID flows to T_-

Admissions.adm_StaffID. 

UI Location: Client Inquiry > Referral > Marketing Staff 

(Through ReferralEditor1) 

bigint 8 True   
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 cliinq_OasisPhysicianID 

Oasis physician ID for the client inquiry record. 

During the conversion from a client inquiry to an 

active client, cliinq_OasisPhysicianID flows to T_-

Admissions.adm_OasisPhysicianID. 

bigint 8 True   

 cliinq_ReferralTakenBy 

The Taken By field defaults to the mapped user of the 

user logged into the system. For more information, 

see User  

Security. The icon to open the Staff record will display 

on the field for either the Taken By user or the Admin 

user. 

UI Location: Client Inquiry > Referral > Taken by 

(Through ReferralEditor1) 

nvarchar(50) 100 True   

 
cliinq_ServiceCall_ActivityID 

Used to get Service Call from Date of Activity if 

present. 

Flows from: T_Activities.act_ID 

bigint 8 True   

 cliinq_ClientAddressFrom 

Select either 'Same as Caller' or 'Same as Service 

Call'. The default is 'Same as Caller'. When 'Same as 

Caller' is chosen, Phone1 from the Client Inquiry 

Caller tab will copy as the primary phone for the 

Client. The Note field will populate with the text Auto 

Added from Client Inquiry Caller tab.When 'Same as 

Service Call' is chosen, Phone1 from the Client 

Inquiry Service Call tab will copy as the primary phone 

for the Client. The Note field will populate with the text 

Auto Added from the Client Inquiry Service Call tab. In 

both cases, the phones will copy with the type of 

Home. If multiple phones are copied, Home will be the 

type for all of the records. After copying, modify the 

records and select the appropriate type if necessary. 

Values: 0: Same as Caller, 1: Same as Client, 2: 

Same as Service Call 

UI Location: Client Inquiry > Client > Client Address 

Information 

tinyint 1 True   

 cliinq_ServiceCallAddressFrom 

Select either Same as Caller or Same as Service 

Call. The default is Same as Caller. When Same as 

Caller is chosen, Phone 1 and Phone 2 from the 

Client Inquiry Caller tab will copy to Phone1 and 

Phone2 on the current tab. When Same as Client is 

chosen, Phone 1 and Phone 2 from the Client Inquiry 

Client tab will copy to Phone1 and Phone2 on the 

current tab.  

Values: 0: Same as Caller, 1: Same as Client, 2: 

Same as Service Call 

UI Location: Client Inquiry > Service Call > Service 

Call Address Information 

tinyint 1 True   

 
cliinq_ClientSalutationID 

Select the Salutation for the client. The Salutation is 

used when  

int 4 True   
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running a mail merge or printing labels or envelopes 

in Letters.  For further  

information see DDM Salutations and Letters. 

Flows from: T_Salutation.salut_ID 

UI Location: Client Inquiry > Client > Salutation 

 
cliinq_CallerSalutationID 

Select the Salutation for the caller. The Salutation is 

used when running a mail merge or printing labels or 

envelopes in Letters. For further information see DDM 

Salutations and Letters. 

Flows from: T_Salutation.salut_ID 

During the conversion from a client inquiry to an 

active client, cliinq_CallerSalutationID flows to T_-

Client.cli_Salut. 

UI Location: Client Inquiry > Caller > Salutation 

int 4 True   

 cliinq_NonAdmissionNotes 

Notes as needed regarding Non Conversion. 

UI Location: Client Inquiry > Caller > Notes (under 

Non Conversion) 

nvarchar(1024) 2048 True   

 
cliinq_ReferralTakenByID 

Caregiver Referral Taken By ID for the client inquiry 

record. used to pull the referral taken by name for the 

UI. 

Flows from: T_Caregiver.car_ID 

During the conversion from a client inquiry to an 

active client, cliinq_ReferralTakenByID flows to T_-

Admissions.adm_ReferralTakenByID. 

UI Location: Client Inquiry > Referral > Taken by 

(Through ReferralEditor1) 

bigint 8 True   

 cliinq_ClientEmail 

Email address for Client. This will pull from the Client 

Inquiry Caller tab if the email address is entered on 

the Client Inquiry Caller tab and the Allow MatrixCare 

to email this caller box is checked prior to setting the 

Relation to Client as Self.  

During the conversion from a client inquiry to an 

active client, cliinq_ClientEmail flows to T_Client.cli_-

Email. 

UI Location: Client Inquiry > Client > Email 

nvarchar(50) 100 True   

 cliinq_ClientAllowMassEmail 

Check this box to allow letters and other items to be 

sent to this caller from  

within Matrixcare. 

During the conversion from a client inquiry to an 

active client, cliinq_ClientAllowMassEmail flows to T_-

Client.cli_AllowMassEmail. 

UI Location: Client Inquiry > Client > Allow MatrixCare 

to Email This Client 

bit 1 False  ((0)) 

 
cliinq_ServiceCallScheduledByID 

The ID of the Service Call scheduled By. Used to pull 

the name of the staff and show in the UI.The 

Scheduled By will default to the Mapped To staff 

record for the user who is logged into the 

bigint 8 True   
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Indexes 

 

  

system. If the user is the Scheduled By user or the 

user is an Admin, the icon to open the Staff record will 

display on the field. For more information, see User 

Security. 

Flows from: T_Caregiver.car_ID 

UI Location: Client Inquiry > Service Call > Schedule 

By 

 
cliinq_RegionID 

Office Area for the Client Inquiry record. 

Flows from: T_Region.reg_ID 

During the conversion from a client inquiry to an 

active client, cliinq_RegionID flows to T_Client.cli_-

RegionID. 

UI Location: Client Inquiry > Office Area 

int 4 True   

 

cliinq_ClientInquiryRatingID 

Assign a rating to the Client Inquiry. This allows you to 

quantify the type of lead the inquiry is using a 

customizable rating system. For more information, 

see DDM Client Inquiry Rating. You can clear the field 

by pressing Backspace or Delete. 

Flows from: T_ClientInquiryRating.cliinqrat_ID 

UI Location: Client Inquiry > Caller > Rating 

int 4 True   

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_ClientInquiry cliinq_ID True 80 

 IX_T_ClientInquiry_ClientInquiryRatingID cliinq_ClientInquiryRatingID   

 IX_T_ClientInquiry_ReferralCampaignID cliinq_ReferralCampaignID  80 

 IX_T_ClientInquiry_ReferralEnitityTypeID_-

ReferralEntityID 

cliinq_ReferralEntityTypeID, cliinq_Referral-

EntityID 

 80 
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Foreign Keys 

 

 

 

Name Delete Columns 

FK_T_ClientInquiry_T_Activities  cliinq_ServiceCall_ActivityID->[dbo].[T_Activities].[act_ID] 

FK_T_ClientInquiry_T_Caregiver  cliinq_CaregiverID->[dbo].[T_Caregiver].[car_ID] 

FK_T_ClientInquiry_T_Caregiver_Referral-

TakenBy 

 cliinq_ReferralTakenByID->[dbo].[T_Caregiver].[car_ID] 

FK_T_ClientInquiry_T_Caregiver_ServiceCall-

ScheduledBy 

 cliinq_ServiceCallScheduledByID->[dbo].[T_Caregiver].[car_ID] 

FK_T_ClientInquiry_T_Client Set-

Null 

cliinq_ConvertedClientID->[dbo].[T_Client].[cli_ID] 

FK_T_ClientInquiry_T_ClientInquiryRating  cliinq_ClientInquiryRatingID->[dbo].[T_ClientInquiry-

Rating].[cliinqrat_ID] 

FK_T_ClientInquiry_T_ClientInquiryRelation  cliinq_CallerRelatonID->[dbo].[T_ClientInquiryRelation].[cliinqrel_ID] 

FK_T_ClientInquiry_T_Payers  cliinq_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_ClientInquiry_T_ReferralCampaigns  cliinq_ReferralCampaignID->[dbo].[T_Referral-

Campaigns].[refcamp_ID] 

FK_T_ClientInquiry_T_ReferralEntities  cliinq_ReferralEntityTypeID->[dbo].[T_ReferralEntities].[refent_ID] 

FK_T_ClientInquiry_T_ReferralJoin  cliinq_ReferralContactJoinID->[dbo].[T_ReferralJoin].[refjoin_ID] 

FK_T_ClientInquiry_T_ReferralTypes  cliinq_ReferralTypeID->[dbo].[T_ReferralTypes].[reftyp_ID] 

FK_T_ClientInquiry_T_RefferalNonAdmission-

Reasons 

 cliinq_NonAdmissionReasonID->[dbo].[T_ReferralNonAdmission-

Reasons].[refnar_ID] 

FK_T_ClientInquiry_T_Region  cliinq_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_ClientInquiry_T_Salutation  cliinq_ClientSalutationID->[dbo].[T_Salutation].[salut_ID] 

FK_T_ClientInquiry_T_Salutation1  cliinq_CallerSalutationID->[dbo].[T_Salutation].[salut_ID] 
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Client Inquiry Field List Items 

 [dbo].[T_ClientInquiryFieldListItems] 

 

 

Note: Detailed documentation is pending. 
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Client Inquiry Fields 

 [dbo].[T_ClientInquiryFields] 

 

 

Note: Detailed documentation is pending. 
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Client Inquiry Phones 

 [dbo].[T_ClientInquiryPhones] 

 

 

Note: Detailed documentation is pending. 
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Client Inquiry Rating 

 [dbo].[T_ClientInquiryRating] 

 

 

Note: Detailed documentation is pending. 
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Client Inquiry Relation 

 [dbo].[T_ClientInquiryReleation] 

 

 

Note: Detailed documentation is pending. 
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Client Inquiry Values 

 [dbo].[T_ClientInquiryValues] 

 

 

Note: Detailed documentation is pending. 
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Client Payers 

 [dbo].[T_ClientPayers] 

 

Description 

Information about clients, payers, and related payment types details. 

Columns 

Key Name Data Type Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

clipay_ID 

Unique system generated ID for the 

client payers record.  

bigint  8 False 1 - 1  

(3)

 

clipay_ClientID 

The ID of the client assigned when client 

is added to the system. 

Relates to [T_Client].[cli_ID] 

bigint  8 False   

(4)

 

clipay_PayerID 

The ID of the payer assigned when 

payer is added to the system. 

Used to pull client payers record to 

Admission Payers, Client Payers and 

Schedule Details Payers tabs. 

Relates to [T_Payers].[pay_ID] 

bigint  8 False   

 clipay_SeqNo 

This field is used in determining the 

primary payer for a client, which will 

determine the total charge for associated 

schedules.  It does not determine the 

order in which payers are billed though. 

clipay_ChargeAllocationSeqNo is the 

field used to determine what order to bill 

client payers. 

UI Location: Client > Payers > Payer 

Sequence (Through ClientsPayersInfo 

class) 

int  4 False  ((0)) 

 
clipay_PolicyNumber 

The policy number for the insurance 

company, if applicable. This appears on 

the Payer's invoice under the client's 

name and address. 

UI Location: Client > Payers > Policy 

(Through ClientsPayersInfo class) 

nvarchar(25)  50 True   

 clipay_EffectiveDate 

Enter the beginning date to which the 

datetime  8 False  ([dbo].[Get-

Today]()) 
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current record applies. This is for 

informational purposes. 

UI Location: Client > Payers > Effective 

From (Through ClientsPayersInfo class) 

 clipay_ExpirationDate 

Enter the ending date to which the 

current record applies. This is for 

informational purposes. 

UI Location: Client > Payers > Effective 

To (Through ClientsPayersInfo class) 

datetime  8 False  ('12/31/9999') 

 
clipay_BillSplitTypeID 

Select the method that defines how the 

payment is be allocated to the payer(s). 

The choices are Balance, Daily Benefit, 

Hourly, Monthly Benefit, Split, Visit, and 

Weekly Benefit. See Payment Allocation 

Types for details on each type and 

applicable usage. 

B: Balance 

S: Split 

V: Visit  

T: Transfer 

C: COB Manage 

Time/Date Based Benefits 

H: Hourly 

I:   Schedule Hourly 

D: Daily 

W:Weekly 

M:Monthly 

UI Location: Client > Payers > Pmt 

Allocation (Through ClientsPayersInfo 

class) 

char(1)  1 False  ('B') 

 clipay_DefaultFlag 

If checked, the current record represents 

the default payer. 

UI Location: Client > Payers > Default 

(Through ClientsPayersInfo class) 

bit  1 False  ((1)) 

 clipay_Amount 

Dollar amount allowed per Pmt 

Allocation type. Not used in conjunction 

with Balance. 

For example, if a patient has a Daily 

Benefit amount of $100/day, the Pmt 

Allocation type would be Daily Benefit 

and the Pmt Allowance would be $100. 

UI Location: Client > Payers > Pmt 

Allowance (Through ClientsPayersInfo 

class) 

money  8 False  ((0)) 

 
clipay_Percent 

Percent allowed per Pmt Allocation type. 

For example, if the primary payer will 

pay 80% of the total bill, that payer 

decimal(5,4)  5 False  ((0)) 
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would have a Pmt Allocation of Split and 

a Pmt Prcnt of 80%. 

UI Location: Client > Payers > Pmt Prcnt 

(Through ClientsPayersInfo class) 

 clipay_DiscountAmount 

Enter the discount amount. Informational 

only, for internal tracking purposes. 

It is not used in the draft process itself. 

UI Location: Client > Payers > Disc amt 

(Through ClientsPayersInfo class) 

money  8 False  ((0)) 

 
clipay_DiscountPercent 

Enter the discount percent. Informational 

only, for internal tracking purposes. 

It is not used in the draft process itself. 

UI Location: Client > Payers > Disc Prcnt 

(Through ClientsPayersInfo class) 

decimal(5,4)  5 False  ((0)) 

 clipay_Deductible 

Policy deductible amount. Informational 

only, for internal tracking purposes. 

It is not used in the draft process itself. 

UI Location: Client > Payers > Pol 

Deduct (Through ClientsPayersInfo 

class) 

money  8 False  ((0)) 

 clipay_DeductibleBalance 

Policy deductible balance. Informational 

only, for internal tracking purposes. 

It is not used in the draft process itself. 

UI Location: Client > Payers > Deduct 

Bal (Through ClientsPayersInfo class) 

money  8 False  ((0)) 

 
clipay_CopayerID 

Not used. 

Relates to [T_Payers].[pay_ID] 

bigint  8 True   

 clipay_CopayAmount 

Not used. 

money  8 False  ((0)) 

 
clipay_CopayPercent 

Not used. 

decimal(5,4)  5 False  ((0)) 

 
clipay_CopayMultiplier 

Not used. 

char(1)  1 False  ('V') 

 clipay_CopayInvoiceNote 

Not used. 

nvarchar(255)  510 True   

 clipay_Notes 

 

Notes for informational purposes.  

This for payer notes for this record. 

UI Location: Client > Payers > Notes 

(Through ClientsPayersInfo class) 

nvarchar(255)  510 True   

 clipay_BillNote 

Notes for informational purposes. 

 This for bill notes for this record. 

nvarchar(255)  510 True   
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UI Location: Client > Payers > Bill Note 

(Through ClientsPayersInfo class) 

 clipay_ActiveFlag 

Indicates if the payer is active or 

inactive. 

UI Location: Client > Payers > Status 

(Through ClientsPayersInfo class) 

and Client > Admission > Payers > 

Status (Through AdmissionPayersInfo 

class) 

bit  1 False  ((1)) 

 clipay_ExcludeHoliday 

When checkbox is checked, excludes 

Holiday Bill Rate Calculations for the 

payer record. 

UI Location: Client > Payers > Exclude 

Holiday (Through ClientsPayersInfo 

class) 

bit  1 False  ((0)) 

 clipay_CreatedDate 

Date and time the record was created. 

UTC date updated by SQL Server's 

current UTC date.  

UI Location: Client > Payers > Created 

On (Through ClientsPayersInfo class) 

datetime  8 False  (getutcdate()) 

 clipay_CreatedUser 

User who created the record.  

UI Location: Client > Payers > Created 

By (Through ClientsPayersInfo class) 

nvarchar(50)  100 False   

 clipay_ModifiedDate 

Date and time the record was last 

modified. 

UTC date updated by SQL Server's 

current UTC date.  

UI Location: Client > Payers > Modified 

On (Through ClientsPayersInfo class) 

datetime  8 False  (getutcdate()) 

 clipay_ModifiedUser 

User who last modified the record.  

UI Location: Client > Payers > Modified 

By (Through ClientsPayersInfo class) 

nvarchar(50)  100 False   

 clipay_TS 

The timestamp of the record.  

timestamp  8 False   

 clipay_AuthRequired 

Not used. 

bit  1 False  ((0)) 

 clipay_AuthsUseServiceCategories 

Check this box to use the Service 

Categories rather than the specific 

Service Codes when creating 

authorization records and when running 

authorization scheduling checks against 

scheduled services. 

Ex. Service Category=SN. The agency 

has configured the SN Category as the 

bit  1 False  ((0)) 
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assigned category for the services of 

RN, RN SOC, RN ROC, etc. 

The authorizations created using the 

category of SN will cover the schedules 

for any of the services assigned to that 

category. 

UI Location: Client > Payers > Auths Use 

Service Categories (Through Clients-

PayersInfo class) 

 clipay_AuthorizationConflictsAllow 

Used when running the scheduling 

conflict checks. Select either 'Default' or 

'Disallow'. Default means the settings 

have been pulled from the setting on the 

Payer Billing Info tab. Disallow will create 

a hard stop regarding Authorizations. 

This field will be locked down and cannot 

be overridden if the Payer level record is 

set to ‘Disallow’. 

The level of conflict check configured at 

the payer level will apply to this client. If 

the Payer level record has a setting of 

‘User Override’, then this field will be 

enabled and display the options of 

‘Default’ or ‘Disallow’. 

This allows the user to set the Client > 

Payer Authorization checks as a hard 

stop (Disallow) when the Payer level 

record may have been set to ‘Default’ 

and the User/Office/Global default 

setting is ‘Warn Only’. For further 

information, see Payers Billing Info. 

UI Location: Client > Payers > Auth 

Conflicts (Through ClientsPayersInfo 

class) 

tinyint  1 False  ((0)) 

 
clipay_AddressBookID 

Enter entity from Address Book if 

needed, for informational purposes only. 

Relates to [T_AddressBook].[addbk_ID] 

bigint  8 True   

 clipay_ChargeAllocationSeqNo 

Defaults from the Payer Sequence. 

Determines the sequence in which the 

charges get allocated to the payers for 

billing.  This field is not used in 

determining the primary payer for that 

client.  The field clipay_SeqNo is used to 

determine the primary payer, which is 

the payer who determines the total 

charge for associated schedules. Last 

allocation sequence should have Pmt 

Allocation of 'Balance'. See Charge 

Allocation Sequence Configurations for 

full details. 

UI Location: Client > Payers > Alloc 

(Through ClientsPayersInfo class) 

int  4 False  ((0)) 
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Indexes 

Foreign Keys 

 

 

 

 

 clipay_ManageCOB 

Not used. 

int True 4 False   

Key Name Key Columns Unique 

 
PK_T_ClientPayers clipay_ID True 

 IX_T_ClientPayers_ClientID_PayerID_PolicyNumber clipay_ClientID, clipay_PayerID, clipay_PolicyNumber True 

 IX_T_ClientPayers_ID_PayerID clipay_ID, clipay_PayerID True 

 IX_T_ClientPayersPayerID clipay_PayerID  

 IX_T_ClientPayers_ClientID clipay_ClientID  

 IX_T_ClientPayers_clipay_ClientIDPayerID clipay_PayerID, clipay_ClientID  

Name Columns 

FK_T_ClientPayers_T_AddressBook clipay_AddressBookID->[dbo].[T_AddressBook].[addbk_ID] 

FK_T_ClientPayers_T_Client clipay_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_ClientPayers_T_Payers clipay_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_ClientPayers_T_Payers_CopayerID clipay_CopayerID->[dbo].[T_Payers].[pay_ID] 
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Client Type 

 [dbo].[T_ClientType] 

 

 

Description 

Defines the Client Types available in the application. Users can use the system (Global) Client 

Types, add their own Client Types at the Office level, or override the system (Global) Client 

Types.  

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
clt_ID 

System generated ID number for the ClientType 

record. Also called ID. 

 

int 4 False 10001 - 

1 

 

 
clt_Name 

The Name of the Client Type.  

nvarchar(50) 100 True  ('') 

 
clt_ListItemType 

The list type of the client type for the DropDown 

List control. 0 = Global, 1 = Office, 2 = Override 

tinyint 1 False  ((0)) 

 

clt_BranchID 

Branch ID for offices that have special client type 

requirements not covered by the system client 

types. 

 

int 4 True   

 
clt_RptGroupID 

Optional report group ID for reporting. 

int 4 False  ((60)) 

 

clt_OverrideID 

ID of client type to be overridden with this client 

type. 

 

int 4 True   

 clt_Active 

The status of the client type. 0 = inactive, 1 = 

active 

bit 1 False  ((1)) 

 clt_CreatedDate 

UTC date updated by SQL server's current UTC 

date. The date the client type record was 

created. Also called Created On in the Drop 

Down Maintenance grid. 

 

datetime 8 False  (getutcdate()) 

 clt_CreatedUser 

The UserID of the user that created the client 

nvarchar(50) 100 False   
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Indexes 

 

Foreign Keys 

 

 

 

type record. Also called Created By in the Drop 

Down Maintenance grid. 

 

 clt_ModifiedDate 

UTC date updated by SQL server's current UTC 

date. The date when the client type record was 

last modified. 

Also called Modified On in the Drop Down 

Maintenance grid. 

 

datetime 8 False  (getutcdate()) 

 clt_ModifiedUser 

The UserID of the user that last modified the 

client type record. Also called Modified By in the 

Drop Down Maintenance grid.  

nvarchar(50) 100 False   

 clt_TS 

The timestamp field of the client type record. 

Also called TS.  

 

timestamp 8 False   

 clt_Description 

The description of the client type. 

nvarchar(1000) 2000 True  ('') 

Key Name Key Columns Unique Fill Factor 

 
PK_T_ClientType clt_ID True 80 

 IX_T_ClientType_BranchOverrideName clt_BranchID, clt_OverrideID, clt_Name True 80 

Name Columns 

FK_T_ClientType_T_Branches clt_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_ClientType_T_ClientType clt_OverrideID->[dbo].[T_ClientType].[clt_ID] 

FK_T_ClientType_T_ReportGroups clt_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 
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Diagnosis 

 

 [dbo].[T_Diagnosis] 

 

 

Note: Detailed documentation is pending. 
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Diagnosis Categories 

 

 [dbo].[T_DiagnosisCategories] 

 

 

Note: Detailed documentation is pending. 
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Emergency Types 

 

 [dbo].[T_EmergencyTypes] 

 

 

Note: Detailed documentation is pending. 

 

 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 183 

Entities 

 

 [dbo].[T_Entities] 

 

 

Note: Detailed documentation is pending. 
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Expense Types 

 

 [dbo].[T_ExpenseTypes] 

 

 

Note: Detailed documentation is pending. 
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HHA Categories 

 

 [dbo].[T_HHACategories] 

 

 

Note: Detailed documentation is pending. 
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HHA Tasks 

 

 [dbo].[T_HHATasks] 

 

 

Note: Detailed documentation is pending. 

 

 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 187 

Invoice Batch 

 [dbo].[T_InvoiceBatch] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

invb_ID 

 

bigint 8 False 1 - 1  

 

invb_BranchID 

 

int 4 False   

 
invb_InvProcessID 

 

int 4 False  ((2)) 

 invb_StartDate 

 

datetime 8 False  ([dbo].[Get-

Today]()) 

 invb_EndDate 

 

datetime 8 False  ([dbo].[get-

Today]()) 

 invb_InvoiceDate 

 

datetime 8 True   

 

invb_PayerID 

 

bigint 8 True   

 
invb_ServiceCodeID 

 

int 4 True   

 
invb_FinalizedDate 

 

datetime 8 True   

 
invb_ServCategoryID 

 

int 4 True   

 invb_LastDraftDate 

 

datetime 8 True   

 invb_LastDraftUser 

 

nvarchar(50) 100 True   

 invb_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 invb_CreatedUser 

 

nvarchar(50) 100 False   

 invb_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 invb_ModifiedUser 

 

nvarchar(50) 100 False   
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Indexes 

 

Foreign Keys 

 

 invb_TS 

 

timestamp 8 False   

 

invb_ClientID 

 

bigint 8 True   

 invb_ReDraft 

This field determines whether a batch pulls the 

most recently drafted results for an Invoice 

Batch or redrafts and pulls those results. 

 

IF       invb_ReDraft == 0 (Do not ReDraft) 

AND  record count of T_InvoiceDetailsDraft > 0  

THEN  Do not ReDraft, Use the existing records 

ELSE  ReDraft 

 

There's also an optional parameter in the draft 

process to force the redraft to happen 

regardless of the settings 

bit 1 False  ((1)) 

Key Name Key Columns Unique Fill Factor 

 
PK_T_InvoiceBatch invb_ID True 80 

 IX_T_InvoiceBatch_BranchID invb_BranchID  80 

 IX_T_InvoiceBatch_ClientID invb_ClientID  80 

 IX_T_InvoiceBatch_FinalizedDate invb_FinalizedDate  80 

 IX_T_InvoiceBatch_PayerID invb_PayerID  80 

Name Columns 

FK_T_InvoiceBatch_T_Branches invb_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_InvoiceBatch_T_Client invb_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_InvoiceBatch_T_InvoiceBatch invb_ID->[dbo].[T_InvoiceBatch].[invb_ID] 

FK_T_InvoiceBatch_T_InvoiceProcess invb_InvProcessID->[dbo].[T_InvoiceProcess].[invPr_ID] 

FK_T_InvoiceBatch_T_Payers invb_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_InvoiceBatch_T_ServiceCode invb_ServiceCodeID->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_InvoiceBatch_T_ServiceCode1 invb_ServCategoryID->[dbo].[T_ServiceCode].[svcc_ID] 
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Invoice Batch Taxes 

 [dbo].[T_InvoiceBatchTaxes] 

 

Description 

Defines the relationship between different Tax Types and Invoice Batch Tax Groups. This table 

is used to determine Tax calculations for services that have Taxes that will be shown on an 

Invoice. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity 

 
invbtx_ID 

System generated unique ID for the Invoice Batch Tax record. 

int 4 False 1 - 1 

 

invbtx_InvBatchGroupID 

The ID of the Invoice Branch Tax Group that this Invoice Batch Tax 

record is associated with.  

bigint 8 False  

 
invbtx_TaxTypeID 

The ID of the associated Tax Type record (T_TaxTypes). Not 

shown in the UI; only the description is shown in the UI. 

int 4 True  

 
invbtx_TaxID 

The ID of the system generated unique ID for the Branch Tax 

record (T_BranchTaxes).  

int 4 False  

 invbtx_Percent 

The percentage value of the tax which comes from the Branch Tax 

record (T_BranchTaxes). The percentage of the Invoice Detail 

amount that will be added to the taxes of an applicable Invoice 

Detail. 

decimal(10,6) 9 True  

 invbtx_FixedAmt 

The fixed amount value of the tax which comes from the Branch 

Tax record. This is a fixed amount that will be added to the taxes of 

an applicable Invoice Detail.   

money 8 False  

 invbtx_Description 

The description of the Invoice Batch Tax. Comes from the btx_Desc 

field in T_BranchTaxes. 

nvarchar(100) 200 True  

 invbtx_EffectiveStart 

The Effective Start date for this Invoice BatchTax record. It comes 

from brtx_EffectiveStart in the T_BranchTaxes table. It is UTC and 

is updated by SQL Server based on the office time zone.  

datetime 8 True  

 invbtx_EffectiveEnd 

The Effective End date for this Invoice BatchTax record. It comes 

from brtx_EffectiveEnd in the T_BranchTaxes table. It is UTC and 

is updated by SQL Server based on the office time zone.  

datetime 8 True  

 invbtx_HCPCS 

The HCPCS code, if required by a payer. If different payers require 

different HCPCS Codes then add a Tax Group for each payer in the 

nchar(25) 50 True  
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Indexes 

 

Foreign Keys 

 

Branch Tax grid. This field comes from brtx_HCPCS in the T_-

BranchTaxes table. 

 invbtx_Desc 

This field does not appear to be used as there are no references to 

this field in the UI. 

nchar(100) 200 True  

Key Name Key Columns Unique Fill Factor 

 
PK__InvoiceBatchTaxes invbtx_ID True 80 

 IX_T_InvoiceBatchTaxes_invbtx_InvBatchGroupID invbtx_InvBatchGroupID   

Name Delete Columns 

FK_T_InvoiceBatchTaxes_T_BranchTaxes  invbtx_TaxID->[dbo].[T_BranchTaxes].[brtx_ID] 

FK_T_InvoiceBatchTaxes_T_InvoiceBatchTax-

Groups 

Cascade invbtx_InvBatchGroupID->[dbo].[T_InvoiceBatchTax-

Groups].[invbtg_ID] 

FK_T_InvoiceBatchTaxes_T_TaxTypes  invbtx_TaxTypeID->[dbo].[T_TaxTypes].[taxtyp_ID] 
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Invoice Batch Tax Groups 

 [dbo].[T_InvoiceBatchTaxGroups] 

 

Description 

Defines the relationship between Invoice Batches and Tax Types for the Branch.  

Columns 

 

Indexes 

 

Foreign Keys 

 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity 

 
invbtg_ID 

System generated unique ID for the Invoice Batch Tax Groups 

record. 

bigint 8 False 1 - 1 

 

invbtg_InvoiceBatchID 

The ID of the Invoice Batch that this Invoice Batch Tax Group 

record is associated with. Flows from [T_InvoiceBatch].[invb_-

ID] 

bigint 8 True  

 

invbtg_TaxGroupId 

The ID of the Branch Tax Group that this Invoice Batch Tax 

Group record is associated with. Flows from [T_BranchTax-

Groups].[brtg_ID] 

int 4 False  

 invbtg_TaxGroupDescription 

Invoice Tax Group Description which is shown on the Invoice 

Report from Finalized Invoices. 

nvarchar(1000) 2000 True  

Key Name Key Columns Unique Fill Factor 

 
PK_T_InvoiceBatchTaxGroups invbtg_ID True 80 

 IX_T_InvoiceBatchTaxGroups_InvBatchID invbtg_InvoiceBatchID, invbtg_TaxGroupId   

Name 

No 

Check Delete Columns 

FK_T_InvoiceBatch_T_InvoiceBatchTaxGroups True Set-

Null 

invbtg_InvoiceBatchID->[dbo].[T_Invoice-

Batch].[invb_ID] 

FK_T_InvoiceBatchTaxGroups_T_BranchTax-

Groups 

  invbtg_TaxGroupId->[dbo].[T_BranchTax-

Groups].[brtg_ID] 
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Invoice Details 

 [dbo].[T_InvoiceDetails] 

 

Description 

Provides information on invoice items. 

Columns 

Key Name Data Type Computed 

Max Length 

(Bytes) Allow Nulls Identity Default 

 

invd_ID 

Invoice detail ID field of the 

invoice details. 

Each Invoice Detail record will 

show as a separate row under 

an Invoice in the Invoice 

Batching grid or Invoice 

Search screen.  In most cases 

each Invoice Detail will show 

as a single line item on the 

printed/extracted Invoice.  The 

Payer Entity has options that 

can cause multiple Invoice 

Detail records to be grouped 

into a single line item on the 

printed/extracted Invoice.  The 

field invd_InvoiceGroupID 

determines which Invoice 

Details will be grouped 

together into a single line item 

on the printed/extracted 

Invoice. 

Payment Postings > Payment 

and Postings > Inv. Detail ID 

(Not hidden) 

CMS1500 > invd_ID (Hidden) 

Invoice Postings > invd_-

ID (Hidden) 

UB04 > invd_ID (Hidden) 

UB04Invoice > invd_-

ID (Hidden) 

UB92Invoice > invd_-

ID (Hidden) 

bigint  8 False 1 - 1  

 

invd_InvhID 

Invoice ID field of the invoice 

details. Flows from T_Invoice-

Header.invh_ID. 

bigint  8 False   
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This represents the Invoice 

that this Invoice Detail belongs 

to.  In most cases the invoice 

detail record will show as a 

single line item on that Invoice. 

CMS1500 > invd_Invh 

(Hidden) 

IDUB04 > invd_InvhID 

(Hidden) 

UB04Invoice > invd_InvhID 

(Hidden) 

UB92Invoice > invd_InvhID 

(Hidden) 

 

invd_SchedulePayerID 

Schedule payer ID field of the 

invoice details. 

Each Schedule has a list of 

payers associated with it.  This 

Schedule/Payer relationship is 

stored in T_Schedule-

Payers.  This ID points back to 

the Schedule Payer record that 

is being billed for this Invoice 

Detail.  If a Schedule is split 

between multiple Invoice 

Details then each of those 

Invoice Details should point to 

the same Schedule Payer.  For 

a single Invoice, every 

Schedule Payer record 

associated with the Invoice 

Details on that Invoice should 

point to the same Payer Entity, 

that Payer Entity should match 

the PayerID on the Invoice 

Header, and should match the 

PayerID on all Invoice Details 

for that Invoice.  This field is 

nullable but should always 

have a value if it cascades 

down from the Schedule 

or Schedule Expense 

records.  Some examples of 

records where this field will be 

NULL are PPS items (RAP, 

Final), Taxes, and Estimated 

Charges. 

Payment Postings > Payment 

and Postings > invd_Schedule-

PayerID (Hidden) 

CMS1500 > invd_Schedule-

PayerID (Hidden) 

Invoice Postings > invd_-

SchedulePayerID (Hidden) 

UB04 > invd_SchedulePayer-

ID (Hidden) 

bigint  8 True   
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UB04Invoice > invd_Schedule-

PayerID (Hidden) 

UB92Invoice > invd_Schedule-

PayerID (Hidden) 

 

invd_ServiceCodeID 

Service code ID field of the 

invoice details.  This points 

back to the T_ServiceCode 

and cascades down from 

either the Schedule record or 

the Schedule Expense 

record.  This field is nullable 

but should always have a 

value if it cascades down from 

the Schedule or Expense 

records.  Some examples of 

records where this field will be 

NULL are PPS items (RAP, 

Final), Taxes, and Estimated 

Charges. 

int  4 True   

 

invd_ScheduleExpenseID 

Expense ID field of the invoice 

details.  This points back to the 

Schedule Expenses.  This field 

is nullable and will only have a 

value if this data cascades 

down from a Schedule 

Expense.  In queries, if you're 

looking to identify which 

Invoice Details records are 

expenses you can look at this 

field and if it's not NULL that 

record is an 

expense.  Alternatively you can 

join to the service code table 

and verify that the IsExpense 

value is 1. 

bigint  8 True   

 

invd_ScheduleID 

Schedule ID field of the invoice 

details.  This points back to the 

Schedule.  This field is nullable 

but should always have a 

value if the record cascades 

down from the Schedule or 

Schedule Expense record.  In 

queries, if you're looking to 

identify which records are 

Schedules or Expenses you 

can look at this field and if it's 

not NULL that record is a 

Schedule (Service) or 

Expense. 

bigint  8 True   

 
invd_BranchID 

Branch ID field of the invoice 

details.  This BranchID should 

match the BranchID on both 

the Invoice Header and the 

Invoice Batch. 

int  4 False   
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invd_PayerID 

Payer ID field of the invoice 

details.  This PayerID should 

match the PayerID on the 

InvoiceHeader.  If the 

SchedulePayerID has a value 

then this PayerID should 

match the PayerID on that 

SchedulePayer record. 

bigint  8 False   

(2)

 

invd_ClientID 

Client ID field of the invoice 

details.  ClientID can also be 

on the InvoiceHeader, but the 

ClientID on the InvoiceHeader 

is not guaranteed, it's only 

used by some Bill Types.  The 

ClientID on the Invoice Detail 

is required and should be 

relied on for any queries that 

involve the ClientID. 

Payment Postings > Payment 

and Postings > invd_ClientID 

(Hidden) 

CMS1500 > invd_Client-

ID (Hidden) 

Invoice Postings > invd_Client-

ID (Hidden) 

UB04Invoice > invd_Client-

ID (Hidden) 

UB92Invoice > invd_Client-

ID (Not hidden) 

bigint  8 False   

 invd_RateSource 

 

Rate source field of the invoice 

details.  The values in this field 

correspond to the values in the 

BillRatesType.RatesOverride-

Type in the Application.  This 

field should be a fairly accurate 

indication of what created this 

record and where the rate from 

the record came from.  It's not 

entirely dependable though.  In 

particular it fails for PPS 

records where it is NULL in at 

least some situations, but I 

suspect it fails some other 

places also.  I believe when 

the rate comes off the 

Schedule or Expense then this 

field is also NULL.  Other 

situations where this will be 

NULL are Taxes and 

Estimated Charges.  So this 

field is mostly useful for 

determining which rate 

schedule was used to pull this 

tinyint  1 True   
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rate, but if used with a few 

other fields like Schedule, 

Expense, RevCode, Include-

Taxes, and a couple fields off 

the Header you can make a 

pretty accurate breakdown of 

where each records rate 

comes from.  This RateSource 

is specific to the Charge 

Rate.  There are similar 

columns to this for the OT Rate 

Source and Contract Rate 

Source. 

OfficeRates '0 

PayerOfficeRates '1 

PayerOfficeAreaRates '2 

ClientRates '3 

ClientCaregiverRates '4 

CaregiverRates '5 

Charts '6 

Schedule '7 

Expense '8 

PPS '9 

NotFound '10 

Service '11 

WeeklyOT '12 

WeeklyOTAdjustment '13  

PayrollAdjustment '14  

Tax '15 

 

invd_RateID 

Rate ID field of the invoice 

details.  This points back to the 

Rates table.  This field is 

nullable but will always have a 

value if the rate was cascaded 

from a Rates record.  In all 

other situations this field will be 

NULL. 

bigint  8 True   

 invd_ChargeRate 

Charge rate field of the invoice 

details. Called Rate, Bill-

Rate, DetailsCharge-

Rate, ChargeRate.  This is the 

Rate that is used in the 

calculation of the expected 

revenue (invd_Allocated-

ChargeWOTax) of this 

record.  The RateSource field 

of this table mostly describes 

where this Rate came from. 

Payment Postings > Payment 

and Postings > Chrg Rate (Not 

hidden) 

smallmoney  4 False   
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CMS1500 > invd_ChargeRate 

(Hidden) 

Invoice Postings > Chg Rate 

(Not hidden) 

UB04 > invd_ChargeRate 

(Hidden) 

UB04Invoice > invd_Charge-

Rate (Hidden) 

UB92Invoice > invd_Charge-

Rate (Hidden) 

 invd_InvoiceRate 

Invoice rate field of the invoice 

details.  This is the rate that is 

used in calculating the amount 

that typically shows on the 

Invoice.  It is slightly different 

than the ChargeRate in that it 

determines what the Payer 

wants to see on the Invoice 

and not what the expected 

revenue of this record is.  Each 

Bill Type is different though 

and they don't always rely on 

this field.  The source of this 

rate will vary, but it will 

sometimes be determined by 

settings on the Payer.  In 

cases where the Invoice 

should show the same value 

as the expected revenue this 

will field will usually be NULL. 

CMS1500 > invd_InvoiceRate 

(Hidden) 

UB04 > invd_InvoiceRate 

(Hidden) 

UB04Invoice > invd_Invoice-

Rate (Hidden) 

UB92Invoice > invd_Invoice-

Rate (Hidden) 

smallmoney  4 True   

 invd_ChargeUnits 

Charge units field of the 

invoice details. Called Details-

Units, . The sum of all invd_-

ChargeUnits is called BillUnits, 

ServiceUnits, Charge-

Units or chg_units.  This is the 

number of units of the Service, 

Expense, or other line item 

type being billed.  The 

calculation of expected 

revenue is very complicated, 

but in most single payer 

situations the expected 

revenue of the line item will be 

equal to the ChargeUnits * 

ChargeRate.  You can usually 

guess where this field was set, 

decimal(18,8)  9 False   



198 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

but it will vary per Bill Type.  In 

most Schedule situations it's 

reverse engineered from the 

ChargeUnitFlag and the 

duration fo the Schedule.  This 

field applies mostly to the 

ChargeRate, the other Rates in 

the record will have their own 

Units fields associated with 

them.  I say mostly because 

there are some complex 

situations where the 

chargeunits may have an 

effect on how fields other than 

the expected revenue (invd_-

AllocatedChargeWOTax) are 

calculated. 

Payment Postings > Payment 

and Postings > Chrg Units (Not 

hidden) 

CMS1500 > invd_ChargeUnits 

(Hidden) 

Invoice Postings > Chg 

Units (Not hidden) 

UB04 > invd_ChargeUnits 

(Hidden) 

UB04Invoice > invd_Charge-

Units (Hidden) 

UB92Invoice > invd_Charge-

Units (Hidden) 

 invd_ChargeUnitFlag 

Charge unit flag field of the 

invoice details. Shows how it 

was charged. The MAX invd_-

ChargeUnitFlag is called unit-

Flag.  This field describes the 

type of Units we're dealing 

with.  It refers back to the Unit-

Flags table.  For any value 

greater than 0 we're dealing 

with a time based unit.  In 

these cases the value is the 

number of minutes of the 

Unit.  For example 1 would 

mean that each unit was 

equivalent to 1 minute, while 

30 would mean each unit was 

equivalent to a half hour.  the 

Value 0 is a little more flexible 

and usually refers to Visits for 

Schedules and the ambiguous 

Units for everything else.  This 

field is sometimes used when 

rates/units etc need to be 

amortized or allocated in a 

complex manor.  This field 

applies mostly to the Charge-

Units and ChargeRate, but the 

smallint  2 True   
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calculations for amounts are 

complex and there are 

situations where this value will 

be used in the determination of 

Amounts other than the 

expected revenue. 

CMS1500 > invd_ChargeUnit-

Flag (Hidden) 

UB04 > invd_ChargeUnitFlag 

(Hidden) 

UB04Invoice > invd_Charge-

UnitFlag (Hidden) 

UB92Invoice > invd_Charge-

UnitFlag (Hidden) 

 invd_InvoiceUnits 

Invoice units field of the invoice 

details.  This is the number of 

units used in the calculation of 

the InvoiceAmount, which is 

typically the Amount shown on 

the Invoice which is not 

necessarily the amount of 

expected revenue.  It is also 

typically the number of units 

shown on the Invoice, but 

again, each BillType is 

different and it is not 

guaranteed to use the Invoice-

Units. 

CMS1500 > invd_InvoiceUnits 

(Hiden) 

UB04 > invd_InvoiceUnits 

(Hidden) 

UB04Invoice > invd_Invoice-

Units (Hidden) 

UB92Invoice > invd_Invoice-

Units 

decimal(18,8)  9 True   

 invd_InvoiceUnitFlag 

Invoice unit flag field of the 

invoice details.  It refers back 

to the UnitFlags table.  For any 

value greater than 0 we're 

dealing with a time based 

unit.  In these cases the value 

is the number of minutes of the 

Unit.  For example 1 would 

mean that each unit was 

equivalent to 1 minute, while 

30 would mean each unit was 

equivalent to a half hour.  the 

Value 0 is a little more flexible 

and usually refers to Visits for 

Schedules and the ambiguous 

Units for everything else.  This 

field is sometimes used when 

rates/units etc need to be 

amortized or allocated in a 

smallint  2 True   
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complex manor.  This field 

applies to the InvoiceUnits and 

InvoiceRate. 

CMS1500 > invd_InvoiceUnit-

Flag (Hidden) 

UB04 > invd_InvoiceUnitFlag 

(Hidden) 

UB04Invoice > invd_Invoice-

UnitFlag (Hidden) 

UB92Invoice > invd_Invoice-

UnitFlag (Hidden) 

 
invd_ChargeFlag 

Charge flag field of the invoice 

details.  This field is used in 

determining how to calculate 

the Invoice Header Charge-

Total.  It's mostly used to effect 

the value shown on PPS 

Invoices where the Invoice 

needs to display a Total that 

doesn't match the sum of 

expected revenue or the 

Display Amount. 

CMS1500 > invd_ChargeFlag 

(Hidden) 

UB04 > invd_ChargeFlag 

(Hidden) 

UB04Invoice > invd_Charge-

Flag (Hidden) 

UB92Invoice > invd_Charge-

Flag 

0: Charge  - Invoice Total from 

Charge Fields (Default) 

1: Charge - Invoice Total from 

Invoice Fielda (RAP) 

2: No Charge - Invoice Total 

from Charge Fields (Final 

Claim) 

3: No Charge - Invoice Total 

from Invoice Fields  

4: Charge - Invoice Total from 

TotalCharge Field (invd_Total-

Charges), before allocation 

due to payer's split types. 

tinyint  1 False  ((0)) 

 invd_SplitType 

Split type field of the invoice 

details.  This one character 

field explains the logic used in 

allocating charges across 

multiple payers.  It's uses are 

more complex though, and I 

would use it very carefully if at 

all.  It usually cascades down 

from the Schedule Payers 

record associated with this 

Invoice Detail.  But it defaults 

char(1)  1 False  ('S') 
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to S which can be confusing 

for situations where it was not 

specifically set.  And I believe 

there are situations where the 

SchedulePayers and 

ScheduleShiftPayers have 

values other than what shows 

in this field.  I believe during 

the transfer process the value 

T is used on the Invoice Detail, 

no Schedule Payer record is 

created, and a different value 

is used in the ScheduleShift-

Payer.  Anyway, just be careful 

if you need to use this field 

search out the local experts 

who will probably need to do a 

significant amount of 

research.  This field mostly 

associates with the values in 

the application list created by 

ListItemsUtility.GetBillSplit-

TypeListItems.  But there are 

some situations, like the value 

T where they are not 

selectable so they are not in 

the Application. 

Values 

-------------------------------------- 

B - Balance 

S - Split 

V - Visit 

H - Hourly Benefit 

I - Schedule Hourly Benefit 

D - Daily Benefit 

W - Weekly Benefit 

M - Monthly Benefit 

C - COB Managed 

T - Transfer 

 

Payment Postings > Payment 

and Postings > Split Type (Not 

hidden) 

CMS1500 > invd_SplitType 

(Hidden) 

Invoice Postings > Split 

Type (Not hidden) 

UB04Invoice > invd_SplitType 

(Hidden) 

UB92Invoice > invd_SplitType 

(Not hidden) 

 invd_BenefitDate 

Benefit Date field of the invoice 

details. Non-UTC date.This 

datetime  8 True   
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field used to be invd_Daily-

BenefitDay. It was changed to 

invd_BenefitDate in order to 

support Monthly, Weekly, and 

Hourly Benefit Allocation in 

addition to Daily Benefit 

Allocation. We need to take a 

closer look at the logic used in 

this field and the associated 

ScheduleShiftPayer fields and 

describe the use for each 

allocation type.  This field will 

be set for certain Benefit Split-

Types (D - Daily, W - Weekly, 

M - Monthly).  You'll notice that 

it's not set for either of the 

Hourly Benefit Types (H - 

Hourly, I - Schedule 

Hourly).  This is because those 

Invoice Details are summed 

together on the Invoice, so 

their particular date (which is a 

particular hour of the day) is 

meaningless after they are 

merged into a single record. 

CMS1500 > invd_BenefitDate 

(Hidden) 

UB04Invoice > invd_Benefit-

Date (Hidden) 

UB92Invoice > invd_Benefit-

Date (Not hidden) 

 invd_PmtAllowance 

Payment allowance field of the 

invoice details. Max allowed for 

the benefit period. 

CMS1500 > invd_Pmt-

Allowance (Hidden) 

UB04Invoice > invd_Pmt-

Allowance (Hidden) 

UB92Invoice > invd_Pmt-

Allowance (Not hidden) 

money  8 True   

 invd_SplitPercent 

Split percent field of the invoice 

details. How much it is being 

split.  This is used to determine 

the percent of the expected 

revenue to allocated to this 

Invoice Detail when the Split 

Type is S - Split 

Payment Postings > Payment 

and Postings > Split 

% (Hidden) 

CMS1500 > invd_SplitPercent 

(Hidden) 

Invoice Postings > Split % (Not 

hidden) 

decimal(5,4)  5 False  ((1)) 
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UB04 > invd_SplitPercent 

(Hidden) 

UB04Invoice > invd_Split-

Percent (Hidden) 

UB92Invoice > invd_Split-

Percent (Not hidden) 

 invd_Description 

Description field of the invoice 

details. Called 

Returned as ItemDescription 

if ServiceGrouping is 

NULL.Returned as Details-

ServiceName or Service-

Grouping if T_Service-

Code.svcc_Name is NULL. 

Returned as svcc_-

Name, ServiceName or 

Code if OverrideService-

Code.svcc_Name, System-

ServiceCode.svcc_Name, T_-

InvoiceDetails.invd_-

Description, T_Service-

Code.svcc_Name in different 

combinations are 

NULL.Payment Postings > 

Payment and Postings > 

Service Code (Not hidden) 

CMS1500 > invd_Description 

(Hidden) 

Invoice Postings > Description 

(Not hidden) 

UB04 > 43 DESCRIPTION 

(Not Hidden) 

UB04Invoice > 43 

DESCRIPTION (Not Hidden) 

UB92Invoice > 43 

DESCRIPTION (Not Hidden) 

nvarchar(100)  200 True   

 
invd_BillCodeID 

Bill code ID field of the invoice 

details.  refers back to the Bill-

Code table.  The Bill Code 

records are mostly used to 

determine the value in the 

RevCode field, which is mostly 

or entirely used by the UB04 

Bill Types.  I believe this field 

relates directly to T_BillCodes 

but will cascade down from the 

T_ServiceCodes.svcc_Bill-

CodeID.  Each Payer has their 

own values for Rev Code 

stored in the T_PayerBillCodes 

table.  VERY IMPORTANT - 

This field is in NO WAY related 

to the invd_BillCode field, 

they're TOTALLY 

different.  That they are directly 

int  4 True   
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next to each other in the table 

is a HUGE mind destroying 

accident. 

 invd_BillCode 

Bill code field of the invoice 

details.  This field is one of the 

most confusingly named 

fields.  invd_BillCode is not 

related to T_BillCodes which is 

related to invd_RevCode.  But 

invd_BillCode is related to T_-

Schedules.sch_RevenueCode, 

which is not related to invd_-

RevCode.  So... yeah.  It's also 

frequently called ChargeFlag in 

the drafting process which is 

confusing because it's very 

related to the field invd_-

ChargeFlag.  I think there were 

several attempts to rename 

things that ended in this 

mess.  But basically this is the 

field that determines whether a 

service/expense is billable.  It 

will usually cascade down from 

the schedule, but it's a field 

that's used differently all over 

the place.  Here are the 

simplest values. 

0: Default1: Billable2: Billable 

No Charge3: Not Billable 

4: A special value used by the 

1500 to effect invd_Charge-

Flag 

CMS1500 > invd_BillCode 

(Hidden) 

UB04 > invd_BillCode 

(Hidden) 

UB04Invoice > invd_BillCode 

(Hidden) 

tinyint  1 True   

 invd_SchShfID 

Schedule shift ID field of the 

invoice details.  refers back to 

the ScheduleShifts 

table.  During the draft each 

schedule will be broken up by 

Shift and occasionally some 

other reasons (like crossing 

midnight).  These records are 

stored in the ScheduleShifts 

table and are used to calculate 

the total amount for a given 

Schedule Shift.  This is then 

allocated across all the payers 

for that Schedule and Shift 

which then cascades down to 

an individual Invoice 

Detail.  There have been some 

bigint  8 True   
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issues with this field not getting 

updated appropriately in the 

past.  You can usually count 

on this being correct, but there 

may be some undiscovered 

data errors. 

 invd_ShiftNo 

Shift No field of the invoice 

details. Called invd_ShiftNo, 

Shift_Number or Shift_Name. 

Valid values are NULL and 

from 0 through 6. 

CMS1500 > invd_ShiftNo 

(Hidden) 

UB04 > invd_ShiftNo (Hidden) 

UB04Invoice > invd_ShiftNo 

(Hidden) 

UB92Invoice > invd_Shift-

No (Not hidden) 

tinyint  1 True  ((1)) 

 
invd_HolidayID 

Holiday ID field of the invoice 

details. Also called invd_-

HolidayID.  If this record is 

affected by holiday rates you 

this ID will refer back to the 

Branch Holidays table 

bigint  8 True   

 invd_HolidayAdd 

Holiday add field of the invoice 

details. 

CMS1500 > invd_HolidayAddn 

(Hidden) 

UB04 > invd_HolidayAdd 

(Hidden) 

UB04Invoice > invd_Holiday-

Add (Hidden) 

UB92Invoice > invd_Holiday-

Add (Not hidden) 

smallmoney  4 True   

 invd_HolidayMult 

Holiday mult. field of the 

invoice details. 

CMS1500 > invd_HolidayMult 

(Hidden) 

UB04 > invd_HolidayMult 

(Hidden) 

UB04Invoice > invd_Holiday-

Mult (Hidden) 

UB92Invoice > invd_Holiday-

Mult (Not hidden) 

decimal(6,2)  5 True   

 invd_ServiceDateFrom 

Starting date of the service. 

Service date from field of the 

invoice details. Non-UTC 

date. Also called invd_-

datetime  8 False   
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MedicareExpenseDate-

From, invd_ServiceDate-

To, RAPFBVDate, Visit Date, 

ScheduleStart, StartTime, Inv-

VisitStartDate, DetailsService-

Date, ServiceMonth, invh_-

Date, invd_ServiceDate-

From, ServiceDate, Service-

DatePeriod, TransactionDate,  

CMS1500 > invd_ServiceDate-

From (Hidden) 

UB04Invoice > 45 SERV. 

DATE (Not hidden) 

UB92Invoice > 45 SERV. 

DATE (Not hidden) 

 invd_ServiceDateTo 

Ending date of the service. 

Service date to field of the 

invoice details. Non-UTC date. 

Also called EndTime, InvVisit-

EndDate, ServiceDateTo. 

CMS1500 > invd_ServiceDate-

To (Hidden) 

UB04 > invd_ServiceDate-

To (Hidden) 

UB04Invoice > invd_Service-

DateTo (Hidden) 

UB92Invoice > invd_Service-

DateTo (Hidden) 

datetime  8 True   

 invd_RevCode 

The revenue code field of the 

invoice details. 

CMS1500 > invd_RevCode 

(Hidden) 

UB04 > 42 REV CODE (Not 

hidden) 

UB04Invoice > 42 REV CODE 

(Not hidden) 

UB92Invoice > 42 REV CODE 

(Not hidden) 

nvarchar(14)  28 True   

 invd_HCPCS 

The Healthcare Common 

Procedure Coding System field 

of the invoice details. Also 

called RAPHIPPS. 

CMS1500 > invd_HCPCS (Not 

hidden) 

UB04 > 44 HCPCS / RATES 

(Hidden) 

UB04Invoice > 44 HCPCS / 

RATES (Hidden) 

UB92Invoice > 44 HCPCS / 

RATES (Not hidden) 

nvarchar(25)  50 True   
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 invd_1500POS 

The 1500 place of service 

code field of the invoice 

details. 

CMS1500 

> invd_1500POS (Not hidden) 

UB04 > invd_1500POS (Not 

hidden) 

UB04Invoice 

> invd_1500POS (Hidden) 

UB92Invoice 

> invd_1500POS (Hidden) 

int  4 True  ((12)) 

 invd_1500TOS 

The 1500 type of service code 

field of the invoice details. 

CMS1500 > invd_1500TOS 

(Hidden) 

UB04 

> invd_1500TOS (Hidden) 

UB04Invoice 

> invd_1500TOS (Hidden) 

UB92Invoice 

> invd_1500TOS (Hidden) 

int  4 True  ((0)) 

 invd_1500Diag 

The 1500Diag field of the 

invoice details. 

CMS1500 > invd_1500Diag 

(Hidden) 

UB04 

> invd_1500Diag (Hidden) 

UB04Invoice 

> invd_1500Diag (Hidden) 

UB92Invoice 

> invd_1500Diag (Hidden) 

int  4 True  ((1)) 

 invd_1500EPSDT 

Early and  Periodic Screening, 

Diagnostic, and Treatment field 

of the invoice details. 

CMS1500 

> invd_1500EPSDT (Not 

hidden) 

UB04 

> invd_1500EPSDT (Hidden) 

UB04Invoice 

> invd_1500EPSDT (Hidden) 

UB92Invoice 

> invd_1500EPSDT (Hidden) 

nvarchar(50)  100 True   

 invd_1500EMG 

1500EMG field of the invoice 

details. 

CMS1500 > invd_1500EMG 

(Not hidden) 

nvarchar(50)  100 True   
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UB04 

> invd_1500EMG (Hidden) 

UB04Invoice > invd_1500EMG 

UB92Invoice 

> invd_1500EMG (Hidden) 

 invd_1500COB 

Coordination of benefits field of 

the invoice details. 

CMS1500 

> invd_1500COB (Hidden) 

UB04 

> invd_1500COB (Hidden) 

UB04Invoice 

> invd_1500COB (Hidden) 

UB92Invoice 

> invd_1500COB (Hidden) 

nvarchar(50)  100 True   

 invd_1500LocalUse 

The 1500Local Use field of the 

invoice details. 

CMS1500 > invd_1500Local-

Use (Hidden) 

UB04 > invd_1500Local-

Use (Hidden) 

UB04Invoice 

> invd_1500LocalUse (Hidden) 

UB92Invoice 

> invd_1500LocalUse (Hidden) 

nvarchar(50)  100 True   

 invd_UB_FL49 

UB_FL49 field of the invoice 

details. 

CMS1500 > invd_UB_FL49 

(Hidden) 

UB04 > 49 (Not hidden) 

UB04Invoice > 49 (Hidden) 

UB92Invoice > invd_UB_-

FL49 (Not hidden) 

nvarchar(20)  40 True   

 invd_NonCovered 

Non covered field of the 

invoice details. 

CMS1500 > invd_Non-

Covered (Hidden) 

UB04 > 48 NON COV 

CHRGS (Not hidden) 

UB04Invoice > 48 NON COV 

CHRGS (Not hidden) 

UB92Invoice > 48 NON COV 

CHRGS (Not hidden) 

money  8 True   

 invd_TotalCharges 

Total charges field of the 

invoice details. Also 

called TotalChargeAmount. 

money  8 True   
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Payment Postings > Payment 

and Postings > invd_Total-

Charges (Hidden) 

CMS1500 > invd_Total-

Charges (Hidden) 

Invoice Postings > invd_Total-

Charges (Hidden) 

UB04 > invd_TotalCharges 

(Hidden) 

UB04Invoice > invd_Total-

Charges (Hidden) 

UB92Invoice > invd_Total-

Charges (Hidden) 

In any invoice processing that 

is build on Private Invoice 

process, this field will be set to 

==> (( invd_chargeUnits - 

invd_OTUnit )* invd_charge-

Rate +( invd_OTUnit * 

invd_chargeRate )* invd_-

OTMulti). This value will be 

used for either Standard 

Invoice reports, or when we 

want to used the Total Charge 

and not the allocated Charge / 

Amount. 

 invd_DiscountAmount 

Discount amount field of the 

invoice details. 

Payment Postings > Payment 

and Postings > invd_Discount-

Amount (Hidden) 

CMS1500 > invd_Discount-

Amount (Hidden) 

Invoice Postings > invd_-

DiscountAmount (Hidden) 

UB04 > invd_DiscountAmount 

(Hidden) 

UB04Invoice > invd_Discount-

Amount (Hidden) 

UB92Invoice > invd_Discount-

Amount (Not hidden) 

money  8 False  ((0)) 

 invd_DiscountPercent 

 

Payment Postings > Payment 

and Postings > invd_Discount-

Percent (Hidden) 

CMS1500 > invd_Discount-

Percent (Hidden) 

Invoice Postings > invd_-

DiscountPercent (Hidden) 

UB04 > invd_DiscountPercent 

(Hidden) 

decimal(5,4)  5 False  ((0)) 
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UB04Invoice > invd_Discount-

Percent (Hidden) 

UB92Invoice > invd_Discount-

Percent (Not hidden) 

 invd_CreatedDate 

The date the invoice detail was 

created. Also called Created-

Date. UTC date. 

datetime  8 False  (getutcdate()) 

 invd_CreatedUser 

The user who created the 

invoice detail; the user logged 

into the system when the 

invoice detail is created. Also 

called CreatedUser. 

nvarchar(50)  100 False   

 invd_ModifiedDate 

The most recent date the 

invoice detailed was modified. 

Also called ModifiedDate. UTC 

date. 

datetime  8 False  (getutcdate()) 

 invd_ModifiedUser 

The user who made the most 

recent modification to the 

invoice detail; the user logged 

into the system when the 

modification to the invoice 

detail is made. Also called 

ModifiedUser. 

nvarchar(50)  100 False   

 invd_TS 

Invoice detail time stamp. Also 

called TS. 

timestamp  8 False   

 invd_DisplayUnits 

Invoice detail units to display. 

Also called Unitsday_1 

through Unitsday_31 and  the 

sum of all Unitsday is called 

UnitsUsed. 

decimal(18,8) True 9 True   

 invd_DisplayRate 

Invoice detail rate. Also called 

Price. 

smallmoney True 4 False   

 invd_DisplayUnitFlag 

Shows how it was billed to the 

client. 

smallint True 2 True   

 invd_BatchTaxGrpID 

Depends on the value of 

Invd_IncludeTaxes: 

invd_IncludeTaxes = 2  the 

value from the The T_Branch-

Taxes is stored (brtx_ID). 

Invd_IncludeTaxes < 2 the 

value from T_InvoiceBatchTax-

Groups is stored (invbtg_ID) 

bigint  8 True   
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 invd_TotalTaxPercent 

The tax percent of the invoice 

detail. 

CMS1500 > invd_TotalTax-

Percent (Hidden) 

UB04Invoice > invd_TotalTax-

Percent (Hidden) 

UB92Invoice > invd_TotalTax-

Percent (Not hidden) 

decimal(10,6)  9 True   

 invd_TotalTaxFixedAmt 

Fixed tax amount of the invoice 

detail. 

CMS1500 > invd_TotalTax-

FixedAmt (Hidden) 

UB04Invoice > invd_TotalTax-

FixedAmt (Hidden) 

UB92Invoice > invd_TotalTax-

FixedAmt (Not hidden) 

money  8 True   

 invd_AcctExtDate 

invd_AcctExtDate of the 

invoice detail. Non-UTC date. 

CMS1500 > invd_AcctExtDate 

(Hidden) 

UB04 > invd_AcctExtDate 

(Hidden) 

UB04Invoice > invd_AcctExt-

Date (Hidden) 

UB92Invoice > invd_AcctExt-

Date (Not hidden) 

datetime  8 True   

 invd_Round 

 

Rouding method.0: No 

Rounding, 1: Round Up, 2: 

Truncate, 3: Round 

tinyint  1 False  ((3)) 

 invd_RoundDecimal 

The Invoice Line Number of 

decimals to round 

tinyint  1 False  ((2)) 

 invd_OTMulti 

Overtime multiplier factor of 

the invoice detail. 

CMS1500 > invd_-

OTMulti (Hidden) 

UB04 > invd_OTMulti (Hidden) 

UB04Invoice > invd_OTMulti 

(Hidden) 

UB92Invoice > invd_OTMulti 

(Not hidden) 

decimal(8,4)  5 False  ((1.5)) 

 invd_OTUnit 

Quantity of units considered 

overtime. 

CMS1500 > invd_-

OTUnit (Hidden) 

decimal(8,4)  5 False  ((0)) 
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UB04 > invd_OTUnit (Hidden) 

UB04Invoice > invd_OTUnit 

(Hidden) 

UB92Invoice > invd_OTUnit 

(Not hidden) 

 invd_IncludeEFT 

Electonic fund transfer field of 

the invoice detail. Also called 

InclEFT 

bit  1 True   

 
invd_ServiceUTCDateFrom 

Starting date/time fo service 

activity. UTC date updated by 

the UI based on widnows 

user's time zone. 

datetime  8 False   

 invd_ServiceUTCDateTo 

End date/time fo service 

activity. UTC date updated by 

the UI based on widnows 

user's time zone. 

datetime  8 True   

 invd_AllocatedAmt 

 Allocated Amount per Invoice 

Details. 

money  8 True   

 
invd_1500BillingModifierID1 

Billing modifier 1 of the invoice 

detail. Modifiers are used to 

increse the level of service 

specificity. 

Billing payers on a UB04 

and/or electronically with the 

837I file often includes the use 

of Modifiers. This is often 

necessary with Medicaid 

payers. The UB04 billing 

process includes the modifiers. 

This affects payers that have 

the bill types of UB04, UB04 

(Charge + Tax), and PPS 

Claim; and those that process 

the 5010 837I billing file. 

- Bill Type on Payers>Billing 

tab set to UB04- EDI Type on 

Payers>EDI Settings tab is set 

to 5010 837I- Set the Modifiers 

on the Payers>Payer Services 

tab. Each Service Code can 

have up to four Modifiers. 

- The Schedule Details>1500 

tab is used for both 1500 and 

UB04 modifiers and displays 

the modifiers from the Payer IF 

the user creating and/or 

completing the schedule has 

permission to this tab 

[permission to 

Schedule.H1500 and 

Schedule.H1500C]. 

int  4 True   
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- Modifier columns may be 

added to the Schedule List 

View layout for 

easier reviewing for Payers 

that require modifiers. 

- The UB04 invoice batch 

displays the HCPC and 

Modifiers in the HCPCS 

column in the grid (UB04 does 

not have a separate locator for 

the modifiers). 

- The UB04 Preview form also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. 

- The UB04 invoice report also 

displays the HCPC and 

Modifiers in the 

HCPCS locator.  

CMS1500 > invd_1500Billing-

ModifierID1 (Not hidden) 

UB04Invoice 

> invd_1500BillingModifierID1 

(Hidden) 

UB92Invoice 

> invd_1500BillingModifier-

ID1 (Not hidden) 

 
invd_1500BillingModifierID2 

Billing modifier 2 of the invoice 

detail. Modifiers are used to 

increse the level of service 

specificity. 

Billing payers on a UB04 

and/or electronically with the 

837I file often includes the use 

of Modifiers. This is often 

necessary with Medicaid 

payers. The UB04 billing 

process includes the modifiers. 

This affects payers that have 

the bill types of UB04, UB04 

(Charge + Tax), and PPS 

Claim; and those that process 

the 5010 837I billing file. 

- Bill Type on Payers>Billing 

tab set to UB04- EDI Type on 

Payers>EDI Settings tab is set 

to 5010 837I- Set the Modifiers 

on the Payers>Payer Services 

tab. Each Service Code can 

have up to four Modifiers. 

- The Schedule Details>1500 

tab is used for both 1500 and 

UB04 modifiers and displays 

the modifiers from the Payer IF 

the user creating and/or 

completing the schedule has 

int  4 True   
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permission to this tab 

[permission to 

Schedule.H1500 and 

Schedule.H1500C]. 

- Modifier columns may be 

added to the Schedule List 

View layout for 

easier reviewing for Payers 

that require modifiers. 

- The UB04 invoice batch 

displays the HCPC and 

Modifiers in the HCPCS 

column in the grid (UB04 does 

not have a separate locator for 

the modifiers). 

- The UB04 Preview form also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. 

- The UB04 invoice report also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. CMS1500 

> invd_1500BillingModifier-

ID2 (Not hidden) 

UB04Invoice 

> invd_1500BillingModifierID2 

(Hidden) 

UB92Invoice 

> invd_1500BillingModifier-

ID2 (Not hidden) 

 
invd_1500BillingModifierID3 

Billing modifier 3 of the invoice 

detail. Modifiers are used to 

increse the level of service 

specificity. 

Billing payers on a UB04 

and/or electronically with the 

837I file often includes the use 

of Modifiers. This is often 

necessary with Medicaid 

payers. The UB04 billing 

process includes the modifiers. 

This affects payers that have 

the bill types of UB04, UB04 

(Charge + Tax), and PPS 

Claim; and those that process 

the 5010 837I billing file. 

- Bill Type on Payers>Billing 

tab set to UB04- EDI Type on 

Payers>EDI Settings tab is set 

to 5010 837I- Set the Modifiers 

on the Payers>Payer Services 

tab. Each Service Code can 

have up to four Modifiers. 

- The Schedule Details>1500 

tab is used for both 1500 and 

int  4 True   
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UB04 modifiers and displays 

the modifiers from the Payer IF 

the user creating and/or 

completing the schedule has 

permission to this tab 

[permission to 

Schedule.H1500 and 

Schedule.H1500C]. 

- Modifier columns may be 

added to the Schedule List 

View layout for 

easier reviewing for Payers 

that require modifiers. 

- The UB04 invoice batch 

displays the HCPC and 

Modifiers in the HCPCS 

column in the grid (UB04 does 

not have a separate locator for 

the modifiers). 

- The UB04 Preview form also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. 

- The UB04 invoice report also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. CMS1500 

> invd_1500BillingModifier-

ID3 (Not hidden) 

UB04Invoice 

> invd_1500BillingModifierID3 

(Hidden) 

UB92Invoice 

> invd_1500BillingModifier-

ID3 (Not hidden) 

 
invd_1500BillingModifierID4 

Billing modifier 4 of the invoice 

detail. Modifiers are used to 

increse the level of service 

specificity. 

Billing payers on a UB04 

and/or electronically with the 

837I file often includes the use 

of Modifiers. This is often 

necessary with Medicaid 

payers. The UB04 billing 

process includes the modifiers. 

This affects payers that have 

the bill types of UB04, UB04 

(Charge + Tax), and PPS 

Claim; and those that process 

the 5010 837I billing file. 

- Bill Type on Payers>Billing 

tab set to UB04- EDI Type on 

Payers>EDI Settings tab is set 

to 5010 837I- Set the Modifiers 

on the Payers>Payer Services 

int  4 True   
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tab. Each Service Code can 

have up to four Modifiers. 

- The Schedule Details>1500 

tab is used for both 1500 and 

UB04 modifiers and displays 

the modifiers from the Payer IF 

the user creating and/or 

completing the schedule has 

permission to this tab 

[permission to 

Schedule.H1500 and 

Schedule.H1500C]. 

- Modifier columns may be 

added to the Schedule List 

View layout for 

easier reviewing for Payers 

that require modifiers. 

- The UB04 invoice batch 

displays the HCPC and 

Modifiers in the HCPCS 

column in the grid (UB04 does 

not have a separate locator for 

the modifiers). 

- The UB04 Preview form also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. 

- The UB04 invoice report also 

displays the HCPC and 

Modifiers in the 

HCPCS locator. CMS1500 

> invd_1500BillingModifier-

ID4 (Not hidden) 

UB04Invoice 

> invd_1500BillingModifierID4 

(Hidden) 

UB92Invoice 

> invd_1500BillingModifier-

ID4 (Not hidden) 

 invd_ProviderNPI 

Caregiver NPI number 

(National Provider Number) 

that performed the service of 

the invoice detail. 

CMS1500 > invd_Provider-

NPI (Not hidden) 

UB04Invoice > invd_Provider-

NPI (Hidden) 

UB92Invoice > invd_Provider-

NPI (Not hidden) 

nvarchar(10)  20 True   

 invd_OtherIDType 

Other ID type of referring 

provider of the invoice detail. 

CMS1500 > invd_Other-

IDType (Not hidden) 

nvarchar(2)  4 True   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 217 

UB04Invoice > invd_Other-

IDType (Hidden) 

UB92Invoice > invd_Other-

IDType (Not hidden) 

 invd_OtherID 

Other ID number of referring 

provider of the invoice detail. 

CMS1500 > invd_OtherID (Not 

hidden) 

UB04Invoice > invd_OtherID 

(Hidden) 

UB92Invoice > invd_Other-

ID (Not hidden) 

nvarchar(50)  100 True   

 
invd_AuthorizationID 

Authorization ID of the 

authorized service of the 

invoice detail. Also called Auth-

ID. 

bigint  8 True   

 invd_AuthDetailID 

Authorization detail ID of the 

authorized service of the 

invoice detail. 

bigint  8 True   

 invd_AuthCode 

Payment authorization code of 

the invoice detail. Also called 

AuthCode. 

nvarchar(50)  100 True   

 invd_DefDaysRem 

 

Payment deferral status code 

of the invoice detail.0: No 

deferral 

1: Deferral in progress 

2: Deferral completed 

tinyint  1 False  ((0)) 

 
invd_IncludeTaxes 

Include taxes status code of 

the invoice detail. 

0: Off ( Not to include taxes in 

the Charge total) 

1: On ( Include taxes in the 

Charge total) 

2: Taxes Only for charge total 

3: Taxes record from Transfer 

Process 

Payment Postings > Payment 

and Postings > (Hidden) 

CMS1500 > invd_Include-

Taxes (Hidden) 

Invoice Postings > invd_-

IncludeTaxes (Not hidden) 

UB04Invoice > invd_Include-

Taxes (Hidden) 

tinyint  1 False  ((0)) 



218 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

UB92Invoice > invd_Include-

Taxes (Not hidden) 

 
invd_RegionID 

The region ID of the branch of 

the invoice detail. 

int  4 True   

 invd_AdmissionID 

The admission ID of the client 

of the invoice detail. 

bigint  8 True   

 
invd_DetailsType 

 

Details type code of the invoice 

detail.0 : Service  

1 : Expense  

2 : Tax 

tinyint  1 False   

 invd_AdjustedChargeTotal 

Charge Total plus all Invoice 

Adjustments 

money  8 True   

 invd_Balance 

Total charges plus any 

postings against the invoice 

details record. It can be 

negative. 

money  8 True   

 invd_TotalRevAdjustments 

Total  Revenue Adjustment 

Postings against the Invoice 

Details ( posttyp_PostingType 

= 1 ) 

UB92Invoice > invd_TotalRev-

Adjustments (Not hidden) 

money  8 False  ((0)) 

 invd_TotalNonRevAdjustments 

Total Non Revenue 

Adjustment Postings against 

the Invoice Details (posttyp_-

PostingType = 3 ) 

UB92Invoice > invd_TotalNon-

RevAdjustments (Not hidden) 

money  8 False  ((0)) 

 invd_TotalPayments 

Total payment postings against 

the Invoice Details (posttyp_-

PostingType = 0) 

UB92Invoice > invd_Total-

Payments (Not hidden) 

money  8 False  ((0)) 

 
invd_InvoiceGroupID 

Grouping based on invh_-

GroupingProcessID. 

0 - No grouping used on this 

Invoice, invd_InvoiceGroupID 

= invd_ID 

1 - HCFA 1500 grouping used 

on this invoice.  Invoice Details 

will be grouped by HCPCS 

code, Auth Code, Modifiers, 

bigint  8 True   
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and Unit Flag.  The invd_-

InvoiceGroupID for grouped 

details will be the MIN(invd_ID) 

for that grouping. 

 
invd_InvoiceGroupCount 

Used to help in applying 835 

payments when Invoices are 

grouped on the 837 

int  4 True  ((1)) 

 invd_ScheduleNote 

Taken from the associated T_-

Schedules.sch_Description 

column for NON Schedule 

Expense Invoice Details (this 

includes schedules with 

multiple services stored in T_-

ScheduleExpenses).   

This applies to any Invoice 

Process that uses usp_-

InvoiceBatch_DraftPrivate.   

This also applies to any 

Invoice created through a 

transfer.   

This field will always be NULL 

for expenses and PPS Invoice 

Processes.   

This will be displayed below 

the Invoice Details on the 

Standard and Payer Invoices 

depending on the values in T_-

Branches.br_InvParm_Display-

SchNotes and T_Payers.pay_-

InvParm_DisplaySchNotes. 

CMS1500 > invd_Schedule-

Note (Hidden) 

UB04Invoice > invd_Schedule-

Note (Hidden) 

UB92Invoice > invd_Schedule-

Note (Not hidden) 

nvarchar(4000)  8000 True   

 invd_NoCalcUnits 

Used with the 1500 in cases 

where we want to show Units 

on the Invoice that ultimately 

aren't used in calculations for 

any of the Amount fields 

(expected revenue or display 

amount, etc) 

decimal(18,8)  9 True   

 invd_NoCalcUnitFlag 

Used with the 1500 in cases 

where we want to show Units 

on the Invoice that ultimately 

aren't used in calculations for 

any of the Amount fields 

(expected revenue or display 

amount, etc) 

smallint  2 True   



220 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

 invd_NoCalcDateFrom 

Non-UTC date. 

datetime  8 True   

 invd_DisplayDateFrom 

Date to display invoice details 

from. Non-UTC date. 

CMS1500 > invd_DisplayDate-

From (Not hidden) 

UB04Invoice > invd_Display-

DateFrom (Not hidden) 

UB92Invoice > invd_Display-

DateFrom (Not hidden) 

datetime True 8 False   

 invd_NoCalcDateTo 

Non-UTC date. 

datetime  8 True   

 invd_DisplayDateTo 

Date to display invoice details 

to. Non-UTC date. 

CMS1500 > invd_DisplayDate-

To (Not hidden) 

UB04Invoice > invd_Display-

DateTo (Not hideen) 

UB92Invoice > invd_Display-

DateTo (Not hideen) 

datetime True 8 True   

 invd_TaxPortion 

This is the exact portion of this 

service that's applied to taxes 

money  8 True   

 invd_TotalTaxes 

Total amount of taxes of the 

invoice detail. Also called 

Taxes 

UB04Invoice > invd_Total-

Taxes (Hidden) 

UB92Invoice > invd_Total-

Taxes (Not hidden) 

money True 8 True   

 invd_ContractRate 

Contract rate of the invoice 

detail. 

smallmoney  4 True   

 invd_ContractRateSource 

Source of contract rate of the 

invoice detail. 

tinyint  1 True   

 invd_ContractRateID 

Contract rate ID of the invoice 

detail. 

int  4 True   

 invd_1500DiagLabel 

The actual diagnosis pointers 

displayed in the 1500 detail 

section (FL24E). The original 

goal was to not store this on 

the table, but it caused too 

many issues because it was 

required to know the version of 

the 1500 used in order to 

create this string from the 

bitfield stored in 

nvarchar(4)  8 True   
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invd_1500Diag.  I have left that 

field intact, but added this field 

to be used in the 1500 

preview. It should only be 

updated in the 1500 draft 

processes. 

UB04Invoice > invd_1500Diag-

Label (Not hidden) 

 invd_ScheduleShiftPayersID 

This field refers back to the T_-

ScheduleShiftPayers 

table.  The relationship 

between T_InvoiceDetails, T_-

ScheduleShifts, and T_-

ScheduleShiftPayers is 

complex.  I wouldn't say that 

T_ScheduleShiftPayers is a 

many to many relationship to 

T_InvoiceDetails.  But I will at 

least say it's a one to many 

AND a many to one 

relationship.  This confusion is 

mostly due to the Benefit split 

types.  Where multiple Invoice 

Details can point back to a 

single Schedule Shift Payer for 

Daily, Weekly, and Monthly 

split types and multiple 

Schedule Shift Payers can 

point back to a single Invoice 

Detail record for Hourly and 

Schedule Hourly split 

types.  So using these 2 tables 

together in a query can be 

complex, Definitely seek the 

help of the local expert when 

using. 

bigint  8 True   

 

invd_TransferFromInvoice-

DetailID 

Used in the COB 

process.  This will point back to 

the Invoice Detail record that 

the current Invoice Detail 

record was transferred from. 

bigint  8 True   

 

invd_TransferToInvoiceDetail-

ID 

Used in the COB 

process.  This will point back to 

the Invoice Detail record that 

the current Invoice Detail 

record was transferred to. 

bigint  8 True   

 invd_DraftID 

This is usde during the 

finalization process.  When we 

finalize we copy records from 2 

to 10 draft tables into finalized 

tables.  There is a complex 

relationship between all of 

bigint  8 True   
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these tables and it can be 

difficult to maintain that 

relationship during the 

copy.  The draft ID helps us 

link back to the draft record to 

relink a finalized child record to 

it's parent and to it's own 

children. 

 invd_OTRate 

Rate used with OTUnits in 

calculating the OT Charge. 

UB92Invoice > invd_-

OTRate (Not hidden) 

decimal(18,8)  9 False  ((0)) 

 invd_OTCalcType 

Describes the logic used in 

calculating the OT Charge for 

this Invoice Detail 

Values 

------------------------------------ 

0 - Default, This is equivalent 

to no OT being calculated. 

1 - Legacy, This uses the 

OTUnits and OTMultiplier 

manually added to the 

Schedule 

2 - Manual, This uses the 

OTUnits and looks up the 

appropriate OTRate 

3 - Automatic 

Client/Caregiver/Batch Order-

Allocated 

UB92Invoice > invd_OTCalc-

Type (Not hidden) 

tinyint  1 False  ((0)) 

 invd_PayrollBatchID 

Used by the Registry Invoice to 

link to the Payroll Batch 

containing Payroll Items for 

this schedule 

bigint  8 True   

 invd_OTRateSource 

Values: 

        OfficeRates = 0 

        PayerOfficeRates = 1 

        PayerOfficeAreaRates = 

2 

        ClientRates = 3 

        ClientCaregiverRates = 4 

        CaregiverRates = 5 

        Charts = 6 

        Schedule = 7 

        Expense = 8 

        PPS = 9 

        NotFound = 10 

tinyint  1 False  ((255)) 
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        Service = 11 

        WeeklyOT = 12 

        WeeklyOTAdjustment = 

13 

        PayrollAdjustment = 14  

        Tax = 15 

        DailyOT = 16 

        DailyDoubleOT = 17 

        SeventhDayOT = 18 

        SeventhDay-

OTAdjustment = 19 

        DailyOTAdjustment = 20 

        DailyDouble-

OTAdjustment = 21 

        SeventhDay = 22 

        SeventhDayAdjustment = 

23 

        PPSQCode = 24 

        PPSRap = 25 

        PPSFinal = 26 

        PPSLUPA = 27 

        Estimate = 28 

        TaxTransfer = 29 

        TotalCharges = 30  

        Transfer = 31 

        NoOT = 253 

        NoRate = 254 

        Unknown = 255 

 invd_OTUnitsSubtract 

This field determines whether 

OTUnits are subtracted from 

the Total Units when 

calculating the normal billing 

amount.  As of 7/2016 the OT 

process is an add on rate for 

visits and those units should 

not be subtracted from the 

Billing Units. 

bit  1 False  ((0)) 

 invd_DisplayOTUnits 

New column of the over time 

units used for calculations on 

reports. 

decimal(8,4) True 5 False   

 invd_ChargeTotalWOTax 

This is the Total Charge per 

Invoice 

detail,  including  OTcalculation 

with corresponding Rounding. 

However, without taxes. Mostly 

replaced by invd_Allocated-

ChargeWOTax. 

CMS1500 > invd_ChargeTotal-

WOTax (Hidden) 

money True 8 True   
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UB04Invoice > invd_Charge-

TotalWOTax (Hidden) 

UB92Invoice > invd_Charge-

TotalWOTax (Not hidden) 

 invd_AllocatedChargeWOTax 

This is calculated from 

Allocated Amount per Invoice 

detail,  including  OTcalculation 

with corresponding Rounding. 

However, without taxes. 

money True 8 True   

 invd_ChargeTotal 

Total charge of the invoice 

detail. Also called Chg Rate, 

ChargeTotal, Reimbursement, 

ServiceCharges, TotalChgs. 

The sum of all invd_Charge-

Total is also called Total-

Charges, invd_ChargeTotal, 

ChargeTotal. 

Payment Postings > Payment 

and Postings > Total (Not 

hidden) 

CMS1500 > invd_ChargeTotal 

(Hidden) 

Invoice Postings > Total 

Charge (Not hidden) 

UB04Invoice > invd_Charge-

Total (Hidden) 

UB92Invoice > invd_Charge-

Total (Not hidden) 

decimal(38,6) True 17 True   

 invd_DisplayTotal 

The sum of all invd_Display-

Total is also called Invoice-

Total or TotalDisplayAmount. 

Payment Postings > Payment 

and Postings > invd_Display-

Total (Hidden) 

CMS1500 > invd_Display-

Total (Not hidden) 

Invoice Postings > Invoice 

Total (Hidden) 

UB04Invoice > 47 TOTAL 

CHARGES (Not hidden) 

UB92Invoice > invd_Display-

Total (Not hidden) 

numeric(38,6) True 17 True   

 invd_ContractTotal 

Total amount of the contract of 

the invoice detail. 

money True 8 True   

 invd_DisplayOTRate 

New column of the over time 

rate used for calculations on 

reports. 

decimal(18,8) True 9 False   

 invd_LineItemTypeOverride 

This field allows you to 
tinyint  1 True   
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override the value in invd_-

LineItemType. 

 

Values 

----------------------------------- 

0 = Unknown 

1 = Service 

2 = Expense 

3 = Tax 

4 = Estimate 

5 = Totals 

6 = PPS RAP 

7 = PPS Final 

8 = PPS LUPA 

9 = PPS QCode 

10 = PPS Medicare Advantage 

 invd_LineItemType 

This describes the type of 

Invoice Detail we're working 

with. 

default of 0 (unknown) 

Values 

----------------------------------- 

0 = Unknown 

1 = Service 

2 = Expense 

3 = Tax 

4 = Estimate 

5 = Totals 

6 = PPS RAP 

7 = PPS Final 

8 = PPS LUPA 

9 = PPS QCode 

10 = PPS Medicare Advantage 

tinyint True 1 True   

 invd_Sequence 

This field represents the 

sequence of this shift for all 

Schedule Shift records for this 

Schedule ordered by schsh_-

StartTime.  This field is updated 

when an Invoice is extracted, 

so there is a high probability for 

this field to be null. 

int  4 True   

 invd_ShiftCount 

The Total number of T_-

ScheduleShift records for this 

Schedule 

int  4 True   
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Indexes 

Foreign Keys 

Key Name Key Columns Unique 

 
PK_T_InvoiceDetails invd_ID True 

 IX_T_InvoiceDetails_AuthorizationID_ServiceUTCDate-

From 

invd_AuthorizationID, invd_ServiceUTCDate-

From 

 

 IX_T_InvoiceDetails_BranchID_PayerID_ClientID invd_BranchID, invd_PayerID, invd_ClientID  

 IX_T_InvoiceDetails_ClientID invd_ClientID  

 IX_T_InvoiceDetails_HolidayID invd_HolidayID True 

 IX_T_InvoiceDetails_IncludeTaxes invd_ID, invd_IncludeTaxes  

 IX_T_InvoiceDetails_InvoiceGroupID invd_InvoiceGroupID, invd_InvoiceGroupCount  

 IX_T_InvoiceDetails_RateID invd_RateID  

 IX_T_InvoiceDetails_ScheduleID_ExpenseID invd_ScheduleID, invd_ScheduleExpenseID  

 IX_T_InvoiceDetails_SchedulePayerID invd_SchedulePayerID  

 IX_T_InvoiceDetails_ServiceCodeID invd_ServiceCodeID  

 IX_T_InvoiceDetails_TransferFromInvoiceDetailID invd_TransferFromInvoiceDetailID  

 IX_T_InvoiceDetails_TransferToInvoiceDetailID invd_TransferToInvoiceDetailID  

 IX_T_InvoiceDetails_invhID invd_InvhID, invd_DetailsType  

Name Columns 

FK_T_InvoiceDetails_T_BillCodes invd_BillCodeID->[dbo].[T_BillCodes].[bcd_ID] 

FK_T_InvoiceDetails_T_BillingModifiersID1 invd_1500BillingModifierID1->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_InvoiceDetails_T_BillingModifiersID2 invd_1500BillingModifierID2->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_InvoiceDetails_T_BillingModifiersID3 invd_1500BillingModifierID3->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_InvoiceDetails_T_BillingModifiersID4 invd_1500BillingModifierID4->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_InvoiceDetails_T_BranchHolidays invd_HolidayID->[dbo].[T_BranchHolidays].[brhol_ID] 

FK_T_InvoiceDetails_T_Client invd_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_InvoiceDetails_T_InvoiceHeader invd_InvhID->[dbo].[T_InvoiceHeader].[invh_ID] 

FK_T_InvoiceDetails_T_Payers invd_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_InvoiceDetails_T_Rates invd_RateID->[dbo].[T_Rates].[rate_ID] 

FK_T_InvoiceDetails_T_Region invd_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_InvoiceDetails_T_ScheduleExpenses invd_ScheduleExpenseID->[dbo].[T_ScheduleExpenses].[schexp_ID] 

invd_ScheduleID->[dbo].[T_ScheduleExpenses].[schexp_schID] 

FK_T_InvoiceDetails_T_SchedulePayers invd_SchedulePayerID->[dbo].[T_SchedulePayers].[schcp_ID] 

FK_T_InvoiceDetails_T_Schedules invd_ScheduleID->[dbo].[T_Schedules].[sch_ID] 

FK_T_InvoiceDetails_T_ServiceCode invd_ServiceCodeID->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_InvoiceDetails_TransferFrom invd_TransferFromInvoiceDetailID->[dbo].[T_InvoiceDetails].[invd_ID] 
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FK_T_InvoiceDetails_TransferTo invd_TransferToInvoiceDetailID->[dbo].[T_InvoiceDetails].[invd_ID] 
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Invoice Grouping Type 

 [dbo].[T_InvoiceGroupingType] 

 

 

Note: Detailed documentation is pending. 
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Invoice Header 

 [dbo].[T_InvoiceHeader] 

 

Description 

Provides the main invoice information.  

Columns 

Key Name Data Type Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

(2) 

invh_ID 

Unique invoice ID used to reference 

an invoice across the system, 

UB04/UB92. 

Payment Postings > Payment and 

Postings > Invoice ID. 

Invoice Postings > Invoice ID. 

Schdeule Expenses > invh_ID. 

bigint  8 False 1 - 1  

 
invh_InvoiceNumber 

Invoice number field of the invoice 

header. 

Payment Postings > Payment and 

Postings > Invoice #. 

Invoice Postings > Invoice Num. 

nvarchar(50)  100 False   

(4) 

invh_InvoiceDate 

Invoice date field of the invoice 

header. Non-UTC date. 

Payment Postings > Payment and 

Postings > Invoice Date. 

Invoice Postings > Invoice Date. 

datetime  8 False   

 

invh_PeriodClosedID 

Invoice period closign ID. Created 

when invoice header record is 

closed. 

bigint  8 True   

(5)

 

invh_BranchID 

Branch ID field of the invoice header, 

UB04/UB92. 

Payment Postings > Payment and 

Postings > Office. 

Invoice Postings > Office. 

 

Schedule Expenses > invh_BranchID 

int  4 False   

 
invh_BillTypeID 

Bill type ID field of the invoice 

int  4 False   
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header/UB04. Bill types ID and 

descriptions on T_BillType. 

Payment Postings > Payment and 

Postings > Bill Type. 

Invoice Postings > Bill Type. 

 invh_Status 

Invoice status field of the invoice 

header/UB04. 

Payment Postings > Payment and 

Postings > Status. 

Invoice Postings > Status. 

int True 4 False   

(4)

 

invh_PayerID 

Payer ID field of the invoice header, 

1500/UB04. 

Payment Postings > Payment and 

Postings > invh_PayerID. 

Invoice Postings > invh_PayerID. 

bigint  8 False   

(3)

 

invh_ClientID 

Client ID field of the invoice header, 

1500/UB04. 

Payment Postings > Payment and 

Postings > invh_ClientID. 

Invoice Postings > invh_ClientID. 

bigint  8 True   

 

invh_BatchID 

Invoice batch ID field of the invoice 

header, 1500/UB04. 

Payment Postings > Payment and 

Postings > Batch ID. 

Invoice Postings > Batch ID. 

 

Schedule Expenses > invh_BatchID. 

bigint  8 False   

 invh_DraftID 

Invoice draft ID field of the invoice 

header. 

bigint  8 True   

 

invh_POCID 

Invoice Plan of Care (POC) ID field of 

the invoice header, 1500/UB04. The 

new POC ID is auto assigned and 

the new 60 Day Cert Period Dates 

are auto calculated. 

Payment Postings > Payment and 

Postings > POC ID. 

Invoice Postings > POC ID. 

bigint  8 True   

 
invh_InvoiceTotalRound 

Invoice total round mode field of the 

invoice header, 1500/UB04. 0: No 

Rounding, 1: Round Up, 2: Truncate, 

3: Round 

tinyint  1 False  ((1)) 

 
invh_InvoiceTotalRoundDecimal 

Invoice total number of decimals to 

round, 1500/UB04. 

tinyint  1 False  ((2)) 
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invh_InvoiceLineRound 

Invoice line rounding mode, 

1500/UB04. 0: No Rounding, 1: 

Round Up, 2: Truncate, 3: Round 

tinyint  1 False  ((0)) 

 
invh_InvoiceLineRoundDecimal 

Invoice line number of decimals to 

round, 1500/UB04. 

tinyint  1 False  ((2)) 

(3) 

invh_CancelDate 

Invoice cancel date field of the 

Invoice header, 1500/UB04. SQL 

Server’s current UTC date. 

datetime  8 True   

 invh_CancelUser 

User who canceled the invoice. Set 

from current user. 

nvarchar(50)  100 True   

 invh_CreatedUser 

User who created the invoice.  

nvarchar(50)  100 True   

 invh_CreatedDate 

Date invoice was created. SQL 

Server’s current UTC date. 

datetime  8 False  (getutcdate()) 

 invh_ModifiedUser 

User who made invoice's most recent 

modification. 

nvarchar(50)  100 True   

 invh_ModifiedDate 

Date of invoice's most recent 

modification. SQL Server’s 

current UTC date 

datetime  8 False  (getutcdate()) 

 invh_TS 

Invoice's header timestamp field. 

timestamp  8 True   

 invh_ClientControlNo 

Invoice client's control number. Flows 

from invh_InvoiceNumber. 

Form UB04 field '3a PAT. CTRL#' 

and form UB92 field 3 'PATIENT 

CONTROL NO'.  

nvarchar(50)  100 True   

 invh_TypeOfBill 

Invoice's type of bill code. Flows from 

T_UB04.ub_TypeOfBill. 

Form UB04 field 4 and form UB92 

field 4.  

nvarchar(10)  20 True   

 invh_FedTaxID 

Form UB04 field 5 and form UB92 

field 5. 

Branch's federal tax ID that produced 

the invoice. 

nvarchar(25)  50 True   

 invh_StatementFrom 

The start date of the accounting 

extract period from which the 

produced the invoice. Non-UTC date. 

Form UB04 field 6, form UB92 field 6 

and form 1500. 

datetime  8 True   
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 invh_StatementThrough 

The end date of the accounting 

extract period from which the 

produced the invoice. Non-UTC date. 

Form UB04 field 6, form UB92 field 6 

and form 1500. 

datetime  8 True   

 invh_ClientLastName 

Client's last name field of the invoice 

header, 1500/UB04.Flows from T_-

Client.cli_LastName. 

nvarchar(50)  100 True   

 invh_ClientFirstName 

Client's first name field of the invoice 

header, 1500/UB04.Flows from T_-

Client.cli_FirstName. 

nvarchar(50)  100 True   

 invh_ClientMiddleName 

Client's middle name field of the 

invoice header, 1500. Flows from T_-

Client.cli_MiddleName. 

nvarchar(50)  100 True   

 invh_ClientSuffixName 

Client's suffix field of the invoice 

header, UB04. Flows from T_-

Client.cli_Suffix. 

nvarchar(50)  100 True   

 invh_Address1 

Client's address1 field of the invoice 

header, 1500/UB04. Flows from T_-

Client.cli_Address1. 

nvarchar(255)  510 True   

 invh_Address2 

Client's address2 field of the invoice 

header, 1500/UB04. Flows from T_-

Client.cli_Address2. 

nvarchar(60)  120 True   

 invh_City 

Client's city field of the invoice 

header, 1500/UB04. Flows from T_-

Client.cli_City. 

nvarchar(50)  100 True   

 invh_StateOrProvince 

Client's state or province field of the 

invoice header, 1500/UB04. Flows 

from T_Client.cli_StateOrProvince. 

nvarchar(20)  40 True   

 invh_PostalCode 

Client's postal code field of the 

invoice header, 1500/UB04. Flows 

from T_Client.cli_PostalCode. 

nvarchar(20)  40 True   

 invh_County 

Client's county of the invoice header 

and UB04. Flows from T_Client.cli_-

County. 

nvarchar(50)  100 True   

 invh_Country 

Client's country code of the invoice 

header and UB04. Flows from T_-

Client.cli_Country. 

int  4 False  ((240)) 

 invh_DOB 

Client's date of birth of the invoice 

datetime  8 True   
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header. Flows from T_Client.cli_-

BirthDate. 

UB04 form field 10 and UB92 field 

14.  

 invh_Sex 

Client's sex of the invoice 

header. Flows from T_Client.cli_Sex. 

UB04 form field 11 and UB90 field 

15. 

char(1)  1 True   

 invh_ClientNumber 

Client number of the invoice 

header. Flows from T_-

H1500.h1500_PatientAccount-

Number or T_Client.cli_ID. 

UB04 form field 8a. 

nvarchar(19)  38 True   

 invh_PrvdrName 

Provider's (Branch) name of the 

invoice header. Flows from T_-

Branches.br_FormalName. 

UB04 form field 1.  

nvarchar(128)  256 True   

 invh_PrvdrAddress1 

Provider's (Branch) address1 of the 

invoice header. Flows from T_-

Branches.br_Address1 or T_-

Branches.br_RemitAddress1 on form 

1500. 

UB04 form field 1. 

nvarchar(255)  510 True   

 invh_PrvdrAddress2 

Provider's (Branch) address2 of the 

invoice header.  Flows from T_-

Branches.br_Address2 or T_-

Branches.br_RemitAddress2 on form 

1500. 

UB04 form field 1. 

nvarchar(60)  120 True   

 invh_PrvdrCity 

Provider's (Branch) city of the invoice 

header. Flows from T_Branches.br_-

RemitCity for H1500 T_-

Branches.br_City for UB04 

H1500 and UB04 form field 1. 

nvarchar(50)  100 True   

 invh_PrvdrStateOrProvince 

Provider's (Branch) state or province 

of the invoice header. Flows from T_-

Branches.br_StateOrProvince for 

H1500 and T_Branches.br_StateOr-

Province for UB04. 

H1500 and UB04 form field 1. 

nvarchar(20)  40 True   

 invh_PrvdrPostalCode 

Provider's (Branch) postal code of 

the invoice header. Flows from T_-

Branches.br_RemitPostalCode for 

H1500 and T_Branches.br_Postal-

Code for UB04. 

nvarchar(20)  40 True   
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H1500 and UB04 form field 1. 

 invh_PrvdrCounty 

Provider's (Branch) county of the 

invoice header and UB04. 

Flows from T_Branches.br_County. 

nvarchar(50)  100 True   

 invh_PrvdrCountry 

Provider's (Branch) country of the 

invoice header and UB04. 

Flows from T_Branches.br_Country. 

int  4 False  ((240)) 

 invh_PrvdrTelephone 

Provider's (Branch) telephone 

number of the invoice header. Flows 

from V_BranchPrimaryPhone.bsph_-

Phone for H1500 and T_-

Branches.br_RemitPhone for UB40. 

H1500 and UB04 form field 1. 

nvarchar(30)  60 True   

 invh_PrvdrFax 

Provider's (Branch) fax number of the 

invoice header. Flows from T_-

Branches.br_RemitFax. 

UB04 form field 1 

nvarchar(30)  60 True   

 invh_PrvdrEmail 

Provider's (Branch) email field of the 

invoice header. 

nvarchar(50)  100 True   

 invh_PrvdrNPI 

Provider's (Branch) NPI of the invoice 

header, H1500 and UB04. Flows 

from T_Branches.br_NPI. 

nvarchar(15)  30 True   

 invh_PrvdrType1 

Provider's (Branch) type1 field of the 

invoice header, H1500 and UB04. 

nvarchar(2)  4 True   

 invh_PrvdrID1 

Provider's (Branch) ID1 field of the 

invoice header, H1500 and UB04. 

nvarchar(50)  100 True   

 invh_PrvdrType2 

Provider's (Branch) type2 field of the 

invoice header, H1500 and UB04. 

nvarchar(2)  4 True   

 invh_PrvdrID2 

Provider's (Branch) ID2 field of the 

invoice header, H1500 and UB04. 

nvarchar(50)  100 True   

 invh_PrvdrType3 

Provider's (Branch) type3 field of the 

invoice header, H1500 and UB04. 

nvarchar(2)  4 True   

 invh_PrvdrID3 

Provider's (Branch) ID3 field of the 

invoice header, H1500 and UB04. 

nvarchar(50)  100 True   

 invh_PayName 

Pay-to name field of the invoice 

header, H1500 and UB04 form field 

2. Flows from 

T_Payers.pay_Name. 

nvarchar(50)  100 True   
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 invh_PayAddress1 

Pay-to address1 field of the invoice 

header. Flows from T_Payers.pay_-

Address1. 

H1500 and UB04 form field 2 

nvarchar(255)  510 True   

 invh_PayAddress2 

Pay-to address2 field of the invoice 

header, H1500 and UB04. 

Flows from 

T_Payers.pay_Address2. 

nvarchar(60)  120 True   

 invh_PayCity 

Payer city field of the invoice header. 

Flows from T_Payers.pay_City. 

H1500 and UB04 form field 2 

nvarchar(50)  100 True   

 invh_PayStateOrProvince 

Pay-to state or province field of the 

invoice header. Flows from T_-

Payers.pay_StateOrProvince. 

H1500 and UB04 form field 2. 

nvarchar(20)  40 True   

 invh_PayPostalCode 

Pa-to postal code field of the invoice 

header, H1500 and UB04 form field 

2. Flows from 

T_Payers.pay_PostalCode. 

nvarchar(20)  40 True   

 invh_PayCounty 

Pay-to county field of the invoice 

header, H1500 and UB04. 

Flows from 

T_Payers.pay_County 

nvarchar(50)  100 True   

 invh_PayCountry 

Pay-to country code field of the 

invoice header, H1500 and UB04. 

Flows from 

T_Payers.pay_Country 

int  4 False  ((240)) 

 invh_AdmissionDate 

Client admission date field of the 

invoice header, H1500. Flows from 

T_H1500.h1500_OthrInsuredsDOB 

for H1500 and from T_-

Admissions.adm_ActualSOCDate for 

UB04. Non-UTC date. 

UB04 form field 12 and UB92 form 

field 17. 

datetime  8 True   

 invh_AdmissionHR 

Client admission hour field of the 

invoice header. Flows from T_-

UB04.ub_AdmissionHour. 

UB04 form field 13 and UB92 form 

field 18. 

nvarchar(10)  20 True   

 invh_AdmissionType 

Client type of admission field of the 

nvarchar(10)  20 True   
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invoice header. Flows from T_-

UB04.ub_AdmissionType. 

UB04 form field 14 and UB92 form 

field 19. 

 invh_AdmissionSRC 

Client source of admission field of the 

invoice header. Flows from 

RIGHT(T_Admission-

Sources.admsrc_Name, 2) or 1 if T_-

AdmissionSources.admsrc_Name IS 

NULL . 

UB04 form field 15 and UB92 form 

field 20.  

nvarchar(10)  20 True   

 invh_MedicalRecordNumber 

Medical record field of the invoice 

header. Flows from T_-

Admissions.adm_MedicalRecord-

Number. 

UB04 form field 3a PAT CTRL# and 

UB92 form field 23. 

nvarchar(50)  100 True   

 invh_RPartyName 

Responsible party name field of the 

invoice header. 

UB04 form field 38. 

nvarchar(50)  100 True   

 invh_RPartyAddress1 

Responsible party address1 field of 

the invoice header. Flows from T_-

Client.cli_Address1, T_-

H1500.h1500_InsuredsAddress1 or 

NULL depending on some 

conditions. 

UB04 form field 38a 

nvarchar(255)  510 True   

 invh_RPartyAddress2 

Responsible party address2 field of 

the invoice header. Flows from T_-

Client.cli_Address2 or NULL 

depending on some conditions. 

UB04 form field 38b 

nvarchar(60)  120 True   

 invh_RPartyCity 

Responsible party city field of the 

invoice header, H1500 and UB04. 

Flows from T_Client.cli_City, T_-

H1500.h1500_InsuredsCity or NULL 

depending on some conditions. 

UB04 field 38c combined with state 

and postal code (RPartyCityState-

PostalCode). 

nvarchar(50)  100 True   

 invh_RPartyStateOrProvince 

Responsible party state or province 

field of the invoice header, H1500 

and UB04. Flows from T_Client.cli_-

StateOrProvince, T_H1500.h1500_-

InsuredsState or NULL depending on 

some conditions. 

nvarchar(20)  40 True   
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UB04 field 38c combined with city 

and postal code (RPartyCityState-

PostalCode). 

 invh_RPartyPostalCode 

Responsible party postal code field of 

the invoice header, H1500 and 

UB04. Flows from T_Client.cli_-

PostalCode, T_H1500.h1500_-

InsuredsZipCode or NULL depending 

on some conditions. 

UB04 field 38c combined with city 

and state or province (RPartyCity-

StatePostalCode). 

nvarchar(20)  40 True   

 invh_RPartyCounty 

Responsible party county field of the 

invoice header. 

UB04 field 38d combined with 

country (RPartyCountyCountry). 

nvarchar(50)  100 True   

 invh_RPartyCountry 

Responsible party country field of the 

invoice header. 

UB04 field 38d combined with county 

(RPartyCountyCountry). 

int  4 True  ((240)) 

 
invh_CurrentPayerLocation 

Current payer location field of the 

invoice header. 

tinyint  1 False  ((1)) 

 invh_Payer1 

Payer name field of the invoice 

header. Flows from T_Payers.pay_-

Name. 

UB04 form field 50 and UB92 form 

field 50. 

nvarchar(50)  100 True   

 invh_ProviderNo1 

Provider number/health plan ID field 

of the invoice header. Flows from T_-

UB04.ub_HealthPlanIDPrimary. 

UB04 form field 51 and UB92 form 

field 51. 

nvarchar(20)  40 True   

 invh_RelInfo1 

Release of information field of the 

invoice header, 1500. Flows from T_-

Admissions.adm_RelInfo. 

UB04 form field 52 and UB92 form 

field 52. 

nvarchar(3)  6 True   

 invh_AsgBen1 

Assignment of benefits field of the 

invoice header, 1500. Flows from T_-

Admissions.adm_AssignBenefits for 

UB04 or T_H1500.h1500_Accept-

AssignmentFlag for 1500. 

UB04 form field 53 and UB92 form 

field 53. 

nvarchar(3)  6 True   
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 invh_PriorPayments1 

Prior payments field of the invoice 

header. 

UB04 form field 54 and UB92 form 

field 54. 

money  8 True   

 invh_EstAmountDue1 

Estimated amount due field of the 

invoice header. Flows from V_-

InvoiceTotalsDraft.InvoiceTotal. 

UB04 form field 55 and UB92 form 

field 55.  

money  8 True   

 invh_Payer2 

Payer name (2) field of the invoice 

header, Flows from T_UB04.ub_-

PayerNameSecondary. 

UB04 form field 50 and UB92 form 

field 50.  

nvarchar(50)  100 True   

 invh_ProviderNo2 

Provider number/health plan ID (2) 

field of the invoice header. Flows 

from T_UB04.ub_HealthPlan-

IDSecondary. 

UB04 form field 51 and UB92 form 

field 51. 

nvarchar(20)  40 True   

 invh_RelInfo2 

Release of information (2) field of the 

invoice header, 1500.  Flows from 

T_UB04.ub_RelInfoSecondary. 

UB04 form field 52 and UB92 form 

field 52. 

nvarchar(3)  6 True   

 invh_AsgBen2 

Assignment of benefits (2) field of the 

invoice header, 1500. Flows from T_-

Admissions.adm_AssignBenefits for 

UB04 or T_UB04.ub_AssignBenefits-

Secondary. 

UB04 form field 53 and UB92 form 

field 53.  

nvarchar(3)  6 True   

 invh_PriorPayments2 

Prior payments (2) field of the invoice 

header. 

UB04 form field 54 and UB92 form 

field 54. 

money  8 True   

 invh_EstAmountDue2 

Estimated amount due (2) field of the 

invoice header. 

UB04 form field 55 and UB92 form 

field 55. 

money  8 True   

 invh_Payer3 

Payer name (3) field of the invoice 

header. Flows from T_UB04.ub_-

PayerNameTertiary. 

nvarchar(50)  100 True   
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UB04 form field 50 and UB92 form 

field 50.  

 invh_ProviderNo3 

Provider number/health plan ID (3) 

field of the invoice header. Flows 

from T_UB04.ub_HealthPlan-

IDTertiary. 

UB04 form field 51 and UB92 form 

field 51.  

nvarchar(20)  40 True   

 invh_RelInfo3 

Release of information (3) field of the 

invoice header, 1500.  Flows from 

T_UB04.ub_RelInfoTertiary. 

UB04 form field 52 and UB92 form 

field 52. 

nvarchar(3)  6 True   

 invh_AsgBen3 

Assignment of benefits (3) field of the 

invoice header, 1500. Flows from T_-

Admissions.adm_AssignBenefits for 

UB04 or T_UB04.ub_AssignBenefits-

Tertiary. 

UB04 form field 53 and UB92 form 

field 53. 

nvarchar(3)  6 True   

 invh_PriorPayments3 

Prior payments (3) field of the invoice 

header. 

UB04 form field 54 and UB92 form 

field 54. 

money  8 True   

 invh_EstAmountDue3 

Estimated amount due (3) field of the 

invoice header.  

UB04 form field 55 and UB92 form 

field 55. 

money  8 True   

 invh_DueFromPatient 

Estimated amoutn due - Patient field 

of the invoice header. 

UB92 form field 55. 

money  8 True   

 invh_InsuredsName1 

Insured's name field of the invoice 

header, 1500. 

UB04 form field 58 and UB92 form 

field 58. 

nvarchar(102)  204 True   

 invh_P_Rel1 

Patient's relationship field of the 

invoice header, 1500. Flows from T_-

H1500.h1500_PatientsRelationFlag 

to 1500 and T_UB04.ub_Patient-

RelationshipPrimary or 18 for UB04 

UB04 form field 59 and UB92 form 

field 59. . 

nvarchar(5)  10 True   

 invh_GroupName1 

Insurance group name field of the 

nvarchar(50)  100 True   
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invoice header, 1500. Flows from T_-

H1500.h1500_InsuredsInsurance-

PlanProgramName for 1500 and T_-

UB04.ub_InsuranceGroupName-

Primary for UB04.  

UB04 form field 61 and UB92 form 

field 61. 

 invh_InsuranceGroupNo1 

Insurance group number field of the 

invoice header, 1500. Flows from T_-

H1500.h1500_InsuredsPolicyGrp-

NumFECANum for 1500 and T_-

UB04.ub_InsuranceGroupNo-

Primary.  

UB04 form field 62 and UB92 form 

field 62. 

nvarchar(50)  100 True   

 invh_InsuredsName2 

Insured's name (2) field of the invoice 

header, 1500. Flow from T_-

H1500.h1500_OthrInsuredsName for 

1500 and T_UB04.ub_Insureds-

NameSecondary for UB04. 

UB04 form field 58 and UB92 form 

field 58. 

nvarchar(102)  204 True   

 invh_P_Rel2 

Patient's relationship (2) field of the 

invoice header, 1500.  Flows from 

T_UB04.ub_PatientRelationship-

Secondary for UB04. 

UB04 form field 59 and UB92 form 

field 59. 

nvarchar(5)  10 True   

 invh_GroupName2 

Insurance group name (2) field of the 

invoice header, 1500.  Flows from 

T_H1500.h1500_InsuredsInsurance-

PlanProgramName for 1500 and T_-

UB04.ub_InsuranceGroupName-

Primary for UB04.  

UB04 form field 61 and UB92 form 

field 61. 

nvarchar(50)  100 True   

 invh_InsuranceGroupNo2 

Insurance group number (2) field of 

the invoice header, 1500. Flows from 

T_UB04.ub_InsuranceGroupNo-

Secondary.  

UB04 form field 62 and UB92 form 

field 62. 

nvarchar(50)  100 True   

 invh_InsuredsName3 

Insured's name (3) field of the invoice 

header, 1500. Flows from T_-

UB04.ub_InsuredsNameTertiary for 

UB04. 

UB04 form field 58 and UB92 form 

field 58. 

nvarchar(102)  204 True   
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 invh_P_Rel3 

Patient's relationship (3) field of the 

invoice header, 1500. Flows from T_-

UB04.ub_PatientRelationshipTertiary 

for UB04. 

UB04 form field 59 and UB92 form 

field 59. 

nvarchar(5)  10 True   

 invh_GroupName3 

Insurance group name (3) field of the 

invoice header, 1500. Flows from T_-

H1500.h1500_InsurancePlan-

ProgramName for 1500 and T_-

UB04.ub_InsuranceGroupName-

Tertiary for UB04.  

UB04 form field 61 and UB92 form 

field 61. 

nvarchar(50)  100 True   

 invh_InsuranceGroupNo3 

Insurance group number (3) field of 

the invoice header, 1500. Flows from 

T_H1500.h1500_OthrInsuredsPolicy-

GrpNum for 1500 and T_UB04.ub_-

InsuranceGroupNoTertiary for UB04. 

UB04 form field 62 and UB92 form 

field 62. 

nvarchar(50)  100 True   

 invh_TreatmentAuthCode1 

Treatment authorization code field of 

the invoice header. Flows from T_-

UB04.ub_TreatmentAuthCode-

Primary. 

UB04 form field 63 and UB92 form 

field 63. 

nvarchar(50)  100 True   

 invh_EmployerName1 

Employer name field of the invoice 

header. Flows from T_UB04.ub_-

EmployerNamePrimary. 

UB04 form field 65 and UB92 form 

field 65. 

nvarchar(50)  100 True   

 invh_TreatmentAuthCode2 

Treatment authorization code (2) field 

of the invoice header. Flows from T_-

UB04.ub_TreatmentAuthCode-

Secondary. 

UB04 form field 63 and UB92 form 

field 63.  

nvarchar(50)  100 True   

 invh_EmployerName2 

Employer name (2) field of the 

invoice header. Flows from T_-

UB04.ub_EmployerNameSecondary. 

UB04 form field 65 and UB92 form 

field 65. 

nvarchar(50)  100 True   

 invh_TreatmentAuthCode3 

Treatment authorization code (3) field 

nvarchar(50)  100 True   
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of the invoice header. Flows from T_-

UB04.ub_TreatmentAuthCode-

Tertiary. 

UB04 form field 63 and UB92 form 

field 63. 

 invh_EmployerName3 

Employer name (3) field of the 

invoice header. Flows from T_-

UB04.ub_EmployerNameTertiary. 

UB04 form field 65 and UB92 form 

field 65. 

nvarchar(50)  100 True   

 invh_ICDVersion 

DX version qualifier. ICD Version 

Indicator (9=9th version, 0=10th 

version) Medicare processes 9 of the 

invoice header, 1500. Flow from T_-

H1500.h1500_OthrInsuredsSexFlag 

for 1500 and T_UB04.ub_DXVersion-

Qualifier for UB04. 

UB04 form field 66. 

nvarchar(2)  4 True  ((9)) 

 invh_PrinDiagCd 

Principal diagnosis code field of the 

invoice header, 1500. 

UB04 form field 67 and UB92 form 

field 67. 

nvarchar(10)  20 True   

 invh_ADMDiagCode 

Admitting diagnosis code field of the 

invoice header. Flows from T_-

UB04.ub_AdmittingDiagnosisCode. 

UB04 form field 69 and UB92 form 

field 76. 

nvarchar(10)  20 True   

 invh_VisitReason1 

Patient's reason for visit code field of 

the invoice header. Flows from T_-

UB04.ub_PatientRsnVisitCode-

Primary. 

UB04 form field 70 and UB92. 

nvarchar(10)  20 True   

 invh_VisitReason2 

Patient's reason for visit (2) code field 

of the invoice header. Flows from T_-

UB04.ub_PatientRsnVisitCode-

Secondary. 

UB04 form field 70 and UB92. 

nvarchar(10)  20 True   

 invh_VisitReason3 

Patient's reason for visit (3) code field 

of the invoice header. Flows from T_-

UB04.ub_PatientRsnVisitCode-

Tertiary. 

UB04 form field 70. 

nvarchar(10)  20 True   

 invh_PPSCode 

PPS code field of the invoice header, 

UB04 form field 71. Flows from T_-

UB04.ub_PPSCode. 

nvarchar(3)  6 True   
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 invh_ECode1 

External caue of injury code field of 

the invoice header. Flows from T_-

UB04.ub_ExternalCauseInjury-

Primary. 

UB04 form field 72. 

nvarchar(10)  20 True   

 invh_ECode2 

External caue of injury code (2) field 

of the invoice header. Flows from T_-

UB04.ub_ExternalCauseInjury-

Secondary. 

UB04 form field 72. 

nvarchar(10)  20 True   

 invh_ECode3 

External cause of injury code (3) field 

of the invoice header. Flows from T_-

UB04.ub_ExternalCauseInjury-

Tertiary. 

UB04 form field 72. 

nvarchar(10)  20 True   

 
invh_Attend_PhysID 

Attending physician ID field of the 

invoice header. 

UB04 and UB92 form field 82. 

bigint  8 True   

 
invh_Oper_PhysID 

Operating physician ID field of the 

invoice header, UB04. 

bigint  8 True   

 
invh_Other_PhysID1 

Other physician ID field of the invoice 

header, UB04. 

bigint  8 True   

 
invh_Other_PhysID2 

Other physician ID (2) field of the 

invoice header, UB04. 

bigint  8 True   

 invh_Remarks 

Remarks field of the invoice header. 

UB04 form field 80 and UB92 for field 

84. 

nvarchar(256)  512 True   

 invh_UB04 

UB04 XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_OtherDiagnosticsCodeData 

Diagnostic Codes XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_ProcedureCodeData 

Procedure Code XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_AttendingPhysicanData 

Attending Physician XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_OperatingPhysicianData 

Operating Physician XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_OtherPhysician1Data 

Other Physician XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_OtherPhysician2Data 

Other Physiciann (2) XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   
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 invh_CMS1500 

CMS1500 XML Collection. 

xml([dbo].[Soneto-

InvoiceCollection]) 

 max True   

 invh_LegacyID 

Not used. 

int  4 True   

 invh_LegacyBranchId 

Not used. 

int  4 True   

 

invh_AcctExtID 

Account extract ID field of the invoice 

header. 

bigint  8 True   

 
invh_Balance 

Balance due field of the invoice 

header. 

money  8 True  ((0)) 

 invh_TotalCharges 

Total charges field of the invoice 

header. 

money  8 True  ((0)) 

 invh_ClientPhone 

Client's phone number field of the 

invoice header. 

nvarchar(30)  60 True   

 

invh_AdmissionID 

Client's admission ID field of the 

invoice header. 

bigint  8 True   

 

invh_EFTID 

Electronic's funds transfer ID of the 

invoice header. 

int  4 True   

 invh_ClientPayerID 

Client payer's ID of the invoice 

header. 

bigint  8 True   

 invh_SignedName 

Authorized payer signature filed of 

the invoice heater. 

nvarchar(102)  204 True   

 invh_SignedDate 

Date of authorized payment filed of 

the invoice heater. 

datetime  8 True   

 invh_AuthCode 

Payment authorization code field of 

the invoice header. 

nvarchar(50)  100 True   

 invh_Notes 

Notes field of the invoice header. 

nvarchar(max)  max True   

 invh_OriginalServCharges 

Sum of Details Charge Total when 

the Details Type = 0 

money  8 True   

 invh_OriginalExpCharges 

Sum of Details Charge Total when 

the Details Type = 1 

money  8 True   

 invh_OriginalTaxCharges 

Sum of Details Charge Total when 

the Details Type = 2 

money  8 True   

 invh_AdjustedServCharges 

Sum of Details Charge Total plus all 

money  8 True   
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Invoice details Adjustments when the 

Details Type = 0 

 invh_AdjustedExpCharges 

Sum of Details Charge Total plus all 

Invoice details Adjustments when the 

Details Type = 1 

money  8 True   

 invh_AdjustedTaxCharges 

Sum of Details Charge Total plus all 

Invoice details Adjustments when the 

Details Type = 2 

money  8 True   

 invh_DisplayTotal 

Invoice total field of the invoice 

header. 

money  8 True   

 invh_OriginalCharges 

Original charges field of the invoice 

header. 

money True 8 True   

 invh_InvoiceVersion 

Used to identify significant changes 

to invoices.  Any records prior to 1.14 

will have NULL in this field.  Any 

records created with 1.14 or later will 

have a number associating it to a 

particular Invoice ID.  Right now this 

is used for the Standard Invoice, but 

it can be used for any Bill Type.  For 

1.14 I'm defaulting this value to 3 to 

leave room to identify records 

created between 1.11 and 1.13 (2) or 

prior to 1.11 (1), when significant 

changes were made. 

NULL - Prior to 1.14 

3 - 1.14 and later 

int  4 True  ((4)) 

 invh_GroupingProcessID 

0 - No grouping used on this Invoice 

1 - HCFA 1500 grouping used on this 

invoice.  Invoice Details will be 

grouped by HCPCS code, Auth 

Code, Modifiers, and Unit Flag.  The 

invd_InvoiceGroupID for grouped 

details will be the MIN(invd_ID) for 

that grouping. 

int  4 False  ((-1)) 

 invh_InvoicePrintLine 

Not being used? 

nvarchar(256)  512 True   

 invh_RollUpTaxesOnPrint 

When = 1 Set the Invoice Header to 

force printing to roll taxes into service 

charges and when = 0 means excess 

payments for this Invoice should not 

be distributed among taxes. 

bit  1 False  ((0)) 

 invh_Cert_SSN_HIC_ID_No1 

Insured's unique ID field of the 

invoice header, 1500, UB04 form 

field 60 and UB92 for field 60. Flows 

from T_Client.cli_HIC for 1500 and 

varbinary(255)  255 True   
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T_UB04.ub_InsuredsUnique-

IDPrimary or T_Client.cli_HIC for 

UB04 and UB92. 

 invh_Cert_SSN_HIC_ID_No2 

Insured's unique ID (2) field of the 

invoice header, UB04 form field 60 

and UB92 for field 60. Flows from T_-

UB04.ub_InsuredsUnique-

IDSecondary. 

varbinary(255)  255 True   

 invh_Cert_SSN_HIC_ID_No3 

Insured's unique ID (3) field of the 

invoice header, UB04 form field 60 

and UB92 for field 60. Flows from T_-

UB04.ub_InsuredsUniqueIDTertiary. 

varbinary(255)  255 True   

 invh_JoinICDVersion 

The ICD version. (9=9th version, 

0=10th version). 

tinyint  1 True  ((9)) 

 

invh_TransferFromInvoiceHeaderID 

invh_TransferFromInvoiceHeaderID:  

If this invoice was transferred from 

another invoice, the invh_ID of the 

previous invoice is stored in this field.  

This data is here for a couple of 

reasons.  First, the foreign key will 

prevent the original invoice from 

being deleted unless the transfer 

invoice is deleted first.  This will 

prevent any bugs that allow an 

invoice to be deleted if the invoice it 

was transferred from still exists (even 

in cancelled state).  Invoices can only 

be deleted if the entire chain of 

invoices following them are also 

deleted.  The field also serves as an 

immediate identification that the 

Invoice is the result of a transfer 

process.  It also creates a very easy 

to follow chain of order among 

invoices that have been transferred 

multiple times.  In addition to having 

some applications for reporting and 

reverse/delete processes, it is 

extremely useful for debugging.  This 

is the primary source for transfer 

history among invoices.  Once the 

invoice is created this field will 

NEVER change.  It always 

references the previous invoice in the 

chain, which can NEVER be 

removed unless this invoice is 

deleted first.  So this field is a 

permanent record of transfer chains, 

even if the transfers are reversed 

multiple times.  The corresponding 

field invh_TransferToInvoiceHeader-

ID can be used to determine the 

current active transfer chain, but it 

will be cleared out if the next invoice 

bigint  8 True   
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in the chain is reversed or deleted.  

So invh_TransferToInvoiceHeaderID 

cannot give the full transfer history 

that invh_TransferFromInvoice-

HeaderID can. 

 

invh_TransferToInvoiceHeaderID 

invh_TransferToInvoiceHeaderID:  

This field stores the invh_ID of the 

invoice this invoice was transferred 

to.  It is similar to its counterpart 

invh_TransferFromInvoiceHeaderID 

in that it gives a clear view of an 

invoice transfer chain.  It serves its 

own purpose though, and has slightly 

different use.  It will immediately 

identify whether this invoice has been 

transferred, which is useful in 

determining whether it is eligible to 

be transferred.  Any time the Transfer 

To invoice is deleted or reversed, the 

preceding invoice will have it's invh_-

TransferToInvoiceHeaderID set to 

NULL.  This means this field is not 

useful for a full history of invoice 

transfer chains.  But it is useful for 

finding the active invoice transfer 

chain. 

bigint  8 True   

 invh_TransferType 

invh_TransferType:  This field 

records the Invoice Transfer Type 

used to create this invoice. By default 

the value is 0, meaning it was not 

created as part of the transfer 

process. 

 

0:  Not a Transfer Invoice Process 

1:  Balance Transfer - This is the 

original transfer process used to 

transfer the current balances to a 

standard invoice.  This transfer 

process does not currently use an 

invoice process.  During this transfer 

process the new invoice is created 

immediately, there is no 

draft/finalize.  So there should be no 

invoice process records with invPr_-

TransferType = 1.  So there are 

situations where the invoice process 

will have a TransferType of 0 but the 

Invoice Header will have a Transfer-

Type of 1.  This transfer process is 

kicked off from the finalized batching 

screen using the procedure usp_-

Invoice_Transfer. 

2:  Invoice Transfer to Secondary 

Payer - This transfer process is new, 

and utilizes the typical draft/finalize, 

so it requires an invoice 

tinyint  1 False  ((0)) 
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process.  This gives us flexibility to 

make specific 

draft/finalize/reverse/delete 

procedures for different bill types.  In 

particular this will help manage 

differences between transfers for 

UB04, 1500, and standard/payer 

invoices.  It also gives us the ability 

to make custom invoice processes to 

address specific customer/payer 

transfer needs.  This transfer process 

is kicked off from the finalized 

batching screen using the procedure 

usp_InvoiceBatch_Transfer. 

?:  May need to add another Transfer 

Type in the future to handle MSP 

 invh_COBInvoiceID 

Not being used? 

bigint  8 True   

 invh_SchedulePayersChecksum 

The results of each Schedule Payer 

Checksum of Sequence, Client-

PayerID, PayerID, and 

Sequence*ClientPayerID*PayerID 

then grouped by Schedule or 

Schedule Expense and aggregate 

checksummed. 

int  4 False  ((-1)) 

 invh_COBSequence 

Not being used? 

int  4 False  ((0)) 

 

invh_CancelEFTID 

For Royalty processes that include 

PPS Invoices.  When a PPS RAP or 

PPS Final Invoice is canceled, a 

portion of those charges must be 

reversed on the Royalty Extract.  At 

the time that amount is included on 

an extract the invh_CancelEFTID will 

be stamped with the associated 

EFTID. 

int  4 True   

 

invh_AssociatedPPSInvoiceHeader-

ID 

For PPS Rap Invoices this ID will 

point to the PPS Final Invoice and 

vice versa.  When a PPS Final 

Invoice is canceled, this ID will 

remain and will continue to point to 

the PPS RAP Invoice, but this field 

will be cleared out on the PPS Rap 

Invoice. 

bigint  8 True   

 invh_RoyaltyFrontPercentage 

For Royalty that includes PPS, this is 

the Amount of a billed RAP that is 

added to the Royalty when the RAP 

is included in a Royalty Period.  It will 

be followed by a PPS Royalty 

Fulfillment when the RAP is canceled 

or the Final Claim is finalized.  The 

decimal(5,4)  5 False  ((1)) 
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Indexes 

 

  

fulfillment percentage will be equal to 

1 - the Front Percentage. 

Key Name Key Columns Unique 

 
PK_T_InvoiceHeader invh_ID True 

 IX_T_InvoiceHeader_InvoiceNumber invh_InvoiceNumber, invh_BranchID True 

 IX_T_InvoiceHeader_AdmissionID invh_AdmissionID  

 IX_T_InvoiceHeader_Associated-

PPSInvoiceHeaderID 

invh_AssociatedPPSInvoiceHeaderID  

 IX_T_InvoiceHeader_BatchID invh_BatchID  

 IX_T_InvoiceHeader_BranchID_AcctExtID_-

InvoiceDate 

invh_BranchID, invh_AcctExtID, invh_InvoiceDate  

 IX_T_InvoiceHeader_BranchID_CancelDate invh_BranchID, invh_CancelDate  

 IX_T_InvoiceHeader_BranchID_InvoiceDate invh_BranchID, invh_InvoiceDate, invh_CancelDate, invh_-

ClientID, invh_PayerID 

 

 IX_T_InvoiceHeader_CancelEFTID invh_CancelEFTID  

 IX_T_InvoiceHeader_ClientID invh_ClientID, invh_InvoiceDate, invh_Balance, invh_ID  

 IX_T_InvoiceHeader_EFTID invh_EFTID  

 IX_T_InvoiceHeader_POCID invh_POCID  

 IX_T_InvoiceHeader_PayerID invh_PayerID  

 IX_T_InvoiceHeader_PeriodClosedID invh_PeriodClosedID  

 IX_T_InvoiceHeader_TransferFromInvoice-

HeaderID 

invh_TransferFromInvoiceHeaderID  

 IX_T_InvoiceHeader_TransferToInvoice-

HeaderID 

invh_TransferToInvoiceHeaderID  

 IX_T_InvoiceHeader_datePayerID invh_BranchID, invh_InvoiceDate, invh_CancelDate, invh_-

PayerID 

 

 _dta_index_T_InvoiceHeader_ID_PayerID_-

ClientID 

invh_ID, invh_PayerID, invh_ClientID  
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Foreign Keys 

 

 

 

 

 

Name Columns 

FK_T_InvoiceHeader_T_AcctExtract invh_AcctExtID->[dbo].[T_AcctExtract].[acctext_ID] 

FK_T_InvoiceHeader_T_Admissions invh_AdmissionID->[dbo].[T_Admissions].[adm_ID] 

FK_T_InvoiceHeader_T_BillType invh_BillTypeID->[dbo].[T_BillType].[biltyp_ID] 

FK_T_InvoiceHeader_T_Branches invh_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_InvoiceHeader_T_Client invh_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_InvoiceHeader_T_EFT invh_EFTID->[dbo].[T_EFT].[eft_ID] 

FK_T_InvoiceHeader_T_EFT_Cancel invh_CancelEFTID->[dbo].[T_EFT].[eft_ID] 

FK_T_InvoiceHeader_T_InvoiceBatch invh_BatchID->[dbo].[T_InvoiceBatch].[invb_ID] 

FK_T_InvoiceHeader_T_InvoiceHeader_PPS invh_AssociatedPPSInvoiceHeaderID->[dbo].[T_InvoiceHeader].[invh_ID] 

FK_T_InvoiceHeader_T_Payers invh_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_InvoiceHeader_T_PeriodDates invh_PeriodClosedID->[dbo].[T_PeriodDates].[prdcls_ID] 

FK_T_InvoiceHeader_T_Physician invh_Oper_PhysID->[dbo].[T_Physician].[phys_ID] 

FK_T_InvoiceHeader_T_Physician1 invh_Other_PhysID1->[dbo].[T_Physician].[phys_ID] 

FK_T_InvoiceHeader_T_Physician2 invh_Other_PhysID2->[dbo].[T_Physician].[phys_ID] 

FK_T_InvoiceHeader_T_Physician3 invh_Attend_PhysID->[dbo].[T_Physician].[phys_ID] 

FK_T_InvoiceHeader_T_PlanOfCare invh_POCID->[dbo].[T_PlanOfCare].[poc_ID] 

FK_T_InvoiceHeader_TransferFrom invh_TransferFromInvoiceHeaderID->[dbo].[T_InvoiceHeader].[invh_ID] 

FK_T_InvoiceHeader_TransferTo invh_TransferToInvoiceHeaderID->[dbo].[T_InvoiceHeader].[invh_ID] 
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Invoice Process 

 

 [dbo].[T_InvoiceProcess] 

 

 

Note: Detailed documentation is pending. 
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Margin Types 

 [dbo].[T_MarginTypes] 

 

Description 

Margin Types for liabilities that affect Gross Margin (Payroll and Billing). 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
margtyp_ID 

System generated ID number for the margin 

types record. 

Also called ID. 

int 4 False 10001 - 

1 

 

 
margtyp_Name 

The name of the margin type. 

Also called Name. 

nvarchar(50) 100 True   

 margtyp_CreatedDate 

UTC date updated by SQL server's current 

UTC date. 

The date the margin type record was created. 

Also called CreatedDate. 

datetime 8 False  (getutcdate()) 

 margtyp_CreatedUser 

The user logged in to the system when the 

margin type record was created. 

Also called CreatedUser. 

nvarchar(50) 100 False   

 margtyp_ModifiedDate 

UTC date updated by SQL server's current 

UTC date. 

The date when the margin types record was 

last modified. 

Also called ModifiedDate. 

datetime 8 False  (getutcdate()) 

 margtyp_ModifiedUser 

The user logged in to the system when the 

margin types record was last modified. 

Also called ModifiedUser. 

nvarchar(50) 100 False   

 margtyp_TS 

The timestamp field of the margin type record. 

Also called TS. 

timestamp 8 False   

 
margtyp_ListItemType 

 

The list type of the margin for the DropDown-

List control. 

tinyint 1 False  ((0)) 
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Indexes 

 

Foreign Keys 

 

 

 

 
margtyp_RptGroupID 

Optional report group ID for reporting. 

int 4 False  ((71)) 

 

margtyp_BranchID 

 

Optional Branch ID for offices that have 

special margin requirements not covered by 

the system margins. 

int 4 True   

 

margtyp_OverrideID 

Optional ID of system margin to be overridden 

with this margin. 

int 4 True   

 margtyp_Description 

The description of the margin type. 

nvarchar(1000) 2000 True  ('') 

 margtyp_Active 

The status active/inactive of the margin type. 

bit 1 False  ((1)) 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_MarginTypes margtyp_ID True 80 

 IX_T_MarginTypes_BranchOverride-

Name 

margtyp_BranchID, margtyp_OverrideID, margtyp_-

Name 

True 80 

Name Columns 

FK_T_MarginTypes_T_Branches margtyp_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_MarginTypes_T_MarginTypes margtyp_OverrideID->[dbo].[T_MarginTypes].[margtyp_ID] 

FK_T_MarginTypes_T_ReportGroups margtyp_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 
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Medications 

 

 [dbo].[T_Medications] 

 

 

Note: Detailed documentation is pending. 
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OT Exempt Types 

Note: The OT Exempt Types are no longer being used.  

 [dbo].[T_OTExemptTypes] 

 

Columns 

 

  

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

otextyp_ID int  False (10001,1)  
 

otextyp_Name [nvarchar](50) 50 False   

 otextyp_OTExemptHrs [decimal](8, 2)  False  0 

 otextyp_ListItemType tinyint  False  0 

 
otextyp_BranchID int  False   

 otextyp_RptGroupID int  False  122 

 
otextyp_OverrideID int  False   

 otextyp_Active bit  False   

 otextyp_CreatedDate datetime  False  (getutcdate()) 

 otextyp_CreatedUser [nvarchar](50) 50 False  'sbsdba' 

 otextyp_ModifiedDate datetime  False  (getutcdate()) 

 otextyp_ModifiedUser [nvarchar](50) 50 False  'sbsdba' 

 otextyp_TS timestamp  False   

 otextyp_Description [nvarchar](1000) 1000 False  ('') 

 otextyp_Bill 

Flag to indicate this NonWorking type 

applies to billing 

bit  False  0 

 otextyp_Pay 

Flag to indicate this NonWorking type 

applies to payroll 

bit  False  1 
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique 

Fill 

Factor 

 

PK_T_OTExemptTypes otextyp_ID True 80 

 IX_T_OTExemptTypes_BranchOverrideName otextyp_BranchID, otextyp_OverrideID, 

otextyp_Name 

True 80 

Name Columns 

FK_T_OTExemptTypes_T_Branches otextyp_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_OTExemptTypes_T_OTExemptTypes otextyp_OverrideID-> [dbo].[T_OTExemptTypes] ([otextyp_ID]) 

FK_T_OTExemptTypes_T_ReportGroups otextyp_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Payer Bill Codes 

 [dbo].[T_PayerBillCodes] 

 

 

Note: Detailed documentation is pending. 
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Payer Branches 

 [dbo].[T_PayerBranches] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
paybr_ID 

System generated unique ID for the Payer Branches 

record. 

bigint 8 False 1 - 1  

 
paybr_PayerID 

The ID of the Payer that this Payer Branches record is 

associated with. Flows from [T_Payer].[pay_id] 

bigint 8 False   

 
paybr_Branch_ID 

The ID of the Branch that this Payer Branches record is 

associated with. Flows from [T_Branches].[br_id]. 

Shown in the Payer/Offices form as the Office, shown in 

the Offices grid. 

int 4 False   

 paybr_CreatedUser 

The user logged in the system when the record was 

created. Called Created By in the Payer>Offices form, 

shown in the Offices grid. 

nvarchar(50) 100 False   

 paybr_CreatedDate 

The Date the Payer Branches record was created. UTC 

date. Updated by SQL Server's current UTC date. 

Called Created On in the Payer>Offices form, shown in 

the Offices grid. 

datetime 8 False  (getutcdate()) 

 paybr_ModifiedUser 

The user logged in the system when the record was last 

modified. Called Modified By in the Payer>Offices form, 

shown in the Offices grid. 

nvarchar(50) 100 False   

 paybr_ModifiedDate 

The date that this record was last modified. It is a UTC 

date and is updated by the SQL Server current UTC 

date. This date is converted to the user's computer's 

timezone in the UI. Called Modified On in the 

Payer>Offices form, shown in the Offices grid. 

datetime 8 False  (getutcdate()) 

 paybr_TS 

The TS field of the Payer Branches record. 

timestamp 8 False   

 paybr_AllowFlexibleTimeScheduling 

Indicates whether the payer uses flexible scheduling 

times. Used to control missed visit notifications. Used 

only for payer offices. Called Tel Ignore Time in the 

Payer>Offices form, shown in the Offices grid. When 

checked, a first downloaded arrival and departure call 

from the Telephony server associates to the first 

scheduled visit for the Client (If there are multiple visits 

bit 1 False  ((0)) 
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Indexes 

Foreign Keys 

scheduled for the day for a Client, any further 

downloaded arrival and departure calls will display in the 

Unassigned Calls section of the Telephony Call Review 

screen and need to be manually matched to the 

scheduled visit). 

Key Name Key Columns Unique Fill Factor 

 
PK_T_PayerBranches paybr_ID True 80 

Name Delete Columns 

FK_T_PayerBranches_T_Branches  paybr_Branch_ID->[dbo].[T_Branches].[br_ID] 

FK_T_PayerBranches_T_Payers Cascade paybr_PayerID->[dbo].[T_Payers].[pay_ID] 
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Payer Documents 

 [dbo].[T_PayerDocuments] 

 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
paydoc_ID bigint 8 False 1 - 1  

 
paydoc_PayerID bigint 8 False   

 
paydoc_TypeID int 4 False   

 paydoc_Data image max False   

 paydoc_Format nvarchar(50) 100 False   

 paydoc_FileName nvarchar(256) 512 False   

 paydoc_FileSize bigint 8 True   

 paydoc_Thumbnail image max True   

 paydoc_Notes nvarchar(4000) 8000 True   

 
paydoc_Sharelevel int 4 False   

 paydoc_CreatedDate datetime 8 False  (getutcdate()) 

 paydoc_CreatedUser nvarchar(50) 100 False   

 paydoc_ModifiedDate datetime 8 False  (getutcdate()) 

 paydoc_ModifiedUser nvarchar(50) 100 False   

 paydoc_TS timestamp 8 False   

 paydoc_isCompressed bit 1 False  ((0)) 

 
paydoc_SubTypeID int 4 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_PayerDocuments paydoc_ID True 80 

 IX_T_PayerDocuments paydoc_PayerID  80 

Name Columns 

FK_T_PayerDocuments_T_DocumentSubTypes paydoc_SubTypeID->[dbo].[T_DocumentSubTypes].[docstyp_ID] 

FK_T_PayerDocuments_T_DocumentTypes paydoc_TypeID->[dbo].[T_DocumentTypes].[doctyp_ID] 

FK_T_PayerDocuments_T_Payer paydoc_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_PayerDocuments_T_PayerDocumentShare-

Levels 

paydoc_Sharelevel->[dbo].[T_PayerDocumentShare-

Levels].[paydocslvl_ID] 
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Payer Phones 

 [dbo].[T_PayerPhones] 

 

 

Note: Detailed documentation is pending. 
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Payer Services 

 [dbo].[T_PayerServices] 

 

 

Note: Detailed documentation is pending. 
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Payer Status 

 [dbo].[T_PayerStatus] 

 

 

Note: Detailed documentation is pending. 
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Payer Type 

 [dbo].[T_PayerType] 

 

Description 

Defines the Payer Types available in the application. Users can use the system (Global) Payer -

Types, add their own Payer Types at the Office level, or override the system (Global) Payer-

Types.  

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
paytyp_ID 

System generated ID number for the Payer Type 

record. Also called ID. 

int 4 False 10001 - 

1 

 

 
paytyp_Name 

The Name of the Payer Type. 

nvarchar(50) 100 True  ('') 

 paytyp_Active 

The status of the payer type. 0 = inactive, 1 = active  

bit 1 False  ((1)) 

 paytyp_CreatedDate 

UTC date updated by SQL server's current UTC 

date. The date the payer type record was created. 

Also called Created On in the Drop Down 

Maintenance grid. 

datetime 8 False  (getutcdate()) 

 paytyp_CreatedUser 

The user logged in to the system when the payer 

type record was created. Also called Created By in 

the Drop Down Maintenance grid. 

nvarchar(50) 100 False   

 paytyp_ModifiedDate 

UTC date updated by SQL server's current UTC 

date. The date when the payer type record was last 

modified. 

Also called Modified On in the Drop Down 

Maintenance grid. 

datetime 8 False  (getutcdate()) 

 paytyp_ModifiedUser 

The user logged in to the system when the payer 

type record was last modified. Also called Modified 

By in the Drop Down Maintenance grid. 

nvarchar(50) 100 False   

 paytyp_TS 

The timestamp field of the payer type record. Also 

called TS. 

timestamp 8 False   

 
paytyp_ListItemType 

The list type of the payer type for the DropDown 

List control. 0 = Global, 1 = Office, 2 = Override  

tinyint 1 False  ((0)) 

 
paytyp_RptGroupID 

Optional report group ID for reporting. 

int 4 False  ((76)) 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 265 

Indexes 

Foreign Keys 

 

 

 

 

paytyp_BranchID 

Optional Branch ID for offices that have special 

payer type requirements not covered by the system 

payer types. 

int 4 True   

 

paytyp_OverrideID 

Optional ID of system payer type to be overridden 

with this payer type. 

int 4 True   

 paytyp_Description 

The description of the payer type. 

nvarchar(1000) 2000 True  ('') 

 
paytyp_AcctID 

The FK to the T_AcctsCharts table. The default 

acctID is set to 1 ( Default Account). This is called 

Accounting Chart in the Drop Down Maintenance 

grid in the UI, if exists.   

int 4 True   

 
paytyp_DefAcctID 

The FK to the T_AcctsCharts table. The default 

acctID is set to 1 ( Default Account). This is called 

Deferred Accounting Chart in the Drown Down 

Maintenance grid in the UI, if exists. This is the 

Account for Deferred Revenue such as Medicare 

Revenue.  

int 4 True   

 paytyp_AcctCode 

The Account Code of the associated Accounting 

Chart, if it exists. Called Account Code in the UI. 

nvarchar(50) 100 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_PayerType paytyp_ID True 80 

 IX_T_PayerType_BranchOverrideName paytyp_BranchID, paytyp_OverrideID, paytyp_Name True 80 

Name Columns 

FK_T_PayerType_T_AcctCharts paytyp_AcctID->[dbo].[T_AcctCharts].[acct_ID] 

FK_T_PayerType_T_AcctCharts1 paytyp_DefAcctID->[dbo].[T_AcctCharts].[acct_ID] 

FK_T_PayerType_T_Branches paytyp_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PayerType_T_PayerType paytyp_OverrideID->[dbo].[T_PayerType].[paytyp_ID] 

FK_T_PayerType_T_ReportGroups paytyp_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 
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Payers  

 [dbo].[T_Payers] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

pay_ID 

 

bigint 8 False 1 - 1  

 

pay_BranchID 

 

int 4 False   

(2)

 

pay_ClientID 

 

bigint 8 True   

(2) 

pay_Name 

 

nvarchar(50) 100 False   

 pay_Address1 

 

nvarchar(255) 510 True   

 pay_Address2 

 

nvarchar(60) 120 True   

 pay_City 

 

nvarchar(50) 100 True   

 pay_StateOrProvince 

 

nvarchar(20) 40 True   

 pay_PostalCode 

 

nvarchar(20) 40 True   

 pay_County 

 

nvarchar(50) 100 True   

 pay_Country 

 

int 4 False  ((240)) 

 pay_Active 

 

bit 1 False  ((1)) 

 pay_ContactSalut 

 

nvarchar(5) 10 True   

 pay_ContactTitle 

 

nvarchar(50) 100 True   

 
pay_ContactFirstName 

 

nvarchar(50) 100 True   

 
pay_ContactLastName 

 

nvarchar(50) 100 True   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 267 

 pay_Phone 

 

nvarchar(30) 60 True   

 pay_PhoneType 

 

int 4 True   

 pay_Notes 

 

text max True   

 
pay_PayerTypeID 

 

int 4 False   

 
pay_NPI 

 

nvarchar(10) 20 True   

 pay_BillTypeID 

 

int 4 False  ((9)) 

 pay_AgencyProviderNum 

 

nvarchar(20) 40 True   

 pay_ExcludeFromBatch 

 

bit 1 False  ((1)) 

 pay_PaymentTypeID 

 

int 4 True   

 pay_RegionID 

 

int 4 True   

 pay_AuthRequired 

 

bit 1 False  ((0)) 

 
pay_AnsiISAFI01 

Authorization Information Qualifier 

nvarchar(2) 4 True  ('00') 

 pay_AnsiISAFI02 

Authorization Information 

nvarchar(10) 20 True   

 
pay_AnsiISAFI03 

Security Information Qualifier 

nvarchar(2) 4 True  ('00') 

 pay_AnsiISAFI04 

Security Information 

nvarchar(10) 20 True   

 
pay_AnsiISAFI05_1 

Sender Interchange ID Qualifier 

nvarchar(2) 4 True  ('ZZ') 

 pay_AnsiISAFI06 

Interchange Sender ID 

nvarchar(15) 30 True   

 
pay_AnsiISAFI05_2 

Receiver Interchange ID Qualifier 

nvarchar(2) 4 True  ((28)) 

 pay_AnsiISAFI07 

Interchange Receiver ID 

nvarchar(15) 30 True   

 
pay_AnsiISAFI10 

Interchange Control Standards Indentifier 

char(1) 1 True  ('U') 

 pay_AnsiISAFI11 

Interchange Control Version Number 

nvarchar(5) 10 True  ('00401') 

 pay_AnsiISAFI12 

Interchange Control Version Number 

nvarchar(9) 18 True   

 
pay_AnsiISAFI13 

Aknowledgment Requested 

char(1) 1 True  ('1') 
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pay_AnsiISAFI14 

Usage Indicator 

char(1) 1 True  ('P') 

 pay_AnsiISAFI15 

Component Element Separator 

char(1) 1 True  ('>') 

 pay_AnsiGSF479 

 

nvarchar(2) 4 True  ('HC') 

 pay_AnsiGSF28 

Group Control Number 

int 4 True  ((1)) 

 pay_AnsiGSF455 

Group Control Number 

nvarchar(2) 4 True  ('X') 

 pay_AnsiGSF480 

Group Control Number 

nvarchar(12) 24 True  ('004010X096A1') 

 pay_AnsiSTF143 

Group Control Number 

nvarchar(3) 6 True  ((837)) 

 pay_AnsiSTF329 

Group Control Number 

nvarchar(9) 18 True  ('0001') 

 pay_AnsiSTF1705 

 

nvarchar(35) 70 True   

 pay_AnsiBHTF1005 

Transaction Set Purpose Code 

nvarchar(4) 8 True  ('0019') 

 pay_AnsiHeaderREFF128 

 

nvarchar(3) 6 True  ((87)) 

 pay_AnsiHeaderREFF127 

 

nvarchar(30) 60 True  ('004010X096A1') 

 pay_AnsiLoop1000ANM1F98 

 

nvarchar(3) 6 True  (N'41') 

 pay_AnsiLoop1000BNM1F98 

 

nvarchar(3) 6 True  (N'40') 

 pay_AnsiLoop1000ANM1F66 

 

nvarchar(2) 4 True  (N'46') 

 pay_AnsiLoop1000BNM1F66 

 

nvarchar(2) 4 True  (N'46') 

 pay_AnsiReceiverName 

 

nvarchar(35) 70 True   

 pay_AnsiIDType1 

1: Use NPI, 2: Use Employer's ID 3:Use 

Provider Number 

tinyint 1 False  ((1)) 

 pay_AnsiIDType2 

 

tinyint 1 False  ((0)) 

 pay_AnsiIDType3 

 

tinyint 1 False  ((0)) 

 pay_AnsiPhysIDType1 

 

tinyint 1 False  ((1)) 

 pay_AnsiPhysIDType2 

 

tinyint 1 False  ((0)) 

 pay_AnsiPhysIDType3 

 

tinyint 1 False  ((0)) 
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pay_InvoiceTotalRound 

0: No Rounding, 1: Round Up, 2: Truncate, 

3: Round 

tinyint 1 False  ((1)) 

 pay_InvoiceTotalRoundDecimal 

The Invoice Total Number of Decimals to 

Round 

tinyint 1 False  ((2)) 

 
pay_InvoiceLineRound 

0: No Rounding, 1: Round Up, 2: Truncate, 

3: Round 

tinyint 1 False  ((3)) 

 

pay_InvoiceLineRoundDecimal 

The Invoice Line Number of decimals to 

round 

tinyint 1 False  ((2)) 

 pay_EdiTypeID 

 

int 4 True   

 pay_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 pay_CreatedUser 

 

nvarchar(50) 100 False   

 pay_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 pay_ModifiedUser 

 

nvarchar(50) 100 False   

 pay_TS 

 

timestamp 8 False   

 pay_StatusID 

 

int 4 False  ((1)) 

 pay_LegacyID 

 

int 4 True   

 pay_LegacyBranchID 

 

int 4 True   

 pay_Email 

 

nvarchar(50) 100 True   

 
pay_ERNID 

 

nvarchar(10) 20 True   

 pay_Itemize1500Billing 

 

bit 1 False  ((0)) 

 pay_AllowMassEmail 

 

bit 1 False  ((0)) 

 pay_AuthorizationConflictsAllow 

 

tinyint 1 False  ((0)) 

 pay_AuthorizationConflictsOverride 

 

tinyint 1 False  ((0)) 

 pay_DailyBenefit12am 

If the Payers Split Type is assigned to  Daily 

Benefit in a schedule, and pay_Daily-

Benefit12am is false, then  DailyBenefitDay 

is the day of the Schedule Start time and 

would not Split 

bit 1 False  ((0)) 
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 pay_ShowDFPSplit 

0: Always 

1: Only on primary 

2: Never 

tinyint 1 False  ((2)) 

 pay_ShowDFPBalance 

0: Always 

1: Only on primary 

2: Never 

tinyint 1 False  ((2)) 

 pay_ShowDFPDailyBenefit 

0: Always 

1: Only on primary 

2: Never 

tinyint 1 False  ((2)) 

 pay_ShowDFPVisit 

0: Always 

1: Only on primary 

2: Never 

tinyint 1 False  ((2)) 

 pay_UseClientForInsured 

 

bit 1 False  ((0)) 

 
pay_InvDetailProviderTypeID 

0 = None, 1 = Caregiver, 2 = Office  

tinyint 1 False  ((0)) 

 pay_UseBillContactForSign 

 

bit 1 False  ((0)) 

 pay_UseBillProviderForFacility 

 

bit 1 False  ((0)) 

 pay_BillByShift 

 

bit 1 False  ((1)) 

 pay_StampAuth 

 

bit 1 False  ((0)) 

 pay_DXVersionDefault 

Current values: 

0: Timing Date 

9: ICD-9 

10: ICD-10 

255: No Diagnosis 

tinyint 1 False  ((0)) 

 pay_ContactSalutationID 

 

int 4 True   

 pay_InvBreakByAuth 

 

bit 1 False  ((0)) 

 pay_InvBreakByHCPCS 

 

bit 1 False  ((0)) 

 pay_InvoiceFromToType 

0) Invoice Batch From and Through dates 

1) Invoice First and Last Service Dates 

tinyint 1 False  ((0)) 

 pay_ShowInvFromDtOnly 

If Only single dated of service is reported for 

the Invoice. 

bit 1 False  ((0)) 
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True - The From Date only should be pulled 

to the invoice 

false - The From Date and To Date pulled 

by the option in pay_InvoiceFromToType 

 pay_InvoiceUnitFlag 

 

smallint 2 True   

 pay_ElectPmtGatewayCustProfileID 

 

nvarchar(20) 40 True   

 pay_ElectPmtDfltCustPmtProfileID 

 

nvarchar(20) 40 True   

 pay_InvParm_DisplayBrLogo 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_DisplayCrBalances 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_DisplayCarFistNameOnly 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_DisplayRecentPmts 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_DisplayOutstandingInv 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_DisplayDepositBalances 

0: False, 1: True, 2: Default 

tinyint 1 False  ((2)) 

 pay_InvParm_PmtWithinDays 

Payments within Days 

tinyint 1 True   

 pay_1500OthrPvdrType 

0 None, 2 Employer's Identification Number, 

3 Medicare Provider Number, 4 Medicaid 

Provider Number, 5 Blue Cross Provider 

Number, 6, Blue Shield Provider Number, 7 

License Number, 8 Taxonomy, 255 Office 

Additional 

tinyint 1 False  ((0)) 

 pay_AuthorizationFromPhysicanOrder 

Build Authorizations from Physicians 

Orders. Default the setting to False. 

bit 1 False  ((0)) 

 pay_InvParm_DisplaySchTime 

Determines whether to display Start and 

End Times on Invoice Details on (all 

versions) of the Standard Invoice, Payer 

Invoice, and Basic Invoice 

 0: False,  

 1: True,  

 2: Default 

tinyint 1 False  ((2)) 

 pay_485Box1UsePolicyNumber 

 

bit 1 False  ((0)) 

 pay_AnsiISAFI65 

Repetition Separator 

char(1) 1 True  ('^') 

 pay_DeliveryMethod 

1 is Print,2 is E-mail,3 is both Print and E-

mail 

tinyint 1 False  ((1)) 



272 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

 pay_AnsiSBR1032 

HIPAA 5010 - Added so we could data drive 

this value rather than having it hard coded 

depending on the EDI Type.  This allowed 

us to remove the Medicaid version of the 

837I.  This data element is SITUATIONAL, 

but at the moment should always be filled in.  

There are technically a limited number of 

options for this data element, but given the 

likliehood of this data element changing, I've 

decided to do NO edits against the value.  

The database default is a zero length string, 

but the Payer EDI screen will default this to 

"MA" for the 837I EDI Type and "MC" for the 

837P EDI Type. 

nvarchar(2) 4 True  ('') 

 pay_AnsiLoop2310A_Enable 

HIPAA 5010 - Added so we could data drive 

the use of the 837P 2310A - Referring 

Provider Loop.  This does not apply to the 

837I where 2310A is the Attending 

Physician Loop and is based off the UB04.  

A tinyint was used instead of a bit because 

these fields should really have more options 

that are currently stored elsewhere. 

VALUES: 

0 - Disabled 

1 - Enabled 

DEFAULT:  0 - Disabled 

tinyint 1 False  ((0)) 

 pay_AnsiLoop2310B_Enable 

HIPAA 5010 - Added so we could data drive 

the use of the 837P 2310B - Rendering 

Provider Loop.  This does not apply to the 

837I where 2310B is the Operating 

Physician Loop and is based off the UB04.   

A tinyint was used instead of a bit because 

these fields should really have more options 

that are currently stored elsewhere. 

VALUES: 

0 - Disabled 

1 - Office 

2 - Admission Case Manager 

3 - Schedule Caregiver 

DEFAULT:  1 - Office 

 

2012.10.15 - The values for this field have 

been altered.  A customer needed the ability 

to use the Admission Case Manager as the 

rendering provider.  Another scenario of 

Schedule Caregiver is a possibility, but has 

not been added to the UI and has not been 

coded for. 

tinyint 1 False  ((1)) 

 pay_AnsiLoop2310C_Enable 

HIPAA 5010 - Added so we could data drive 

the use of the 837P 2310C - Service Facility 

Loop.  This does not apply to the 837I where 

tinyint 1 False  ((0)) 
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2310C is the Other Operating Physician 

Loop and is based off the UB04.   A tinyint 

was used instead of a bit because these 

fields should really have more options that 

are currently stored elsewhere. 

VALUES: 

0 - Disabled 

1 - Office 

2 - Patient Home 

DEFAULT:  0 - Disabled 

 pay_AnsiCLM1359 

HIPAA 5010 - Added so we could data drive 

this value rather than having it hard coded.  

Previously this value was always returned 

as "A" - Assigned. 

VALUES: 

"A" - Assigned 

"C" - Not Assigned 

 

A value "B" - Clinical Lab Services Only 

does not apply to our customers so it is not 

supported. 

char(1) 1 True  ('A') 

 pay_AnsiCLM1351 

HIPAA 5010 - Added so we could data drive 

this value rather than having it hard coded.  

Previously this value was always returned 

as "".  This should technically be an 

Admission level value, but it is unlikely that 

any of our customers require the ability to 

change this at the admission level. 

VALUES: 

"" - Not Required 

"P" - Signature Generated by provider 

 

nvarchar(1) 2 True  ('') 

 pay_AnsiCLM1331 

Place of Service Code - HIPAA 5010 - 

Added so we could data drive this value 

rather than having it hard coded.  Previously 

this value was always returned as "12".  This 

should technically be a Claim level value.  

We do have this at the Service Level but I 

don't want to force them to update this on 

every Service.  It will almost always be "12" 

for our customers.  I'm adding it to the Payer 

EDI so that they can override it in case they 

need to.  This will Default to "12" - Home.  

These values are maintained by the NUBC 

and can be updated outside the 837 spec, 

so this will not be a dropdown, it will be a 

textbox where they can freewrite their 

values.  The min length of the field is 1, the 

max length is 2. 

nvarchar(2) 4 True  ('12') 

 pay_AnsiCLM1325 

Claim Frequency Code - HIPAA 5010 - 
nvarchar(1) 2 True  ('1') 
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Added so we could data drive this value 

rather than having it hard coded.  Previously 

this value was always returned as "1".  This 

should technically be a Claim level value.  

This is usually "1", "2", "3", or "4" for Home 

Care, but it's really used for UB04s and the 

837I.  I believe I read somewhere that it 

should always be "1" for Home Health 

Claims on the 1500/837P.  There is no place 

to specify it on the 1500, so I'm adding it to 

the Payer EDI so that they can override it in 

case they need to.  This will Default to "1".  

These values are maintained by the NUBC 

and can be updated outside the 837 spec, 

so this will not be a dropdown, it will be a 

textbox where they can freewrite their 

values.  This field must be exactly 1 

character. 

 pay_AnsiCLM1073_1 

Provider Signature Indicator - HIPAA 5010 - 

Added so we could data drive this value 

rather than having it hard coded.  Previously 

this value was always returned as "Y".  This 

should technically be a Claim level value.  

But for most provider/payer relationships it 

will always be the same.  I'm adding it to the 

Payer EDI so that they can override it in 

case they need to.  This will Default to "Y".  

There are only 2 possible values, "Y" - Yes 

and "N" No.  This field must be exactly 1 

character. 

nvarchar(1) 2 True  ('Y') 

 pay_EDIPostingTypeID 

1 - Original PPS 835 posting (no longer 

used) 

2 - New PPS 835 posting 

3 - SVC level REF*6R based posting 

4 - SVC level Procedure Code Date Range 

Posting 

5 – Tellus SVC level REF*6R based posting 

tinyint 1 False  ((3)) 

 pay_AnsiLoop2300REF_9F_Enable 

 

tinyint 1 False  ((0)) 

 pay_EDIAdditionalID 

 

nvarchar(50) 100 True   

 pay_EDIAdditionalIDType 

 

nvarchar(3) 6 True   

 pay_InvParm_PayerInvGroupBy 

2:  Client 

1:  Caregiver 

tinyint 1 False  ((2)) 

 pay_AnsiLoop2010BBNM1F1035_1 

Loop 2010BB NM103 

nvarchar(60) 120 True   

 pay_AnsiLoop2010BBNM1F66 

Loop 2010BB NM108 

 

nvarchar(2) 4 False  (N'PI') 
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Values: 

"PI" - Payer Identifier 

"XV" - Centers for Medicare and Medicaid 

Services PlanID 

 pay_AnsiLoop2010BBNM1F67 

Loop 2010BB NM109 

nvarchar(80) 160 True   

 pay_InvParm_DisplaySchNote 

Determines whether to display Schedule 

Notes (sch_Description) on the Standard 

and Payer Invoice 

 

VALUES 

0: False  

1: True 

2: Default (Use value in T_Branches.br_Inv-

Parm_DisplaySchNotes) 

 

DEFAULT 

2: Default (Use value in T_Branches.br_Inv-

Parm_DisplaySchNotes) 

tinyint 1 False  ((2)) 

 pay_InvoiceGroupingTypeID 

Determines what logic to use for grouping 

Invoice Details.  Values taken from T_-

InvoiceGroups 

 

VALUES 

0: No Grouping 

1: Group by Service across entire Invoice 

2: Group by Service and Day (as defined by 

Service Start Date) 

 

DEFAULT 

0: No Grouping 

int 4 False  ((0)) 

 pay_WeeklyBenefitStart 

Setting for Weekly benefits.values are from 

0 to 6 representing days of week.default 

value takes from br_TreatmentWeekStart-

Day from the UI when creating new payer 

tinyint 1 False  ((0)) 

 pay_MonthlyBenefitStart 

Setting for Monthly Benefit Start.values are 

from 1 to 31 representing days of month. 

tinyint 1 False  ((1)) 

 pay_AnsiLoop1000ANM1F1035_1 

Loop 1000A NM103 

nvarchar(60) 120 True   

 pay_AnsiLoop1000ANM1F67 

Loop 1000A NM109 

nvarchar(80) 160 True   

 pay_AnsiLoop1000BNM1F67 

Loop 1000B NM109 

nvarchar(80) 160 True   

 pay_AnsiGSF142 

GS02 

nvarchar(15) 30 True   
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 pay_AnsiGSF124 

GS03 

nvarchar(15) 30 True   

 pay_AnsiLoop2000C_Enable 

HIPAA 5010 - Added so we could data drive 

the use of the 837P 2000C - Patient 

Hierarchical Loop.  Because most of our 

customers provide services to Homebound 

patients, they are usually the patient is 

usually the insured.  This is especially true 

for Medicare and the Medicaid providers 

we've used.  This specific change is being 

made to address issues for a customer 

doing services for children who are usually 

not the Insured.  Logic for creating the 

patient loop will also depend on information 

on the UB04 and HCFA1500.  However, in 

order to avoid any complications with 

existing customers, this field has been 

added to force customers to turn this loop 

on in the few cases where they may provide 

services to dependents of the insured. 

VALUES: 

0 - Disabled 

1 - Enabled 

DEFAULT:   

0 - Disabled 

tinyint 1 False  ((0)) 

 
pay_ContAllowAdj 

pay_ContAllowAdj:  This field stores the 

type of adjustment to use when the Invoice 

Draft uses the public rate to determine the 

charge and creates a contractual allowance 

revenue adjustment to set the receivable 

amount to the contracted rate.  This way the 

invoice displays the public rate but the 

receivable is still the contract rate.  If this 

field is empty it equates to using the contract 

rate for the charge and not using public rate 

w/ adjustments.  The UI filters the available 

adjustments to offer just those adjustments 

where posttyp_PostingType = 1 (Invoice 

Revenue Adjustment) and posttyp_Type = 0 

(Amount can be positive or negative). 

int 4 True   

 pay_InvBreakByPOC 

Determines whether to split an Invoice by 

Plan of Care 

bit 1 False  ((0)) 

 pay_EDI837_TerminateSegmentWithLine-

Feed 

This field determines whether or not 837 

extracts have line feeds between segments 

bit 1 False  ((1)) 

 pay_InvParm_DisplayRatesCharges 

Controls displaying rates and charges on 

invoices. 1 displays them, 0 hides them. 

Defaults to 1. 

bit 1 False  ((1)) 

 pay_Features 

Collection of settings associated to a payer.  

int 4 True   
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Indexes 

 

Foreign Keys 

 

 

 

 

 

1 = Enable Order Tracking (associated with 

running plan of care) 

 pay_EvvAggregatorId 

Determines the EVV Aggregator to be used 

by this payer.  This is a foreign key to T_-

EVVAggregators. 

int 4 True   

Key Name Key Columns 

Included 

Columns Unique 

Fill 

Factor 

 
PK_T_Payers pay_ID  True 80 

 IX_T_ContactFirstName pay_ContactFirstName   80 

 IX_T_ContactLastName pay_ContactLastName   80 

 IX_T_Payers pay_ClientID   80 

 IX_T_Payers_BranchID_ERNID pay_BranchID, pay_-

ERNID 

  80 

 IX_T_Payers_ClientID pay_ClientID   80 

 IX_T_Payers_Name pay_Name   80 

 IX_T_Payers_PayerTypeID pay_PayerTypeID   80 

 _dta_index_T_Payers_15_1512756842__-

K1_4 

pay_ID pay_Name  80 

Name Columns 

FK_T_Payers_T_Branches pay_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_Payers_T_Client pay_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_Payers_T_PaymentPostingType pay_ContAllowAdj->[dbo].[T_PaymentPostingType].[posttyp_ID] 
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Payment Posting 

 

 [dbo].[T_PaymentPosting] 

 

 

Note: Detailed documentation is pending. 
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Payment Posting Type 

 

 [dbo].[T_PaymentPosting Type] 

 

 

Note: Detailed documentation is pending. 
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Payment Register 

 

 [dbo].[T_PaymentRegister] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
pmtreg_ID bigint 8 False 1 - 1  

(3)

 

pmtreg_BranchID int 4 False   

 
pmtreg_Number nvarchar(50) 100 True   

 pmtreg_Amount money 8 False  ((0)) 

 pmtreg_Net-

Payment 

money 8 False  ((0)) 

 
pmtreg_PayerID bigint 8 False   

 pmtreg_Dated datetime 8 True   

(2) 
pmtreg_Deposit-

Date 

datetime 8 True   

 pmtreg_Memo nvarchar(1000) 2000 True   

 
pmtreg_Payment-

RegisterStatusID 

int 4 False  ((0)) 

 
pmtreg_ClientID bigint 8 True   

 
pmtreg_Period-

DatesID 

bigint 8 True   

 
pmtreg_Payment-

RegisterTypeID 

int 4 False   

 pmtreg_-

OrderID 

int 4 True   

 pmtreg_-

Authorization-

Number 

nvarchar(50) 100 True   
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Indexes 

 pmtreg_-

Transaction-

Number 

nvarchar(50) 100 True   

 pmtreg_-

CreatedDate 

datetime 8 False  (getutcdate()) 

 pmtreg_-

CreatedUser 

nvarchar(50) 100 False   

 pmtreg_-

ModifiedDate 

datetime 8 False  (getutcdate()) 

 pmtreg_-

ModifiedUser 

nvarchar(50) 100 False   

 pmtreg_TS timestamp 8 False   

 

pmtReg_-

AcctExtID 

bigint 8 True   

 pmtReg_-

AcctExtDate 

datetime 8 True   

 pmtreg_-

Deposit-

Balance 

money 8 False  ((0)) 

 
pmtreg_-

AvailableTo-

Post 

money 8 False  ((0)) 

 
pmtReg_Edi-

ID 

bigint 8 True   

 pmtreg_-

ElectPmt-

CustID 

nvarchar(20) 40 True   

 pmtreg_-

ElectPmt-

CustPmtID 

nvarchar(20) 40 True   

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_PaymentRegister pmtreg_ID True 80 

 IX_T_PaymentRegister pmtreg_BranchID, pmtreg_AvailableToPost  80 

 IX_T_PaymentRegister_1 pmtreg_BranchID, pmtreg_Number  80 

 IX_T_PaymentRegister_BranchID pmtreg_BranchID, pmtreg_PaymentRegister-

StatusID 

 80 
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Foreign Keys 

 

 

 

 

 IX_T_PaymentRegister_DepositDate pmtreg_DepositDate  80 

 IX_T_PaymentRegister_PayerDeposit-

Client 

pmtreg_PayerID, pmtreg_DepositDate, pmtreg_-

ClientID 

  

 IX_T_PaymentRegister_PeriodClosing-

DateID 

pmtreg_PeriodDatesID  80 

 IX_T_PaymentRegister_pmtReg_AcctExt-

ID 

pmtReg_AcctExtID   

Name Columns 

FK_T_PaymentRegister_T_AcctExtract pmtReg_AcctExtID->[dbo].[T_AcctExtract].[acctext_ID] 

FK_T_PaymentRegister_T_Branches pmtreg_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PaymentRegister_T_Client pmtreg_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_PaymentRegister_T_EDIPayments pmtReg_EdiID->[dbo].[T_EDIPayments].[edipmt_ID] 

FK_T_PaymentRegister_T_Payers pmtreg_PayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_PaymentRegister_T_PaymentRegister1 pmtreg_PaymentRegisterStatusID->[dbo].[T_PaymentRegister-

Status].[pmtrstat_ID] 

FK_T_PaymentRegister_T_PaymentRegister-

Types 

pmtreg_PaymentRegisterTypeID->[dbo].[T_PaymentRegister-

Types].[pmtrtyp_ID] 

FK_T_PaymentRegister_T_PeriodDates pmtreg_PeriodDatesID->[dbo].[T_PeriodDates].[prdcls_ID] 
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Payment Register Status 

 

 [dbo].[T_PaymentRegisterStatus] 

 

 

Note: Detailed documentation is pending. 
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Payment Register Types 

 

 [dbo].[T_PaymentRegisterTypes] 

 

 

Note: Detailed documentation is pending. 

 

 

 

 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 285 

Payment Types 

 

 [dbo].[T_PaymentTypes] 

 

 

Note: Detailed documentation is pending. 
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Payroll Adjustment 

 [dbo].[T_PayrollAdjustment] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

prolla_ID 

 

bigint 8 False 1 - 1  

 
prolla_BranchID 

 

int 4 False   

 
prolla_ScheduleID 

 

bigint 8 False   

 

prolla_PayrollAdjCode 

 

int 4 False   

 
prolla_PayDate 

 

datetime 8 True   

 
prolla_Unit 

 

decimal(8,2) 5 False   

 
prolla_Rate 

 

money 8 False   

 

prolla_Status 

0 – Not Paid, 1 – In Progress, 2 – Completed 

smallint 2 False  ((0)) 

 prolla_RecalcOvertime 

 

bit 1 False  ((0)) 

 prolla_Notes 

 

nvarchar(500) 1000 True   

 prolla_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 prolla_CreatedUser 

 

nvarchar(50) 100 False   

 prolla_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 prolla_ModifiedUser 

 

nvarchar(50) 100 False   

 prolla_TS 

 

timestamp 8 False   

 prolla_OriginalPayDate 

prolla_PayDate will be transfered to this field 

during finalizing of payroll for cancelation process 

to revert back to the original value 

datetime 8 True   
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Indexes 

Foreign Keys 

 

 

 

 

Key Name Key Columns Unique Fill Factor 

 
PK_T_PayrollAdjustment prolla_ID True 80 

 IX_T_PayrollAdjustment_AdjustmentCode prolla_PayrollAdjCode  80 

 IX_T_PayrollAdjustment_PayDate prolla_PayDate  80 

 IX_T_PayrollAdjustment_Status prolla_Status  80 

Name Columns 

FK_T_PayrollAdjustment_T_Branches prolla_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PayrollAdjustment_T_PayrollAdjustment prolla_ID->[dbo].[T_PayrollAdjustment].[prolla_ID] 

FK_T_PayrollAdjustment_T_PayrollAdjustmentCode prolla_PayrollAdjCode->[dbo].[T_PayrollAdjustmentCode].[prollac_ID] 

FK_T_PayrollAdjustment_T_Schedules prolla_ScheduleID->[dbo].[T_Schedules].[sch_ID] 
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Payroll Adjustment Code 

 [dbo].[T_PayrollAdjustmentCode] 

 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
prollac_ID int 4 False 10001 - 1  

 prollac_Active bit 1 False  ((1)) 

 prollac_CreatedDate datetime 8 False  (getutcdate()) 

 prollac_CreatedUser nvarchar(50) 100 False   

 prollac_ModifiedDate datetime 8 False  (getutcdate()) 

 prollac_ModifiedUser nvarchar(50) 100 False   

 prollac_TS timestamp 8 False   

 
prollac_Name nvarchar(50) 100 True  ('') 

 
prollac_ListItemType tinyint 1 False  ((0)) 

 
prollac_RptGroupID int 4 False  ((130)) 

 
prollac_BranchID int 4 True   

 prollac_Description nvarchar(1000) 2000 True   

 
prollac_OverrideID int 4 True   

 prollac_PayrollCode nvarchar(50) 100 False  ('E0A') 

 prollac_DeductEarn nvarchar(5) 10 False  (N'E') 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_PayrollAdjustmentCode prollac_ID True 80 

 IX_T_PayrollAdjustmentCode_BranchID_-

OverrideID_Name 

prollac_BranchID, prollac_OverrideID, 

prollac_Name 

True  

Name Columns 

FK_T_PayrollAdjustmentCode_T_Branches prollac_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PayrollAdjustmentCode_T_PayrollAdjustmentCode prollac_OverrideID->[dbo].[T_PayrollAdjustmentCode].[prollac_ID] 

FK_T_PayrollAdjustmentCode_T_ReportGroups prollac_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 
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Payroll Batch 

 [dbo].[T_PayrollBatch] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
prollb_ID 

The ID field of the PayrollBatchInfo object. 

System ID for the payroll batch record. 

Also called PayrollBatchID, BatchID. 

Column "Batch ID" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Batch ID" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

bigint 8 False 1 - 1  

(2)

 

prollb_BranchID 

System ID for the branch in the payroll batch record. 

This is the branch that the payroll was 

drafted/finalized in. If Payroll Across Offices is turned 

off (glbl_PayrollUserCaregiverOffice == 0), the batch 

will only pull in schedules from admissions belonging 

to that Office. 

If Payroll Across Offices is turned on (glbl_Payroll-

UserCaregiverOffice == 1), the batch will pull in 

schedules for Caregivers that belong to this Office. 

int 4 False   

 
prollb_ExtractTypeID 

The ExtractTypeID field of the PayrollBatchInfo object. 

System ID for the payroll extract type record. 

 

The PayrollExtractType contains information about 

how to process schedules, OT, and Payroll 

Adjustments.. These are found in the T_Payroll-

ExtractTypes table.  

Used to pull the extract type name and show on: 

 

Column "Payroll Type" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

 

Column "Payroll Type" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

int 4 False  ((2)) 

(2) 

prollb_PayDate 

The PayDate field of the PayrollBatchInfo and Payroll-

AdjustmentDetailInfo objects. 

 

Non-UTC date. 

datetime 8 False   
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The day payments to caregivers are made. 

This will be stamped on the schedule (sch_PayDate) 

of the caregiver. 

 

Also called PayDate, BatchDate. 

Column "Pay Date" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Pay Date" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

 prollb_FinalizedDate 

The FinalizedDate field of the PayrollBatchInfo object. 

The date the payroll batch is finilized and locked for 

changes. 

 

UTC date. Updated by SQL Server's current UTC 

date (GetUTCDate) 

. When a draft batch is finalized the records are 

removed from T_PayrollDetailsDraft and moved to T_-

PayrollDetails (along with a few supporting tables). 

Also called FinalizedDate.Column "Finalized Date" on 

Create Payroll > Batch > "Select an Existing 

Batch" drop down. (Visible) 

Column "Finalized Date" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 True   

 

prollb_CaregiverGroupID 

The CaregiverGroupID field of the PayrollBatchInfo 

object. 

System ID for the caregiver group record. 

 

The Caregiver Group is not a required field, and if the 

Caregiver Group is left blank, ALL Caregivers 

(regardless of Caregiver Group) will pull into the 

payroll batch. If a Caregiver Group is selected, only 

those Caregivers with a matching group will pull in.  

Used to pull the caregiver group name and show on: 

Column "Caregiver Group" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Caregiver Group" on Finilized Payroll > 

Batch > "Select an Existing Batch" drop down. 

(Visible) 

int 4 True   

 
prollb_PayrollCompanyExtractTypeID 

The PayrollCompanyExtractTypeID field of the 

PayrollBatchInfo object. 

 

System ID for the payroll company extract type in the 

payroll batch record. 

 For 

Foreign Key to T_PayrollCompanyExtractTypes. 

This table contains information about how to export 

the payroll batch records into a data file.   

Used to pull the payroll company extract name and 

show on: 

int 4 True   
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Column "Pr Co Extract" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

 prollb_LastPRCompanyExtractDate 

The LastPRCompanyExtractDate field of the Payroll-

BatchInfo and DraftPayrollBatchResults objects. 

UTC date. 

Updated by SQL Server's current UTC date (Get-

UTCDate) 

 

The most recent date when the payroll batch was 

extracted into a data file.  

Column "Ex Last Run" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 True   

 prollb_LastPRCompanyExtractUser 

The LastPRCompanyExtractUser field of the Payroll-

BatchInfo and DraftPayrollBatchResults objects. 

 

The user who last extracted data from the payroll 

extract.  

Column "Run By" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

nvarchar(50) 100 True   

 prollb_CreatedDate 

The Date the PayrollBatch Record was Created. 

UTC date. Updated by SQL Server's current UTC 

date (GetUTCDate) 

Also callled CreatedDate, Created_Date. 

Column "Created On" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Created On" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 False  (getutcdate()) 

 prollb_CreatedUser 

 

The CreatedUser field of the PayrollBatchInfo object. 

 

Also callled CreatedUser. 

Column "Created By" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Created By" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

nvarchar(50) 100 False   

 prollb_ModifiedDate 

 

The Date the PayrollBatch Record was last Modified. 

 

UTC date. Updated by SQL Server's current UTC 

date (GetUTCDate) 

Also callled ModifiedDate. 

Column "Modified On" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Modified On" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 False  (getutcdate()) 
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 prollb_ModifiedUser 

 

The ModifiedUser field of the PayrollBatchInfo object. 

Also callled ModifiedUser. 

Column "Modified By" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Modified By" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

nvarchar(50) 100 False   

 prollb_TS 

The TS (timestamp) field of the PayrollBatchInfo and 

DraftPayrollBatchResults objects. 

Also called TS. 

timestamp 8 False   

 prollb_CancelUser 

The CancelUser field of the PayrollBatchInfo object. 

The user who cancelled the payroll batch. 

Column "Canceled By" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

nvarchar(50) 100 True   

 prollb_CancelDate 

 

The CancelDate field of the PayrollBatchInfo object. 

The date the payroll batch was cancelled. 

UTC date. Updated by SQL Server's current UTC 

date (GetUTCDate) 

Column "Canceled On" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 True   

 prollb_ServiceThroughDate 

The ServiceThroughDate field of the PayrollBatchInfo 

object. 

Also called Date, ServiceThroughDate. 

The end date of the payroll period to include 

completed services.The payroll will include any 

completed schedules that were not previously 

included in payroll extracts with service date prior to 

the through date.  

Column "Service Through Date" on Create Payroll > 

Batch > "Select an Existing Batch" drop down. 

(Visible) 

Column "Service Through Date" on Finilized Payroll > 

Batch > "Select an Existing Batch" drop down. 

(Visible) 

datetime 8 True   

 prollb_LastDraftDate 

 

The LastDraftDate field of the PayrollBatchInfo object. 

UTC date. 

The last date that the payroll batch was drafted. 

Column "Last Drafted on" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

datetime 8 True   

 prollb_LastDraftUser 

 

The LastDraftUser field of the PayrollBatchInfo object. 

nvarchar(50) 100 True   
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Indexes 

Foreign Keys 

 

 

The last user that drafted this payroll batch. 

Column "Last Drafted By" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

 
prollb_CaregiverID 

Foreign Key to T_Caregiver.  

If this field is null then schedules were not filtered by 

caregiver ID.  

If this field has a value then only schedules with the 

same caregiver ID will be brought into the batch.  

Shown on: 

Column "Caregiver" on Create Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

Column "Caregiver" on Finilized Payroll > Batch 

> "Select an Existing Batch" drop down. (Visible) 

bigint 8 True   

 prollb_OTSettings 

XML formatted overtime settings record at the time 

the payroll batch was created.  

xml max True   

 prollb_IsHolidayOTEligible 

Is Holiday OT Eligible. When the value = 1 then 

Holiday Pay is included in Regular Rate OT 

Calculation. This is the value from the Office at the 

time that the Payroll Batch is created.  

bit 1 False  ((1)) 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_PayrollBatch prollb_ID True 80 

 IX_T_PayrollBatch_BranchID prollb_BranchID  80 

 IX_T_PayrollBatch_BranchID_Caregiver-

GroupID_PayDate 

prollb_BranchID, prollb_CaregiverGroupID, 

prollb_PayDate 

 80 

 IX_T_PayrollBatch_PayDate prollb_PayDate  80 

Name Columns 

FK_T_PayrollBatch_T_Branches prollb_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PayrollBatch_T_Caregiver prollb_CaregiverID->[dbo].[T_Caregiver].[car_ID] 

FK_T_PayrollBatch_T_CaregiverGroup prollb_CaregiverGroupID->[dbo].[T_CaregiverGroup].[carg_ID] 

FK_T_PayrollBatch_T_PayrollCompany-

ExtractTypes 

prollb_PayrollCompanyExtractTypeID->[dbo].[T_PayrollCompanyExtract-

Types].[prollcoe_ID] 

FK_T_PayrollBatch_T_PayrollExtractTypes prollb_ExtractTypeID->[dbo].[T_PayrollExtractTypes].[prolle_ID] 
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Payroll Details 

 [dbo].[T_PayrollDetails] 

 

Columns 

Key Name Data Type Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

prolld_ID 

The ID field of the PayrollDetailsInfo 

object. 

System ID for the payroll detail record. 

This provides a unique ID for each 

payroll detail record in the batch. Ex: 

One schedule could be split into shifts, 

resulting in two payroll detail records. 

Each payroll detail record would have 

the same Schedule ID but a different 

Payroll Detail ID. Ex: A schedule could 

have an expense, with both processed in 

the same payroll batch. The service and 

the expense would have the same 

Schedule ID but a different Payroll Detail 

ID. Ex: Overtime records do not have a 

Schedule ID – the Payroll Detail ID is the 

ID for overtime records. This does not 

display on the Finalized payroll batch 

form. 

Also called Pay Detail ID and Payroll-

DetailsID. Column "ID" in Payroll Batch 

Details > Batch Create Payroll Details 

(Hidden). 

bigint  8 False 1 - 1  

(4)

 

prolld_PayrollBatchID 

The PayrollBatchID field of the Payroll-

DetailsInfo object. 

Displays on the Finalized payroll batch 

form in the batch drop down list Batch ID 

field. 

Column "Payroll Batch ID"  in Payroll 

Batch Details > Batch Create Payroll 

Details (Hidden). 

bigint  8 False  ((0)) 

 prolld_CheckTransID 

The CheckTransID field of the Payroll-

DetailsInfo object. 

Column "Check Trans ID" in Payroll 

Batch Details > Batch Create Payroll 

Details (Hidden). 

int  4 True   
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(4)

 

prolld_CaregiverID 

The CaregiverID field of the Payroll-

DetailsInfo object. 

System ID of the Caregiver in the payroll 

detail record. This does not display on 

the Finalized payroll batch form. 

Column "Caregiver" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

bigint  8 False  ((0)) 

 prolld_PayrollCompanyEmployeeID 

The PayrollCompanyEmployeeID field of 

the PayrollDetailsInfo object. 

Also called EmpNum, EmplNo, Vendor, 

caregid, Emp ID, caregiverFileNumber, 

EmpPrCoID, EmployeeID, Payroll-

EmployeeID, cgPayrollFileNum. 

Column "Payroll File #" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible). 

nvarchar(50)  100 True   

 

prolld_ScheduleID 

The ScheduleID field of the Payroll-

DetailsInfo object. 

System ID of the payroll detail record. 

Displays on the Finalized payroll batch 

form in the Sch/Exp ID column on the 

payroll details grid. 

Column "Schedule" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

bigint  8 True   

 

prolld_ScheduleExpenseID 

The ScheduleExpenseID field of the 

PayrollDetailsInfo object. 

Also called Expense_ID. 

System ID of the expense payroll detail 

record. Displays on the Finalized payroll 

batch form in the Sch/Exp ID column on 

the payroll details grid. [Note: The 

expense row in the extract file will 

contain both a Schedule_ID and a 

Schedule_Expense_ID.] 

 

Column "Schedule Expense" in Payroll 

Batch Details > Batch Create Payroll 

Details (Hidden). 

bigint  8 True   

 prolld_ShiftNo 

The ShiftNo field of the PayrollDetails-

Info object. 

Office Shifts are configured to account 

for all 168 hours of the 7 day week, 

starting with Sunday 12:00 am and 

ending with Sunday 12:00 am. Each 

office should have at least Shift 1 

configured (one shift that covers all 168 

hours). The system can accommodate 

up to 6 Shifts. Each Office Shift is 

smallint  2 True   
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named in the Shift Descriptions portion 

of the form, then each shift is defined 

with Day and Start/End times in the Shift 

Assignment portion of the form. 

Shift number can be from 1 through 6. 

Column "Shift" in Payroll Batch Details > 

Batch Create Payroll Details (Visible). 

 
prolld_BranchHolidayID 

The BranchHolidayID field of the Payroll-

DetailsInfo object. ID of the office holiday 

entry set up on "Holidays" tab of the 

office settings. Column "Holiday 

Name" in Payroll Bath Details > Batch 

Create Payroll Details (Visible). 

bigint  8 True   

 prolld_HolidayMultiplier 

The HolidayMultiplier field of the Payroll-

DetailsInfo object. 

The multiplier is be used against the 

established bill rates for the holiday rate 

calculations. The default value is 1.00. 

The multiplier for time and a half is 1.50. 

This is  set up on "Holidays" tab of the 

office settings. 

Column "Holiday Multiplier" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

decimal(4,2)  5 False  ((0)) 

 prolld_HolidayAddition 

The HolidayAddition field of the Payroll-

DetailsInfo object. 

The additional amount to be added to 

the established hourly bill rates for the 

holiday rate calculations. It is  set up on 

"Holidays" tab of the office settings. The 

default value is 0.00 which also 

means that no Add-On is to be used. 

Column "Holiday Add" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible). 

smallmoney  4 False  ((0)) 

 
prolld_ServiceEndTime 

The ServiceEndTime field of the Payroll-

DetailsInfo object. 

Service End Time of the payroll detail 

record. Displays on the Finalized payroll 

batch form in the Service End Time 

column on the payroll details grid. 

Overtime records will show the overtime 

period end date (daily or weekly, 

depending on the overtime record). 

 

Date and time the service ended, as 

recorded in the telephony interface. The 

duration is auto-calculated. UTC Date 

updated by the UI based on the user's 

datetime  8 True   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 297 

time zone.Also called Endtime, Service-

End, sch_EndTime. Used in the 

calculation of Hours and TotalHours. 

Column "Service End Time" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

(5) 

prolld_ServiceDate 

The ServiceDate field of the Payroll-

DetailsInfo object. 

Service Start Date of the payroll detail 

record. Displays on the Finalized payroll 

batch form in the Service Start Time 

column on the payroll details grid. 

Overtime records will show the overtime 

period start date (daily or weekly, 

depending on the overtime record). The 

file content sorts by Service Start 

Date/Start Time. 

Date and time the service started, as 

recorded in the telephony interface.UTC 

Date updated by the UI based on the 

user's time zone.Also called StartTime, 

SvcDate, Svc Date, ChargeDate, 

ServiceStart, ServiceStartDate, sch_-

StartTime. Used in the calculation of 

Hours and TotalHours.Column "Service 

Start Time" in Payroll Batch Details > 

Batch Create Payroll Details (Visible). 

datetime  8 False   

(2)

 

prolld_ServiceCodeID 

The ServiceCodeID field of the Payroll-

DetailsInfo object. 

System ID of the Service or Expense of 

the payroll detail record. This does not 

display on the Finalized payroll batch 

form. 

The ID of the service performed by the 

caregiver. Service codes are defined in 

Drop Down Maintenance Service Codes. 

This is a system generated number. Any 

Service Code with an ID under 10000 is 

a system default and cannot be 

changed.Column "Service" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

int  4 True   

 prolld_Notes 

The Notes field of the PayrollDetailsInfo 

object. 

Notes regarding caregiver pay 

adjustment. 

Column "Notes" in Payroll Batch Details 

> Batch Create Payroll Details (Hidden). 

nvarchar(255)  510 True   

 prolld_DeductionEarning 

The DeductionEarning field of the 

PayrollDetailsInfo object. 

Deduct/Earn Code of the payroll detail 

record. Displays on the Finalized payroll 

char(2)  2 True  ('E') 
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batch form in the D/E column on the 

payroll details grid. 

If overtime is to be included in the 

extract file, use the deduction code of ‘E’ 

for OT. Value default to 'E'. Also called 

DedEarn. 

Column "D/E" in Payroll Batch Details > 

Batch Create Payroll Details (Visible). 

 prolld_Rate 

The Rate field of the PayrollDetailsInfo 

object. 

Per Unit Pay Rate of the service, 

expense, or payroll adjustment of the 

payroll detail record. Displays on the 

Finalized payroll batch form in the Pay 

Rate column on the payroll details grid. 

In the case of an Overtime detail line, 

the rate will display without the OT 

Multiplier being applied. 

Also called Rate, PayRate, IncomeRate. 

Column "Pay Rate" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible). 

smallmoney  4 False  ((0)) 

 prolld_RateSource 

The rate source value of the payroll 

detail. 

System Rate Source Lookup location for 

the service or expense of the payroll 

detail record. For Payroll Adjustments 

the Rate Source displays ‘Payroll 

Adjustment’. For Overtime records the 

Rate Source displays the overtime type 

(Ex: DailyOT, WeeklyOT). 

The payroll batch 'Rate Source' column 

will display the location the pay rate was 

pulled from.Also called 

Ratesource.Column "Rate Source" in 

Payroll Batch Details > Batch Create 

Payroll Details (Hidden). 

16 = 'Daily OT' 

17 = 'Daily Double OT' 

18 = 'Seventh Day OT' 

19 = 'Seventh Day OT Adj.' 

20 = 'Daily OT Adj.' 

21 = 'Daily Double OT Adj.' 

22 = 'Seventh Day' 

tinyint  1 True   

 
prolld_RateID 

The rate ID of the payroll detail. 

ID of the caregiver pay rate record. 

Column "Rate" in Payroll Bath Details > 

Batch Create Payroll Details (Hidden). 

bigint  8 True   
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 prolld_Units 

The Units field of the PayrollDetailsInfo 

object. 

The quantity of units associated with the 

payroll details.It can be number of visits, 

hours or 15 minutes blocks. 

Also called PayUnit, PayUnits, Units, 

HoursOrUnitsPaid, IncomeUnit. Sum as 

TotalRegUnits, TotalUnits. Used to 

calculate AdjDedAmt.Column "Reg 

Units" in Payroll Batch Details > Batch 

Create Payroll Details (Visible). 

decimal(18,8)  9 False  ((0)) 

 prolld_PayUnitFlag 

The PayUnitFlag field of the Payroll-

DetailsInfo object. 

Unit type defines the measure of unit to 

be associated to the service scheduled. 

-Visit: Units measured as 1 regardless of 

the duration (start/end time) of the visit. 

The total duration of  

the visit (hours) is displayed on the 

Scheduling Details>Main tab. The bill 

and pay units will always be 1 when 

'Visit' is selected as the Service Unit. 

Reports are available that pull the total 

hours of the visit as well as the number 

of units for the visit. 

-Hourly: Units measured based on the 

duration of the visit (start/end time), with 

each unit equaling 1 hour. The total 

duration of the visit (hours) displays on 

the Scheduling Details>Main tab. The bill 

and pay units match the total duration 

hours when 'Hourly' is selected as the 

Service Unit. 

-15 Minutes: Units measured based on 

the duration of the visit (start/end time), 

with each unit equaling 15 minutes. The 

total duration of the visit (hours) displays 

on the Scheduling Details>Main tab. 

-Daily: Units measured based on the 

duration of the visit (start/end time) using 

a 24 hours multiplier. 

 

Column "Pay Unit" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible). 

smallint  2 False  ((60)) 

 
prolld_OT_DayUnits 

The OT_DayUnits field of the Payroll-

DetailsInfo object. 

The number of OT units on the Daily 

Overtime payroll detail records. Displays 

on the Finalized payroll batch form in the 

OT Units column on the payroll details 

grid. 

decimal(5,2)  5 False  ((0)) 
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Column "OT Day Units" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

 prolld_OT_DayMultiplier 

The OT_DayMultiplier field of the 

PayrollDetailsInfo object. 

The multiplier used for Daily Overtime 

calculations. Configured on the 

Office>Payroll tab>Daily Overtime> 

Multiplier field. Does not display on the 

Finalized payroll batch form. 

Column "OT Day Multiplier" in Payroll 

Batch Details > Batch Create Payroll 

Details (Hidden).  

decimal(4,2)  5 False  ((0)) 

 prolld_OTDayRateType 

The OTDayRateType in the payroll 

detail. 

tinyint  1 False   

 
prolld_OT_WeekUnits 

The OT_WeekUnits field of the Payroll-

DetailsInfo object. 

The number of OT units on the Weekly 

Overtime payroll detail records. Displays 

on the Finalized payroll batch form in the 

OT Units column on the payroll details 

grid. 

Also called TotalHours, IncomeUnit, 

OTWeekUnits. Used to calculate Pay-

Unit, paidOTHours.Column "OT Week 

Units" in Payroll Batch Details > Batch 

Create Payroll Details (Hidden). 

decimal(5,2)  5 False  ((0)) 

 prolld_OT_WeekMultiplier 

The OT_WeekMultiplier field of the 

PayrollDetailsInfo object. 

The multiplier used for Weekly Overtime 

calculations. Configured on the 

Office>Payroll tab>Weekly 

Overtime>Multiplier field. Does not 

display on the Finalized payroll batch 

form. 

Used to calculate Rate, paid-

OTAmount.Column "OT Week 

Multiplier" in Payroll Batch Details > 

Batch Create Payroll Details (Hidden). 

decimal(4,2)  5 False  ((0)) 

 prolld_OTWeekRateType 

The prolld_OTWeekRateType in the 

payroll detail. 

tinyint  1 False   

 prolld_EarnCode 

The EarnCode field of the PayrollDetails-

Info object. 

Earn Code of the payroll detail record. 

Displays on the Finalized payroll batch 

form in the Earn Code column on the 

payroll details grid. 

If your office enters Payroll Adjustments, 

assign the Earn Code to each 

nvarchar(50)  100 False  ('0A') 
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adjustment code. Payroll Adjustments 

can be a positive or negative amount, 

and can affect the Earnings Amount for 

the Payroll Code as well as the OT 

calculation (and hours) for the Caregiver. 

Assign Earn Code 21 (Caregiver Pay) to 

the Payroll Adjustment Codes. 

Also called EarnCode, PayCode, 

Job, PayEarnCode 

Column "Earn Code" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible)ADP Earn CodesCode 

21=Caregiver PayCode35=MileageCode 

36=Other ReimbursementCode 

22=Caregiver Hours- This will be passed 

in the extract file when services with 

Earn Code of 21 (Caregiver Pay) are 

passed. Earn Codes 35 (Caregiver 

Mileage) and 36 (Reimbursement), as 

well as Payroll Adjustments, are not 

included in the Gross Caregiver Hours 

(Earn Code 22) calculation.   

 prolld_OverrideDepartment 

The OverrideDepartment field of the 

PayrollDetailsInfo object. 

Used when caregiver work across 

departments. 

Also called Dept, TempDept, Ovrd-

Dept.Column "Override Department" in 

Payroll Batch Details > Batch Create 

Payroll Details (Hidden). 

nvarchar(15)  30 True   

 prolld_OverrideDivision 

The OverrideDivision field of the Payroll-

DetailsInfo object. 

Used when caregiver work across 

divisions. 

Also called OvrdDiv.Column "Override 

Division" in Payroll Batch Details > Batch 

Create Payroll Details (Hidden). 

nvarchar(50)  100 True   

 prolld_OverrideBranch 

The OverrideBranch field of the Payroll-

DetailsInfo object. 

Used when caregiver work across 

branches. 

Also called OvrdBrnchColumn "Override 

Office" in Payroll Batch Details > Batch 

Create Payroll Details (Hidden). 

nvarchar(50)  100 True   

 prolld_OverrideState 

The OverrideState field of the Payroll-

DetailsInfo object. 

Used when caregiver work across 

states. 

Also called OvrdState.Column "Override 

State" in Payroll Batch Details > Batch 

Create Payroll Details (Hidden). 

nvarchar(50)  100 True   
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 prolld_OverrideLocal 

The OverrideLocal field of the Payroll-

DetailsInfo object. 

Used when caregiver work across 

locations. 

Also called OvrdLocal.Column "Override 

Local" in Payroll Batch Details > Batch 

Create Payroll Details (Hidden). 

nvarchar(50)  100 True   

 prolld_Job 

The Job field of the PayrollDetailsInfo 

object. 

Also called Job. 

Column "Job" in Payroll Batch Details > 

Batch Create Payroll Details (Hidden). 

nvarchar(50)  100 True   

 prolld_Vacation 

The Vacation field of the PayrollDetails-

Info object. 

Column "Vacation" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

money  8 True  ((0)) 

 prolld_Loan 

The Loan field of the PayrollDetailsInfo 

object. 

Column "Loan" in Payroll Batch Details > 

Batch Create Payroll Details (Hidden). 

money  8 True  ((0)) 

 prolld_Fee 

The Fee field of the PayrollDetailsInfo 

object. 

Column "Fee" in Payroll Batch Details > 

Batch Create Payroll Details (Hidden). 

money  8 True  ((0)) 

 prolld_Other 

The Other field of the PayrollDetailsInfo 

object. 

Column "Other" in Payroll Batch Details 

> Batch Create Payroll Details (Hidden). 

money  8 True   

 prolld_Misc 

The Misc field of the PayrollDetailsInfo 

object. 

Column "Misc" in Payroll Batch Details > 

Batch Create Payroll Details (Hidden). 

money  8 True  ((0)) 

 prolld_Holiday 

The Holiday field of the PayrollDetails-

Info object. 

Column "Holiday" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

money  8 True  ((0)) 

 prolld_Advance 

The Advance field of the PayrollDetails-

Info object. 

Column "Advance" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

money  8 True   
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 prolld_Amount 

The Amount field of the PayrollDetails-

Info object. 

The total pay amount of the payroll detail 

record. Displays on the Finalized payroll 

batch form in the Pay Amt column on the 

payroll details grid. 

Column "Pay Amt" in Payroll Batch 

Details > Batch Create Payroll 

Details (Visible). 

money  8 True  ((0)) 

 prolld_SourceTS 

The SourceTS field of the PayrollDetails-

Info object. 

Column "SourceTS" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

binary(8)  8 True   

 prolld_CreatedDate 

The Date the PayrollDetails Record was 

Created. 

UTC date. Updated by SQL' server 

current UTC date (GetUTCDate) 

Also called CreatedDate. 

datetime  8 False  (getutcdate()) 

 prolld_CreatedUser 

CreatedUser field of the PayrollDetails-

Info object. 

The user who created the payroll 

detail. Also called CreatedUser. 

nvarchar(50)  100 False   

 prolld_ModifiedDate 

The Date the PayrollDetails Record was 

last Modified. 

UTC date. Updated by SQL' server 

current UTC date (GetUTCDate) 

Also called ModifiedDate. 

datetime  8 False  (getutcdate()) 

 prolld_ModifiedUser 

The ModifiedUser field of the Payroll-

DetailsInfo object. 

The user who last modified the payroll 

detail. Also called ModifiedUser. 

nvarchar(50)  100 False   

 prolld_TS 

The TS field of the PayrollDetailsInfo 

object. 

Also called TS.  

timestamp  8 False   

 prolld_OTWeeklyHours 

The OTWeeklyHours field of the Payroll-

DetailsInfo object. 

The Branch OT weekly hours (40). 

Column "OT Limit Hours" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

tinyint  1 True  ((0)) 

 
prolld_PayOT 

The PayOT field of the PayrollDetailsInfo 

object. 

tinyint  1 True   
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0: Exclude: Do not include unless 

another service in the week is set to 1 

(Include), 3 (Include-Override), or 4 

(Include-Standard) 

1: Include: Always include in OT 

calculations.   

2: Always Exclude:  Never include in OT 

calculations. 

3: Include-Override: Always include in 

OT calculations. 

4: Include-Standard: Always include in 

OT calculations. 

Any Payroll Week that has at least one 

service set to 3 (Include-Override) will 

use the Override Payroll OT Rules 

Any Payroll Week that has at least one 

service set to 1 (Include) and no 

services set to 3 (Include-Override) will 

use the Default Payroll OT Rules 

Any Payroll Week that has at least one 

service set to 4 (Include-Standard) and 

no services set to 3 (Include-Override) or 

1 (Include) will use the Standard Payroll 

OT Rules  

UI Location: DB Maintenance > Drop 

Down Maintenance > Service Codes > 

OT PayColumn "OT Pay" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

 prolld_WeekStartTime 

The WeekStartTime field of the Payroll-

DetailsInfo object. 

The Payroll Week Start Time for the 

overtime record. Displays on the 

Finalized payroll batch form in the Week 

Start Time column on the payroll details 

grid. 

Column "Week Start Time" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

datetime  8 True   

 prolld_WeekEndTime 

The WeekEndTime field of the Payroll-

DetailsInfo object. 

The Payroll Week End Time for the 

overtime record. Displays on the 

Finalized payroll batch form in the Week 

Start Time column on the payroll details 

grid. 

Column "Week End Time" in Payroll 

Bath Details > Batch Create Payroll 

Details (Visible). 

datetime  8 True   

 prolld_OTAdjustedUnits 

The OTAdjustedUnits field of the Payroll-

DetailsInfo object. 

decimal(5,2)  5 True   
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The number of hours that constitute the 

OT adjustment for the OT Adjustment 

payroll detail record. [Note: This could 

be 0 if the adjustment is solely due to a 

pay rate change.] Displays on the 

Finalized payroll batch form in the OT 

Adjusted Hours column on the payroll 

details grid. 

Column "OT  Adjusted Hours" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

 prolld_OTAdjustedRate 

The OTAdjustedRate field of the Payroll-

DetailsInfo object. 

Column "OT Adjusted Rate" in Payroll 

Batch Details > Batch Create Payroll 

Details (Hidden). 

smallmoney  4 True  ((0)) 

 prolld_TotalAmount 

This field is a calculated field equal to 

the prolld_TotalPayment which is the 

actual Payment to the caregiver.  

The total pay amount of the payroll detail 

record. Displays on the Finalized payroll 

batch form in the Pay Amt column on the 

payroll details grid. 

Previouse to the Payroll Adjustment, the 

prolld_Total Amount was used in many 

reports, QB Extract, so on. In order not 

to break the previous processes the field 

is maintained as a copy to the Actual 

payment (prolld_TotalPayment).Also 

called TotalAmount, Pay_Amount, Total-

Amt, Amount, TotalAmt, TotalPaid-

Schedule,  

money True 8 True   

(2)

 

prolld_PayrollAdjID 

The PayrollAdjID field of the Payroll-

DetailsInfo object. 

System ID of the Payroll Adjustment of 

the payroll detail record. Displays on the 

Finalized payroll batch form in the Pay 

Adj ID column on the payroll details grid. 

Also accessible on the Finalized payroll 

batch form by opening the schedule 

details of the payroll detail record. 

Displays in the ID field on the Pay Adj 

tab of the schedule detail record. 

Also called AdjustmentID.Column "Pay 

Adj ID" in Payroll Batch Details > Batch 

Create Payroll Details (Visible). 

bigint  8 True   

 prolld_TotalPayment 

The TotalPayment field of the Payroll-

DetailsInfo object. 

This field is an assigned column for the 

actual payment. Evaluated from the 

Adjustment to the the Calculated field of 

the prolld_TotalDetailAmount. 

money  8 True   
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Also called TotalPayment. Sum called 

PayTotal, TotalPay. 

Column "Actual Pay Amt" in Payroll 

Batch Details > Batch Create Payroll 

Details (Visible). 

 prolld_PayerID 

The payer ID of the payroll detail. 

System generated number which 

identifies the payer in the payroll detail 

record. 

bigint  8 True   

 prolld_AddOn 

A new field that will get the Client or 

Client Payer Rate for the ServiceCode 

"AddOn". Adds a flat dollar amount to a 

Caregiver’s base pay rate for all services 

of a specific unit type. The Add On 

amount will be  

unit type specific, and will add the 

specified dollar amount to the 

Caregiver’s base pay rate for all the 

payable services performed with that 

same unit type. The Add On amount is 

entered on the Client>Pay Rates tab 

when all Caregiver’s performing services 

to the Client should receive the 

additional Add On pay rate; and is  

entered on the Client>Caregiver Specific 

Pay Rates tab when only certain 

Caregiver’s performing services to the 

Client should receive the additional Add 

On pay rate. The Add On amount will 

only pull to payroll when  

entered into the Client>Pay Rates tab or 

the Client>Caregiver Specific Pay Rates 

tab. Entering the Add On amount in any 

other Soneto Pay Rate area will not 

affect payroll. 

Column "Add On" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

smallmoney  4 False  ((0)) 

 prolld_PrimaryRate 

A new field that will be a calculated field, 

representing the Origingal Rate before 

the Addon Rate. 

Column "Actual Rate" in Payroll Batch 

Details > Batch Create Payroll 

Details (Hidden). 

smallmoney True 4 True   

 prolld_AddOnRateID 

A new field that will get the Client or 

Client Payer Rate Override for the 

ServiceCode "AddOn". 

int  4 True   

 
prolld_RegionID 

The Region ID of the payroll detail. 

int  4 True   
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System generated number which 

identifies the region in the payroll detail 

record. 

 prolld_ClientID 

The Client ID of the payroll detail. Also 

called ClientID. 

System generated number which 

identifies the client in the payroll detail 

record. 

bigint  8 True   

 prolld_TotalDetailAmount 

This is a calculated field to determine the 

exact value from the rate, units, OTunit, 

OTRate, and the rounding. 

Also called Rate. 

decimal(29,12) True 17 True   

 prolld_IsExpense 

True if the service code on the payroll 

details is an expense. This is the value 

of svcc_IsExpense at the time the 

payroll is drafted. Records created 

before the column was added will have a 

null value. 

bit  1 True  ((0)) 

 prolld_CarExcludeOT 

True if the caregiver is OTExempt. This 

is the value of car_EmpOTFlag field of 

T_Caregiver at the time the Payroll is 

drafted. Records created before the 

column was added will have a null value. 

bit  1 True   

 

prolld_BranchID 

The ID of the branch (office) that the 

schedule related to the payroll detail 

record belongs to. 

When the T_GlobalSettings.glbl_Payroll-

UseCaregiverOffice setting is 0 then the 

prolld_BranchID value will always match 

the Office ID of the related Payroll Batch 

record (T_PayrollBatch.prollb_BranchID) 

 

int  4 False   
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Indexes 

 

  

Key Name Key Columns Unique 

 

Filtered 

Fill 

Factor 

 
PK_T_PayrollDetails 

 

prolld_ID True  80 

 IX_T_PayrollDetails 

 

prolld_PayrollAdjID   80 

 IX_T_PayrollDetails_-

BranchHolidayID 

 

prolld_BranchHolidayID  True  

 IX_T_PayrollDetails_-

BranchID_ServiceDate 

Index added as part of 

changes for OT across 

offices 

prolld_BranchID, prolld_ServiceDate    

 IX_T_PayrollDetails_-

CaregiverID 

 

prolld_CaregiverID, prolld_ServiceDate    

 IX_T_PayrollDetails_Daily-

OT 

 

prolld_CaregiverID, prolld_PayrollBatchID, prolld_-

ServiceDate, prolld_OT_DayUnits 

  80 

 IX_T_PayrollDetails_-

PayrollBatchID 

 

prolld_PayrollBatchID   80 

 IX_T_PayrollDetails_-

ScheduleExpenseID 

 

prolld_ScheduleExpenseID   80 

 IX_T_PayrollDetails_-

ScheduleID 

 

prolld_ScheduleID   80 

 IX_T_PayrollDetails_-

ServiceCodeID 

 

prolld_ServiceCodeID   80 

 IX_T_Payroll-

Details_weeklyOT 

 

prolld_CaregiverID, prolld_PayrollBatchID, prolld_-

ServiceDate, prolld_OT_WeekUnits 

  80 

 ix_T_PayrollDetails_-

OTDaily2 

 

prolld_CaregiverID, prolld_ID, prolld_ServiceDate, 

prolld_ServiceEndTime, prolld_PayrollBatchID, prolld_-

ServiceCodeID, prolld_PayrollAdjID, prolld_PayOT 

  80 
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Foreign Keys 

 

Name Columns 

FK_T_PayrollDetails_T_Branches prolld_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_PayrollDetails_T_BranchHolidays prolld_BranchHolidayID->[dbo].[T_BranchHolidays].[brhol_ID] 

FK_T_PayrollDetails_T_Caregiver prolld_CaregiverID->[dbo].[T_Caregiver].[car_ID] 

FK_T_PayrollDetails_T_PayrollAdjustment prolld_PayrollAdjID->[dbo].[T_PayrollAdjustment].[prolla_ID] 

FK_T_PayrollDetails_T_PayrollBatch prolld_PayrollBatchID->[dbo].[T_PayrollBatch].[prollb_ID] 

FK_T_PayrollDetails_T_Rates prolld_RateID->[dbo].[T_Rates].[rate_ID] 

FK_T_PayrollDetails_T_Region prolld_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_PayrollDetails_T_ScheduleExpenses prolld_ScheduleExpenseID->[dbo].[T_ScheduleExpenses].[schexp_ID] 

FK_T_PayrollDetails_T_Schedules prolld_ScheduleID->[dbo].[T_Schedules].[sch_ID] 

FK_T_PayrollDetails_T_ServiceCode prolld_ServiceCodeID->[dbo].[T_ServiceCode].[svcc_ID] 
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Payroll Details OT 

 [dbo].[T_PayrollDetailsOT] 

 

Columns 

Key Name Data Type Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity 

 
prolldOT_ID 

  

bigint  8 False 1 - 1 

(2) 

prolldOT_PayrollBatchID 

The ID of the Payroll Batch that created this record 

(Payroll Detail OT). This is the payroll batch that caused 

this record to be created. 

This is not always the Payroll Batch ID of the related 

payroll detail. 

The Payroll Batch ID of the related Payroll Detail record 

is stored in the prolldOT_BatchID column. 

When the related Payroll Detail record is created with 

the same batch as the current Payroll Details OT record 

both the prolldOT_PayrollBatchID and the prolldOT_-

BatchID will have the same value. 

bigint  8 True  

 prolldOT_BatchID 

The Payroll Batch ID of the related payroll detail record.  

This is not always the Batch ID that created this (payroll 

detail OT) Record.  

The Payroll Batch ID  that created this record is stored 

in the prolldOT_PayrollBatchID column. 

See additional prolldOT_PayrollBatchID and prolldot_-

RecordID column descriptions. 

bigint  8 True  

 
prolldOT_CaregiverID 

The ID of the caregiver that this record is created for.  

bigint  8 True  

 
prolldOT_ScheduleID 

The ID of the related schedule. 

bigint  8 True  

 prolldOT_RatioOFHoursIncludedInWeek 

Duration of the shift portion that falls in the week versus 

total shift duration 

numeric(32,20)  17 True  

 prolldOT_WeeklyTotalhoursForOT 

Total OT eligible hours that the caregiver worked for the 

current week.  

This value is repeated for all the records within the same 

Payroll Batch, caregiver and week combination. 

numeric(38,13)  17 True  

 prolldOT_BlendedRate 

The Blended Rate. Regular Rate Of Pay used for the 

Overtime calculation. 

numeric(38,6)  17 True  
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This value is repeated for all the records within the same 

Payroll Batch, caregiver and week combination. 

 prolldOT_ProrateOTAmount 

For daily OT records a null value is assigned. 

For weekly OT records that fall into a week that the 

caregiver''s hours exceed the weekly OT limit this will be 

set to:  

prolldOT_BlendedRate *  ( ( ( prolldOT_Weekly-

TotalhoursForOT - prolldOT_WeeklyHoursLimit ) / 

prolldOT_WeeklyTotalhoursForOT ) * prolldot_Weekly-

HoursForOT )  * ( prolldOT_OTMultiplier - 1 ) 

For weekly OT records that fall into a week that the 

caregiver''s hours do not exceed the weekly OT limit this 

will be set to 0. 

Do not use this column as it will be eliminated in the 

future. 

numeric(38,6)  17 True  

 prolldOT_ProrateOTHours 

For daily OT records a null value is assigned. 

For weekly OT records that fall into a week that the 

caregiver's hours exceed the weekly OT limit this will be 

set to:  

prolldot_WeeklyHoursForOT * prolldOT_ProrateFor-

OTExempt 

For weekly OT records that fall into a week that the 

caregiver's hours do not exceed the weekly OT limit this 

will be set to 0. 

Do not use this column as it will be eliminated in the 

future. 

numeric(38,6)  17 True  

 prolldOT_PortionForBlendedRate 

How much did this record contribute to the blended rate.  

The following formula is used to calculate the value: 

(prolldOT_BlendedRate / prolldOT_WeeklyTotalhours-

ForOT )* prolldot_WeeklyHoursForOT *prolldOT_-

ProrateForOTExempt  

Only use this value for Weekly OT Records. 

numeric(38,6)  17 True  

 prolldOT_WeeklyHoursLimit 

Weekly hours threshold before the Caregiver will get 

paid Weekly OT.   

This value is repeated for all the records within the same 

Payroll Batch, caregiver and week combination. 

This value is usually populated from br_OTWeekHours. 

tinyint  1 True  

 prolldOT_ProrateForOTExempt 

This is the ratio of non OT exempt hours versus the total 

shift hours. 

The following formula is used to calculate the ratio: 

(ShiftDuration - OTExemptHours) / ShiftDuration 

 

This column is no longer used since OTExempt Hours 

are no longer supported but the data is needed for 

legacy OT records. 

All new records will have a value of 1.000 

decimal(9,5)  5 True  
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 prolldOT_ActualHours 

The  Hours in the shift /record, not taking the week or 

day portion into consideration. 

This is the total duration of the shift before it is splitted 

into payroll periods (week or day). 

If the duration of a shift is 12 hours and 8 hours falls into 

week 1 and 4 hours fall into week2 then both payroll OT 

records (week 1 and week 2) will have the prolldOT_-

ActualHours value set to 12. 

decimal(11,4)  9 True  

 prolldOT_PayAmount 

This is the total pay amount for the total duration of the 

shift. If the shift spans two payroll weeks then the same 

amount will appear for both OT payroll records. The 

amount stored in this column will not be the prorated 

amount for each week. 

decimal(19,8)  9 True  

 prolldOT_TotalWeekPayAmount 

The total amount paid to the caregiver for the week. 

This amount is the sum of all OT eligible Payroll detail 

amounts for the week. If a payroll detail line spans two 

weeks only the portion of the payroll detail amount for 

the week is included in the sum.  In this case the prolld-

OT_RatioOfHoursIncludedInWeek value is used to split 

the payroll detail amount into each week.  

Example: 

A shift starts on Sat 11:00 pm and ends on Sun. 9:0 am, 

Each payroll week starts and ends on Sunday 12:00 

am. 

The shifts spans two weeks.  1 out of 10 hours fall into 

week 1 and 9 out of 10 hours fall into week 2. If the total 

OT eligible pay amount for the shift is $100 then  $10 

($100 * 1/10) will be allocated to week 1 and $90 (100 * 

9/10) will be allocated to week 2. 

This amount is used for the Blended Rate calculation. 

This value is repeated for all the records within the same 

Payroll Batch, caregiver and week combination. 

decimal(19,8)  9 True  

 prolldOT_WeeklyHours 

The portion of the detail line hours that falls into the 

current payroll week. When the payroll detail line falls 

into a single week then this will match the payroll detail 

line hours. When the payroll detail line spans two weeks 

then prolldOT_WeeklyHours will be set to the number of 

hours that fall into the current week. 

Important: This is not the OT eligible hours. Non OT 

eligible hours are included in the prolldOT_Weekly-

Hours. 

Also this value does not prorate the OT hours based on 

the legacy prolldOT_ProrateForOTExempt value.  

The prolldOT_WeeklyHoursForOT column is used to 

store the OT eligible hours. 

numeric(16,8)  9 True  

 prolldOT_AccumWeeklyHours 

if this record is not a Weekly record (IsWeekly = 1) then 

this column will have a null value. 

Oterwise, the value will be the total accumulated OT 

eligible Hours the caregiver has worked in the week up 

to and including this payroll OT line. This amount is 

numeric(16,8)  9 True  
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calculated by sorting all weekly payroll detail OT lines by 

prolldOT_StartTime and using a running sum from top to 

bottom. 

 prolldOT_AccumDailyHours 

If this record is not a Daily record (IsWeekly = 0) then 

this column will have a null value. 

Oterwise, the value will be the total accumulated OT 

eligible Hours the caregiver has worked in the day up to 

and including this payroll OT line. This amount is 

calculated by sorting all daily payroll detail OT lines by 

prolldOT_StartTime and using a running sum from top to 

bottom. 

numeric(16,8)  9 True  

 prolldOT_NotWorkingHrs 

The number of OT exempt hours allocated to the record. 

This is callculated using this formula: 

ScheduleDuration * (1- ProrateForOTExempt) 

For new records this is no longer supported. All new 

records will always have a value of 0 since OT exempt 

hours is no longer supported. 

 

Note: New functionality now uses the columns T_-

Schedules.sch_PayNonWorkStartTime and T_-

Schedules.sch_PayNonWorkEndTime to indicate non-

working hours. With the new functionality the non-

working duration (duration between T_Schedules.sch_-

PayNonWorkStartTime and T_Schedules.sch_PayNon-

WorkEndTime) is no longer included in the payroll 

details records and therefore the duration is completely 

excluded from OT calculations. 

decimal(8,4)  5 True  

 
prolldOT_StartTime 

The start date and time of the payroll details portion that 

falls into the current payroll OT period.  

If this payroll detail OT record is a weekly OT record (is-

Weekly = 1) then the value of this column will be set to 

the start date time of the portion of the payroll details 

record that falls into the week specified on this record .  

When a payroll detail record spans two weeks, then two 

related weekly payroll detail OT records will be created. 

Example:  

Payroll detail Start: 11/7/2015 5:00 PM. 

Payroll detail end: 11/8/2015 5:00 AM 

If the payroll week ends on 11/8/2015  12:00 AM then 

two payroll OT line items will be created for this payroll 

detail.  

1. The first line will have prolldOT_StartTime = 

11/7/2015 5:00 PM and prolldOT_EndTime = 11/8/2015  

12:00 AM. 

2. The second line will have prolldOT_StartTime = 

11/8/2015  12:00 AM and prolldOT_EndTime = 

11/8/2015 5:00 AM. 

 

If this payroll detail OT record is a daily OT record (is-

Weekly = 0) then the value of this column will be set to 

datetime  8 True  



314 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

the start date time of the portion of the payroll details 

record that falls into the day specified on this record .  

When a payroll detail record spans two days, then two 

related weekly payroll detail OT records will be created. 

For example:  

Payroll detail Start: 11/7/2015 5:00 PM. 

Payroll detail end: 11/8/2015 5:00 AM 

If the payroll day ends on 11/8/2015  12:00 AM then two 

payroll OT line items will be created for this payroll 

detail.  

1. The first line will have prolldOT_StartTime = 

11/7/2015 5:00 PM and prolldOT_EndTime = 11/8/2015  

12:00 AM. 

2. The second line will have prolldOT_StartTime = 

11/8/2015  12:00 AM and prolldOT_EndTime = 

11/8/2015 5:00 AM. 

 prolldOT_EndTime 

The end date and time of the payroll details portion that 

falls into the current payroll OT period.  

Same logic is used as the logic described on column 

prolldOT_StartTime. 

datetime  8 True  

 prolldOT_ScheduleDuration 

The duration in hours between prolldOT_StartTime and 

prolldOT_EndTime.  

Note: This is neither the duration of the schedule nor the 

duration of the payroll detail line. This is the duration of 

the payroll detail OT line.  

See prolldOT_StartTime comments. 

numeric(16,8)  9 True  

 
prolldOT_WeekNum 

The week number assigned to the payroll week of this 

payroll OT record. 

The week number is assigned by the payroll batch draft 

process and is only relevant to the current batch. 

The payroll draft process generates the week numbers 

based on the range of payroll weeks that are included in 

the batch. 

The first payroll week in the batch will have week 

number set to 1, the second payroll week will have week 

number set to 2 etc. 

This column is set for both Weekly OT record and Daily 

OT records.  

For daily OT records, this column will be set to the week 

that the current daily OT record falls into. 

tinyint  1 True  

 prolldOT_WeekStartTime 

The start date and time of the current record's payroll 

week.  

For daily OT records, this column will be set to the week 

start date time that the current daily OT record falls into. 

datetime  8 False  

 prolldOT_WeekEndTime 

Payroll week end Time for the corresponding week 

datetime  8 False  
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 prolldOT_DayNo 

Day of the week. Ex if payroll weekday is Monday, then 

the DayNO will be 1 for Monday, 2 for Tue. etc... 

tinyint  1 True  

 prolldOT_DayStartTime 

 the corresponding Day of the Week's Start Time. 

datetime  8 True  

 prolldOT_DayEndTime 

 the corresponding Day of the Week's End Time. 

datetime  8 True  

 prolldOT_DailyTotalhours 

Total OT eligible hours for the caregiver in the 

corresponding Day of the Week. 

decimal(8,2)  5 True  

 prolldOT_DailyOTUnits 

The Daily OT units caused by the record for the 

corresponding Day of the week. 

decimal(8,2)  5 True  

 prolldOT_DailyOTLimit 

Daily OT Limit. Ex: for every day of the week if it is 

between 8th and 12th hour accumulated then the Daily 

OT Limit would be 8. 

int  4 True  

 prolldOT_TotalDailyOTUnitsPerWeek 

 Total Daily OT units for the curresponding week of the 

caregiver 

decimal(8,2)  5 True  

 prolldOT_WeeklyOTUnits 

The weekly  OT Units for the record. 

decimal(8,2)  5 True  

 prolldOT_OTMultiplier 

The multiplier used to calculate OT. 

For weekly OT records the multiplier will always be >= 1 

because it includes the regular pay + the OT multiplier 

(example: 1.5) 

For Daily OT records the multiplier will always be <= 1 

because it only includes the OT multiplier (example: 0.5) 

decimal(8,2)  5 True  

 prolldOT_Rate 

The pay rate of the shift. This is is the rate of the shift 

before any OT calculations. 

smallmoney  4 True  

 prolldOT_Units 

The number of unit of the shift.  

decimal(8,4)  5 True  

 
prolldOT_IsWeekly 

1 if this is a weekly OT line, 0 if daily OT line 

tinyint  1 True  

 prolldOT_HasSevenDayOT 

1 if Seventh Day OT rules are used to calculate OT for 

this caregiver/week 

and the caregiver worked seven consecutive days 

during the week. 0 otherwise. 

bit  1 True  

 prolldOT_TotalPay 

This column is not used. It is set to null on all records. It 

is referenced is some report stored procedures and 

should be removed in the future. 

money  8 True  

 prolldot_DailyOTOrder 

The sequence of the shift in relation to other shifts in the 

period. The shifts are sequenced by start time. If the 

period is week then this is the sequence of the shift in 

the week. If the period is day, then then is the sequence 

of the shift in the day. 

smallint  2 True  
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 prolldot_Ranked 

This column is not used 

smallint  2 True  

 prolldot_RecordID 

The ID of the related payroll detail record. 

Note that the related payroll detail record is not always 

created with the same batch as the current payroll detail 

OT record.  

When a late schedule is included in a payroll batch, the 

OT calculations of the draft process will include all 

payroll details from prior batches that have schedules 

for the same caregiver and week. In these cases the 

batch Id of the prior Payroll detail records will be 

different than the batch ID of the payroll detail OT 

record. 

bigint  8 True  

 prolldot_AdjustmentAmt 

This is a legacy column that is no longer used. 

Adjustment amount is not used in OT calculations 

smallmoney  4 True  

 prolldot_AdjustmentHrs 

This is a legacy column that is no longer used, Payroll 

Adjustments hours are no longer included in OT 

calculations. 

decimal(8,2)  5 True  

 prolldot_WeeklyHoursForOT 

The total OT eligible hours for this shift and weekly 

period. This column is calculated as follows; 

1. When this service is not eligible for OT the prolldot_-

WeeklyHoursForOT is set to 0. A service is not eligible 

for OT when the Pay OT flag is set to 2 (always exclude) 

or all the services in the week are set to 0 (exclude).Also 

a shift is not eligible for OT when the caregiver exclude 

OT flag is set to true. 2. When a service is eligible for 

OT and OT exempt hours are included in the OT 

calculation (legacy functionality) the prolldot_Weekly-

HoursForOT is set to prolldot_WeeklyHours * prolldOT_-

ProrateForOTExempt.3. Otherwise the value is equal 

to prolldot_WeeklyHours. 

Note: For daily periods this column is set to null. 

decimal(8,2)  5 True  

 prolldOT_dailyhoursForOT 

 The hour in the record to be used for the  OT 

calculation, for corresponding day of the week of 

caregiver 

decimal(8,4)  5 True  

 prolldOT_Description 

Service code name associated to the payroll detail 

nvarchar(100)  200 True  

 prolldOT_ClientID 

Unique client ID associated to the payroll detail 

bigint  8 True  

 
prolldOT_BatchTS 

The timestamp of the batch when the batch was 

finalized 

bigint  8 True  

 prolldot_isexpense 

1: if the payroll details is from a record in T_Schedule-

Expenses. 

0: Otherwise. 

Schedule expenses are no longer included in OT 

calculations. This will only be set to 1 for legacy records. 

bit  1 True  
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Indexes 

 

 

 

 

The value should match the value of the related T_-

PayrollDetails.prolld_IsExpense column, 

 prolldOT_RecordTotalPayment 

This field  is used to find the total Payment including OT 

allocated to the record.  

For Weekly OT records the Regular Pay amount is 

added to the weekly OT amount allocated to the 

record.For Daily OT records the Regular Pay amount is 

not included in the RecordTotalPayment amount (only 

the daily OT amount allocated to the record is). 

The is done to ensure that the Regular Pay amount is 

not duplicated when daily OT is allocated to a detail line. 

numeric(38,6) True 17 True  

 prolldOT_OTPayment 

This column stores the OT Payment that is allocated to 

this record. 

numeric(38,6) True 17 True  

 prolldOT_OTUnits 

Number of OT hours allocated to this line. 

decimal(8,2) True 5 True  

 prolldOT_RecordUnits 

Do not use this column. It will be discontinued. 

numeric(16,8) True 9 True  

 prolldOT_PayrollTypeID 

Do not use this column. It will be discontinued. 

int  4 True  

 prolldOT_PayrollAdjID 

The related payroll adjustment ID 

bigint  8 True  

Key Name Key Columns Unique 

 
PK_T_PayrollDetailsOT prolldOT_ID True 

 IX_T_PayrollDetailsOT_caregiver-

SheduleWeeknum 

prolldOT_CaregiverID, prolldOT_ScheduleID, prolldOT_Week-

Num, prolldOT_StartTime 

 

 IX_T_PayrollDetailsOT_payrollbatchID prolldOT_PayrollBatchID, prolldOT_IsWeekly  

 IX_T_PayrollDetailsOT_payrollbatchIDTS prolldOT_PayrollBatchID, prolldOT_BatchTS  
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Payroll OT Allocations 

 [dbo].[T_PayrollOTAllocations] 

 

 

This table defines the schedule shift portions that are allocated OT. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

ota_ID 

The unique Id of the record 

bigint 8 False (1,1)  

 

ota_PeriodShiftID 

The Id of the related T_PayrollOTPeriodShifts 

record that is allocated OT 

bigint 8 False   

 ota_AllocationStartTime 

The UTC time that the shift allocation period 

starts 

datetime 8 True   

 

ota_AllocationEndTime 

The UTC time that the shift allocation period 

ends 

datetime 8 True   

 ota_RuleID 

The Id of the rule that was used to allocate OT 

tinyint 1 True   

 ota_Multiplier 

The multiplier used to calculate OT (1.5) 

[decimal](8, 

4) 

5 False   

 ota_TotalAllocatedMinutes 

The total number of minutes allocated to OT 

smallint 2 False   

 ota_TotalAllocatedOTAmount 

The total amount allocated to O 

smallmoney 4 False   

 ota_DraftID 

This column helps re-link FK relationships when 

a record is moved from draft to finalized 

bigint 8 True   

 
ota_RuleOTTypeId tinyint 1 False   

 ota_LegacyID bigint 8 True   

 ota_Seq 

The sequence of allocations within the period. 

tinyint 1 False   

 ota_ThresholdMinutes smallint 2 True   

 
ota_OTPayrollDetailsID 

The ID of the Payroll Details OT line that 

includes the OT amount for this allocation 

bigint 8 True   
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Indexes 

Foreign Keys 

 

 

 

Key Name Key Columns Unique Fill Factor 

 

PK_T_PayrollOTAllocations_ota_ID ota_ID True  

 IX_T_PayrollOTAllocations_PeriodShiftID ota_PeriodShiftID False  

Name Delete Columns 

FK_T_PayrollOTAllocations_T_PayrollDetails  ota_OTPayrollDetailsID-

>[dbo].[T_PayrollDetails] ([prolld_ID]) 

FK_T_PayrollOTAllocations_T_PayrollOTPeriodShifts Cascade ota_PeriodShiftID-

>[dbo].[T_PayrollOTPeriodShifts] 

([ots_ID]) 

FK_T_PayrollOTAllocations_T_PayrollOTTypes  ota_RuleOTTypeId-

>[dbo].[T_PayrollOTTypes] ([ottype_ID]) 
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Payroll OT Periods 

 [dbo].[T_PayrollOTPeriods] 

 

This table defines the OT periods that a caregiver worked. There are two type of OT 

periods: 

• Week Periods 

• Day Periods 

If a payroll OT process pays daily OT then 8 periods are created for each week that a 

caregiver worked. One week period and 7 day periods.  

If a payroll OT process only pays weekly OT then a single week OT period record will be 

created for each week that a caregiver worked. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

otp_ID 

Unique record Id 

bigint 8 False (1,1)  

 

otp_PayrollBatchID 

The Id of the Payroll Batch that this record 

was created for 

bigint 8 True   

 otp_WeekNumber 

The Week number that this period belongs 

to. This will be a number from 1 - 53 that 

represent the week of the year 

tinyint 1 False   

 

otp_WeekYear 

The Year that this period belongs to, This is 

the calendar year that the period starts on 

smallint 2 False   

 otp_DayNumber 

The Day number that this period belongs to. 
If the period type is week then a null value 

is used. Otherwise 

a number from 0 to 6 will be stored that 

represents the day of the week. 

smallint 2 True   

 otp_CaregiverID 

The Id of the caregiver that this record 

belongs to 

bigint 8 True   

 otp_StartDateTime 

The UTC date and time that this period 

starts on 

datetime 8 False   

 otp_EndDateTime datetime 8 False   
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The UTC date and time that this period 

ends on 

 otp_TotalOTEligibleMinutes 

The total OT eligible minutes that the 

caregiver worked in the period. 

smallint 2 True   

 otp_TotalOTEligiblePaid 

The total OT eligible amount that the 

caregiver was paid in the week. If this is a 

day period the amount will match the 

amount set on the related week period. 

smallmoney 4 False   

 otp_BlendedRate 

The OT blended rate for the week. If this is 

a day period the amount will match the 

amount set on the related week period. 

[decimal](8, 

4) 

5 False   

 otp_TotalAllocatedOTMinutes 

The number of OT allocated minutes in the 

period. For example, if the caregiver worked 

41 eligible hours and the caregiver is paid 

OT after 40 hours then this value will be set 

to 60. 

smallint 2 False   

 otp_TotalAllocatedOTPaid 

The total OT amount that the caregiver will 

be paid in the period. If this is a week period 

and the caregiver is paid both daily and 

weekly OT then only the OT amount paid 

due to weekly OT rules will be stored. 

smallmoney 4 False   

 otp_OTThresholdMinutes 

The number of minutes that the caregiver 

must work before paid OT. When multiple 

rules exist for the period the minimum 

threshold will be returned. 

smallint 2 True   

 otp_OTConfig 

The config settings that were used to 

calculate OT for this period. 

xml max True   

 otp_IsWeekRecord 

True if this is a week record, false if day 

record. 

bit 1 False   

 otp_PayrollTypeID 

The payroll process type that was used to 

calculate OT. 

int 4 True   

 otp_BranchID 

The branch ID that this payroll week 

belongs to. 

int 4 False  {(0)} 

 otp_ParentID 

This is the ID of the top level weekly period. 
If this is a weekly record then the value of 

this column will match the value of the 
otp_ID record.  

If this is a daily record, then this column will 

have the ID of the top level weekly record 

related to daily record. 

bigint 8 True   
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Indexes 

Foreign Keys 

 otp_HasLegacyRecords 

1 if created with legacy code and data was 
migrated to this table from 

T_PayrollDetailsOT. 

0 if it does not have legacy records. 

bit 1 False  {(0)} 

 otp_DraftID 

This column helps re-link FK relationships 

when a record is moved from draft to 

finalized 

bigint 8 True   

 otp_WeekSeq 

A unique sequence of the week across the 

batch. This is needed in order to create 

parity with legacy records 

in T_PayrollDetailsOT. 

tinyint 1 True   

 otp_OTMultiplier 

The multiplier used to calculate OT (1.5). 

When multiple rules exist for the period the 

multiplier for the minimum OT threshold will 

be returned. 

[decimal](8, 

4) 

5 True   

 otp_HasSeventhDayOT 

1 if Seventh Day OT rules are used to 

calculate OT for this caregiver/week and the 

caregiver worked seven consecutive days 

during the week. 0 otherwise. 

bit 1 True  {(0)} 

 otp_WeekOTPay 

Describes how OT is calculated: 

1: Include(Use default rules) 

2: Always Exclude (No OT is calculated) 

3: Include Override (Use override rules) 

4: Include-Standard (Use Standard OT 

Rules) 

tinyint 1 False   

 otp_TotalMinutes 

The total minutes worked in the period 

smallint 2 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_PayrollOTPeriods_otp_ID otp_ID True  

 IX_T_PayrollOTPeriods_BranchAndDate otp_BranchID,otp_WeekYear,otp_WeekNumber, 

otp_DayNumber 

False  

 IX_T_PayrollOTPeriods_CaregiverAndDat

e 

otp_CaregiverID,otp_WeekYear,otp_WeekNumb

er, otp_DayNumber 

False  

 IX_T_PayrollOTPeriods_ParentID otp_ParentID False  

 IX_T_PayrollOTPeriods_PayrollBatchID otp_PayrollBatchID,otp_CaregiverID, 

otp_WeekYear,otp_WeekNumber, 

otp_DayNumber 

True  

Name Columns 
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FK_T_PayrollOTPeriods_T_Branches otp_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_PayrollOTPeriods_T_Caregiver otp_CaregiverID-> [dbo].[T_Caregiver] ([car_ID]) 

FK_T_PayrollOTPeriods_T_PayrollBatch otp_PayrollBatchID-> [dbo].[T_PayrollBatch] ([prollb_ID]) 

FK_T_PayrollOTPeriods_T_PayrollExtractTypes otp_PayrollTypeID-> [dbo].[T_PayrollExtractTypes] ([prolle_ID]) 

FK_T_PayrollOTPeriods_T_PayrollOTPeriods otp_ParentID]-> [dbo].[T_PayrollOTPeriods] ([otp_ID]) 
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Payroll OT Period Shifts 

 [dbo].[T_PayrollOTPeriodShifts] 

 

This table defines the portions of the schedule shifts that fall into each OT periods 

(T_¬Payroll¬OTPeriods): 

Indexes 

Foreign Keys 

 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

ots_ID bigint 8 False (1,1)  

 

ots_PeriodID bigint 8 False   

 ots_PayrollDetailsID bigint 8 False   

 ots_PeriodShiftStartTime datetime 8 False   

 ots_PeriodShiftEndTime datetime 8 False   

 ots_PeriodShiftEligiblePay smallmoney 4 False   

 ots_Seq tinyint 1 True   

 ots_Duration smallint 2 False   
 

ots_LegacyID bigint 8 True   

 ots_DraftID bigint 8 True   

 ots_AccumulatedDuration smallint 2 True   

 ots_OTEligibleMinutes smallint 2 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_PayrollOTPeriodShifts_ots_ID ots_ID True  

 IX_T_PayrollOTPeriodShifts_PayrollDetailsID ots_PayrollDetailsID, ots_PeriodID, 

ots_PeriodShiftStartTime 

True  

 IX_T_PayrollOTPeriodShifts_PeriodShifts ots_PeriodID,ots_Seq False  

Name Delete Columns 

FK_T_PayrollOTPeriodShifts_T_PayrollDetails  ots_PayrollDetailsID-> 

[dbo].[T_PayrollDetails] ([prolld_ID]) 

FK_T_PayrollOTPeriodShifts_T_PayrollOTPeriods Cascade ots_PeriodID-> [dbo].[T_PayrollOTPeriods] 

([otp_ID]) 
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Payroll OT Types 

 [dbo].[T_PayrollOTTypes] 

 

Columns 

Indexes 

 

 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

ottype_ID 

The unique ID of the Record 

tinyint 1 False   

 

ottype_Name 

The name of the overtime record type 

[nvarchar](50) 100 False   

 ottype_DetailRateSource 

The RateSource that is stamped into the 

T_PayrollDetails.prolld_RateSource 

column for this OT Type. 

tinyint 1 True   

 ottype_AdjDetailRateSource 

The Rate Source that will be stamped 

into the 

T_PayrollDetails.prolld_RateSource 

column for Payroll OT Adjustments of this 

OT Type. 

tinyint 1 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_PayrollOTTypes ottype_ID True  
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Phone Type 

 

 [dbo].[T_PhoneType] 

 

 

Note: Detailed documentation is pending. 
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Physician 

 [dbo].[T_Physician] 

 

 

Description 

This table stores all information about a Physician.  

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
phys_ID 

System generated unique identifier for the Physician 

record. Shown on the banner of all Physician tabs as 

ID in the UI.  

bigint 8 False 1 - 1  

 
phys_FirstName 

Physician First Name. Shown on the banner of all 

Physician tabs as First in the UI.  

nvarchar(50) 100 False   

 
phys_LastName 

Physician Last Name. Shown on the banner of all 

Physician tabs as Last in the UI.  

nvarchar(50) 100 False   

 phys_Active 

Physician Status: Active or Inactive are Global but 

more Status values can be added in Drop Down 

Maintenance Physician Status which are saved in the 

T_PhysicianStatus table. Shown on the banner of all 

Physician tabs as Status in the UI.  

bit 1 False  ((1)) 

 

phys_BranchID 

Branch ID of the office that this physician services. 

The ID isn't shown in the UI but the br_Name is. FK to 

T_Branches.br_id.  

int 4 False   

 phys_CompanyName 

Name of Company that the Physician is associated 

with, if applicable.  

nvarchar(50) 100 True   

 phys_MiddleInitial 

Physician's Middle Initial.  

nvarchar(2) 4 True   

 phys_Title 

Physician's Title.  

nvarchar(20) 40 True   

 phys_Sex 

The Sex of the Physician.  

char(1) 1 True   

 phys_Suffix 

Physician Suffix, if applicable.  

nvarchar(50) 100 True   

 phys_ContactName 

The Office Contact Name, if applicable.  

nvarchar(35) 70 True   
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 phys_Birthday 

The Birthdate of the Physician. The Age will 

automatically calculate.  

datetime 8 True   

 phys_Address1 

The main Address of the Physician.  

nvarchar(255) 510 True   

 phys_Address2 

Optional Address field.  

nvarchar(60) 120 True   

 phys_City 

The City the Physician resides in.  

nvarchar(50) 100 True   

 phys_StateOrProvince 

The State the Physician resides in.  

nvarchar(20) 40 True   

 phys_PostalCode 

The Zip Code of the Physician. The system accepts + 

4 zip codes. The + 4 zip code displays on all 

correspondence (letters, envelopes, labels and 

invoices) and reports that utilize zip codes (including 

the Caregiver Name Badge report). The non-numeric 

value (dash) is stripped from the OASIS extract file, 

the CAHPS extract file, and the 837 electronic billing 

files. 

nvarchar(20) 40 True   

 phys_County 

The County the Physician resides in.  

nvarchar(50) 100 True   

 
phys_Country 

The Country that the Physician resides in.This value is 

a FK to the T_Countries table. 

int 4 False  ((240)) 

 phys_Phone 

The Phone Number of the Physician. 

nvarchar(30) 60 True   

 phys_PhoneType 

The Phone Type of the entered Phone Number for the 

Physician. Examples are  Home, Work, Fax, etc. FK to 

the T_PhoneType table and the values are found in 

the UI under Dropdown Maintenance, the System 

Office, Phone Types dropdown list.  

int 4 True   

 phys_Specialty 

The medical specialty of the Physician.  

nvarchar(50) 100 True   

 phys_LicenseNum 

Physician's License Number. 

nvarchar(50) 100 True   

 
phys_UPIN 

Physician's UPIN number. 

nvarchar(15) 30 True   

 phys_DEANumber 

Physician's Drug Enforcement Administration license 

number. 

nvarchar(50) 100 True   

 phys_DEADate 

Physician Drug Enforcement Administration license 

date.  

datetime 8 True   

 phys_ExpireDt 

Physician license expiration date.  

datetime 8 True   

 phys_DataCurrent 

Last date information was updated. 

datetime 8 True   

 phys_ContactDate 

Initial contact date with Physician.  

datetime 8 True   

 phys_Degree 

Physician's Degree. 

nvarchar(50) 100 True   
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 phys_LicenseStatus 

Status of the Physician's license.  

nvarchar(50) 100 True   

 phys_ActivityStatus 

Notes regarding the activity status of the Physician.  

nvarchar(50) 100 True   

 phys_TaxID 

Physician Tax ID.  

nvarchar(50) 100 True   

 phys_TaxType 

Physician Tax Type.  

nvarchar(30) 60 True   

 
phys_NPI 

Physician's 10 digit NPI number. 

nvarchar(10) 20 True   

 phys_EDIAdditionalID 

To be used when a payer specifies a specific ID for 

Loop 2310 (Physicians Name) is required. Enter that 

ID here. In the Payer record, Loop 2310 in the EDI 

Settings Tab must be set to Physician Additional. 

nvarchar(20) 40 True   

 phys_EDIAdditionalIDType 

To be used when a payer specifies a specific Type for 

Loop 2310. Enter that Type here. In the Payer Record, 

Loop 2310 in the EDI Settings Tab must be set to 

Physician Additional. 

nvarchar(3) 6 True   

 phys_Email 

The Email Address of the Physician. 

nvarchar(128) 256 True   

 phys_InfoRequested 

Enter any notes in this field to request information from 

the Physician.  

nvarchar(500) 1000 True   

 phys_Notes 

Enter any notes in this field to provide additional 

information about the Physician.  

nvarchar(500) 1000 True   

 
phys_RegionID 

Office Area of Physician. FK to T_Region. Office Area 

is entered in Dropdown Maintenance for the Office 

Area drop down list. 

int 4 True   

 phys_CreatedDate 

Date and Time that the Physician record was created. 

UTC date updated by SQL Server's current UTC date. 

UI Location: Physician > Created On. 

datetime 8 False  (getutcdate()) 

 phys_CreatedUser 

User who created the Physician record. 

nvarchar(50) 100 False   

 phys_ModifiedDate 

Date and time that the Physician record was modified. 

UTC date updated by SQL Server's current UTC date. 

UI Location: Physician > Modified On.  

datetime 8 False  (getutcdate()) 

 phys_ModifiedUser 

User who last modified the Physician record. 

nvarchar(50) 100 False   

 phys_TS 

The timestamp of the record. 

timestamp 8 False   

 
phys_StatusID 

Physician Status ID. This is a FK to the T_Physician-

Status.phys_id from that table is saved in the T_-

Physician table.  

int 4 False  ((1)) 

 
phys_OasisInterfaceID 

Not used.  

nvarchar(50) 100 True   
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Indexes 

 

Foreign Keys 

 

 

 

 phys_AllowMassEmail 

If this column has a value of 1 (True)  then the 

Physician has agreed to allow letters and other items 

to be sent  from within the MatrixCare system. If this 

column has a value of 0 (False) then the Physician 

does not give consent to receive email from Matrix-

Care. 

bit 1 False  ((0)) 

 
phys_Dear 

The Salutation for the Physician. The Salutation is 

used when running a mail merge or pinrting labels or 

envelopes in Letters. This dropdown is populated by 

entries in the Salutations drop down and this column is 

a FK to T_Salutation.salut_ID.  

int 4 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_Physician phys_ID True 80 

 IX_T_Physician phys_BranchID  80 

 IX_T_Physician_FirstName phys_FirstName  80 

 IX_T_Physician_LastName phys_LastName  80 

 IX_T_Physician_OasisInterfaceID phys_OasisInterfaceID  80 

 IX_T_Physician_UPIN phys_UPIN  80 

Name Columns 

FK_T_Physician_T_Branches phys_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_Physician_T_Countries phys_Country->[dbo].[T_Countries].[ctry_ID] 

FK_T_Physician_T_PhysicianStatus phys_StatusID->[dbo].[T_PhysicianStatus].[phys_ID] 

FK_T_Physician_T_Region phys_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_Physician_T_Salutation phys_Dear->[dbo].[T_Salutation].[salut_ID] 
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Physician Phones 

 [dbo].[T_PhysicianPhones] 

 

 

Columns 

Indexes 

Foreign Keys 

 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

pph_ID bigint  False (1,1)  

 

pph_PhysicianID bigint  False   

 pph_Phone nvarchar(30)  False   

 

pph_PhoneType int  False   

 pph_Note nvarchar(256)  True   

 pph_Sequence smallint  False  1 

Key Name Key Columns Unique Fill Factor 

 

PK_T_PhysicianPhones pph_ID True 80 

 IX_T_PhysicianPhones_PhysicianID pph_PhysicianID False 80 

 IX_T_PhysicianPhones_Unique pph_PhysicianID, pph_Sequence True 80 

Name Columns 

FK_T_PhysicianPhones_T_PhoneType pph_PhoneType-> [dbo].[T_PhoneType] ([pht_ID]) 

FK_T_PhysicianPhones_T_Physician pph_PhysicianID-> [dbo].[T_Physician] ([phys_ID]) 
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Physician Status 

 [dbo].[T_PhysicianStatus] 

 

 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

phys_ID int  False (10001,1)  

 

phys_Name [nvarchar](50) 50 True   

 phys_ShowOrHide bit  False  0 
 

phys_ListItemType tinyint  False  0 

 phys_RptGroupID int  False  83 

 phys_BranchID int  True   

 phys_OverrideID int  True   

 phys_Active bit  False  1 

 phys_CreatedDate datetime  False  (getutcdate()) 

 phys_CreatedUser [nvarchar](50) 50 False   

 phys_ModifiedDate datetime  False  (getutcdate()) 

 phys_ModifiedUser [nvarchar](50) 50 False   

 phys_TS timestamp  False   

 phys_Description [nvarchar](1000) 1000 True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_PhysicianStatus phys_ID True  

 IX_T_PhysicianStatus_BranchOverrideName phys_BranchID, phys_OverrideID, 

phys_Name 

True  

Name Columns 

FK_T_PhysicianStatus_T_Branches phys_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_PhysicianStatus_T_PhysicianStatus phys_OverrideID-> [dbo].[T_PhysicianStatus] ([phys_ID]) 

FK_T_PhysicianStatus_T_ReportGroups phys_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 
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Plan of Care 

 [dbo].[T_PlanofCare] 

 

 

Note: Detailed documentation is pending. 
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Plan of Care Diagnosis 

 [dbo].[T_PlanofCareDiagnosis] 

 

 

Note: Detailed documentation is pending. 
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Plan of Care Documents 

 [dbo].[T_PlanofCareDocuments] 

 

 

Note: Detailed documentation is pending. 
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Plan of Care Medications 

 [dbo].[T_PlanofCareMedications] 

 

 

Note: Detailed documentation is pending. 
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Plan of Care Mod Orders 

 [dbo].[T_PlanofCareModOrders] 

 

 

Note: Detailed documentation is pending. 
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Plan of Care Orders 

 [dbo].[T_PlanofCareOrders] 

 

 

Note: Detailed documentation is pending. 
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Race 

 [dbo].[T_Race] 

 

 

Note: Detailed documentation is pending. 
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Rate Bill Shifts 

 

 [dbo].[T_RateBillShifts] 

 

 

Note: Detailed documentation is pending. 
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Rate Schedule Last Changes 

 

 [dbo].[T_RateScheduleLastChanges] 

 

 

Note: Detailed documentation is pending. 
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Rates 

 

 [dbo].[T_Rates] 

 

 

Note: Detailed documentation is pending. 
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Rates Override Type 

 

 [dbo].[T_RatesOverrideType] 

 

 

Note: Detailed documentation is pending. 
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Rates Type 

 

 [dbo].[T_RatesType] 

 

 

Note: Detailed documentation is pending. 
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Record Type 

 

 [dbo].[T_RecordType] 

 

 

Note: Detailed documentation is pending. 
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Region 

 [dbo].[T_Region] 

 

Description 

Information about branch regions. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
reg_ID 

System generated unique ID for the region 

record. 

Also called ID, officeArea_ID, officeAreaID, 

BranchRegionID, oAreaID 

UI Location: Drop Down Maintenance > Office 

Area > ID 

int 4 False 1 - 1  

 reg_Name 

The region name of the branch office. 

Also called OfficeArea, Office_Area, officeArea-

Name, BranchRegionName, oAreaName, 

clientofficeArea_Name 

UI Location: Drop Down Maintenance > Office 

Area > Name 

nvarchar(50) 100 False   

 reg_Description 

The description of the region. 

UI Location: Drop Down Maintenance > Office 

Area > Description 

nvarchar(1000) 2000 True   

 reg_BranchID 

The ID of the branch in the region record. 

int 4 False   

 reg_Active 

Determines if a region is active or inactive. 

UI Location: Drop Down Maintenance > Office 

Area > Active 

bit 1 False  ((1)) 

 reg_CreatedDate 

Date the region record was created. 

UTC date updated by SQL Server's current UTC 

date.  

UI Location: Drop Down Maintenance > Office 

Area > Created On 

datetime 8 False  (getutcdate()) 

 reg_CreatedUser 

User who created the region record. 

UI Location: Drop Down Maintenance > Office 

Area > Created By 

nvarchar(50) 100 False   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 347 

 

Indexes 

 

 

 

 reg_ModifiedDate 

Date region record's most recent modification. 

UTC date updated by SQL Server's current UTC 

date.  

UI Location: Drop Down Maintenance > Office 

Area > Modified On 

datetime 8 False  (getutcdate()) 

 reg_ModifiedUser 

User who made region record's most recent 

modification.  

UI Location: Drop Down Maintenance > Office 

Area > Modified By 

nvarchar(50) 100 False   

 reg_TS 

Timestamp of the region record. This column is 

hidden in MyData.  

timestamp 8 False   

 reg_AcctClass 

Classes to QBooks Details Acct Extract  

UI Location: Drop Down Maintenance > Office 

Area > Acct Class. This column is hidden in My-

Data.  

nvarchar(30) 60 True   

Key Name Key Columns Unique Fill Factor 

 
PK_T_Region reg_ID True 80 



348 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Referral Entities 

 [dbo].[T_ReferralEntities] 

 

 

Description 

The Referral Entities table defines all of the Referral Entities in the MatrixCare application. The 

main Referral Entities are Caregiver, Client, Physician, Payer, Referral Source, Referral 

Contact, Address Book, and Staff. These are used in the following views: V_Admission-

Referrals, V_CaregiverHiringReferrals, and V_ClientInquiryReferrals.  

Columns 

 

Indexes 

 

 

 

 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Default 

 
refent_ID 

Primary Key of the Referral Entities table.  

tinyint 1 False  

 refent_Name 

Name of the Referral Entity. 

nvarchar(25) 50 False  

 refent_EntityEnum 

Enum of the Referral Entity. 

nvarchar(25) 50 False  

 refent_CreatedUser 

The UserID of the user that created the Referral Entities 

record.  

nvarchar(50) 100 False  

 refent_CreatedDate 

UTC date updated by SQL server's current UTC date. The 

date the referral entities record was created.  

datetime 8 False (getutcdate()) 

 refent_ModifiedUser 

The UserID of the last user that modified the Referral 

Entities record.  

nvarchar(50) 100 False  

 refent_ModifiedDate 

UTC date updated by SQL server's current UTC date. The 

date the referral entities record was last modified. 

datetime 8 False (getutcdate()) 

 refent_TS 

The timestamp field of the Referral Entities record. 

timestamp 8 False  

Key Name Key Columns Unique Fill Factor 

 
PK_T_ReferralEntities refent_ID True 80 
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Referral Facilities 

 [dbo].[T_ReferralFacilities] 

 

 

Note: Detailed documentation is pending. 
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Referral Facilities Branches 

 [dbo].[T_ReferralFacilitiesBranches] 

 

 

Note: Detailed documentation is pending. 
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Referral Facilities Status 

 [dbo].[T_ReferralFacilitiesStatus] 

 

 

Note: Detailed documentation is pending. 
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Referral Facility Documents 

 [dbo].[T_ReferralFacilityDocuments] 

 

 

Note: Detailed documentation is pending. 
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Referral Facility Documents Share Levels 

 [dbo].[T_ReferralFacilityDocumentsShareLevels] 

 

 

Note: Detailed documentation is pending. 
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Referral Join 

 [dbo].[T_ReferralJoin] 

 

 

Note: Detailed documentation is pending. 
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Referral Non Admission Reasons 

 [dbo].[T_ReferralNonAdmissionReasons] 

 

 

Note: Detailed documentation is pending. 
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Referral Rating 

 [dbo].[T_ReferralRating] 

 

 

Note: Detailed documentation is pending. 
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Referral Staff Join 

 [dbo].[T_ReferralStaffJoin] 

 

 

Note: Detailed documentation is pending. 
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Referral Territories 

 [dbo].[T_ReferralTerritories] 

 

 

Note: Detailed documentation is pending. 
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Referral Types 

 [dbo].[T_ReferralTypes] 

 

 

Note: Detailed documentation is pending. 
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Referral By 

 [dbo].[T_ReferralBy] 

 

 

Note: Detailed documentation is pending. 

 

 

 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 361 

Referral By Status 

 [dbo].[T_ReferralByStatus] 

 

 

Note: Detailed documentation is pending. 
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Report Groups 

 [dbo].[T_ReportGroups] 

 

Description 

Contains data records for Report Groups. 

Columns 

Indexes 

Foreign Keys 

 

 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
rptgrp_ID int  False 10001,1  

 rptgrp_Name Nvarchar(50)  False   

 
rptgrp_TypeID int  False   

 rptgrp_Active bit  False  ((0)) 

 rptgrp_CreatedDate datetime  False  (getutcdate()) 

 rptgrp_CreatedUser Nvarchar(50)  False   

 rptgrp_ModifiedDate datetime  False  (getutcdate()) 

 rptgrp_ModifiedUser Nvarchar(50)  False   

 rptgrp_TS timestamp  False   

 rptgrp_Description Nvarchar(1000)  True   

       

Key Name Key Columns Unique Fill Factor 

 

PK_T_ReportGroups rptgrp_ID True 80 

Name Columns 

FK_T_ReportGroups_T_ReportGroupTypes rptgrp_TypeID-> [dbo].[T_ReportGroupTypes] ([rptgrptyp_ID]) 
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Report Group Types 

 [dbo].[T_ReportGroupTypes] 

 

Description 

Contains data records for Report Group Types. 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
rptgrptyp_ID int  False   

 rptgrptyp_Name nvarchar(50)  False   

 rptgrptyp_Description nvarchar(256)  True   

 rptgrptyp_Type tinyint  False  ((2)) 

 rptgrptyp_EnumName nvarchar(50)  True   

 rptgrptyp_Active bit  False  ((1)) 

 rptgrptyp_CreatedDate datetime  False  (getutcdate()) 

 rptgrptyp_CreatedUser nvarchar(50)  False   

 rptgrptyp_ModifiedDate datetime  False  (getutcdate()) 

 rptgrptyp_ModifiedUser nvarchar(50)  False   

 rptgrp_TS timestamp  False   

 rptgrptyp_DDMaintenance bit  False  ((1)) 

 rptgrptyp_TableName varchar(50)  True   

 rptgrptyp_TableAbbreviation varchar(20)  True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_ReportGroupTypes rptgrptyp_ID True 80 

Name Columns 

FK_T_ReportGroupTypes_T_ReportGroupTypes rptgrptyp_ID-> [dbo].[T_ReportGroupTypes] ([rptgrptyp_ID]) 
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Schedule Expenses 

 [dbo].[T_ScheduleExpenses] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

schexp_ID 

 

System generated ID for the schedule expense record. 

Also pulls expenses items to invoice. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > ID 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > ID 

bigint 8 False 1 - 1  

(4)

 

schexp_schID 

 

Schedule ID for the schedule expense record. 

Relates to T_Schedules.sch_ID. 

bigint 8 False   

(2)

 

schexp_expID 

 

Expense service code which has been added to the 

schedule. Payer ID for the schedule expense record. 

Used to pull payer name and display in the UI. 

Relates to T_ServiceCode.svcc_ID 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Expense Code 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Expense 

Code 

int 4 False   

 schexp_ClientPayerID 

The client's payer ID for the expenses on the service 

scheduled. 

bigint 8 True   

 schexp_PayerID 

The payer ID for the expenses on the service 

scheduled. 

bigint 8 True   

 schexp_CostUnits 

The unit cost of the schedule expenses. 

decimal(8,4) 5 True   

 schexp_CostRateOverrideAmt 

The cost rate of the schedule expenses. 

smallmoney 4 True   

 schexp_CostRateOverrideModifiedUser 

User that last modified the cost rate. 

nvarchar(50) 100 True   
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 schexp_CostRateOverrideModifiedDate 

Date and time the cost rate was last modified. 

UTC date updated by SQL Server's current UTC date. 

datetime 8 True   

 schexp_BillUnits 

The number of expense units to be billed. If the 

expense is not billable, this remains at 0. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill Units 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill Units 

decimal(8,4) 5 False  ((0)) 

 schexp_BillRateUnitFlag 

 

smallint 2 False  ((1)) 

 schexp_BillRateOverrideAmt 

The bill rate for the expense code here.  If expense bill 

rates are set in another location (such as Office or 

Payer), then this bill rate may be left at $0. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill Rate 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill Rate 

smallmoney 4 False  ((0)) 

 schexp_BillRateOverrideModifiedUser 

User that last modified the bill rate. 

nvarchar(50) 100 True   

 schexp_BillRateOverrideModifiedDate 

Date and time the bill rate was last modified. 

UTC date updated by SQL Server's current UTC date. 

datetime 8 True   

 schexp_BillRateID 

The ID of the bill rate on the schedule expenses 

record. 

bigint 8 True   

 schexp_BillRate 

The billable rate that the service is billed at. 

smallmoney 4 True   

 schexp_TotalCharge 

Total billable charges. 

smallmoney 4 True   

 schexp_PayUnits 

The number of expense units to be paid. If the 

expense is not payable, this remains at 0. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Pay Units 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Pay Units 

decimal(8,4) 5 False  ((0)) 

 schexp_PayRateUnitFlag 

 

smallint 2 False  ((1)) 

 schexp_PayRateOverrideAmt 

Enter the pay rate for the expense code here. If 

expense pay rates are set in another location (such as 

Office or Payer), then this pay rate may be left at $0. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Pay Rate 

smallmoney 4 False  ((0)) 
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and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Pay Rate 

 schexp_PayRateOverrideModifiedUser 

User that last modified the pay rate. 

nvarchar(50) 100 True   

 schexp_PayRateOverrideModifiedDate 

Date and time the pay rate was last modified. 

UTC date updated by SQL Server's current UTC date. 

datetime 8 True   

 schexp_Notes 

Any applicable notes for the schedule expense record.  

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Notes 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Notes 

nvarchar(255) 510 True   

 schexp_PayDate 

Completed schedules not marked in the previous 

column with NPD will display a Pay Date. This date 

indicates the date on which the individual schedule 

was paid (or is scheduled to be paid). 

Non-UTC date. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Pay date 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Pay Date 

datetime 8 True   

 
schexp_RevenueCode 

Displays the appropriate Bill Flag for this 

expense.  The choices are Billable, Billable No 

Charge, NotBillable, or Default.  The selection Default 

will pull from the setting for the Service Code in DDM 

Service Codes. If the service code is Billable in the 

Service Code, then this will appear here as Default 

(Billable); if it is Not Billable, then it will display here as 

Default (Not Billable).  

0: Default 

1: Billable 

2: Billable No Charge 

3: Not Billable 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill Flag 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill Flag 

tinyint 1 False  ((0)) 

 
schexp_Paycode 

Displays the appropriate Pay Flag for this expense. 

The choices are NotPayable, Payable, or Default.  The 

selection Default will pull from the setting for the 

Service Code in DDM Service Codes. If the service 

code is Payable in the Service Code, then this will 

appear here as Default (Payable); if it is Not Payable, 

then it will display here as Default (Not Payable).    

0: Not Payable 

1: Payable 

tinyint 1 False  ((2)) 
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2: Default (Check Payer Services and ServiceCode) 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Pay Flag 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Pay Flag 

 schexp_PayReviewFlag 

 

bit 1 False  ((0)) 

(2) 

schexp_PayrollBatchID 

Displays the Payroll Batch ID for the paid schedule.  

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > PR Batch ID 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > PR Batch 

ID 

bigint 8 True   

 schexp_NotesDate 

Shows the date on which the schedule was marked as 

Completed. 

Non-UTC date. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Confirmed 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > 

Confirmed 

datetime 8 True   

 
schexp_BillingStatus 

Displays the current billing status for each 

schedule.  Statuses are Complete (billing is complete), 

In-Progress (only one payer has been billed for 

services, the other payer has not) or Un-Billed (no 

payers have been billed for services). 

0: Un-Billed 

1: Billing Started 

2: Billing Completed 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill Status 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill Status 

tinyint 1 False  ((0)) 

 schexp_CreatedDate 

Date and time the current record was created. 

UTC date updated by SQL Server's current UTC date. 

datetime 8 False  (getutcdate()) 

 schexp_CreatedUser 

User that last modified the current record. 

nvarchar(50) 100 False   

 schexp_ModifiedDate 

Date and time the current record was last modified. 

UTC date updated by SQL Server's current UTC date. 

datetime 8 False  (getutcdate()) 

 schexp_ModifiedUser 

User that created the current record. 

nvarchar(50) 100 False   
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 schexp_TS 

The timestamp field of the schedule expense record. 

timestamp 8 False   

 schexp_BillOTUnits 

The number of over time units for the schedule. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill OT Units 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill OT 

Units 

decimal(8,4) 5 False  ((0)) 

 schexp_BillOTMulti 

The multiplier used for over time calculation for the 

schedule. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Bill OT Multiply 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Bill OT 

Multiply 

decimal(8,4) 5 False  ((1.5)) 

 schexp_OriginalPayDate 

Schexp_PayDate will be transfered to this field during 

finalizing of payroll for cancelation process to revert 

back to the original value. 

datetime 8 True   

 schexp_TotalBillable 

The total billable charges for the schedule. 

money 8 True   

 schexp_TotalBilled 

The actual billed amount for the schedule. 

money 8 True   

 schexp_TotalPaid 

The total amount paid to the caregiver for the service 

on the schedule. 

money 8 True   

 schexp_InvoiceDetailDescription 

Allows you to override the description of the Expense 

or Service for reporting purposes and pulls to the 

Invoice report. Useful if need to account for a variety of 

expenditures made on the Client’s behalf but you do 

not want to configure individual expense/service 

codes. Displays on the Expenses tab of the Schedule 

list views.  Not required - if left blank the Expense 

Code or Service Code will be used. Does not copy 

over with a Recurrence Pattern.  Create a generic 

code for expenses (such as Misc Exp) under DDM 

Service Codes. 

UI Location: Payroll > Create Payroll > Batch tab > 

Schedule Calendar icon > Expenses tab on pop-up 

window > Inv Description 

and Scheduling > Schedule Calendar > Schedule 

Details > Expenses tab on pop-up window > Inv 

Description 

nvarchar(100) 200 True   
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Indexes 

 

Foreign Keys 

 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_ScheduleExpenses schexp_ID True 80 

 IX_T_ScheduleExpenses_ID SchID schexp_ID, schexp_schID True 80 

 IX_T_ScheduleExpenses_PayrollBatchID schexp_PayrollBatchID   

 IX_T_ScheduleExpenses_schexp_expID schexp_expID, schexp_schID  80 

 IX_T_ScheduleExpenses_schexp_schID schexp_schID  80 

 ix_T_ScheduleExpenses_SchIDPayrollBatch-

BillingStatusExpID 

schexp_schID, schexp_PayrollBatchID, 

schexp_BillingStatus, schexp_expID 

 80 

Name Columns 

FK_T_ScheduleExpenses_T_Schedules schexp_schID->[dbo].[T_Schedules].[sch_ID] 

FK_T_ScheduleExpenses_T_ServiceCode schexp_expID->[dbo].[T_ServiceCode].[svcc_ID] 
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Schedule Payers 

 [dbo].[T_SchedulePayers] 

 

Columns 

Key Name Data Type Persisted Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

(5) 

schcp_ID 

 

bigint   8 False 1 - 1  

(7)

 

schcp_ClientPayerID 

 

bigint   8 False   

(7)

 

schcp_PayerID 

 

bigint   8 False   

(7)

 

schcp_AdmissionID 

 

bigint   8 False   

(11)

 

schcp_ScheduleID 

 

bigint   8 True   

(12)

 

schcp_ScheduleExpenseID 

 

bigint   8 True   

(10) 

schcp_SeqNo 

schcp_SeqNo:  This field is 

used in determining the 

primary payer for a 

schedule, which will 

determine the total charge 

for that schedule.  It does 

not determine the order in 

which payers are billed 

though.  schcp_Charge-

AllocationSeqNo is the field 

used to determine what 

order to bill schedule 

payers.  

int   4 False  ((0)) 

 
schcp_BillSplitTypeID 

B: Balance 

char(1)   1 False  ('B') 
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S: Split 

V: Visit  

T: Transfer 

C:  COB 

 

Time/Date Based Benefits 

----------------------- 

H: Hourly 

I:   Schedule Hourly 

D: Daily 

W:Weekly 

M:Monthly 

 schcp_Amount 

 

money   8 False  ((0)) 

 
schcp_Percent 

 

decimal(5,4)   5 False  ((0)) 

 schcp_DiscountAmount 

 

money   8 False  ((0)) 

 
schcp_DiscountPercent 

 

decimal(5,4)   5 False  ((0)) 

 
schcp_CopayerID 

 

bigint   8 True   

 schcp_CopayInvoiceNote 

 

nvarchar(255)   510 True   

 schcp_Notes 

 

nvarchar(255)   510 True   

 schcp_Source 

0:Created by user, 1:Copied 

from Admission, 2:Copied 

from Schedule, 3:Ovewritten 

from ScheduleExpense 

tinyint   1 False  ((0)) 

 schcp_ExcludeHoliday 

 

bit   1 False  ((0)) 

 
schcp_InvoiceID 

 

bigint   8 True   

(10) 

schcp_CancelDate 

 

datetime   8 True   

 schcp_CreatedDate 

 

datetime   8 False  (getutcdate()) 

 schcp_CreatedUser 

 

nvarchar(50)   100 False   

 schcp_ModifiedDate 

 

datetime   8 False  (getutcdate()) 

 schcp_ModifiedUser 

 

nvarchar(50)   100 False   

(3) 

schcp_TS 

 

timestamp   8 False   
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schcp_AddressBookID 

 

bigint   8 True   

 
schcp_FeeChartID 

 

int   4 True   

 
schcp_ChargeAllocation-

SeqNo 

schcp_ChargeAllocation-

SeqNo:  This field is used in 

determining what order to 

bill a schedules payers in.  

This field is not used in 

determining the primary 

payer for that schedule.  

The field schcp_SeqNo is 

used to determine the 

primary payer, which is the 

payer who determines the 

total charge of the schedule. 

int   4 False  ((0)) 

 schcp_ManageCOB 

 

int  True 4 False   

 schcp_COBStatus 

schcp_COBStatus:  Used to 

designate the COB state of 

the current schedule payer 

for a particular schedule or 

expense (meaningless for 

Admission Payers) 

---------------------------------- 

0:  Not a COB 

Schedule/Expense 

1:  COB Hold - A COB 

Schedule/Expense not 

ready to be drafted 

2:  COB Ready To Bill - A 

COB Schedule/Expense 

ready to be drafted 

3:  COB Billed - A COB 

Schedule/Expense already 

billed 

4:  COB Transfered - A COB 

Schedule/Expense 

Transferred to next Invoice 

255:  COB Canceled 

int True True 4 False   

 

schcp_TransferFrom-

InvoiceHeaderID 

Used primarily in COB 

Billing. 

 

-1 is non-COB 

0 is Primary Payer COB or 

unProcessed COB 

> 0 is the previous Invoice-

HeaderID in this COB Chain 

bigint   8 True   
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Indexes 

 

schcp_TransferToInvoice-

HeaderID 

Used primarily in COB 

Billing. 

 

-1 is non-COB 

0 is Final COB Payer or un-

Processed COB 

> 0 is the next Invoice-

HeaderID in this COB Chain 

bigint   8 True   

 

schcp_BillingStatus 

Displays the stage of the 

billing process for this 

schedule payer.  This 

determines whether this 

schedule is brought into a 

billing batch to be drafted. 

Valid values:  

0: Not billed yet. No invoices 

related to this schedule 

payer are created (canceled 

invoices do not count for 

this). 

tivnyint   1 False  ((0)) 

Key Name Key Columns Included Columns Unique 

 
PK_T_SchedulePayers schcp_ID  True 

 IX_T_SchedulePayers_Unique schcp_AdmissionID, schcp_ScheduleID, 

schcp_ScheduleExpenseID, schcp_Seq-

No, schcp_CancelDate 

 True 

 IX_T_SchedulePayers_Unique1 schcp_AdmissionID, schcp_ScheduleID, 

schcp_ScheduleExpenseID, schcp_-

ChargeAllocationSeqNo, schcp_Cancel-

Date 

 True 

 IX_T_SchedulePayers_AdmissionID schcp_AdmissionID, schcp_SeqNo   

 IX_T_SchedulePayers_ClientPayersID schcp_ClientPayerID, schcp_Admission-

ID, schcp_ScheduleID, schcp_Schedule-

ExpenseID 

  

 IX_T_SchedulePayers_InvoiceID schcp_InvoiceID   

 IX_T_SchedulePayers_PayerID schcp_PayerID, schcp_AdmissionID, 

schcp_ScheduleID, schcp_Schedule-

ExpenseID 

  

 IX_T_SchedulePayers_ScheduleExpense-

Cancel 

schcp_ScheduleID, schcp_Schedule-

ExpenseID, schcp_CancelDate 

  

 IX_T_SchedulePayers_ScheduleExpense-

ID 

schcp_ScheduleExpenseID, schcp_Seq-

No, schcp_CancelDate 

  

 IX_T_SchedulePayers_ScheduleID schcp_ScheduleID, schcp_SeqNo, 

schcp_CancelDate 
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Foreign Keys 

 

 

 

 IX_T_SchedulePayers_TransferFrom-

InvoiceHeaderID 

schcp_TransferFromInvoiceHeaderID   

 IX_T_SchedulePayers_TransferToInvoice-

HeaderID 

schcp_TransferToInvoiceHeaderID   

 _dta_index_T_Schedule-

Payers_15_1293976432__K4_K5_K6_-

K20_K7_K1_2_3_25 

schcp_AdmissionID, schcp_ScheduleID, 

schcp_ScheduleExpenseID, schcp_-

CancelDate, schcp_SeqNo, schcp_ID 

schcp_ClientPayer-

ID, schcp_PayerID, 

schcp_TS 

 

 _dta_index_T_Schedule-

Payers_15_1293976432__K5_K1_K7_-

K20_K6_2_3_25 

schcp_ScheduleID, schcp_ID, schcp_-

SeqNo, schcp_CancelDate, schcp_-

ScheduleExpenseID 

schcp_ClientPayer-

ID, schcp_PayerID, 

schcp_TS 

 

 _dta_index_T_Schedule-

Payers_15_1293976432__K6_K5_K7_-

K1_K4_2_3 

schcp_ScheduleExpenseID, schcp_-

ScheduleID, schcp_SeqNo, schcp_ID, 

schcp_AdmissionID 

schcp_ClientPayer-

ID, schcp_PayerID 

 

 _dta_index_T_Schedule-

Payers_15_1293976432__K6_K5_K7_-

K20_1_2_3 

schcp_ScheduleExpenseID, schcp_-

ScheduleID, schcp_SeqNo, schcp_-

CancelDate 

schcp_ClientPayer-

ID, schcp_ID, 

schcp_PayerID 

 

 _dta_index_T_Schedule-

Payers_15_1293976432__K7_K20_K5_-

K6_2_3 

schcp_SeqNo, schcp_CancelDate, 

schcp_ScheduleID, schcp_Schedule-

ExpenseID 

schcp_ClientPayer-

ID, schcp_PayerID 

 

 _dta_index_T_Schedule-

Payers_15_1293976432__K7_K20_K6_-

K1_2_3_25 

schcp_SeqNo, schcp_CancelDate, 

schcp_ScheduleExpenseID, schcp_ID 

schcp_ClientPayer-

ID, schcp_PayerID, 

schcp_TS 

 

Name Columns 

FK_T_SchedulePayers_T_AddressBook schcp_AddressBookID->[dbo].[T_AddressBook].[addbk_ID] 

FK_T_SchedulePayers_T_Admissions schcp_AdmissionID->[dbo].[T_Admissions].[adm_ID] 

FK_T_SchedulePayers_T_BranchChartGroups schcp_FeeChartID->[dbo].[T_BranchChartGroups].[brcg_ID] 

FK_T_SchedulePayers_T_ClientPayers schcp_ClientPayerID->[dbo].[T_ClientPayers].[clipay_ID] 

schcp_PayerID->[dbo].[T_ClientPayers].[clipay_PayerID] 

FK_T_SchedulePayers_T_Payers_CoPayerID schcp_CopayerID->[dbo].[T_Payers].[pay_ID] 

FK_T_SchedulePayers_T_ScheduleExpenses schcp_ScheduleExpenseID->[dbo].[T_ScheduleExpenses].[schexp_ID] 

schcp_ScheduleID->[dbo].[T_ScheduleExpenses].[schexp_schID] 

FK_T_SchedulePayers_T_Schedules schcp_ScheduleID->[dbo].[T_Schedules].[sch_ID] 

schcp_AdmissionID->[dbo].[T_Schedules].[sch_AdmissionID] 

FK_T_SchedulePayers_TransferFrom schcp_TransferFromInvoiceHeaderID->[dbo].[T_InvoiceHeader].[invh_ID] 

FK_T_SchedulePayers_TransferTo schcp_TransferToInvoiceHeaderID->[dbo].[T_InvoiceHeader].[invh_ID] 
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Schedule Recurrence 

 [dbo].[T_ScheduleRecurrence] 

 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

schrec_ID bigint  False (1,1)  

 schrec_Description char  True   

 schrec_OccurrenceDuration int  False   
 

schrec_OccurrenceStartTime datetime  False   

 schrec_PatternDayOfMonth tinyint  False   

 schrec_PatternDaysOfWeek tinyint  False   

 schrec_PatternFrequency tinyint  False   

 schrec_PatternInterval int  False   

 schrec_PatternMonthOfYear tinyint  False   

 schrec_PatternOccurrenceOfDayInMonth tinyint  False   

 schrec_PatternType tinyint  False   

 schrec_RangeEndDate datetime  False   

 schrec_RangeLimit tinyint  False   

 schrec_RangeMaxOccurrences int  False   

 schrec_RangeMaxFrequency int  False   

 schrec_RangeStartDate datetime  False   

 
schrec_RootAppointment bigint  False   

 schrec_OriginalStartDateTime datetime  False   

 schrec_OriginatedFromID bigint  False   

 schrec_OriginType tinyint  False   

 
schrec_TimeZoneID smallint  False  70 

 schrec_CreatedDate datetime  False  (getutcdate()) 

 schrec_CreatedUser nvarchar(50)  False   

 schrec_ModifiedDate datetime  False  (getutcdate()) 

 schrec_ModifiedUser nvarchar(50)  False   

 schrec_TS timestamp  False   

 schrec_FirstDayOfWeek tinyint  False  0 

 schrec_LastGenDate date  True   
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Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique Fill Factor 

 

PK_T_ScheduleRecurrence schrec_ID True 80 

 IX_RootAppointmentID schrec_RootAppointment False 80 

 IX_T_OriginatedFromID schrec_OriginatedFromID False 80 

Name Columns 

FK_T_ScheduleRecurrence_T_Schedules schrec_RootAppointment-> [dbo].[T_Schedules] ([sch_ID]) 

FK_T_ScheduleRecurrence_T_TimeZones schrec_TimeZoneID-> [dbo].[T_TimeZones] ([tz_ID]) 
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Schedule Shift 

 [dbo].[T_ScheduleShift] 

 

 

Note: Detailed documentation is pending. 
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Schedule Shift Payers 

 [dbo].[T_ScheduleShiftPayers] 

 

 

Note: Detailed documentation is pending. 
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Schedules 

 [dbo].[T_Schedules] 

 

Columns 

Key Name Data Type Computed 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

(7) 

sch_ID 

The System schedule ID. 

Schdeule Calendar > Schedule Details 

> Record Info > ID and Scheduling > 

Telephony > Call Review > Sch ID 

bigint  8 False 1 - 1  

(6)

 

sch_ClientID 

Auto-generated unique Client ID. Flows 

from [T_Admissions].[adm_ClientID] 

bigint  8 False   

(4)

 

sch_CaregiverID 

Description: Auto-generated unique 

caregiver ID. Flows from [T_-

Caregiver].[car_ID]. 

bigint  8 True   

(11) 

sch_StartTime 

The start date/time scheduled in UTC. 

Scheduling > Telephony > Call Review 

> Sch.Start 

datetime  8 False  (getdate()) 

(7) 

sch_EndTime 

The end date/time scheduled in UTC. 

Scheduling > Telephony > Call Review 

> Sch.End 

datetime  8 False   

(2)

 

sch_ScheduleStatusID 

The current status of the visit. Built into 

the system are the choices "S" for 

Scheduled, "C" for Completed, and "T" 

for Telephony Completed. Other 

statuses may be added in DDM 

Schedule Status. 

Scheduling > Scheduling Calendar > 

Schedule Details > Main > Status 

int  4 False  ((19)) 

(6)

 

sch_ServiceCodeID 

The service code scheduled. 

Scheduling > Telephony > Call Review 

> Service Code 

int  4 False   

(6)

 

sch_AdmissionID 

The Admission ID to which the 

schedule is attached. Click the 

bigint  8 False   
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Admission icon to jump to that specific 

admission record. 

Scheduling > Scheduling Calendar > 

Schedule Details > Main > Admission 

ID 

 sch_Description 

Enter notes if applicable. Notes that 

exist on schedules at the time invoices 

are finalized display on Standard and 

Payer invoice types if the Office>Billing 

Rpt Parms Display Schedule Notes 

field is set to True or the Payer>Billing 

Rpt Parms field 'Display Schedule 

Notes' field is set to 'True' or 'Default' 

(and Office is set to 'True'). See 

Also How To: Apply Schedule Notes to 

a Client Invoice. Changes made 

to schedule notes after the  

invoice is finalized will not be included 

on invoice reports. If the Schedule 

crosses multiple invoice detail records 

(due to office shifts or holiday shifts) 

the Note will repeat on each invoice 

detail line on the reports. 

Scheduling > Scheduling Calendar > 

Schedule Details > Notes > Notes 

nvarchar(4000)  8000 True   

 sch_ChargeRateOverrideAmt 

 

Description: Entering a bill rate on this 

tab allows all other bill rates to be 

overridden for this one schedule. Enter 

the bill rate for this schedule in order to 

manually overwrite the default bill rate. 

Note: Holiday and Shift differentials 

ARE NOT applied to override records. 

Entering a bill rate override is the rate 

for that schedule and ignores other 

differentials. 

Main Database:  [T_Schedules].[sch_-

ChargeRateOverrideAmt] 

Simplified Database: [T_-

Schedules].[ChargeRate] 

UI: Scheduling > Scheduling Calendar 

> Schedule Details > Bill Info > Bill 

Rate Override > Rate 

smallmoney  4 False  ((0)) 

 sch_ChargeRateOverrideModifiedUser 

The user that manually overwrote this 

bill rate. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Bill Rate 

Override > By 

nvarchar(50)  100 True   

 sch_ChargeRateOverrideModifiedDate 

The date and time this bill rate was 

manually overwritten. 

datetime  8 True   
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Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Bill Rate 

Override > On 

 sch_PayRateOverrideAmt 

Entering a pay rate on this tab allows 

all other pay rates to be overridden for 

this one schedule. Enter the pay rate 

for this schedule in order to manually 

overwrite the default pay rate. 

Note: Holiday and Shift differentials 

ARE NOT applied to override records. 

Entering a pay rate override is the rate 

for that schedule and ignores other 

differentials. 

Main Database: [T_Schedules].[sch_-

PayRateOverrideAmt] 

Simplified Database: [T_-

Schedules].[PayRate] 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Rate Override > Rate 

smallmoney  4 False  ((0)) 

 sch_PayRateOverrideModifiedUser 

The user that manually overwrote 

this pay rate. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Rate Override > By 

nvarchar(50)  100 True   

 sch_PayRateOverrideModifiedDate 

The date and time this pay rate was 

manually overwritten. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Rate Override > On 

datetime  8 True   

 sch_ChargeRateID 

Set from T_InvoiceDetailsDraft.invd_-

RateID  from store procedure that 

copies the InvoiceDetail records from 

the draft table to the finalized table. 

bigint  8 True   

 sch_ChargeRate 

Set from T_InvoiceDetailsDraft.invd_-

ChargeRate. 

smallmoney  4 True   

 sch_Units 

The total amount of units to be billed. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Bill Units 

decimal(8,4)  5 True  ((0)) 

 sch_BillRateUnitFlag 

Displays the unit type for billing. 

Choices are Visit, 15 Minute, Hourly 

and Daily. See Bill and Pay Service 

Units for descriptions of each Unit type. 

Scheduling > Scheduling Calendar > 

Schedule Details > Main > Bill Unit 

Type 

smallint  2 False  ((60)) 
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 sch_PayRateUnitFlag 

Displays the unit type for payroll. 

Choices are Visit, 15 Minute, Hourly 

and Daily. See Bill and Pay Service 

Units for descriptions of each Unit type. 

Scheduling > Scheduling Calendar > 

Schedule Details > Main > Pay Unit 

Type 

smallint  2 False  ((60)) 

 sch_PayUnits 

The total amount of units to be paid. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Units 

decimal(8,4)  5 False  ((0)) 

 sch_OTUnits 

The agency can bill overtime units at 

the dollar amount specified in the 

contract with the client and/or payer. 

Enter a flat dollar amount 

corresponding to the Billing Overtime 

Rate for every service code bill rate in 

the system. Displays how many bill 

units are billed at the OT rate. To 

change the number of OT units, 

change this number. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> Units 

decimal(8,4)  5 False  ((0)) 

 sch_TotalCharge 

Description: Not used. 

smallmoney  4 True   

 sch_NotesDate 

When the schedule has been 

confirmed, a check appears in the box 

and the date of confirmation appears. 

Scheduling > Scheduling Calendar > 

Schedule Details > Notes > Confirmed 

datetime  8 True   

 sch_PayReviewFlag 

Pay reviewed: True or False. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Review 

bit  1 False  ((0)) 

 

sch_PayrollBatchID 

If the schedule has been paid, the pay 

batch number displays here. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay 

Batch 

bigint  8 True   

 sch_PayNotes 

Enter notes if needed. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Notes 

nvarchar(128)  256 True   

 
sch_PayDate 

Date schedule was paid. 

datetime  8 True   
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sch_PayCode 

Displays the Pay Flag for this service 

code. The choices are Payable, Not 

Payable, or Default. The 

selection Default will pull from the 

setting for the Service Code in DDM 

Service Codes. If the service code 

is Payable in the Service Code, then 

this will appear here as Default 

(Payable); if it is Not Payable, then it 

will display here as Default (Not 

Payable). 

Main Database: [T_Schedules].[sch_-

PayCode] 

Simplified Database: [T_-

Schedules].[PayableStatus] is set to 

'Default Billable Status Value' 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Pay Flag 

tinyint  1 False  ((2)) 

 
sch_RevenueCode 

Displays the Bill Flag for this service 

code. The choices are Billable, Billable  

No Charge, NotBillable, or Default. The 

selection Default pulls from the setting  

for the Service Code in DDM Service  

Codes. If the service code is Billable in 

the Service Code, then this will  

appear here as Default (Billable); if it is 

Not Billable, then it displays here  

as Default (Not Billable).  

Main Database: [T_Schedules].[sch_-

RevenueCode] 

Simplified Database: [T_-

Schedules].[BillableStatus] is set to 

'Default Billable Status Value' 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Bill Flag 

tinyint  1 False  ((0)) 

 
sch_BillingStatus 

Displays the stage of the billing 

process for this schedule. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Billing 

Status. Valid values:  

0: Not billed yet. No invoices related to 

this schedule are created (canceled 

invoices do not count for this). 

1: Billing in progress: An invoice for this 

schedule is created but billing for the 

schedule is not yet completed. More 

invoices are expected related to the 

schedule.  

For not PPS billing, this will happen 

when at least one but not all payers in 

the schedule payer list have been 

billed. The billing status will change to 

tinyint  1 False  ((0)) 
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Completed when an invoice for each 

payer in the schedule payer list is 

created. 

For PPS billing this will happen only on 

the first billable visit when the RAP is 

created but the final claim is not 

created.  

2: Billing is completed.  

 

 

sch_AuthID 

ID of the authorization of which the 

schedule is under 

bigint  8 True   

 
sch_1500POS 

Place of Service codes. Used on 

H1500 form.  

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Place of 

Service 

int  4 True  ((12)) 

 sch_1500TOS 

Code for H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Type of 

Service codes: TOS  

int  4 True  ((0)) 

 sch_1500Diag 

Diagnosis. Used on H1500 from. 

1500 v02.12 uses letters A-L (*old 

version v08.05 uses numbers 1-

4). Default is A for v02.12. 

Existing records with default 1 - will 

show default A. 

Existing records with options 2, 3, or 4 

will be mapped to the corresponding 

item. 

Draft 1500 Invoice process looks at the 

Bill Type of the batch:  

If the Bill Type is v02.12 the letter 

diagnosis pointer values will be used 

(up to 4 positions). 

If the Bill Type is v08.05 the numeric 

diagnosis pointer values will be used 

(up to 4 positions) - A=1, B=2, C=3, 

D=4. 

Diagnosis pointer displays in 24E of 

the 1500 Invoice  

Preview form based on the version of 

the batchTax lines do not display a 

diagnosis pointer value  

Payer should be set to 'Group Invoice 

Details' = 'No  

Grouping' if schedules are set with 

different diagnosis pointer values  

int  4 True  ((1)) 
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Field in the UI is sch_1500Diag_Editor 

at Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Diagnosis 

 sch_1500EPSDT 

Early and Periodic Screening 

Diagnosis 

Program. Allows the user to enter in a 

code which 

populates in 24H on the 1500H1500 

form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > 1500 

EPSDT 

nvarchar(50)  100 True   

 sch_1500EMG 

Allows the user to enter in an 

emergency code and this 

info populates in Box 24C on the 1500. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > 1500 

EMG 

nvarchar(50)  100 True   

 sch_1500COB 

H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > 1500 COB 

nvarchar(50)  100 True   

 sch_1500LocalUse 

H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > 1500 

Local Use 

nvarchar(50)  100 True   

 sch_UserDefined1 

Not used. 

nvarchar(50)  100 True   

 

sch_RecurrenceId 

System generated unique Recurrence 

ID. Recurrence can be used more than 

once under the same schedule. 

bigint  8 True   

(5) 

sch_IsRecurringAppointmentRoot 

True if a recurring appointment. 

bit  1 False  ((0)) 

 sch_CreatedDate 

Date and time when the schedule was 

created. 

Scheduling > Scheduling Calendar > 

Schedule Details > Record Info > 

Created On 

datetime  8 False  (getutcdate()) 

 sch_CreatedUser 

The user who created the schedule. 

Scheduling > Scheduling Calendar > 

Schedule Details > Record Info > 

Created By 

nvarchar(50)  100 False   

 sch_ModifiedDate 

Most recent date and time when the 

schedule was modified. 

datetime  8 False  (getutcdate()) 
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Scheduling > Scheduling Calendar > 

Schedule Details > Record Info > 

Modified On 

 sch_ModifiedUser 

The user who made the most recent 

schedule modification. 

Scheduling > Scheduling Calendar > 

Schedule Details > Record Info > 

Modified By 

nvarchar(50)  100 False   

 sch_TS 

Unique timestamp of record. 

timestamp  8 False   

(2) 

sch_IsRecurrenceUnique 

Not used. 

bigint True 8 False   

 sch_LegacyID 

The legacy record Id. Typically used for 

data conversions to identify the 

schedule record in the application that 

this record was converted from. 

int  4 True   

 sch_LegacyBranchID 

The legacy branch or office Id. 

Typically used for data conversions to 

identify the branch or office record that 

the scheduled belonged to in the 

source application. 

int  4 True   

 sch_tzID 

Not used. 

nchar(10)  20 True   

 sch_TimeZoneID 

Timezone of the schedule based on 

the branch location. 

smallint  2 True   

 sch_StartOffset 

Schedule start offset. 

smallint  2 True   

 sch_EndOffset 

Schedule end offset. 

smallint  2 True   

 sch_OTMulti 

Overtime rate multiplier. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> Multiply 

decimal(8,4)  5 False  ((1.5)) 

 
sch_SchedStartTime 

Date and time the service started, as 

recorded in the telephony interface. 

Scheduling > Scheduling Calendar > 

Schedule Details > Schedule Info > 

Start Date 

datetime  8 True   

 sch_SchedEndTime 

Date and time the service ended, as 

recorded in the telephony interface. 

The duration is auto-calculated. 

Scheduling > Scheduling Calendar > 

Schedule Details > Schedule Info > 

End Date 

datetime  8 True   
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 sch_SchedUnits 

Number of hours for the record. 

Scheduling > Scheduling Calendar > 

Schedule Details > Schedule Info > 

Units 

decimal(8,4)  5 False  ((0)) 

 sch_SchedUpdatedDate 

Date the record was updated, as 

recorded by the telephony import. 

Scheduling > Scheduling Calendar > 

Schedule Details > Schedule Info > 

Updated 

datetime  8 True   

 sch_SchedOverrideModifiedDate 

Date the data in the record was over 

written after the telephony import. 

Scheduling > Scheduling Calendar > 

Schedule Details > Schedule Info > 

Override Date 

datetime  8 True   

 sch_SchedOverrideModifiedUser 

User ID who last overrode the 

schedule. 

nvarchar(50)  100 True   

 sch_TelUpdatedDate 

Date schedule updated by telephony. 

datetime  8 True   

 sch_OTExemptHours 

OT exempt hours. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Non-

Working Hours > Hours 

decimal(8,2)  5 False  ((0)) 

 
sch_OTExemptTypeID 

Select the Non-Working type from the 

drop down which populates with 

records set-up under DDM Non 

Working Hours Types. Enables if pay 

unit type is NOT "Visit". If the Type has 

both Pay and Bill =True 

(checked), information entered here on 

the Pay Info tab gets copied to the 

Schedule Details>Bill Info tab Non-

Working Hours fields. Pay Units 

recalculated based on duration of Non-

Working Hours Start and End. *A Non-

Working Type may exist without Non-

Working Start/End times when a 

schedule is in a Status other than a "C" 

Completed status; BUT both Non-

Working Start/End times required when 

Non-Working Type set on a "C" 

Completed schedule. 

Scheduling > Scheduling Calendar > 

Schedule Details > Pay Info > Non-

Working Hours > Type 

int  4 True   

 
sch_1500BillingModifierID1 

H1500 form. 

int  4 True   
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Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Override 

Modifier 1 

 
sch_1500BillingModifierID2 

H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Override 

Modifier 2 

int  4 True   

 
sch_1500BillingModifierID3 

H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Override 

Modifier 3 

int  4 True   

 
sch_1500BillingModifierID4 

H1500 form. 

Scheduling > Scheduling Calendar > 

Schedule Details > H1500 > Override 

Modifier 4 

int  4 True   

(5) 

sch_BranchID 

ID of branch or office that owns the 

scheduled. 

Scheduling > Weekly Schedules > 

Quick Entry > Office 

Scheduling > Telephony > Call Review 

> Branch (Office) 

int  4 False   

 sch_OriginalPayDate 

Sch_PayDate is transfered to this field 

during finalizing of payroll for 

cancelation process to revert back to 

the original value. 

datetime  8 True   

 sch_TotalBillable 

Sum of schsp_AllocatedAmount 

values. Not being used. 

money  8 True   

 sch_TotalBilled 

Sum of schsp_AllocatedAmount values 

if schsp_InvoiceDetailsID is not null. 

Not being used. 

money  8 True   

 sch_TotalPaid 

Sum of T_PayrollDetailsDraft.prolld_-

TotalDetailAmount values. 

money  8 True   

 
sch_ArrivalCallID 

Latest arrival call ID. 

bigint  8 True   

 
sch_DepartureCallID 

Latest Departure call ID. 

bigint  8 True   

 sch_TelephonyStatus 

Indicates reason call did not associate, 

if applicable. If the call associated to 

the visit with no intervention, this field 

will be blank. 

Scheduling > Telephony > Call review 

> Tel.Status 

int  4 True   
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sch_RegionID 

Regional location. 

Scheduling > Scheduling Calendar > 

Schedule Details > Record Info > 

Office Area 

int  4 True   

 sch_BilledPaidRegion 

This will be used to determine 

Schedule's Region value. If the 

schedule is either Billed Or Paid, will 

return the region’s value; possibly a 

null value; otherwise the value of (0) 

will be returned, indicating that the 

schedule should be assigned client’s 

region at billing or payroll process. 

int True 4 True   

 sch_InvoiceDetailDescription 

Allows you to enter an invoice 

description override for the service 

scheduled as found on the Schedule 

Details Main tab. Not required. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Inv 

Description 

nvarchar(100)  200 True   

 sch_QCode 

Enter in the appropriate QCode on the 

first billable visit for the episode. If the 

client changes service locations during 

the certification period (ex: they go to 

an assisted living facility on day 22), 

enter the QCode for ALF on the first 

billable service provided at the ALF 

location. Each billable schedule that 

has a QCode generates an additional 

line item for the Medicare Claim. See 

How To: Enter QCodes for Patient 

Location on PPS Medicare Claims. 

Not available Offline. Field locks down 

on schedules in 'In 

Progress' or 'Billed' statuses. Need-

Schedule.Billed permission to 

modify 'In Progress' first billable visit 

prior to finalizing the Claim. Once the 

Claim is finalized, the QCode field 

CANNOT be changed; would need to 

cancel the Claim in order to modify the 

field. 

See About QCodes for details on the 

CMS Background and Policy regarding 

QCodes. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > QCode 

nvarchar(25)  50 True   

 sch_PayNonWorkStartTime 

Enter the start of the non-working pay 

time. Enables if pay unit type is NOT 

'Visit'. First row that displays in drop 

down is the start time matching the 

schedule start time. Also see DDM Non 

datetime  8 True   
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Working Hours Types. BOTH Non-

Working Start/End Times REQUIRED 

to be entered if selecting a Non-

Working Type. Non-Working Start time 

MUST be before the Non-Working End 

time. Non-Working times CANNOT be 

same as schedule times. 

Determines sch_PayNonWorkStart-

Time_TimeOnly on Scheduling > 

Scheduling Calendar > Schedule 

Details > Pay Info > Non-Working 

Hours > Start 

 sch_PayNonWorkEndTime 

Enter the end of the non-working pay 

time. Enables if pay unit type is NOT 

'Visit'. Duration displays to assist in 

knowing number of non-working hours 

being entered. Also see DDM Non 

Working Hours Types. BOTH Non-

Working Start/End Times REQUIRED 

to be entered if selecting a Non-

Working Type. Non-Working End time 

CANNOT be after the schedule End 

time. Non-Working times CANNOT be 

same as schedule times. 

Determines sch_PayNonWorkStart-

Time_TimeOnly on Scheduling > 

Scheduling Calendar > Schedule 

Details > Pay Info > Non-Working 

Hours > End 

datetime  8 True   

 
sch_BillNonWorkTypeID 

Select the Non-Working type from the 

drop down which populates with 

records set-up under DDM Non 

Working Hours Types. Enables if bill 

unit type is NOT 'Visit'. If the Type has 

both Pay and Bill =True (checked), 

information entered here on the Bill 

Info tab gets copied to the Schedule 

Details>Pay Info tab Non-Working 

Hours fields. Bill Units recalculated 

based on duration of Non-Working 

Hours Start and End. *A Non-Working 

Type may exist without Non-Working 

Start/End times when a schedule is in 

a Status other than a 'C' Completed 

status; BUT both Non-Working 

Start/End times required when Non-

Working Type set on a 'C' Completed 

schedule. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Non-

Working Hours > Type 

int  4 True   

 sch_BillNonWorkStartTime 

Enter the start of the non-working bill 

time. Enables if bill unit type is 

NOT 'Visit'. First row that displays in 

drop down is the start time matching 

datetime  8 True   
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the schedule start time. Also see DDM 

Non Working Hours Types. *BOTH 

Non-Working Start/End 

times REQUIRED to be entered with a 

Non-Working Type when schedule is 

set to a "C" Completed status. BOTH 

Non-Working Start/End Times 

REQUIRED to be entered if selecting a 

Non-Working Type. Non-Working Start 

time MUST be before the Non-Working 

End time.. Non-Working times 

CANNOT be same as schedule times. 

Determines sch_BillNonWorkStart-

Time_TimeOnly on Scheduling > 

Scheduling Calendar > Schedule 

Details > Bill Info > Non-Working Hours 

> Start 

 sch_BillNonWorkEndTime 

Enter the end of the non-working pay 

time. Enables if pay unit type is NOT 

'Visit'. Duration displays to assist in 

knowing number of non-working hours 

being entered. Also see DDM Non 

Working Hours Types. BOTH Non-

Working Start/End Times REQUIRED 

to be entered if selecting a Non-

Working Type. Non-Working End time 

CANNOT be after the schedule End 

time. Non-Working times CANNOT be 

same as schedule times. 

Determines sch_BillNonWorkEnd-

Time_TimeOnly on Scheduling > 

Scheduling Calendar > Schedule 

Details > Bill Info > Non-Working Hours 

> End 

datetime  8 True   

 sch_BillNonWorkStartTimeOffset 

The StartOffset field of the Bill Non 

Working time. 

smallint  2 True   

 sch_BillNonWorkEndTimeOffset 

The EndOffset field of the Bill Non 

Working time. 

smallint  2 True   

 sch_PayNonWorkStartTimeOffset 

The StartOffset field of the Pay Non 

Working time. 

smallint  2 True   

 sch_PayNonWorkEndTimeOffset 

The EndOffset field of the Pay Non 

Working time. 

smallint  2 True   

 sch_NoteReceived 

Displays the current date when a 

schedule has been changed to a 'C' 

Completed status and the Notes 

Received field auto 

checks. Editable with 'Edit' permission 

to Notes tab. If change a schedule 

status from 'C' to any other status, the 

box auto uncheck's, the Note Date field 

date  3 True   
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then clears when answering 'Yes' to 

the prompt that appears asking 

"Remove Confirmed, Pay Date, and 

Note Received and change status to 

S?". *Does not lock down regardless of 

Schedule Status, Schedule Bill Status, 

or Schedule Pay Status. Remains 

editable after the schedule has been 

billed or paid. 

Scheduling > Scheduling Calendar > 

Schedule Details > Notes > Note Date 

 sch_OTRate 

Enter the overtime rate for this 

schedule in order to manually 

enter the overtime rate. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> Rate 

smallmoney  4 False  ((0)) 

 sch_BillOTOverrideModifiedDate 

The date and time this overtime rate 

was entered. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> On 

datetime  8 True   

 sch_BillOTOverrideModifiedUser 

The user that entered this overtime 

rate. 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> By 

nvarchar(50)  100 True   

 
sch_BillingOTCalcType 

Overtime can be calculated Manually 

or Automatically. To manually 

enter overtime, select Manual and 

enter a flat dollar amount. To 

automatically enter overtime, select 

Automatic and overtime will 

be automatically paid based on the 

amount entered in the overtime rate. If 

the bill overtime type drop down is set 

to Automatic, the overtime units will 

default to zero. If the Units field is 

edited, the bill overtime type drop down 

defaults to Manual. The Bill 

overtime Multiplier type is read only. 

This selection is no longer used and is 

only visible if used in a previous 

version. (1 - Multiplier, 2 - Manual, 3 - 

Automatic) 

Scheduling > Scheduling Calendar > 

Schedule Details > Bill Info > Overtime 

> Type 

tinyint  1 False  ((3)) 

 
sch_ServicePlanHeaderId 

Link to the service plan that was the 

active finalized plan at the time of 

check-in. 

bigint  8 True   
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Indexes 

Mobile 

Key Name Key Columns 

Included 

Columns Unique Filtered 

No 

Recompute 

Fill 

Factor 

 
PK_T_Schedules sch_ID  True   80 

 IX_T_Schedules_ID_-

AdmissionID 

sch_ID, sch_AdmissionID  True  True  

 IX_T_Schedules_-

Unique 

sch_CaregiverID, sch_-

ClientID, sch_StartTime, 

sch_ServiceCodeID, sch_Is-

RecurringAppointmentRoot, 

sch_IsRecurrenceUnique 

 True True   

 IX_AdmissionID sch_AdmissionID, sch_-

StartTime, sch_EndTime, 

sch_ID 

    80 

 IX_CaregiverID sch_CaregiverID, sch_Start-

Time, sch_EndTime 

    80 

 IX_ClientID sch_ClientID, sch_Start-

Time, sch_EndTime 

    80 

 IX_EndTime sch_EndTime, sch_-

ScheduleStatusID, sch_-

ServiceCodeID, sch_-

AdmissionID 

    80 

 IX_ServiceCode sch_ServiceCodeID      

 IX_StartTime sch_StartTime      

 IX_StatusCode sch_ScheduleStatusID, 

sch_StartTime, sch_ID, 

sch_BranchID 

   True  

 IX_T_Schedules_-

ArrivalCallID 

sch_ArrivalCallID   True   

 IX_T_Schedules_-

BranchIDScheduleID 

sch_ID, sch_BranchID      

 IX_T_Schedules_-

BranchID_StartTime_-

EndTime 

sch_BranchID, sch_Start-

Time, sch_EndTime, sch_-

ClientID, sch_CaregiverID 

     

 IX_T_Schedules_Client sch_AdmissionID, sch_-

ClientID 

   True  

 IX_T_Schedules_-

DepartureCallID 

sch_DepartureCallID   True   

 IX_T_Schedules_Is-

RecurringAppointment-

Root 

sch_IsRecurring-

AppointmentRoot, sch_-

StartTime, sch_EndTime 

sch_-

Admission

ID 

   80 

 IX_T_Schedules_Pay-

Date 

sch_PayDate    True  

 IX_T_Schedules_-

RecurrenceID 

sch_RecurrenceId    True  
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Foreign Keys 

 IX_T_Schedules_-

ServiceCodeOverride 

sch_ID, sch_ServiceCode-

ID, sch_BranchID 

    80 

 IX_T_Schedules_-

StarttimeBillingStatus-

PayrollbBatchID 

sch_StartTime, sch_Billing-

Status, sch_PayrollBatchID 

    80 

 IX_T_Schedules_-

UnassignedCar 

sch_ClientID, sch_Start-

Time, sch_ServiceCodeID, 

sch_IsRecurring-

AppointmentRoot, sch_Is-

RecurrenceUnique 

  True   

 IX_T_-

Schedules_branchIs-

RecurringAppointment-

Root 

sch_ID, sch_BranchID, 

sch_IsRecurring-

AppointmentRoot, sch_-

SchedStartTime, sch_End-

Time 

    80 

 _dta_index_T_-

Schedules_15_6344980

85__K4_K7_K2_K3_-

K48_K8_-

K1_5_6_9_10_11_12_1

3_14_15_18_19_21_22

_24_25_26_27_28_29_

30_31_32_33_ 

sch_StartTime, sch_-

ServiceCodeID, sch_Client-

ID, sch_CaregiverID, sch_-

IsRecurringAppointment-

Root, sch_AdmissionID, 

sch_ID 

    80 

 idx_T_Schedules_Auth-

ID 

sch_AuthID   True   

Name 

No 

Check Columns 

FK_T_Schedules_T_Admissions  sch_AdmissionID->[dbo].[T_Admissions].[adm_ID] 

sch_ClientID->[dbo].[T_Admissions].[adm_ClientID] 

FK_T_Schedules_T_Authorization True sch_AuthID->[dbo].[T_Authorization].[auth_ID] 

FK_T_Schedules_T_BillingModifiers1  sch_1500BillingModifierID1->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_Schedules_T_BillingModifiers2  sch_1500BillingModifierID2->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_Schedules_T_BillingModifiers3  sch_1500BillingModifierID3->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_Schedules_T_BillingModifiers4  sch_1500BillingModifierID4->[dbo].[T_BillingModifiers].[bilmod_ID] 

FK_T_Schedules_T_Caregiver  sch_CaregiverID->[dbo].[T_Caregiver].[car_ID] 

FK_T_Schedules_T_Client  sch_ClientID->[dbo].[T_Client].[cli_ID] 

FK_T_Schedules_T_OTExemptType  sch_OTExemptTypeID->[dbo].[T_OTExemptTypes].[otextyp_ID] 

FK_T_Schedules_T_OTExemptType_Bill  sch_BillNonWorkTypeID->[dbo].[T_OTExemptTypes].[otextyp_ID] 

FK_T_Schedules_T_PayrollBatch  sch_PayrollBatchID->[dbo].[T_PayrollBatch].[prollb_ID] 

FK_T_Schedules_T_PlaceOfService-

Codes 

 sch_1500POS->[dbo].[T_PlaceOfServiceCodes].[pos_ID] 

FK_T_Schedules_T_Region  sch_RegionID->[dbo].[T_Region].[reg_ID] 

FK_T_Schedules_T_ScheduleRecurrence  sch_RecurrenceId->[dbo].[T_ScheduleRecurrence].[schrec_ID] 



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 395 

 

 

 

FK_T_Schedules_T_ScheduleStatus  sch_ScheduleStatusID->[dbo].[T_ScheduleStatus].[schst_ID] 

FK_T_Schedules_T_ServiceCode  sch_ServiceCodeID->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_Schedules_T_ServicePlanHeader  sch_ServicePlanHeaderId->[dbo].[T_ServicePlanHeader].[sphead_-

ID] 
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Schedules Tasks 

 [dbo].[T_SchedulesTasks] 

 

Columns 

 

  

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
schtsk_ID 

 

bigint 8 False 1 - 1  

 

schtsk_SchID 

 

bigint 8 False   

 

schtsk_TaskID 

 

int 4 False   

 schtsk_Notes 

 

nvarchar(1000) 2000 True   

 schtsk_FromTelephony 

 

bit 1 True  ((0)) 

 schtsk_Active 

 

bit 1 True  ((1)) 

 schtsk_CreatedDate 

 

datetime 8 False  (getutcdate()) 

 schtsk_CreatedUser 

 

nvarchar(50) 100 False   

 schtsk_ModifiedDate 

 

datetime 8 False  (getutcdate()) 

 schtsk_ModifiedUser 

 

nvarchar(50) 100 False   

 schtsk_TS 

 

timestamp 8 False   

 schtsk_NumericValue 

Numeric value associated with the task.  For 

example: weight, blood pressure, height, 

temperature 

decimal(6,2) 5 True   

 schtsk_NotCompletedReason 

A byte value that designates why a schedule 

task was not completed.  Valid values include:  

1-Patient Denied 

tinyint 1 True   

 schtsk_NotCompletedNotes 

Comments indicating why a schedule task was 

not completed. 

nvarchar(1000) 2000 True   
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Indexes 

 

Foreign Keys 

 

 

Key Name Key Columns Unique 

 
PK_T_ScheduleTasks schtsk_ID True 

 IX_T_ScheduleTasks_SchID_TaskID schtsk_SchID, schtsk_TaskID True 

Name Columns 

FK_T_ScheduleTasks_T_HHATasks schtsk_TaskID->[dbo].[T_HHATasks].[hhat_ID] 

FK_T_ScheduleTasks_T_Schedules schtsk_SchID->[dbo].[T_Schedules].[sch_ID] 
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Service Code 

 [dbo].[T_ServiceCode] 

 

Columns 

Key Name Data Type 

Max Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
svcc_ID 

The ID field of the ServiceCodeListItemInfo and 

ServiceCodeInfo objects. 

This is a system generated number.  Any Service 

Code with an ID under 10000 is a system default and 

cannot be changed. 

Also called ID, ServiceCodeID, SvcCodeID, TaskID. 

int 4 False 10001 - 

1 

 

 
svcc_Name 

The Name field of the ServiceCodeListItemInfo, 

ServiceCodeInfo and  PlanOfCareOrdersRptInfo 

objects. 

Name of the Service Code. 

Also called Name, Discipline, Service, ServiceName, 

ServiceCodeName, DetailsServiceName, Service-

Code, vServiceCodeName, Service_Category, Svc-

CodeName, Code, scheduleservice, TaskName. 

UI Location: Settings > Office > Bill Rates > 

Service, Settings > Office > Pay Rates > Service and 

Scheduling > Telephony > Service Code.  

nvarchar(50) 100 True  ('') 

 
svcc_BillCodeID 

The BillCodeID field of the ServiceCodeInfo object. 

System ID of the service bill code record. 

Also called svcc_BillCodeID. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Rev Code. 

int 4 True   

 svcc_IsExpense 

The IsExpense field of the ServiceCodeListItemInfo, 

ServiceCodeInfo and EFTInfo objects. 

Check this box if the service code created is an 

expense rather than a service. Selecting this will 

change the Bill Unit Type and Pay Unit Type to Unit 

(rather than Hourly, 15 Minute, etc). 

Also called IsExpense, ExpenseFlag, svcc_Is-

Expense. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Is Expense. 

bit 1 False  ((0)) 

 svcc_IsMultiple 

 The IsMultiple field of the ServiceCodeListItemInfo, 

ServiceCodeInfo and InvoiceDetailsInfo objects. 

bit 1 False  ((0)) 
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Check Is Multiple to allow the user to select multiple 

services under one schedule on the Services tab on 

the schedule. 

Also called ServiceIsMultiple, isMultiple.UI 

Location:DB Maintenance > Drop Down Maintenance 

> Service Codes > Is Multiple. 

 svcc_OtherCode 

The OtherCode field of the ServiceCodeInfo object. 

Enter the HCPC code associated with the service 

code, if this code is the same for all payers being 

invoiced for this service. If this is not the case,  

leave this field blank and set the HCPCs for each 

Payer in the Payer Services tab of their payer records. 

Also called svcc_OtherCode, default. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > HCPC Code 

nvarchar(20) 40 True   

 svcc_DefaultCost 

The DefaultCost field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

This is used in reporting, when calculating the cost of 

services against the expected revenue. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Default Cost 

money 8 True   

 svcc_DefaultPayUnitFlag 

The DefaultPayUnitFlag field of the ServiceCodeInfo 

object. 

The user must choose a default pay unit for each 

service code, with the choices of Visit, Minute, 15 Min, 

Hourly, or Daily. This default can be overridden in the 

Schedule if needed.Also called PayUnitFlag, 

UI Location: Scheduling > Telephony > Call Log 

> svcc_DefaultPayUnitFlag and DB Maintenance > 

Drop Down Maintenance > Service Codes > Default 

Pay Unit Flag 

smallint 2 False  ((60)) 

 svcc_DefaultBillUnitFlag 

The DefaultBillUnitFlag field of the ServiceCodeInfo 

object. 

The user must choose a default bill unit for each 

service code, with the choices of Visit, Minute, 15 Min, 

Hourly, or Daily. This default can be overridden in the 

Schedule if needed. 

Also called BillUnitFlag. 

UI Location: Scheduling > Telephony > Call Log 

> svcc_DefaultBillUnitFlag and DB Maintenance > 

Drop Down Maintenance > Service Codes > Default 

Bill Unit Flag 

smallint 2 False  ((60)) 

 

svcc_CategoryID 

The CategoryID field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

Once the Service Code Category has been created, 

the user may go back and select the newly created 

category from the list. Service codes assigned to 

Service Code Categories where Doc Type is set to 

Tasks will display a Task tab on the schedule details 

int 4 True   
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page on your mobile device. This option is used for 

services HHA’s would perform, providing them the 

ability to complete assigned Tasks during their visits. 

Service codes assigned to Service Code Categories 

where Doc Type is set to Forms schedule will display 

an Admissions tab instead of a Task tab on the 

schedule details page on your mobile device. This 

option is used for services that a Nurse (skilled 

disciplines) would perform. 

Also called ServiceCatID. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Service Code 

Category 

 svcc_PayrollCode 

The PayrollCode field of the ServiceCodeInfo object. 

Also referred as EarnCode. 

nvarchar(50) 100 False  ('E0A') 

 svcc_DefaultReimbursment 

The DefaultReimbursment field of the ServiceCode-

Info object. 

The default dollar amount of reimbursement of the 

service code record. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Default 

Reimbursement 

money 8 True   

 svcc_WC 

The WC field of the ServiceCodeInfo object. 

Legacy field from Visitrax - not in use. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > WC 

nvarchar(50) 100 True   

 svcc_ShiftPay 

The ShiftPay field of the ServiceCodeInfo object. 

UI Location:DB Maintenance > Drop Down 

Maintenance > Service Codes > Shift Pay (Hidden) 

bit 1 False  ((0)) 

 
svcc_OTPay 

The OTPay field of the ServiceCodeInfo object. 

0: Exclude: Do not include unless another service in 

the week is set to 1 (Include), 3 (Include-Override), or 

4 (Include-Standard) 

1: Include: Always include in OT calculations.   

2: Always Exclude:  Never include in OT calculations. 

3: Include-Override: Always include in OT 

calculations. 

4: Include-Standard: Always include in OT 

calculations. 

Any Payroll Week that has at least one service set to 

3 (Include-Override) will use the Override Payroll OT 

Rules 

Any Payroll Week that has at least one service set to 

1 (Include) and no services set to 3 (Include-Override) 

will use the Default Payroll OT Rules 

Any Payroll Week that has at least one service set to 

4 (Include-Standard) and no services set to 3 (Include-

tinyint 1 False   
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Override) or 1 (Include) will use the Standard Payroll 

OT Rules  

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > OT Pay 

 svcc_BillExcludeHoliday 

The BillExcludeHoliday field of the ServiceCodeInfo 

object. 

Check this box to exclude this service code 

from holiday billing calculations for all invoices. The 

default is unchecked. 

UI Location:DB Maintenance > Drop Down 

Maintenance > Service Codes > Exclude Holiday Bill 

bit 1 False  ((0)) 

 svcc_PayExcludeHoliday 

The PayExcludeHoliday field of the ServiceCodeInfo 

object. 

Check this box to exclude this service code from 

holiday payroll calculations for all Caregivers. The 

default is unchecked. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Exclude Holiday Pay 

bit 1 False  ((0)) 

 
svcc_IsCat 

The IsCat field of the ServiceCodeListItemInfo and 

ServiceCodeInfo objects. 

The service code category of the service code record. 

Check this box if the user is creating a category for a 

specific service code. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Is Category 

bit 1 False  ((0)) 

 svcc_CommissionRate 

The CommissionRate field of the ServiceCodeInfo 

object. 

Legacy field from Visitrax - not in use. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Commission Rate 

decimal(8,4) 5 False  ((0)) 

 svcc_BonusPoints 

The BonusPoints field of the ServiceCodeInfo object. 

Services provided that are to be considered in the 

bonus points threshold calculation must be configured 

with a bonus points value in the Service Code 

table.  Enter the weighted point value for each service 

code as appropriate. 

Also called BonusPoints. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Bonus Points 

decimal(4,2) 5 False  ((0)) 

 svcc_Active 

The Active field of the ServiceCodeListItemInfo and 

ServiceCodeInfo objects. 

Also called Active. 

bit 1 False  ((1)) 

 
svcc_RevenueCode 

The RevenueCode field of the ServiceCodeInfo and 

ServiceCodeListItemInfo objects. 

tinyint 1 False  ((1)) 
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0  'Default(Billable)', 1 'Billable', 2 'Billable No Charge', 

3 'Not Billable' 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Bill Flag 

 svcc_Pay 

The Pay field of the ServiceCodeInfo and Service-

CodeListItemInfo objects. 

Uncheck this box if this service code should never be 

paid. The default is checked. If unchecked, this 

service code will not pull into payroll batches. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Pay 

bit 1 False  ((1)) 

 svcc_POCFirstBillableFlag 

The POCFirstBillableFlag field of the ServiceCodeInfo 

object. 

For the service code to be used as a SOC visit for 

Medicare, this must be checked in order to bill this 

service code to Medicare. NOTE: The Authorization 

Scheduling Check will not run against the first 

schedule with a service code set for ‘Is POC First 

Billable Item’ for the Start of Care episode for the 

Client. See Plan of Care Auth Builder - First Billable 

for more information. 

0: Can not be used as First Billable 

1: First Billable only on subsequent episodes. 

2: First Billable on all episodes 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Is POC First Billable 

Item 

bit 1 False  ((0)) 

 
svcc_ExpenseTypeID 

The ExpenseTypeID field of the ServiceCodeInfo 

object. 

Choose from the list how each expense should be 

categorized. This list may be modified in the System 

Office under Expense Type Drop Down List. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Expense Type ID 

int 4 True   

 svcc_CreatedDate 

The Date the ServiceCode Record was Created. 

UTC date updated by SQL server's current UTC date. 

Also called CreatedDate. 

datetime 8 False  (getutc

date()) 

 svcc_CreatedUser 

The CreatedUser field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

Also called CreatedUser. 

nvarchar(50) 100 False   

 svcc_ModifiedDate 

The Date the ServiceCode Record was last Modified. 

UTC date updated by SQL server's current UTC date. 

Also called ModifiedDate. 

datetime 8 False  (getutc

date()) 

 svcc_ModifiedUser 

The ModifiedUser field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

nvarchar(50) 100 False   
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Also called ModifiedUser. 

 svcc_TS 

The TS field of the ServiceCodeListItemInfo and 

ServiceCodeInfo objects. 

Timestamp field of the service code record. 

Also called TS. 

timestamp 8 False   

 
svcc_ListItemType 

The ListItemType field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

Global, Office, or Override. Global List Item Types, 

which can be seen by all offices, can only be created 

and modified in the System office. Office and Override 

List Item Types, which can only be seen in the 

individual office of creation, can only be created in that 

Office. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > List Item Type 

tinyint 1 False  ((0)) 

 
svcc_RptGroupID 

The RptGroupID field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

Report Group IDs are used to filter parameters for 

reporting purposes in Soneto. 

Also called RptGroupID.UI Location: DB Maintenance 

> Drop Down Maintenance > Service Codes > Report 

Group ID 

int 4 False  ((97)) 

(2)

 

svcc_BranchID 

The BranchID field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

Also called BranchID. 

int 4 True   

(2)

 

svcc_OverrideID 

The OverrideID field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

If creating an override of a Global level List Item Type, 

select the ID of that Global service code to override. 

This allows the user to have an identical Office level 

ID with different parameters, such as changing the OT 

Pay flag. 

Also called OverrideID, OverrideSvcID. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Override ID 

int 4 True   

 svcc_Description 

The Description field of the ServiceCodeInfo and 

ServiceCodeInfo objects. 

Description of the Service Code. 

Also called Description, Skill Desc, Service-

Description. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Description 

nvarchar(1000) 2000 True   

 
svcc_TaxGroupID 

The TaxGroupID field of the ServiceCodeInfo object. 

If an agency bills taxes, then select the tax that should 

be applied to the service code. The tax is set up on 

int 4 True   



404 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

the Office Tax Groups tab. There is an override on the 

Payer Services tab of the Payer. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Tax Group 

 svcc_LegacyID 

Not used. 

int 4 True   

 svcc_LegacyBranchID 

Not used. 

int 4 True   

 
svcc_AcctID 

The AcctID field of the ServiceCodeInfo object. 

Choose the correct Accounting Chart to associate with 

the particular service code. The accounting charts are 

created in DDM Accounting Charts. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Accounting Charts 

int 4 True  ((1)) 

 svcc_UploadTelephony 

The UploadTelephony field of the ServiceCodeInfo 

and ServiceCodeListItemInfo objects. 

Check this box to include the service code in uploads 

to Santrax. The default is unchecked. See Telephony 

for more information. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Upload Telephony 

bit 1 False  ((0)) 

 svcc_TelephonyTaskID 

The TelephonyTaskID field of the ServiceCodeInfo 

and ServiceCodeListItemInfo objects. 

Enter the Telephony Task ID for each service code 

that has a corresponding task in 

telephony. See Telephony for more information. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Telephony Task 

nchar(4) 8 True   

 svcc_IncludeEFT 

The IncludeEFT field of the ServiceCodeInfo object. 

Check this box for each Service Code to include the 

charges for these services on finalized invoices in the 

Royalty EFT calculation. The default is checked. See 

Royalty for more information. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Include EFT 

bit 1 False  ((0)) 

 svcc_ProjectedAvgPayHourly 

The ProjectedAvgPayHourly field of the ServiceCode-

Info object. 

Legacy - not in use. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Projected Average 

Pay Hourly 

money 8 True   

 svcc_ProjectedAvgBillHourly 

The ProjectedAvgBillHourly field of the ServiceCode-

Info object. 

Legacy - not in use. 

money 8 True   
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UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Projected Average 

Bill Hourly 

 svcc_ProjectedAvgBillVisit 

The ProjectedAvgBillVisit field of the ServiceCodeInfo 

object. 

Legacy - not in use. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Projected Average 

Bill Visit 

money 8 True   

 svcc_ProjectedAvgPayVisit 

The ProjectedAvgPayVisit field of the ServiceCodeInfo 

object. 

Legacy - not in use. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Projected Average 

Pay Visit 

money 8 True   

 svcc_IsCopy 

The IsCopy field of the ServiceCodeInfo and Service-

CodeListItemInfo objects. 

When a service code is checked for Is Expense, the 

field Is Copy will enable. Check this box if you want 

the expense item to copy out to all schedules when 

the original schedule recurrence pattern is 

created. The default setting for this indicator is 

unchecked. Note: The expense must exist in the 

original schedule prior to creating the recurrence 

pattern. After the expenses have been copied out with 

the original schedule recurrence pattern, editing or 

adding expenses to schedules within the pattern  

will not update the recurrence pattern. Only the 

schedule being modified will be affected. The units 

can be left at 0 if you do not want to copy out a 

specific number of units for the expense for all the 

schedules in the recurrence. You can modify the 

expense units when confirming the caregiver’s 

schedules. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Is copy 

bit 1 False  ((0)) 

 svcc_IsWorking 

The IsWorking field of the ServiceCodeListItemInfo 

and ServiceCodeInfo objects. 

When a service code is checked for Is Working, the 

Caregiver Search will display the sum of hours worked 

by a caregiver for all service codes, where the service 

codes are in Schedule Status of Completed, 

Telephony Completed, or Scheduled. For further 

information, see Caregiver Search. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Is Working 

bit 1 False  ((1)) 

 svcc_DeductEarn 

The DeductEarn field of the ServiceCodeInfo object. 

Enter the Deduct/Earn Code for the service code if 

required by a customized payroll extract files. 

nvarchar(5) 10 False  (N'E') 
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UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Deduct/Earn 

 svcc_LiveInRptHrs 

The DeductEarn field of the ServiceCodeInfo object. 

This number allows the agency determine (for 

reporting purposes) how many hours constitute Live 

In, or how many hours the Caregiver actually worked. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > LiveIn Report Hours 

decimal(4,2) 5 True   

 svcc_AcctCode 

The AcctCode field of the ServiceCodeInfo object. 

The same Account Code is used for all offices for the 

same category. Enter the 3-digit Account Code for the 

service code category. This is used for the last 3-digits 

of the GL Subaccount code in the extract file. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Account Code 

nvarchar(50) 100 True   

 svcc_DisplayOnClientPortal 

The DisplayOnClientPortal field of the ServiceCode-

Info and ServiceCodeListItemInfo objects. 

Check this box to the service code display on the 

Client Portal. Filter for schedules on the client's portal 

based on schedule service. True = show 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Display on Client 

Portal 

bit 1 True   

 svcc_DisplayOnCaregiverPortal 

The DisplayOnCaregiverPortal field of the Service-

CodeInfo object. 

Filter for schedules on the caregiver's portal based on 

schedule service. True = show 

Check this UI box to have the service code display on 

the Caregiver Portal. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Display on Caregiver 

Portal 

bit 1 True   

 
svcc_TherapyCountingType 

If this service is a therapy service, this specifies how 

the service is treated in relation to medicare therapy 

counting. Select Not Applicable, Discharge Visit, 

Reassessment Visit, or Therapy Visit. Determines if 

Service Codes should be included in therapy counting. 

Must configure for Medicare service codes. Uses the 

Bill Flag of 'Billable' or 'Default (Billable)' to be 

included in therapy counts. See 30th Therapy Visit 

Warnings for more information. 

Not Applicable - Default setting; service not included 

in therapy counting. 

Therapy Visit - service eligible for counting in 

the 30th therapy visit process. REASSESSMENT 

visits SHOULD NOT be set to this. 

Reassessment Visit - service is a Reassessment visits 

and included in the therapy count. 

tinyint 1 False  ((0)) 
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Discharge Visit - service is a Discharge visit and 

included in the therapy count. Signifies 'Medicare 

Discipline' assigned to the service code now 

discharged from the case. [Useful in multi-therapy 

discipline cases, where discharging one discipline 

from the case can shrink the reassessment interval]. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Therapy Counting 

Type 

 
svcc_MedicareDiscipline 

Specifies if this service is a medicare discipline.  This 

relates to the M0080 question on OASIS, or 0 if it's not 

applicable. 

Prefills based on the Service Code's assigned Service 

Code Category. Designates the Medicare discipline 

for the service code. Default is Not Applicable. Service 

Codes with Medicare Discipline = PT, OT, or ST (and 

Therapy Counting Type is not ‘Not Applicable’) will be 

included in the therapy counts. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Medicare Discipline 

tinyint 1 False  ((0)) 

 svcc_DocType 

Specifies if a service category is associated with tasks 

or forms. 

Used with MatrixCare Home Care Mobile to determine 

screen options displayed for schedules on mobile 

devices. The field is populated on Service Code 

Category entries. Possible values are Tasks or Forms. 

The default setting is Tasks. Service code and 

expense entries will display blank in this field. 

UI Location: DB Maintenance > Drop Down 

Maintenance > Service Codes > Doc Type 

tinyint 1 False  ((0)) 

 svcc_IsMultipleService 

Indicates that a schedule with this service code can 

contain more than one service. 

bit 1 False  ((0)) 



408 © 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 

Indexes 

Foreign Keys 

 

 

 

 

 

Key Name Key Columns Unique 

Fill 

Factor 

 
PK_T_ServiceCode_Code svcc_ID True 80 

 IX_T_ServiceCode_BranchID_OverrideID_Is-

Cat_Name 

svcc_BranchID, svcc_OverrideID, svcc_IsCat, 

svcc_Name 

True 90 

 IX_T_ServiceCode_CategoryID svcc_CategoryID  80 

 IX_T_ServiceCode_OverrideBrID svcc_OverrideID, svcc_BranchID  80 

Name Columns 

FK_T_ServiceCode_T_AcctCharts svcc_AcctID->[dbo].[T_AcctCharts].[acct_ID] 

FK_T_ServiceCode_T_BillCode svcc_BillCodeID->[dbo].[T_BillCodes].[bcd_ID] 

FK_T_ServiceCode_T_Branches svcc_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_ServiceCode_T_BranchTaxGroups svcc_TaxGroupID->[dbo].[T_BranchTaxGroups].[brtg_ID] 

FK_T_ServiceCode_T_ExpenseTypes svcc_ExpenseTypeID->[dbo].[T_ExpenseTypes].[exptyp_ID] 

FK_T_ServiceCode_T_MedicareDisciplines svcc_MedicareDiscipline->[dbo].[T_MedicareDisciplines].[mcare_ID] 

FK_T_ServiceCode_T_ReportGroups svcc_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 

FK_T_ServiceCode_T_ServiceCode svcc_CategoryID->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_ServiceCode_T_ServiceCode_OverrideID svcc_OverrideID->[dbo].[T_ServiceCode].[svcc_ID] 

FK_T_ServiceCode_T_TherapyCountingType svcc_TherapyCountingType->[dbo].[T_TherapyCountingType].[thercount_ID] 
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Service Plans 

 [dbo].[T_ServicePlans] 

 

 

Note: Detailed documentation is pending. 
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Skill Categories 

 [dbo].[T_SkillCategories] 

 

Description 

Contains data records for Skill Categories. 

Columns 

Indexes 

Foreign Keys 

 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
skillc_ID int  False 10001,1  

 skillc_Name nvarchar(50)  False  ('') 

 skillc_Active bit  False  ((1)) 

 skillc_ModifiedDate datetime  False  (getutcdate()) 

 skillc_ModifiedUser nvarchar(50)  False   

 skillc_CreatedDate datetime  False  (getutcdate()) 

 skillc_CreatedUser nvarchar(50)  False   

 skillc_TS timestamp  False   

 skillc_ListItemType tinyint  False  ((0)) 

 
skillc_RptGroupID int  False  ((98)) 

 
skillc_BranchID int  True   

 
skillc_OverrideID int  True   

 skillc_Description nvarchar(1000)  True   

 skillc_UserRegPermissionGroupId int  True   

Key Name Key Columns Unique Fill Factor 

 

PK_T_SkillCategories skillc_ID True 80 

 IX_T_SkillCategories_BranchOverrideN

ame 

skillc_BranchID,  skillc_OverrideID,  sk

illc_Name 

True 80 

Name Columns 

FK_T_SkillCategories_T_Branches skillc_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_SkillCategories_T_ReportGroups skillc_RptGroupID-> [dbo].[T_ReportGroups] ([rptgrp_ID]) 

FK_T_SkillCategories_T_SkillCategories skillc_OverrideID-> [dbo].[T_SkillCategories] ([skillc_ID]) 
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Tax Types 

 [dbo].[T_TaxTypes] 

 

Columns 

Indexes 

Foreign Keys 

 

  

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
taxtyp_ID int 4 False 10001 - 1  

 
taxtyp_Name nvarchar(50) 100 True   

 taxtyp_Active bit 1 False  ((1)) 

 taxtyp_CreatedDate datetime 8 False  (getutcdate()) 

 taxtyp_CreatedUser nvarchar(50) 100 False   

 taxtyp_ModifiedDate datetime 8 False  (getutcdate()) 

 taxtyp_ModifiedUser nvarchar(50) 100 False   

 taxtyp_TS timestamp 8 False   

 
taxtyp_ListItemType tinyint 1 False  ((0)) 

 
taxtyp_RptGroupID int 4 False  ((100)) 

 
taxtyp_BranchID int 4 True   

 
taxtyp_OverrideID int 4 True   

 taxtyp_Description nvarchar(1000) 2000 True  ('') 

 
taxtyp_AcctID int 4 True  ((1)) 

Key Name Key Columns Unique Fill Factor 

 
PK_T_TaxTypes taxtyp_ID True 80 

 IX_T_TaxTypes_BranchOverrideName taxtyp_BranchID, taxtyp_OverrideID, taxtyp_Name True 80 

Name Columns 

FK_T_TaxTypes_T_AcctCharts taxtyp_AcctID->[dbo].[T_AcctCharts].[acct_ID] 

FK_T_TaxTypes_T_Branches taxtyp_BranchID->[dbo].[T_Branches].[br_ID] 

FK_T_TaxTypes_T_ReportGroups taxtyp_RptGroupID->[dbo].[T_ReportGroups].[rptgrp_ID] 

FK_T_TaxTypes_T_TaxTypes taxtyp_OverrideID->[dbo].[T_TaxTypes].[taxtyp_ID] 
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Telephony Calls 

 [dbo].[T_TelephonyCalls] 

 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
tcl_ID 

 

bigint 8 False 1 - 1  

 tcl_TelephonyAccountID 

 

nvarchar(50) 100 False   

 
tcl_Purpose 

 

int 4 True   

 tcl_CaregiverTelephonyID 

 

nvarchar(36) 72 True   

 
tcl_CaregiverID 

 

bigint 8 True   

 tcl_CaregiverMatchStatus 

 

smallint 2 False   

 
tcl_ClientID 

 

bigint 8 True   

 tcl_ClientMatchStatus 

 

smallint 2 False   

 tcl_PhoneNumber 

 

nvarchar(30) 60 True   

 tcl_ServerCallID 

 

bigint 8 True   

 
tcl_CallTime 

 

datetime 8 True   

 tcl_Status 

 

tinyint 1 False  ((0)) 

 
tcl_ScheduleID 

 

bigint 8 True   

 tcl_Completed 

 

bit 1 False   

 tcl_CreatedDate 

 

datetime 8 False   

 tcl_BranchID 

 

int 4 True   

 tcl_Hidden 

For users display only, after they feel a call is 

not useful, they can hide it from the QA Review 

List 

bit 1 True   

 tcl_ClientTelephonyID 

New in 1.23.  If calling CG is at a facility or 

nvarchar(36) 72 True   
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husband/wife location with multiple phone 

numbers they can manually choose the client 

telephony ID, and it gets stored here. 

 tcl_Flags 

QA flags to indicate if there is a problem or 

warning on this call 

int 4 True   

 tcl_Overflow 

If this call would have caused a schedule to go 

over 24H, this call stores the number of minutes 

of overflow, as schedules cannot be over 

24Hours. 

int 4 True   

 tcl_ClientNameList 

Stores the Client Name if one, or if multiple 

possible matches, stores a list.  this may be 

based on phone number match, or schedule 

matching. 

nvarchar(100) 200 True   

 tcl_Location 

Useful for Portal time-and-attendance, not 

classic telephony: GPS location of caregiver 

when clocking in or out 

geography max True   

 tcl_Accuracy 

Useful for Portal time-and-attendance, not 

classic telephony: GPS device uploads how 

accurate its coordinates are 

decimal(6,3) 5 True   

 
tcl_EventType 

Describes method of acquiring data.  0 = 

Telephony classic, 1 = Portal Time and 

Attendance 

smallint 2 True   

 tcl_Overridden 

TimeAndAttendance: indicates a record was 

replaced by a more accurate one.  Multiple 

records can be overridden, but there must be 

one which is not per purpose and schedule. 

bit 1 True   

 tcl_ClientLocation 

Location of the client at the time of the call 

being recorded.  This is a copy of the location 

from T_AddressGeo.  Can be for 

troubleshooting if the client location changes. 

geography max True   

 tcl_CertifyCorrect 

User can certify that the check-in or out is 

correct.  To be used in MatrixCare Mobile to 

start with, not phone-telephony or web1. 

bit 1 True   

 tcl_CertifyNotes 

users can supply an explanation associated 

with the tcl_CertifyCorrect value.  Generally, to 

explain why they are reporting that their check-

in/out time is incorrect. 

nvarchar(500) 1000 True   

 tcl_OverrideTime 

(NOTE: No relation to tcl_Overridden)  

Caregivers can provide an override time if they 

were not able to actually check out at the 

correct time.   

datetime 8 True   

 tcl_OverrideTimeUtcOffset 

 

smallint 2 True   
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Indexes 

Foreign Keys 

 

 

 
tcl_OverrideTimeZoneID 

 

smallint 2 True   

 tcl_MachineIPAddress 

The IP Address of the browser of the user 

who clicked the check in/out button.  Will 

be NULL for phone-call telephony and 

portal1.  Only supplied by Web2. 

nvarchar(50) 100 True   

Key Name Key Columns Unique 

 
PK_T_TelephonyCalls tcl_ID True 

 IX_T_TelephonyCalls_CallTime tcl_CallTime  

 IX_T_TelephonyCalls_ClientCaregiver tcl_CaregiverID, tcl_ClientID  

 IX_T_TelephonyCalls_ScheduleIdEventPurpose tcl_ScheduleID, tcl_EventType, tcl_Purpose  

Name Columns 

FK_T_TelephonyCalls_T_TimeZones tcl_OverrideTimeZoneID->[dbo].[T_TimeZones].[tz_ID] 
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Telephony Call Tasks 

 [dbo].[T_TelephonyCallTasks] 

 

Columns 

Indexes 

 

 

 

Key Name Data Type Max Length (Bytes) Allow Nulls Identity Default 

 
tct_TelephonyCallTaskID bigint 8 False 1 - 1  

 
tct_TelephonyCallID bigint 8 False   

 tct_TelephonyTaskID int 4 False   

 tct_Duration decimal(8,4) 5 True   

 tct_ServerCallID bigint 8 True   

 tct_CreatedDate datetime 8 False  (getdate()) 

Key Name Key Columns Unique 

 
PK_T_TelephonyCallTasks tct_TelephonyCallTaskID True 

 IX_TelephonyCallID tct_TelephonyCallID  

 IX_TelephonyCallTaskID tct_TelephonyCallTaskID  
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Travel Time 

 [dbo].[T_TravelTime] 

 

T_TravelTime holds the Travel Time between 2 Schedules 

Columns 

 

  

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 

tt_ToScheduleID 

Holds the ID of the To Schedule 

bigint 8 False   

 

tt_FromScheduleID 

Holds the ID of the From Schedule 

bigint 8 False   

 tt_Duration 

Holds the duration of the travel time 

bigint 8 False  0 

 tt_Payable 

Is Payable(0 - Not Payable, 1 - Payable, 2 - 

Default (Check Payer Services and 

ServiceCode)) 

tinyint 1 False   

 tt_PayRateOverrideAmt smallmoney 4 False   

 tt_CreatedDate 

Record Created Date 

datetime 8 False   

 tt_CreatedUser 

Record Created User 

[nvarchar](50) 100 False   

 tt_ModifiedDate 

Record Modified Date 

datetime 8 False   

 tt_ModifiedUser 

Record Modified User 

[nvarchar](50) 100 False   

 tt_TS 

Record TS 

timestamp 8 False   

 tt_AutoCalculate 

Indicates whether Travel Time should be 

Autocalculated 

bit 1 False  1 

 tt_PayRateOverrideModifiedUser [nvarchar](50) 100 False   

 tt_PayRateOverrideModifiedDate datetime 8 False   



 

© 2020 MatrixCare, Inc. All Rights Reserved, For Licensed MatrixCare Users Only 417 

Indexes 

Foreign Keys 

 

 

Key Name Key Columns Unique Fill Factor 

 

PK_T_TravelTime tt_ToScheduleID True  

Name Update Delete Columns 

FK_T_TravelTime_T_Schedules_FromScheduleID   tt_FromScheduleID-> 

[dbo].[T_Schedules] 

([sch_ID]) 

FK_T_TravelTime_T_Schedules_ToScheduleID Cascade Cascade tt_ToScheduleID-> 

[dbo].[T_Schedules] 

([sch_ID]) 
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Users 

 [dbo].[T_Users] 

 

Description 

Contains data records for Users. 

Columns 

Key Name Data Type 

Max 

Length 

(Bytes) 

Allow 

Nulls Identity Default 

 
user_ID int  False 10001,1  

 user_FirstName nvarchar(30)  True   

 user_LastName nvarchar(50)  True   

 user_UserName nvarchar(50)  False   

 user_ReportUserName nvarchar(128)  True   

 user_Address nvarchar(255)  True   

 user_Address1 nvarchar(255)  True   

 user_Address2 nvarchar(60)  True   

 user_City nvarchar(50)  True   

 user_StateOrProvince nvarchar(20)  True   

 user_PostalCode nvarchar(20)  True   

 user_County nvarchar(50)  True   

 
user_Country int  True  ((240)) 

 user_Phone nvarchar(30)  True   

 user_PhoneTypeID int  True   

 user_LastLogIn datetime  True   

 user_LAN bit  False  ((1)) 

 user_Attempts smallint  False  ((0)) 

 user_Active bit  False  ((1)) 

 user_RetriesExc bit  False  ((0)) 

 
user_BranchID int  False   

 
user_WorkingBranchID int  False   

 user_ImageLoading tinyint  False  ((0)) 

 user_SchedulingCalenderWeekStar

tDay 

tinyint  False  ((7)) 

 user_DefaultTravelTime tinyint  False  ((20)) 

 user_SchedulingConflictOverride tinyint  False  ((0)) 
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 user_SchedulingScheduleConflicts

Allow 

tinyint  False  ((0)) 

 user_SchedulingAvailabilityConflicts

Allow 

tinyint  False  ((0)) 

 user_SchedulingDNUConflictsAllow tinyint  False  ((0)) 

 user_SchedulingAuthorizationConfli

ctsAllow 

tinyint  False  ((0)) 

 user_SchedulingCaregiverExpiratio

nsAllow 

tinyint  False  ((0)) 

 user_SchedulingCheckForOvertime tinyint  False   

 user_NextPayrollDateFlag bit  False  ((0)) 

 user_DefaultPayDate datetime  False   

 user_UseLocalHelp bit  False  ((0)) 

 user_AutoLogoffTime tinyint  False  ((5)) 

 user_DefaultFileLocation nvarchar(100)  False   

 user_ShowDashboardPageOnStart

up 

bit  False  ((0)) 

 user_CarBirthdayReminder bit  False   

 user_CarBirthdayPriorReminderDay

s 

int  True   

 user_CarBirthdayFollowingReminde

rDays 

int  True   

 user_CarAnniversaryReminder bit  False   

 user_CarAnniversaryPriorReminder

Days 

int  True   

 user_CarAnniversaryFollowingRemi

nderDays 

int  True   

 user_CarKeyDatesReminder bit  False   

 user_CarKeyDatesPriorReminderD

ays 

int  True   

 user_CarKeyDatesFollowingRemin

derDays 

int  True   

 user_CarTrainingReminder bit  False   

 user_CarTrainingPriorReminderDay

s 

int  True   

 user_CarTrainingFollowingReminde

rDays 

int  True   

 user_CliBirthdayReminder bit  False   

 user_CliBirthdayPriorReminderDays int  True   

 user_CliBirthdayFollowingReminder

Days 

int  True   

 user_CliAnniversaryReminder bit  False   

 user_CliAnniversaryPriorReminder

Days 

int  True   

 user_CliAnniversaryFollowingRemin

derDays 

int  True   

 user_CliDocumentsReminder bit  False   
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 user_CliDocumentsPriorReminderD

ays 

int  True   

 user_CliDocumentsFollowingRemin

derDays 

int  True   

 user_CliAnniversaryReminder bit  False   

 user_CliAnniversaryPriorReminder

Days 

int  True   

 user_CliAnniversaryFollowingRemin

derDays 

int  True   

 user_CliDocumentsReminder bit  False   

 user_CliDocumentsPriorReminderD

ays 

int  True   

 user_CliDocumentsFollowingRemin

derDays 

int  True   

 user_MiscActivitiesReminder bit  False   

 user_CreatedUser nvarchar(50)  False   

 user_CreatedDate datetime  False  (getutcdate()) 

 user_ModifiedUser nvarchar(50)  False   

 user_ModifiedDate datetime  False  (getutcdate()) 

 user_TS timestamp  False   

 user_DefInquiryView tinyint  False  ((0)) 

 user_DefClientView tinyint  False  ((0)) 

 user_DefCaregiverView tinyint  False  ((0)) 

 user_RemindersPinOnStartup bit  False  ((0)) 

 user_DefRefSourceView tinyint  False  ((0)) 

 user_DriveListPinOnStartup bit  False  ((0)) 

 user_DriveListXML xml  True   

 user_ActCalDaysBefore tinyint  False  ((30)) 

 user_ActCalDaysAfter tinyint  False  ((30)) 

 user_UITimeZoneFrom tinyint  False  ((1)) 

 
user_CaregiverMapID bigint  False   

 
user_ClientMapID bigint  True   

 user_Email nvarchar(50)  True   

 user_AllowMassEmail bit  False  ((0)) 

 user_ShowNotificationsOnStartup bit  False  ((0)) 

 user_SchedulingCheckNoDaysForB

alance 

smallint  False  ((60)) 

 user_SchedulingCheckForBalance tinyint  False  ((3)) 

 user_Favorites xml  True   

 
user_MapToTypeID int  True   

 user_MapToEntityType tinyint  True   

 user_MapToEntityID bigint  True   

 user_AuthFlags int  True   

 user_EulaPortalSignDate datetime  True   
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Indexes 

Foreign Keys 

 

 

 user_EulaSonetoSignDate datetime  True   

 user_SchedulingSkillGroupCheckAll

ow 

tinyint  True   

 user_MustChangePassword bit  True   

 user_PwdChangeDate date  True   

 user_SchedulingCGStatusConflicts

Allow 

tinyint  False  ((0)) 

 user_SchedulingCheckForMaxHour

s 

tinyint  False  ((0)) 

 user_Hidden bit  False  ((0)) 

       

Key Name Key Columns Unique Fill Factor 

 

PK_T_Users user_ID True 80 

 IX_T_Users_BranchID user_BranchID False 80 

 IX_T_Users_LicStatus user_LicStatus, user_BranchID, 
user_ID 

True  

 IX_T_Users_RelatedEntity user_MapToEntityID, 

user_MapToEntityType, 

user_MapToTypeID 

False  

 IX_T_Users_UserName user_UserName True 80 

Name Columns 

FK_T_Users_T_Branches_user_BranchID user_BranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_Users_T_Branches_user_WorkingBranchID user_WorkingBranchID-> [dbo].[T_Branches] ([br_ID]) 

FK_T_Users_T_Caregiver user_CaregiverMapID-> [dbo].[T_Caregiver] ([car_ID]) 

FK_T_Users_T_Client user_ClientMapID-> [dbo].[T_Client] ([cli_ID]) 

FK_T_Users_T_Countries user_Country-> [dbo].[T_Countries] ([ctry_ID]) 

FK_T_Users_T_UserMapTypes user_MapToTypeID-> [dbo].[T_UserMapTypes] ([umr_ID]) 


